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Preface
For details, see the following topics:

• About this documentation

• Notation conventions

• Aurea global support

About this documentation
This guide is par t of the documentation set for Aurea CRM.

Notation conventions
This document uses the following notation conventions:

MeaningConvention

Fixed-width font indicates code, path names, file names, envi-
ronment variable names, parameter names, command names,
machine names, URLs.

Fixed-width

Bold Fixed-width  font is used to indicate user input or to
emphasize cer tain lines of code.

Bold Fixed-
width

Italic Fixed-width font indicates a placeholder for which you
must supply a value.

Italic Fixed-width

Bold sans serif typeface indicates the names of graphic user
interface elements such as dialog boxes, buttons, and fields.

Bold Sans serif

In text, italic serif typeface indicates the first use of an impor-
tant term. The term is defined in the glossary.

Italic serif

Underlined text in command lines and parameter descriptions
indicate that you only have to enter the underlined part of the
command or parameter name. For example, if you use
the-LOGFILE parameter in a command, you only need to enter
-LOGF.

Underlined

Brackets enclose optional arguments.[ ]

Braces enclose two or more items. You can specify only one
of the enclosed items. Vertical bars represent OR separators.
For example, you can specify a or b or c.

{ a | b | c }
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MeaningConvention

Three consecutive periods indicate that you can repeat the
immediately previous item. In code examples, they can be
horizontal or ver tical to indicate omissions.

...

An angle bracket between two menu items indicates that you
should choose an item from a menu. For example, the notation
File >  > Exit means: "Open the File menu and choose Exit."

Menu > Choice

Links to related information in other chapters or documents are
indicated using the >> symbol.

>>

Aurea global support
If you encounter a problem while using an Aurea product or require assistance with
downloading the software or upgrading a product release, please open a ticket on
Aurea Support Central. Preferably, search the ar ticles on the Aurea Knowledge
Base for solutions to your issues before opening a ticket.

Information about the support organization is available on Support Central. The
product documentation is available athttps://help.aurea.com/crm/#.

For information about purchasing an upgrade or professional services, contact your
account executive. If you do not know who your account executive is, or for other
queries, contact us through our website.
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1
Introduction
This manual is intended for administrators of Aurea CRM products.

It describes administrative tasks, tools and functions relevant for all Aurea CRM
products.

The "core" of Aurea CRM consists in a set of DLLs that are used by all Aurea CRM
products. Core features and functionalities cover administrative settings and config-
urations applicable for all products, e.g. access rights definition, triggers, texts in
the data model as well as modifications and extensions to the data model. In addition,
business logic functionality (e.g. price calculations in offer management) is also
provided by the core and therefore the same for all products using the core compo-
nents.

This manual covers the following:

• Setting up stations, adding users and defining access rights, see  Rights Module
on page 97.

• Maintaining the Aurea CRM data model and data stored within Aurea CRM, see 
Maintenance Module on page 265.

• Configuration settings, see Configuration on page 10.

• CRM.server, see CRM.server on page 438.

• CRM.translation tool used to manage the translation of customized texts,
see CRM.translation tool on page 474.

• database structure, command line parameters, number ranges etc., see Appendix.

• functions supporting the development of Industry Solutions, see Industry Solution
Configuration on page 523.

• migration of data and formats of an existing customer solution into another Aurea
CRM environment, see Migrating Data on page 407.

Additional information is provided in the following manuals:

• For details on installing Aurea CRM products, refer to the respective Technical
& Installation Guide.

• For information on the administration of specific Aurea CRM products, refer to
the respective Administrator Guide.

• For information on the Aurea CRM win user interface and basic functions
(conditions, formats etc.), refer to the Aurea CRM win User Manual.
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• For information on the Aurea CRM Business Logic, refer to the Business Logic
Manual for your ver tical.

• For details on the meaning and functionality of individual database fields, refer
to the field help, see Field Help on page 380.

Information on the structure of the Aurea CRM database (tables, fields, indices etc.)
can be found in the Data Model, see Data Model on page 280. You can also output
the database structure as text or XML files, see mmba.exe Parameters on page 13.

All available documentation can be found on the Aurea CRM support page at
https://support.aurea.com.

If not mentioned otherwise, all examples in this manual apply to the BTB vertical.

9AUREA CONFIDENTIAL

https://support.aurea.com


2
Configuration
Here you learn to configure info areas and connection settings.

Aurea CRM Parameters
Learn about the Aurea CRM's functions that can be accessed via the command line.

Many of Aurea CRM's functions can be accessed via the command line.

Use the following syntax:

<Module> -<Parameter> <Value ,Value ...> -<Parameter2> <Value,Value...> ...

Example:

mmco.exe -u com -k o ,101

Use the following syntax for parameters with mode than one character:

<Module> --<Long Parameter> <Value ,Value ...> ...

Example:

mmba.exe -u su --xml Turnover-Report

Enclose values and paths containing spaces in double quotes:

mmba.exe -u "John Smith"

mmim.exe -f "Company Import" -d "c:\My Documents\companies_csv"

Note:  Single quotes are not supported.

Use \" to specify quotes within a value:

mmim.exe -e -u imp -f "Export \"A-Customers\""

Note: The following are case sensitive:

• - Format names

• - Passwords, if the PW must contain upper and lower case option is enabled
in the station configuration, see Password Security.
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General Aurea CRM Parameters
Learn about the general Aurea CRM parameters.

-?

Displays information on the parameters supported by an Aurea CRM module.

-u

Specifies an Aurea CRM user name.

mmba.exe -u "John Smith"

-p

Specifies the password used to log on.

mmri.exe -u su -p 123

-l

Specifies the language the module should be star ted with, see Language IDs on
page 389.

mmba.exe -u su -p <Password> -l 1

Logs on to the main module in English as SU.

--db

Specifies the database type (MS SQL or Oracle) the module should be star ted with,
see mmdb.ini and mmodbc.ini Files on page 71.

mmim.exe -u su -p <Password> --db mss

or

mmim.exe -u su -p <Password> --db ora

-v

If you have installed Aurea CRM with separate program and data directories, you
need to specify the data directory using the parameter –v, see Additional Options
in the Aurea CRM win Installation Guide.

mmba.exe -v c:\u7data

--role

Specifies the role(s) that the user is logged on with, see Rep Roles on page 123.

mmba.exe -u "John Smith" -p johns --role "Support Admin" "Sales Admin"
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-q:<Value>,<Value>,...

Starts a module with the following functions:

• selout: Logs SELECT statements executed by selections in the file <USER
NAME>.<Link to Info Area> (FI, KP or OJ (BTB only)) in the \system\db directory.

• errorlog: Logs database errors to the mmcom.log file in the \system\db directory.

• stmtlog: Logs SQL statements to the module's log file (e.g. SU_1.log) in the
\system\db directory, see Logs and Error Messages on page 506.

• stmttune: (for Oracle databases): If you star t mmba.exe with parameters, all
combinations of tables and indices are tested and sensible TUNE_STMT_REL
combinations are determined. The settings are displayed in a prompt. Click on
Yes to write the settings to the mmdb.ini file, see Optimizing Access on page
89.

--writeprocesslist

If you star t an Aurea CRM module with this parameter, the file u8Pro-
cessList_<Module no.>.txt containing a list of all levels ("processes") available
in this module is written to the \system\db directory, see Module Numbers on page
390. The module is then closed automatically.

The file contains:

• Id: ID of the level.

• Class: Class the level belongs to (for example, levels containing the Activity info
area belong to class 11000), see Level Properties in the Aurea CRM win
Administrator Guide.

• Name: Name of the level in the current language.

• Type: Level type

• core : Levels available in all ver ticals.

• BB/BC/FS: Levels only available in specific ver ticals.

• gen : User-defined levels, see Defining New Levels in the Aurea CRM win
Administrator Guide

• Modules: Name of the module in the current language.

• Infoareas: The info areas contained in the level.

This parameter is supported by the main module as well as the Rights, Maintenance,
Communication, Print, Analysis, Import and Export modules.

--quiet

If you star t an Aurea CRM function using this parameter, no messages are displayed
if errors occur. Use this parameter for sessions that should run in the background.

mmim.exe -u <user name> -p <password> -f "Company Import" --quiet

mmba.exe -u <user name> -p <password> --xml "Revenue 2008" --quiet
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--exit

Automatically closes an update.CRM module:

mmba.exe -u <User> -p <Password> --writedbstr --exit

Note: When executing mmba.exe the --exit parameter only works in combination
with the --write* parameters, see mmba.exe Parameters on page 13.

You can use echo %errorlevel% and --quiet --exit during batch processing to
return General Error Codes on page 508. (Example: mmco.exe -u no_user --quiet
--exit returns error code 105.)

mmba.exe Parameters
Learn about the mmba.exe parameters.

-a

Use this parameter to generate automatic selections, see Automatic Selections in
the Aurea CRM win User Manual.

mmba.exe -u <User> -p <Password> -a sl ,c

• sl: Generates selections.

• os: Generates property selections (BTB only).

• c: Determines that Aurea CRM's main module remains open after executing the
automatic selection.

--auto-sl and --auto-os

Use these parameters to generate cer tain automatic selections by specifying the
format name. The selections are generated irrespective of whether the Autom. is
enabled for the selection and irrespective of the frequency entered for generating
the selection.

mmba.exe --auto-sl <Format 1> <Format 2> ... <Format n>

mmba.exe --auto-os <Format 1> <Format 2> ... <Format n> -a c

• --auto-sl: Generates the specified selections

• --auto-os: Generates the specified property selections (BTB only)

• -a c: Optional parameter, determines that Aurea CRM should remain open after
executing the selection.

Enclose format names containing spaces with quotation marks, e.g. "My Format".
If the format name includes quotation marks, add a backslash before the quotation
marks, e.g. "\"German\" Customers".

--cleanup

Use this parameter to cleanup invalid processes.

13AUREA CONFIDENTIAL

Aurea CRM Parameters

https://help.aurea.com/crm/crm-win-user-manual/crm-win-user-manual/dita/topics/c_win_UsrMan-6_5-Automatic-Selections_upd.html


mmba.exe --cleanup

Note:  Note: You can also use the Repair feature to cleanup invalid processes, >>
Repairing Processes.

Possible Values: D1, D2 (for the Document (D1) and Customer Document (D2)
info areas): --doc-mimetype

Use this parameter to automatically enter data in the MIME Type and Encrypted
fields in document records added prior to Service Pack 6.

mmba.exe -u <User> -p <Password> --doc-mimetype D1

Possible Values: D1, D2 (for the Document (D1) and Customer Document (D2)
info areas)

Note:  From version 7.06, values are automatically entered in these fields when
adding document records or generating a single letter.

--genextkey

Creates external keys for existing catalog values (in variable catalogs), see Unique
System-wide Identification of Catalog Values.

mmba.exe -u <user name> -p <Password> --genextkey

This parameter only functions on the catalog maintenance station.

Existing external keys are not overwritten.

If an external key is already present in the database as the external key of another
catalog value, no key is created for the current catalog value. In this case, the fol-
lowing message is written to the active module's log file: Catalogs ;Warning ;Gener-
ated external key already exists: '1_18_2'. In this case, you need to enter the
external key manually, see Editing Variable Catalogs on page 273.

-m

Creates the file mm_index_<Language>.* and model.* in the current user's user direc-
tory in the selected format and current language.

mmba.exe -u <User> -p <Password> -m 1

• 0: ASCII

• 1: XML

• 2: TXT

If you do not specify a format, the file is created in ASCII format.

The file mm_index_<Language>.* contains a list of all indices for each info area.

The file model.* contains the primary links for each info area. This corresponds to
the structure in the table used to define access rights, for example.
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--migd3link

When upgrading from version 7.04 to 7.05 (or higher): Star t mmba.exe with this
parameter to enter data in the new key fields in the Document Link (D3) info area:

mmba.exe -u <User> -p <Password> --migd3link FI

Possible Values: FI, KP, MA, TD

-q

Starts the SQL Tool, see SQL Tool on page 469.

-r

Starts the Rebuild module, see Rebuild module on page 468.

-f

Use this parameter to rebuild the tables from the command line:

mmba.exe -r -u <User> -p <Password> -f fi ,kp,ma

Possible values are info area codes (separated by a comma) or all to rebuild all
tables.

-w

Use this parameter to remove duplicate catalog values. Specify the catalog number
to star t the function for individual catalogs:

mmba.exe -u <User> -p <Password> -w 1,2,3,4

--writedatetime

Creates the file mm_dbDateTime.txt in the \system\db containing a list of all
combined date and time fields (database fields of the type "date,time") for each info
area. The number of the associated date or time field is enclosed in square brackets.

55 ; Last Output Date; ComAusDatum_DT; date ; 10 ; ; ; [ 56 ];

56 ; Last Output Time; ComAusDatum_DT; time ; 11 ; ; ; [ 55 ];

--writedbstr

Writes information on the currently active data model to the \system\db directory.
The following files are created:

• mm_catno.txt: List of all variable catalogs

• mm_config.txt: List of all available entries in the Configuration info area

• mm_dbfnr_base.txt: List of all info areas containing core fields, including core
field numbers, see Vertical-independent Configuration on page 528.

• mm_dbstr.txt: List of all info areas and fields in Aurea CRM with the user-defined
texts in the current language and the IDs of the Text info area.
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• mm_noPrimaryKey.txt: List of all info areas whose primary key is not numeric,
i.e where the ID column is not generated from one or more field values of the
record.

• mm_rel_base.txt: List of all info areas that are identical in all ver ticals,
see Vertical-independent Configuration on page 528.

• mm_relh.txt: List of all child info areas of the Company, Person in Company
and Property (BTB only) info areas.

• mm_relStLn.txt: List of all info areas whose primary key is composed of station
number plus serial number. Generic links can only be used with these info areas,
see Link on page 305.

--writedbstrfid

Creates the file mmdbstr.txt in the system\db directory with the internal field
IDs output as the field numbers. The order and numbering of fields corresponds to
the order and numbering in the data model.

--writeres

Creates the following files in the \system\db directory:

• mm_ResDialog_xxx.txt: List of all dialogs

• mm_ResMenu_xxx.txt: List of all menus

• mm_ResText_xxx.txt: List of all texts in the user interface

• mm_BefTable.txt: List of button texts with resource IDs

• mm_dbfnrid.txt: List of all field text and original field text resource IDs

• mm_fixcatno.txt: List of all fixed catalog values

• mm_fixcatno_custom.txt: Lists all fixed catalog values (including user-defined
values) with the user-defined texts in the current language and the IDs of the
Text info area. Locked catalog values are not output.

Where xxx is the language that mmba.exe was star ted with.

--writeresfnr

Creates the following files in the \system\db directory (see above for descriptions):

• mm_BefTable.txt

• mm_dbfnrid.txt

• mm_fixcatno.txt

• mm_fixcatno_custom.txt
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--writexmldef

If you star t mmba.exe as SU in English, this parameter creates the following files
in the ..\system\xml directory (in this example for BTB):

• BTBi80.xml: The current data model with the following information:

• <alltables>: All info areas, fields and field properties

• <allrelationships>: All relationships and dependencies between info areas

• <allindexes>: All indices

• BTBi80.txt: List of all fields

• BTBi80_catalogs.xml: List of all variable catalogs

Note: When generating XML files (using --writexmldef) you can specify the
following additional options in the [Option] section of the mm.ini file (see mm.ini
File on page 70):

• xml_lang=1: The files are created in the language you star t mmba.exe with (-l
parameter, see General Aurea CRM Parameters on page 11).

• xml_unique_filename=1: The corresponding language abbreviation is included in
the name of the XML file (e.g. BTBi80_ger.xml).

• xml_user=1: If this option is enabled, users other than the SU can use the
--writexmldef parameter.

• The user and language are written to the header information of the generated
XML files.

--allcatalogs

Use this parameter to output variable and fixed catalogs in XML format. Variable
catalogs are output in the languages assigned to the station, fixed catalogs in all
languages. This parameter is used in conjunction with the following parameter:

• --writexmldef

mmba.exe -u SU -l 1 --writexmldef --allcatalogs

This creates the following files in the .. \system\xml directory (in this example for
BTB):

• BTBi80.xml: The current data model with the following information:

• <languages>: The current language and the catalog base language

• <alltables>: All info areas, fields and field properties

• <allcatalogues>:

• < catalogues >: All catalog values from all variable catalogs. Locked values
are output with a locked="1" attribute.

• < fixcatalogues >: All catalog values from all fixed catalogs. Locked catalog
values are not output. Custom fixed catalogs are only output if they are
actually used in an info area.
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• <allrelationships>: All relationships and dependencies between info areas

• <allindexes>: All indices

• BTBi80_catalogs.xml: List of all variable catalogs

Prerequisite for the output of fixed catalogs is that the respective language dll
files are available.

--CheckRights

Only outputs those fields that the current user is permitted to access according to
their access rights to files containing information on the data model (e.g. mm_db-
str.txt). This parameter can be used in conjunction with the following parameters:

• --writedbstr

• --writedbstrfid

• --writeresfnr

• --writedatetime

--infoAreaColumn

Outputs info areas in their own column (instead of as a header) to those files con-
taining info area names (e.g. mm_dbstr.txt). This parameter can be used in conjunc-
tion with the following parameters:

• --writedbstr

• --writedbstrfid

• --writeresfnr

• --writedatetime

--xmlFieldNames

Use this parameter to output XML field names (as additional column in the file
mm_dbstr.txt). This parameter is used in conjunction with the following parameter:

• --writedbstr

--xml

Use this parameter to create XML reports, see Reports in the Aurea CRM win User
Manual.

mmba.exe -u <User> -p <Password> --xml "Revenue 2008"

--xfile

To create several reports, create a text file (ASCII, Unicode, UTF8) which contains
a report format on each line, and use the parameter --xfile:

mmba.exe -u <User> -p <Password> --xfile c:\reports.txt
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mmcfg.exe Parameters
Use this parameter for silent setup.

-s

Use this parameter to suppress the message at the end of an automatic client instal-
lation, >> Silent Setup in the Installation Guide.

mmri.exe Parameters
Learn about the use of mmri.exe parameters.

-w

mmri.exe -w star ts the Maintenance module, see Maintenance Module on page 265.

mmServer.exe Parameters
Learn about the use of mmserver.exe parameters.

Use the following parameters to register or remove instances of update.seven
server, see Configuring update.seven server on page 460.

-n

Name of the CRM.server instance.

--install

Registers a CRM.server instance:

mmserver.exe --install -n <Service> -u <User> -p <Password>

--remove

Removes a CRM.server instance:

mmserver.exe --remove -n <Service>

update.server.exe Parameters
Learn about the use of update.server.exe parameters.

Use the following parameters to register, star t, stop and remove instances of
CRM.server, see Configuring the Service on page 439.

-i | --install

Installs CRM.server as a service:

update.server.exe --install [-n <servicename>]
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-n | --name

Specifies the name of the service. If undefined, the service is installed as "up-
date.server".

--start

Starts the service:

update.server.exe --start [-n <servicename>]

--stop

Stops the service.

-u | --uninstall

Removes an instance of CRM.server:

update.server.exe --uninstall [-n <servicename>]

-v | -- verbose[ =<value>]

Specifies the log level for the command line output. Available values: Debug, Info,
Warning, Error.

The default is Warning. If you do not provide a value, Info is used.

Configuration Info Area
The Configuration info area is used to configure Aurea CRM system settings.

The settings are grouped into various categories, each containing a number of op-
tions. The Configuration info area can be accessed in both the main and Rights
modules (Info > Configuration).

Note:  Make sure that you deny access to the Configuration info area (in the Rights
module) for users. Otherwise, all users have access to the configuration settings.

There are three basic types of options: Boolean (logical), numeric and text.

• Boolean options can be either enabled or disabled

• Numeric options can be set to a numeric value

• Text options can be set to a text value

Certain options are global options and apply to all Aurea CRM users. Other options
can be defined for individual reps, rep groups or stations. If no rep, group or station
is specified, the setting applies globally.
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Note: To see an overview of the configuration settings for the current user, select
Help > About Aurea CRM from the menu and click on Configuration.

Note: The configuration options in the Configuration info area used to be specified
in the mm.ini file (up to and including marketing.manager 6). Whilst some settings
are still entered in the mm.ini file, most options are now configured from this info
area. For details on the options configured in the mm.ini file, see mm.ini File on
page 70.

Changes to the Configuration info area are refreshed at the interval entered in the
Cat. refresh  frq. field in the Station Configuration info area, see Station Config-
uration on page 233.

As with data in other info areas, configuration settings can be communicated to
other stations.

Adding a Configuration Entry
Learn how to add a configuration entry.

To add a new configuration entry:

1. Click the New button.

2. A dialog box is displayed, containing a list of all the available categories under
Category.

3. Select the category from the list.

A list of the options in the category is displayed under Options.
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4. Select the desired option.

The names of the category and option that were previously included in the mm.ini
file (up to version 6) are displayed under Previous  section name and Previous
option name.

The option's default value is displayed under Default value, if applicable.

5. Click OK.

6. Enter the value for the option in the corresponding field in the Configuration info
area; i.e. enter text values in the text field etc.

You can select Add/edit value, Test value and Load value from the context
menu for some options.

7. Assign the setting to a station, user or group of users, if desired and applicable.
Enter the station number, or select the rep or group by clicking on the icon in the
corresponding field. If no user, group or station is specified, the setting applies
to all users.

Note: To disable a configuration entry, enable the Do not use entry field.

Configuration Settings
Here you can learn to perform the core configurations settings for aurea CRM.

Below is a list of the configuration options available, grouped by category:

Analyses
Learn how to generate analysis report and graphically display it.

Use the following configuration entries to configure the appearance and functional-
ity of analyses in Aurea CRM win:

General bar chart template/General pie chart template

Use these options to specify an XML file to use as a template for the layout of the
analyses. The template is used if no template is specified in an analysis format.
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Select Add/edit value from the context menu to select the XML file. Select Load
value from the context menu to choose a document stored in the Document info
area.

These settings only apply to the ComponentArt graphics.

Detailed information on the XML format can be obtained from Aurea's support.

Bar chart template/Pie chart template

Use this option to define multiple layouts for analysis graphics (distinguished by
their ID). The layout can be specified in the analysis format when defining an anal-
ysis.

These settings are applied globally and only affect the ComponentArt graphics.

Quick output

Use this option to enable ComponentArt's quick rendering algorithm for analyses.

Transfer field type

Use this option to transfer field types to Microsoft Excel when transferring analyses.
This ensures that Excel processes the fields correctly.

Use ComponentArt graphics

ComponentArt's graphics are used if:

• This configuration entry has either not been defined or is set as Active

• and Aurea CRM is star ted locally

• and .NET Framework 4.5 is installed.

Otherwise the Aurea CRM graphics are used instead.

Add this configuration entry and leave the Active field disabled to use the Aurea
CRM graphics.

Affiliations
The Affiliation View allows users to view data linked to a set of companies and/or
persons

For example - All insurance policies taken out by the members of a family). The
child records are read via indirect links (via PB) with link IDs 26000-27999, see Link
IDs on page 394.

Note: The Affiliation View is not available in Aurea CRM win.

Applies to the following info areas

Use this configuration entry to specify the info areas (linked to FI, PE or KP) from
which data should be displayed in the Affiliation View. Specify the info area IDs
separated by semicolon, e.g. MA ;MB ;KM.
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Note: This setting is applied globally.

If you want to display activity records (MA) in the Affiliation View, make sure you
enter the Activity Participants info area (MB) in this parameter as well.

To enable the Affiliation View you also need to activate CRM process 1.4.1.4.7.
"Affiliations".

For information on the business logic involved, see Affiliation View in the Business
Logic Manual.

For information on the Affiliation View in Aurea CRM web and CRM.designer, see
Affiliation View in the Aurea CRM web Administrator Guide.

Business Solutions
Use this option to specify info areas from which records created on a station with
station number >= 10000 may be deleted on stations with station number < 10000.

For more information, see Station Number Ranges on page 526.

Allow deletion of the following data

This option is only available on stations with station number >=10000, see Industry
Solution Configuration on page 523.

Enter the desired info area IDs separated by semicolon.

This setting is applied globally.

Calendar
Learn to configure calendar for holidays and appointments.

Holidays

Use this option to determine the holidays that are displayed in the calendar. You
can either use/edit the existing country calendars or define your own, see Predefined
Calendars on page 25 and XML Definition of Calendars on page 26.

To define a Holidays configuration entry:

1. Create a new Holidays configuration entry.

2. Enter the ID of the desired country calendar (1 or higher). The ID must correlate
with a catalog value ID of the fixed catalog "Calendar" (e.g. 1 = Austria, 2 =
Germany etc.).

The XML files containing the default calendar definitions are located at ..
\system\xml\Calendars.

3. Import an XML file into the Value field:

a. Click on the Value field.

b. Select Add/edit value from the context menu.

c. Select an XML file.
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4. Edit the XML code in the Value field or enter new data, see XML Definition of
Calendars on page 26.

5. Save.

6. Select Test value from the context menu.

If the XML code contains any errors, you receive a corresponding error message.
Correct any errors and save the record again.

7. The small calendar is opened. Test that your settings are correct.

Each Holidays configuration entry you define results in the respective country cal-
endar entry for the users to choose from:

• Aurea CRM win: Calendar drop-down list in Extras > Other Options. If no
selection is made, the international calendar is used by default.

• Aurea CRM web: Holiday Calendar drop-down list in Settings > User
Configuration > Date&Time. (You need to define the available entries as values
of the Calendar.HolidayCalendarID Web Configuration parameter.)

Use the Calendar field in the Country and Rep info areas, to assign specific calen-
dars to countries or reps.

In addition, you can use the Calendar Definition info are (CD) e.g. to define holidays
which do not occur every year, see Calendar Definition Info Area on page 94.

Holidays are highlighted in the small calendar and the Calendar and Daily Overview
views. In the BTB and OTC versions you can also determine that sales group ap-
pointments are not generated on holidays.

The calendar for the currently active user is determined as follows:

1. The calendar selected by the user (Aurea CRM win: Extras > Other Options >
Calendar | Aurea CRM web: Settings > User Configuration > Date&Time >
Holiday Calendar).

2. The calendar entered in the user's Rep record.

3. The calendar entered in the Country record of the country entered in the user's
Rep record.

4. If no value is found, the default calendar "International" (3) is used as a fallback.

Maximum lines for all day-appointments

Use this option to determine how many lines are available by default for all-day
appointments in the calendar in Aurea CRM win.

This setting is applied globally.

Predefined Calendars
Table for predefined country calendars.

The following predefined country calendars (XML files) are available (in .. \sys-
tem\xml\Calendars):
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File NameIDCountryFile NameIDCountry

Belgium.xml13BelgiumAustria.xml1Austria

Netherlands.xml14NetherlandsGermany.xml2Germany

Italy.xml15ItalyInternation-
al.xml

3International

Russia.xml16RussiaCzechRepub-
lic.xml

4Czech Repub-
lic

Poland.xml17PolandSwitzerland.xml5Switzerland

Slovakia.xml18SlovakiaDenmark.xml6Denmark

Brazil.xml24BrazilSpain.xml7Spain

Greece.xml33GreeceUsa.xml8USA

Hungary.xml34HungarySlovenia.xml9Slovenia

Mexico.xml47MexicoFrance.xml10France

Romania.xml50RomaniaPortugal.xml11Portugal

UnitedKing-
dom.xml

12United King-
dom

XML Definition of Calendars
Learn how to define your own country calendars.

To define your own country calendars use the following syntax:

Notes

Notes are included in the xml files in the < !-- --> element.

<!-- ID is 10 -->

<calendar> and <holiday> Elements

Holidays are defined within the <calendar> element. A <holiday> element is defined
for each holiday.
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< calendar >

<holiday m= '1' d ='1' />

</calendar>

Calendar Name

Use the <text> element to determine the name of the calendar in all the available
languages:

<calendar>

<text lang ='0'>Mein Kalender</text>

<text lang ='1'>My Calendar</text>

<holiday m= '1' d ='1' />

</calendar>

If you do not define a name, the catalog text for the selected calendar ID is used
as name (fixed catalog "Calendar").

Fixed Holidays

Fixed holidays are defined using the base='fixed' attribute. This attribute is the
default value and need not be specified. m={1,2,...,12} defines the month;
d={1,2,...,31} defines the day.

Examples:

<holiday m= '1' d ='1' />

The 1st of January is a holiday.

<holiday base='fixed' m= '12' d ='25' />

The 25th of December is a holiday.

Variable Holidays

Use the attribute base='easter' to define holidays relative to Easter Sunday. De-
termine the number of days before or after Easter Sunday using diff ={ n}. A positive
value for n means n days after Easter Sunday; a negative value means n days before
Easter Sunday.

Example:

<holiday base='easter' diff='39' />

The 39th day after Easter Sunday is a holiday.

Naming Holidays

The names of holidays are displayed in the calendar in the header in the daily view,
in the small calendar and in the daily and working week views as tooltips.

Enter the name of the holiday in all available languages using the text element
within the holiday element.
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All text must be entered in an XML compatible format; i.e. special characters may
need to be coded (e.g. use '&amp;' to enter an ampersand).

Example:

<holiday m= '1' d ='1'>

<text lang ='0'>Neujahr</text>

<text lang ='2'>Jour de l'An</text>

<text lang ='-1'>New Year's Day</text>

</holiday>

lang ='#' determines the language, see Language IDs on page 389. If no name has
been defined for a language, the default value (-1) is used.

Abbreviations for weekdays

Weekdays are abbreviated as follows:

Mo, Tu, We, Th, Fr, Sa, Su

Rescheduling Holidays that Fall on a Weekend

If a holiday falls on a specific day, the holiday can be rescheduled.

Example:

<holiday m="9" d="1" day="Sa" subst="+2"/>

If the 1st of September is a Saturday, the holiday is rescheduled for the following
Monday (2 days later).

Fixed Weekdays

The attribute weekday and last are used to determine a weekday within a month.
In this case the d attribute determines the day.

Example:

<holiday m="9" d="2" weekday="Mo" />

The second Monday in September is a holiday

<holiday m="9" d="1" last="Mo" />

The last Monday in September is a holiday.

Holidays that do not Occur Annually

The every attribute determine that a holiday does not take place annually but every
'n' years. The intervals are counted from the year 2000.

<holiday m="4" d="8" every="5" />

The 4th of August is a holiday every 5 years (2005, 2005 etc.)
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Campaigns
Learn about the configurations required for campaigns.

Blind Copy E-Mail

Enter an e-mail address to which all e-mails generated in the course of campaign
management are sent as BCC.

Do not transfer label fields

Enable this option to prevent label fields from being transferred to control files.

E-mail address order

Use this option to determine which e-mail address is used when executing activities.
For information on the default order, see Defining the Activity Format in the Aurea
CRM win User Manual.

Select Add/edit value from the context menu to determine the order for company
and then for person e-mail addresses in the Company, Person in Company and
Additional Address info areas.

You can also enter the fields directly in the Value field using the following syntax:

Example: FI-FI,20,19;KP-KP,28,29;ZA,18;FI,20;19

Company (FI) addresses are searched for in fields 20 and 19 of the Company (FI)
info area; person (KP) addresses are searched for in fields 28 and 29 of the Person
in Company (KP) info area, then in field 18 of the Additional Address (ZA) info
area and then in fields 20 and 19 of the Company (FI) info area. The first address
found by the search is used to send the e-mail.

You can define multiple configuration entries (with different values in the ID field).
Users can then select one of the configurations from the E-mail address order field
in the Execution (Marketing Activity) info area.

Error message in generic text field

In order to use this option, a generic text field needs to be added to the Target
Group (Marketing Activity) info area using the Data Model info area (Maintenance
module), see Data Model on page 280.

Field used to cancel the execution for marketing activities

Enter the number of a Boolean field in the Execution (Marketing Activity) info
area. This field can then be enabled to abort the execution of an activity by
CRM.server, see Aborting the Execution of a Marketing Activity.

When executing the activity, CRM.server polls the status of this field in regular in-
tervals. The default polling interval is 5 seconds. To change the interval, enter "In-
terval=n" (where n is the number of seconds) in the Comment field.
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Generate message on error

If an error occurs when sending an e-mail, the corresponding target group record
is linked to a message containing the corresponding error code and other information,
see Error Codes for Marketing Activities on page 514. If no target group is present,
target groups are added for those records that caused an error.

This message is created for the executing rep by the current rep. If no executing
rep has been entered, the message is also created for the current user.

Suppress Warnings

Use this entry to suppress warnings when executing campaigns. Error messages
are still output.

Catalogs
Learn about the configurations required for catalogs.

Automatically enter external keys

If this option is enabled, an external key is automatically entered for the entry in
the catalog base language when adding new catalog values, see Unique System-
wide Identification of Catalog Values.

The external key is of the format:

< station >_<catno>_<code>

or

< station >_<catno>_<code (parent)>_<code>

This setting is applied globally.

If an external key is already present in the database as the external key of another
catalog value, no key is created for the current catalog value. In this case, the fol-
lowing message is written to the active module's log file: Catalogs ;Warning ;Gener-

ated external key already exists: '1_18_2'. In this case, you need to enter the
external key manually, see Editing Variable Catalogs on page 273.

Check Blacklist/Whitelist
Learn about the Blacklist/Whitelist configurations settings.

The options of this category allow you to specify an external application that is used
to check new records against entries in an external blacklist or whitelist.

City Table
Use this entry to remove the link between fields in info areas and fields in the city
table (City info area in the Maintenance module).

Disconnect Fields from City Table
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Enter the info area's abbreviation and the affected field's number, e.g. (BTB) "FI =
6,14". In this case, the links between the City table and fields 6 (County) and 14
(Area Code) in the Company (FI) info area are removed and data is no longer
transferred automatically.

If you enter "FI=8" (City field), no fields are transferred from the City table.

Note: This setting can only be defined globally or per station for all Aurea CRM
applications apart from Aurea CRM win.

Communication
Learn about the configuration required for communication between stations.

These settings affect communication between stations.

Attachment Name

Executable files cannot be sent or opened in MS Outlook, unless Outlook is config-
ured accordingly. You can therefore specify a file name used by all attachments
sent from within Aurea CRM. The file name may not contain any special characters
apart from underscore (_), and the file extension cannot exceed 3 characters. You
need to enter the same attachment name on each communicating station to ensure
that the file is recognized correctly.

Enter the file name in the Text field.

Benchmark

For testing purposes only.

Maximum Record Size

This parameter accelerates the output of data under SQL Server and Oracle.

Generally, only records' primary keys are transferred and stored in a temporary file.
Once all the keys necessary for communication have been written, each record is
read from the database using the keys in the temporary file.

If you enter a value, all records under the specified size (in bytes) are written directly
to the temporary file and then later transferred to the communication file without
needing to access the database a second time.

The size of a record is determined by the sum of the field lengths in the record. For
example, to determine the length of fields in the Company (FI) info area:

SQL Server:

select sum(length) from syscolumns where id in (select id from sysobjects
where name='INV_FI')

Oracle:

select sum(data_length) from all_tab_columns where table_name='INV_FI';
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Note: The bigger the value, the more space required during output (in the COM
user's directory).

No Inventory

Enable this option to suppress the verification of stock-relevant data when synchro-
nizing stations. If this configuration entry is active, data affecting stocks are deleted
on branch offices when synchronizing (e.g. orders that have not been included in
stocktaking).

This setting must be assigned per station.

Alternatively, you can completely disable stock management by locking the "Inven-
tory Management" process (see CRM Process Configuration on page 98). This is
the approach recommended by Aurea.

Update priority

When communicating, the access rights defined in the Rights module are ignored,
see Rights and Communication. When inputting records, records from the source
station are matched up with existing records based on the primary key. If a record
with an identical key is found, the records are merged. Aurea CRM saves the modi-
fication date and time for each record and uses this information and the settings in
the communication format to determine which data to retain, see Communication
Format in the Aurea CRM win Administrator Guide. Use the Update priority config-
uration entry to prevent field contents in records from being changed by communi-
cation on the target station (this function corresponds to conditional field access
rights). This allows you to prevent data that is synchronized with external systems
from being overwritten by data communicated from branch offices.

Changes to data in the fields on the source station are ignored and the contents of
the record on the target station are output for the source station (synchronization).

If both the records on the target and source stations are affected by a configuration
entry, the data in the station higher up the hierarchy (i.e. the station closest to the
main office according to the existing communication connections) takes precedence.
All corresponding connection records (Communication info area) must be present
on the target station for this to take effect.

Enter conditions to be applied to the fields that should be locked in the Value field
using the following syntax:

[FI: " F26<>'' " 2,5]

[FI: " F35='A' OR F79>='100' AND F79<='500' " 4,10,25]

[ID: " F9='#1' AND F27()'update.com' " 6,102]

Expressions are delimited as follows:

• Enclose definitions for an info areas in square brackets: [FI: ]

• Enclose conditions in quotation marks: " F35= 'A ' OR F79>='100' AND F79<='500'
". (You can use  (Copy Condition) in the Define Conditions dialog to copy
conditions to the clipboard.)

• Enclose comparison values in single quotation marks: F9='#1'
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Enter the fields that should be locked after the condition, separated by commas,
e.g. 2 ,5

If the syntax is invalid, a warning is displayed when saving the configuration entry.
If an entry using invalid syntax is used during communication, nothing is input from
the affected info areas and the warning is displayed and written to the log file.

This configuration entry can be defined globally or per station.

Copy Fields (BTB, OTC)
The options in this category determine which fields are copied between info areas
using the Copy to ... context menu entry.

Example (BTB): The Copy to Offer entry in the context menu in the Service Con-
tract info area: Use the Copy Offer to Offer option to define which custom fields
are copied to a new offer when using the Copy to Offer entry in the context menu.

Select an entry and select Add/edit value from the context menu to enter values.
Select the desired fields in the Copy Fields dialog box. The selected field numbers
are automatically entered in the Value field.

When copying data, the settings are applied in the following order:

1. Aurea CRM's internal business logic

2. The options in the Copy Free Fields category

3. The options in the Copy Fields category

Note:  System fields cannot be copied, see System Fields on page 392.

Copy Free Fields (BTB)
The options in this category allow you to define which custom fields are copied when
the Copy to Order (from an offer) or Copy to Installed Base (from an order) options
are selected.

You need to specify the field numbers in the source info area that should be trans-
ferred. Separate field numbers using a semicolon.

Example: 59;62;...

The free fields with numbers 59, 62 etc. are transferred in this case. Field numbers
can be viewed either in the mm_dbstr.txt file or by double-clicking with the right
mouse button on the header when viewing all fields in the mask (View > All Mask
Fields), see mmba.exe Parameters on page 13 and Displaying all Fields in a Mask
on page 388.

Transferring Catalog Fields

Free catalog fields can be copied by entering the catalogs field numbers under the
corresponding option:
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The FreeC( Head)1, FreeC(Head)2 and FreeC(Head)3 catalog fields are copied
from offers to orders and from orders to installed bases.

The FreeC( Pos.)1, FreeC(Pos.)2 and FreeC(Pos.)3 catalog fields are copied from
offer lines to order items and from order items to components.

Special fields when copying

As there are large number of free fields per info area, it sometimes makes sense
to exclude those fields that should not be copied. If Copy Defined is enabled, those
fields that are listed are transferred. If Copy Defined is disabled, those fields that
are listed are excluded from the transfer, and all other fields are transferred.

Country Table
Use this entry to remove the link between fields in info areas and fields in the country
table (Country info area in the Maintenance module).

Disconnect Fields from Country Table

Enter the info area's abbreviation and the affected field's number, e.g. (BTB) "FI
=21". In this case, the link between the City table and Field 21 (Label) in the
Company (FI) info area is removed and is no longer transferred automatically.

If you enter "FI=5" (Country field), no fields are transferred from the City table.

Note: This setting can only be defined globally or per station for all Aurea CRM
applications apart from Aurea CRM win.

Data Model
Learn about the configuration for data models.

No deletion of Person records when a Company is deleted

By default, a person (PE) record with only one linked CP record is handled as follows:
If the related company record is deleted, the PE record is deleted as well, see Adding,
Editing and Deleting Persons on page 434.

Activate this option if you want to retain these PE records.

This setting is applied globally.

Reference Text

Use this option to define texts for references in the data model.

In Aurea CRM win you can also define references in the desktop settings. The
desktop settings take precedence over the settings in the Configuration info area.

Select Add/edit value from the context menu after selecting the appropriate entry.
The Properties dialog box is displayed. Further information on the References tab
can be found in the Desktop chapter under Reference Tab in the Aurea CRM win
Administrator Guide. In contrast to the desktop settings, you cannot define a target
level in the Configuration info area.
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DDE
The DDE settings affect the exchange of dynamic data.

Below are the DDE settings:

DDE Server - backwards compatible field encoding

As of version 7.0, field numbers are transferred to the DDE server using 5 digits by
default. Vir tual document fields star t from 25050.

Enable this option to revert to the settings used in version 6.0: field numbers are
transferred with 3 digits, and vir tual document fields star t at 950. This allows you
to use interfaces defined for version 6.0 without needing to edit them. However, you
cannot then use the functions provided by the dynamic data model.

Label Address Fields

When transferring field data using DDE transfer formats, field names are displayed
in the language in which the format was defined, irrespective of the language in
which Aurea CRM is running.

To display the names of fields in a label in a different language, enter the name of
the address field in the desired language; for example "Addr" for English. Note that
the numbers 0 to 9 are appended automatically.

Label Salutation

When transferring field data using DDE transfer formats, field names are displayed
in the language in which the format was defined, irrespective of the language in
which Aurea CRM is running.

To display the name of the form of address field in a different language, enter the
name of the form of address field in the desired language; for example "Salutation"
for English.

Microsoft Word (Office 97)

Enable this option if you are using Word for Office 97 with Aurea CRM's DDE func-
tionality.

Microsoft Works for Windows 97

Enable this option to use Aurea CRM's DDE functionality with Works for Windows
97. This entry is required in order to be able to open documents.

Suppress Blank Lines

Enable this option to prevent blank lines from being transferred to Word.
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Documents
Learn about the document configurations.

Allow multiple file uploads / drag&drop

Enabling this option enables the following behavior:

• Aurea CRM win: Documents can be uploaded using drag&drop, see Assigning
Documents with the Mouse in the Aurea CRM win User Manual. This works in all
levels that contain a Document overview button.

• Aurea CRM web: Multiple documents can be uploaded/linked to a record,
see Saving Documents in the Database in the Business Logic Manual. (If the
option is disabled, only one document can be uploaded at a time.)

Note:  Users need sufficient access rights for D1 and D3 in order to be able to
upload documents.

Company document link in person

Enable this option to determine that adding a document link to a person results in
a document link also being added to the company.

Document class used for drag&drop

Note: This setting applies to Aurea CRM win only.

Use this option to automatically enter a value in the Doc.Class field of the document
record based on the MIME type when adding documents using drag&drop. Enter
the MIME type in the ID field (e.g. "application/msword") and select Load value
from the context menu to determine the desired document class (entered in the
catalog base language).

Requirements: The option Allow multiple file uploads / drag&drop must be en-
abled.

For information on MIME types, see http://www.iana.org/assignments/media-types.
Aurea has tested the following document types: .doc, .docx, .xls, .xlsx, .csv, .pdf,
.xml, .bmp, .gif, .jpg, .tiff, .png, .ppt, .pps.

No company fields/No person fields

Enable these options to prevent document fields in the Company or Person in
Company info areas from being offered as targets when saving documents.

File types to be retained

By default, Aurea CRM deleted temporary files immediately after they have been
accessed. Use this option to prevent cer tain files (e.g. .zip) saved in Aurea CRM's
document management from being deleted upon opening.

Enter the file extensions in the value field separated by semicolons.

36AUREA CONFIDENTIAL

Chapter 2: Configuration

https://help.aurea.com/crm/crm-win-user-manual/crm-win-user-manual/dita/topics/c_win_UsrMan-9_1_2_2-Assigning-Documents-_upd.html
https://help.aurea.com/crm/crm-win-user-manual/crm-win-user-manual/dita/topics/c_win_UsrMan-9_1_2_2-Assigning-Documents-_upd.html
http://www.iana.org/assignments/media-types


No document link for companies

Enable this option to prevent document links from being added to company records
when adding a document link from a company-dependent info area.

No document link for persons

Enable this option to prevent document links from being added to person records
when adding a document link from a person-dependent info area.

Note:  If you wish to completely disable the automatic creation of document links,
you need to deny access to the Document Link info area (D3) in the Rights module,
see Rights on page 136.

Export
Learn about export configuration.

Company Separator

This option is used to determine the separator used to separate company names
that span multiple lines.

External Address Search
The options of this category allow you to specify an external application to be used
for the address search and define the options to use.

These options can be defined globally or for each station.

Note:  .NET Framework 4.5 must be installed to use the match-up features provided
by the external application.

External Calendar
Learn about the settings for external calendars.

Below options are used to determine the settings for external calendars:

Category

Aurea CRM supports the German version of Outlook by default. If you are using a
different language version of Outlook, enter the name of the categories in Outlook,
e.g. "Categories" for the English version. This option is used when synchronizing
activities/ absences/ tasks that have already been transferred to Outlook.

External Calendar

Determine the external calendar here. Either "Lotus Notes" or "Outlook" can be en-
tered.
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If neither of these programs is used, deactivate the External Calendar entry if
present.

Export Activities

By default, activities that have been added using an external calendar can be im-
ported and exported. Disable this option to prevent activities from being exported.

Export Tasks

By default, tasks that have been added using an external calendar can be imported
and exported. Disable this option to prevent tasks from being exported.

Export Absences

By default, absences that have been added using an external calendar can be im-
ported and exported. Disable this option to prevent absences from being exported.

Export Default Fields for Activities/Tasks/Absences

The default fields are automatically transferred along with any fields you define in
your own export formats. If you only want to transfer the fields in your export format,
disable this option. The export formats are specified under Export Format for Ac-
tivities/Tasks/Absences.

The following fields are exported by default. The Export / Import column indicates
whether the field is used for export and/or import:

Export / ImportOutlookAurea CRM

Activity (info
area)

Export + ImportSubjectSubject

Export + ImportBodyText

ExportRequired Atten-
dees

Rep

Task (info area)

Export + ImportBodySubject

Export + ImportOwnerRep

Absence (info
area)

Export + ImportSubjectSubject
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Export / ImportOutlookAurea CRM

Export + ImportBodyText

ExportRequired Atten-
dees

Rep

The following fields in activities, tasks and absences are always transferred to the
external calendar, irrespective of the configuration settings:

• Start Date, Start Time (tasks and absences); Date and Time (activities)

• End Date, End Time

• Updated at

• Completed on, Completed at (tasks only)

• Reminder Duration, Reminder Unit

• Status, Private

Export Format for Activities/Tasks/Absences

Select Load value from the context menu to select the export format for activities,
tasks and absences.

Export formats are defined by selecting Extras > Define Transfer Fields from the
menu. You need to enter the name of the corresponding field in the external calendar
in your transfer format (Field Text entry in the Fields tab).

Note:  Fields that contain [, ], _ or # in the field name are not recognized by Outlook.

Outlook Form for Activities/Tasks/Absences

When transferring data to Outlook, the standard Outlook form is used by default.
To define a different Outlook form for activities, tasks or absences, enter the name
of the Outlook form here.

Import Activities

This option determines whether activity records are imported from the external cal-
endar. Disable this option to prevent activities from being imported.

Import Tasks

This option determines whether task records are imported from the external calendar.
Disable this option to prevent tasks from being imported.

Import Absences

This option determines whether absence records are imported from the external
calendar. Disable this option to prevent absences from being imported.
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Import Default fields for Activities/Tasks/Absences

The default fields are automatically imported along with any fields you define in
your own transfer formats (see the table above for a list of the default fields). If you
only want to transfer the fields in your transfer format, disable this option for the
format. The import formats are specified under Import Format for Activi-
ties/Tasks/Absences.

Note: You can use the same format for exporting and importing records of the same
type.

Import Format for Activities/Tasks/Absences

Enter the name of the import format(s) here.

You need to enter the name of the corresponding field in the external calendar in
your transfer format (Field Text entry in the Fields tab). Import formats are defined
by selecting Extras > Define Transfer Fields from the menu.

External Match-up
The options of this category allow you to specify an external application and options
used to match up data.

These options can be defined globally or for individual stations.

Note:  .NET Framework 4.5 must be installed in order to match up data using an
external application.

Font
Types of font configuration.

Printer Font

Enter the font to be used when printing data from Aurea CRM (e.g. "Courier").

Screen Font

Enter the font to be used to display data in Aurea CRM (e.g. "Courier").

Minimum Font Size

Use this option to determine the smallest font size displayed. This option only takes
effect if you have selected a font under Printer Font or Screen Font.
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General Settings
General settings configurations.

Change hierarchy codes immediately

If this option is not configured, changes to the hierarchy code in a rep records are
immediately applied to all info areas. When working with large volumes of data, this
can lead to long waiting times for users when saving the rep record.

Enter the abbreviations of those info areas to which changes to the hierarchy code
should be applied immediately. All other info areas are updated in the background,
to reduce the delay to a minimum.

This option is not applied to changes made in the Hierarchy Change info area;
these changes are immediately applied to all info areas.

Company Match-up Length

Enter the minimum length of the match-up key when adding new companies to
properties. You can enter a value between 2 and 20.

Company Match-up Length %

Enter the minimum length of the match-up key as a percentage of the total length
when adding new companies to properties.

Connection settings for SMTP

Use this option to save the connection settings for sending e-mails via SMTP in the
database. You can define the settings globally, or for individual stations, groups
and reps, depending on your requirements:

1. Select Add/edit value from the context menu.

2. The Connection Settings dialog is displayed. If a suitable smtp.cfg file is present,
the settings in the file are entered as default values in the dialog.

3. Enter the connection settings as described in SMTP Connection Settings on page
92 for the smtp.cfg file.

4. Click on OK.

5. Save the configuration record.

The settings are saved in encrypted form in the Value field.

Note:  In order to be able to use SMTP, you also need to configure SMTP as the
e-mail client using the E-Mail Client configuration entry in the General Settings
(see above).

Decimal Places n

These entries allow you to enter the number of decimal fields displayed by fields
containing floating point numbers. Up to a maximum of 7 decimal places can be
displayed.
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You need to enter the number of decimal places and the field's info area (using the
abbreviation), followed by the number(s) of the field(s) in the info area separated
by commas. Entries are separated using a semicolon.

Spaces are ignored, and repeated field numbers from the same info area are also
ignored.

Examples:

3 ;MA,89,90 ;5,91;BR,23

• 3 decimal places for fields 89 and 90 of the Activity (MA) info area

• 5 decimal places for field 91 of the Activity info area, and field 23 of the Mailing
(BR) info area

MA;6,89;5,90;4,91;BR,23;7,22;0,24

• 6 decimal places for field 89 of the Activity info area

• 5 decimal places for field 90 of the Activity info area

• 4 decimal places for field 91 of the Activity info area, and field 23 of the Mailing
info area

• 7 decimal places for field 22 of the Mailing info area

• 0 decimal places for field 24 of the Mailing info area

Disable Language Independent Text Overrides Native

Enable this option to allow native language text of the CRM user to be displayed
instead of the language independent text. By default, the language independent text
is always displayed.

For more information on Language Texts, see Text Info Area on page 368.

Disable pop-ups

Enter the IDs of the info area for which pop-ups should not be displayed in the
Value field:

• MD: Messages

• ER: Reminders

• MD;ER: For both info areas

This option disables the Enable due reminders/messages pop-up and Popup re-
minders/messages options (Extras > Other Options), see Reminders and Messages
in the Aurea CRM win User Manual.

Display Currencies with 3 Decimal Places

Enable this option to display currency values to 3 decimal places instead of 2.

Disable offer valid to date auto calculation

Enable this option to prevent automatic calculation of the Valid To date field based
on the Valid Days field and the Offer Date.
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Disable Variable Conditions by Default

Enable this option to determine that all lines in a condition are disabled by default
when activating a variable condition. The user can activate these lines.

Display Hits

Enable this option to display the number of hits returned by the search.

Do not log lead status changes (BTB and FS)

Enable this option to determine that changes to the Lead Status field (in company,
person and sales group records) are not logged whenever the Lead Status field is
edited or a new record is added.

This setting can be applied globally or to a single station.

Drag&Drop in Tree View

Enable this option to allow users to move records and merge companies and persons)
in the tree view using drag&drop. This setting can be overridden for each info area
in the desktop settings, >> Tree View Tab in the Aurea CRM win Administrator
Guide.

E-mail Client

You need to specify the client used to send e-mails, or you can choose to send e-
mails via SMTP. The following entries can be made in this field:

• Lotus Notes

• Outlook

• SMTP

Note: You need to define the connection settings in order to be able to send e-mails
using SMTP, see SMTP Connection Settings on page 92 and Connection Settings
for SMTP above.

By default, e-mails are sent as text e-mails by Aurea CRM (exception: Edit -> Send
Record as Link to). To send e-mails as HTML e-mails, use the following syntax:
<e-mail client>;HTML (e.g. Outlook;HTML). This setting takes precedence over the
setting in your e-mail client, the SMTP connection settings and the Send as settings
in transfer formats used by to generate single e-mails (single letter e-mails).

Generate Company Activities

If this option is enabled, one visit is generated per company from the Account
Manager and Sales Group info areas (based on the visit frequency and data from
the Account Manager info area).

If this option is disabled, activities are generated for all persons in the company.
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Generate sequence numbers without year

By default, serial numbers in e.g. the Offer info area are generated including the
year. Enable this option to generate serial numbers without year.

Use this feature to avoid integer overflows which may occur if such numbers are
copied to a field of type "short int (4 Byte)" by a workflow or trigger, see Aurea CRM
Field Types.

Serial numbers in the following info areas are affected:

• BTB: AU, PR

• OTC: AU, BV, KK, MU, PR, PS, VG

The serial numbers are created as follows:

• Generate sequence numbers without year = YES

• the highest available number < 880,000,000 is used

• if a record with serial number 779,999,999 exists, the highest number <
1,000,000,000 is used

• if a record with serial number 999,999,999 exists, the highest number < 2^32-1
is used

• Generate sequence numbers without year = NO

• Stock Control (BV) info area (OTC): If a serial number > 2^31-1 (signed integer)
is created, this number is reset to 0 upon copying it to another info area such
as AU or PR.

• All other info areas: default behavior as described above.

This setting is applied globally.

Log automatic selections

Enable this option to log the execution of automatic selections, see Logs and Error
Messages on page 506.

Log File Separator

Enter the character used to separate entries in the access log files. A semicolon is
used by default. Fur ther details on logging can be found under Logging Read and
Write Access on page 245.

Mail Client Button

Enable this button to display the button used to access the mail client in the Calendar
and Daily Overview. You need to have entered a mail client under External Calendar
for this setting to take effect.

No digit grouping symbol

Enable this option to prevent numeric values from being displayed with a digit
grouping symbol, e.g. 10000 instead of 10,000. This settings overrules the server's
locale settings.
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This setting can be defined globally or per station.

Note:  In Aurea CRM web this setting is only applied if the Locale.Number.Deci-
malSeparator Web Configuration parameter is set to "Server" (default).

No input for completed tasks

If this option is enabled, messages are generated when tasks are completing without
requiring any input from the user.

If this option is not enabled, the message is displayed and the user needs to save
it.

Own appointments only

If this option is enabled, appointments (activities and tasks) are not displayed in
the calendar for reps only entered in the Participants field.

Own activities/tasks only

If this option is enabled, activities or tasks are not displayed in the calendar for reps
only entered in the Participants field.

Note: The Own tasks/activities/appointments only settings are applied globally.

Open Last Windows

Enable this option if the windows that were opened when Aurea CRM was last closed
should be opened again the next time the system is star ted.

Person Search as Default

Enable this option to set the person search as the default search in the calendar or
when clicking on the search button in the level header in the Company + Person
level.

Phonetic Search

Note: This setting applies to Aurea CRM win only.

This option enables or disables the phonetic search function.

Prompt to save Attachments

If this option is enabled, users are asked to confirm that attachments should be
saved when importing activities from their mail client. If this option is disabled, at-
tachments are saved automatically.
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RepOff

Storing a rep in Aurea CRM involves four linked field, Rep, Rep ID, Rep Grp. and
Rep Grp. ID.

Enable the RepOff option if denying access to one of these rep fields should deny
access to all four rep fields.

Search on Click

Enable this option if you only want the search to star t when the search button is
clicked; i.e. not when a user exits a field in the search mask.

Signature

Enable this option to include the current rep's signature (entered in the Signature
field in the Rep info area) when sending e-mails from Aurea CRM win.

Note: The signature is not included in e-mails in RTF format.

SMS Settings

Use this option to save the connection settings for sending SMS (via trigger or
within the scope of marketing activities) in the database instead of using mmsms.ini
files. You can define the settings globally, or for individual stations, groups and
reps.

1. Enter the settings (i.e. the content of the mmsms.ini file) into the Value field.

Or select Add/edit value from the context menu to load an existing mmsms.ini
file.

For information on all required settings, see mmsms.ini File in the Business Logic
Manual.

If this setting is not defined, the mmsms.ini file is used instead.

Start of Fiscal Year

Enter the month that your fiscal year star ts in, e.g. "4" for April. Valid entries are
all months at the star t of a quarter (4,7 and 10). If you do not enter a value, the
fiscal year star ts on January 1.

Note: The setting is ignored when calculating in the Potential info area.

This setting applies to a single station in Aurea CRM win and globally to all other
Aurea CRM applications.

Suppress Shortcuts (Alt)

Note: This setting applies to Aurea CRM win only.
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Enable this option to suppress the shortcuts (Alt + Letter) used to access tabs or
info areas when in edit or new mode.

Suppress Shortcuts (Alt Gr)

Note: This setting applies to Aurea CRM win only.

Enable this option to suppress the shortcuts (Alt Gr + Letter) used to access tabs
or info areas when in edit or new mode.

Title bar

Enter the text to be displayed in Aurea CRM win's title bar. The following placeholders
are available:

DescriptionPlaceholder

Current module<module>

Name of the current rep<rep>

ID of the current rep<repid>

Alias of the current rep<alias>

Login of the current rep<login>

Current station number<station>

Current tenant number<tenant>

Aurea CRMAurea CRM

Current version number<version>

Name of the data source on the server<data-
source>

Name of the database<database>

Table prefix<tableprefix>

Name(s) of the active role(s)<role>

A placeholder can only be included in the title bar once.

47AUREA CONFIDENTIAL

Configuration Info Area



Use Default Dashboards

Use this option to determine whether the standard dashboards delivered with Aurea
CRM win are used.

These standard dashboards require a resolution of at least 1024 x 768.

Variable default values for conditions

Use this option to define fields in the Station, Rep and Rep Addnal Info (OTC only)
info areas that can be used when defining variable conditions in addition to the de-
fault options.

Select Add/edit value from the context menu to select the info areas and fields.
You can save the selected fields as Field Formats.

The selected fields can be used in the following functions in Aurea CRM:

• When defining conditions (see Defining Variable Conditions in the Aurea CRM
win User Manual), in par ticular for access rights and communication, see Rights
on page 136 and Applying Variable Conditions to the Target Station in the Aurea
CRM win Administrator Guide.

• As variables in triggers, see User-defined Variables on page 182.

• As variables in workflows, see Aurea CRM automator Manual.

Note: This option is not supported for defining conditions in Aurea CRM web. Use
$ cur( ID,<fieldId>) instead, e.g. define a filter select from (FI) where (Coun-
try='$cur(ID,13)') to get only companies from the country of the currently logged-in
rep.

48AUREA CONFIDENTIAL

Chapter 2: Configuration

https://help.aurea.com/crm/crm-win-user-manual/crm-win-user-manual/dita/topics/c_win_UsrMan-4_10_3-Defining-Variable-Co_upd.html
https://help.aurea.com/crm/crm-win-admin-guide/crm-win-admin-guide/dita/topics/c_win_adm-3_3_2_1_1_1-Applying-Variable-Co_crm.html


Rights and triggers containing conditions using this MC entry are however evaluated
correctly in Aurea CRM web and all other Aurea CRM products.

Version number field

Upon star ting an Aurea CRM module, the station's Aurea CRM version number is
written to the Version field in the Station info area.

To use a different field in the Station info area, enter the number of the desired
field in the Numeric field.

This setting is applied globally.

Geo-Coordinates
Address data in Aurea CRM records can be "geo-encoded" using an external
application, i.e. the external application calculates the geographic coordinates e.g.
of a company based on the company's address.

The coordinates can be used e.g. to display a record on a map panel in Aurea CRM
web.

Use the options of this category to configure the handling and display of geographic
coordinates in records.

Use Geo-coordinates

Enable this option to activate server-side geo-coding of addresses. If disabled, all
geo-coordinates settings are ignored. (The client-side display of maps in Aurea
CRM web is not affected by this setting.)

Use the following options to customize the limits for batch-geocoding (see Batch-
Geocoding on page 456):

Maximum number of addresses per batch request

Determines the maximum number of geo-coded records per batch (default: 200,000).

Maximum number of batch requests per day

Determines the maximum number of batches per day (default: 5).

Maximum number of addresses in batch requests per year

Determines the maximum number of geo-coded records per year (default:
10,000,000).

Enter the desired values in the Numeric field. These settings are applied globally.

Note:  If you have obtained a Bing license key from Aurea, the limits you specify
here may not exceed the limits defined by MS Bing Maps, see http://www.mi-
crosoft.com/maps/product/terms.html.
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For general information on performing geo-coding in the background using
CRM.server, see Background Geo-Coding on page 455.

Import
Enable this option to limit the match-up of installed bases by Host No. to those
within the same company.

Match-up by Host No. within company

If this option is disabled, the Host No. is matched up across the entire database.

Inventory
This setting can be defined globally or per station.

Take inventory

By default, stocktaking (Stocktaking and Reset options) is only available on the
main office. To allow stocktaking on other stations:

1. Enable the Take inventory option end enter the desired Stat. No. and possible
a Rep Group or Rep.

Lots without quantities (OTC only)

Use this configuration entry to determine that no quantities are displayed when se-
lecting lots (Lot/Quantity field in the Order Item, Stock Control Item, Sample,
Refunding Item and Promotional Material info areas). This allows you to prevent
users from seeing the quantities stored in the system (Quantity Unit).

Links
In order to send links to records in Aurea CRM applications other than Aurea CRM
win (using Edit > Send Record as Link to), you need to specify the address of the
server and the corresponding parameters.

This setting can be defined globally or per station.

web URL

Enter the address of the Aurea CRM web page responsible for processing the query:
http://<server name>/<application path>/crm/view

Example: http://mywebserver/update.crm.web/bb/crm/view

This setting is also used to output links in reports if they are accessed in Aurea
CRM web, see Defining Report Formats in the Aurea CRM win User Manual.

Formatting for web

Enter the parameters for the link to Aurea CRM web. If no parameters are specified,
the following default string is used: uid=$R_ID;$RECID

Possible placeholders:
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$R_ID: info area code

$R_IDX: info area number

$KEY: contents of the key fields in the record, separated by '-'

$RECID: record ID

The following link is inser ted in the e-mail:

<a href='http://<servername>/aurea.crm.web/bb/view?uid=FI;x0000000100000001'>au-
rea.web: Company: Aurea software AG</a>

Listing (OTC)
Listing configurations.

Switch to Prio

Note: This setting applies to Aurea CRM win only.

This entry defines a fallback for the Listing display option. If this option is enabled,
the Prio view is enabled automatically in the quick add levels for Offer, Order, POS
and Refunding if the area is opened by default using the Listing option and no
suitable items are found, see Quick Add in the Business Logic Manual OTC.

This setting is applied globally.

External System

Listings can be inherited using the external company key. Enter the external system
assigned to external company keys that are used to inherit listings.

For fur ther information on listings, see Listing in the Business Logic OTC manual.

The External System option is ignored if you use one of the following options:

Inheritance

Define the type of relationship via which listings can be inherited between companies
when manually adding items.

Enter the relationship type in the catalog base language in the Value field.

Inheritance - Quick Add

Define the type of relationship used to inherit information in listing for quick add
configurations.

You can enter several types of relationships in the catalog base language, e.g.
Corporate;Wholesaler.

Users can then select the desired relationship type using the Inheritance drop-down
list.
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Lists (OTC)
Lists configuration.

Note: This setting applies to Aurea CRM win only.

Entry

[Lists]

Column1= <Name of condition defined for company>,<Name of condition defined
for person>, heading of column 1 in the list

Column2= <Name of condition defined for company>,<Name of condition defined
for person>, heading of column 2 in the list

Column3= <Name of condition defined for company>,<Name of condition defined
for person>, heading of column 3 in the list

...

Column10= <Name of condition defined for company>,<Name of condition defined
for person>, heading of column 10 in the list.

Load at start (OTC)
These settings are used to specify that data from the item master and catalogs are
loaded into memory when Aurea CRM is star ted.

This allows data to be accessed quicker.

Note: These settings apply to Aurea CRM win only.

You need to determine the info areas and catalogs that should be loaded.

Catalog numbers can be viewed either in the mm_dbstr.txt file (generated by
star ting mmba.exe with the --writedbstr parameter) or by double-clicking with the
right mouse button on the header of the window containing the fields in the info area
when viewing all fields in the mask (View > All Mask Fields).

FILE_AR

Enable this option to load the catalogs in the item master info area (AR).
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Catalog No.

You need to specify the catalogs that should be loaded using their field numbers.
Separate catalogs with a comma. For example, to load the product group (10) and
product category catalog (358) enter "10,358"

For performance reasons, only load the following fields from the item master into
main memory for the first quick add or search action:

FieldNo.FieldNo.FieldNo.

SI - Free Samples31Grade6Item No.0

SI - Competition32SI - POS27Item Name1

SI - Refunding33SI - Order28Segment3

Prio.Cred.Note34Prio.Order29Prod.Cat.4

SI - Stock Control35SI - Listing30Brand5

All other fields must be reloaded with each new search or quick add action, which
can be time-consuming.

Mask
Learn about mask configurations.

Note: These settings apply to Aurea CRM win only.

Citrix

Enter 1 if you are working in a Citrix environment. This prevents the contents of the
currently selected field from being deleted when switching between applications.

ToolTips Duration

Determine how long ToolTips should be displayed for text fields (in milliseconds),
see Text Fields for Descriptions in the Aurea CRM win Administrator Guide.

This setting is applied globally.

Editable table columns

Enter a color in RGB format (e.g. "0,255,0" for green). This color is used to indicate
cells in tables that can be edited.
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Header for editable table columns

Enter a color in RGB format (e.g. "0,255,0"). Column headers are displayed in this
color if you can click on the column header to edit all the cells in the column.

No Inventory (OTC)
Enable this option (in the Communication category) to suppress the verification of
inventory-relevant data when synchronizing stations.

This allows booking entries that affect the inventory to be deleted on branch offices.

This setting must be specified per station.

Participants (BTB, OTC)
They determine when a participant record linked to ticket, service contract or installed
base with a defined role is automatically created.

The options in this category are applied globally.

The participant record is created if the value of the respective field in KM/WR/IB is
entered or changed.

The following options are available:

• Billing Address (KM)

• Billing Address (WR) (BTB only)

• Contact Partner (KM)

• End Customer (KM)

• Location (IB)

• Service Contractor (WR)  (BTB only)

Example:

• If a par ticipant is added to a ticket with the role "contact person" and the Inactive
check box is disabled (i.e. the participant is enabled), the participant is
automatically entered in the Contact Person/Company field.

• If you select a company or person in the Contact Person/Company field in the
ticket record, a new participant record is added and set as active. If another
company/person was active in this role, the corresponding participant record is
set to inactive.
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To configure the function described in the above example:

1. Select the Contact Partner (KM) option in the Configuration info area.

2. Select Load Value from the context menu in the Configuration info area.

3. Select the catalog value that the function should access: "contact person".

Note: The selected value is automatically translated to the entry in the catalog
base language.

4. Define the catalog value for the Role catalog in the Maintenance module (Catalog
info area), see Editing Variable Catalogs on page 273.

POS (OTC)
Learn about the POS configuration settings.

Last POS

This setting is applied globally.

Note: This setting applies to Aurea CRM win only.

If the setting is enabled, new POS records are added so that the last three records
(by date) are marked in the Last POS field with 1, 2, 3 whereby 1 indicates the most
recent POS record for the company.

This numbering is used during analysis and allows the latest situation on the cus-
tomer side to be ascertained quickly. For more information, see Point of Sale in the
Business Logic OTC manual.

Reports
Learn about report configuration settings.

Do not cache stylesheets

Note: This setting applies to Aurea CRM win only.

Enable this option to determine that style sheets used by reports should not be
stored in the cache.

By default, style sheets are stored in the cache, which improves performance.
However, Aurea CRM needs to be restar ted if a cached style sheet is changed.

Document Types

Note: This setting applies to Aurea CRM win reports only (regardless of whether
they are called from Aurea CRM win or Aurea CRM web).
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Enter the assembly and class used to convert reports to the desired document type
here (document type, class name, assembly name), e.g.

application/pdf,update.PlugIns.Reporting.Pdf.CorePlugIn,update.PlugIns.Re-
porting.Pdf

(This setting calls Aurea CRM's standard plug-in. It is used as a fallback if Document
Types is undefined.)

Enter a unique value in the ID field in order to differentiate multiple entries from
one another.

For information on the default settings for PDF reports, see the ar ticle “How to use
the reporting PDF plug-in” at https://support.aurea.com.

Resources
Learn about resources configurations settings.

Dispatching

Use the Dispatching option to determine which reps are displayed in the resource
view of the Dispatching Dashboard. You can define any number of conditions for
the ticket and for the reps thus determining which reps are available for a specific
ticket.

Example: By defining a condition on Problem Group for the Ticket info area and
a condition on Problem Group for the Skill info area you can display only reps with
a skill matching the selected ticket's problem group.

If no Dispatching options are defined,

• only the current rep is displayed in Aurea CRM win

• no reps are displayed in Aurea CRM web when Ticket-Related Reps is checked.

To define Dispatching options:

1. Select Add/edit value from the context menu.

2. Click on  (New) in the Ticket pane and define a condition for the ticket.

3. Enter a name for the condition.

4. Conditions are displayed for three info areas in the Rep pane: Rep, Skill and
Group Allocation.

Click on  or  (Edit) to edit the conditions that the rep must meet.

Disable the Active check box to disable a condition.

Note:  Skill and group allocation records are defined in the Rights module,
see Skills on page 124 and Assigning Reps to a Group on page 126.

5. Click OK and save the configuration entry.

When the resource view is accessed from a ticket that meets the condition defined
under Ticket, those reps that meet the conditions defined under Rep are displayed.
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Special Cases:

• If a ticket does not meet any of the conditions defined for tickets, no reps are
displayed for the ticket in the resource view.

• If a ticket meets a ticket condition, but no conditions are defined for reps, all reps
are displayed.

• If a ticket meets several conditions, all conditions are taken into account.

• If you define conditions for a rep group, all reps are displayed whose group meets
the condition.

Sales (OTC)
Enable this option to assign item records to sales drives by date and business area.

Sales Drive by Date

If this option is enabled, item records (PP, UP, VP, WM, MU, AP, MA, AF) are auto-
matically linked to the appropriate sales drive record (VR).

Sales Funnel (BTB)
Learn about sales funnel configuration settings.

The settings for the sales funnel in Aurea CRM win can be defined here, see Con-
figuring the Sales Funnel in the BTB manual.

Note: These settings apply to Aurea CRM win only.

Interval n

These options are used to define intervals. Enter the number of time units in each
interval and the unit type separated by a semicolon.

The following unit types are available:

1=Day, 2=Week, 3=Month, 4=Year, 5=Decade.

For example, enter 30;1 for 30 days.

If no intervals are entered, the scale automatically begins with the current date in
intervals of 30/60/90 days.

The following provide default values for the sales funnel:

Others

Enter "1" to include information on all records that do not fall within the intervals
defined.

Date

Enter a date from which opportunities are calculated.
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Today

Enter "1" to begin the calculation from today's date. This option takes precedence
over the value specified under Date.

Weight

Enter "1" to include the weighting of offers in the calculation.

All Countries

Enter "1" to include all countries in the calculation.

All Areas

Enter "1" to include all areas in the calculation.

All Products

Enter "1" to include all products in the calculation.

Sales Statistics and Revenue Statistics (BTB)
You can use the table in the Sales Statistics and Revenue Statistics info areas
to store other data in tabular form.

However, seeing as several columns and fields have intrinsic functions associated
with them (for example the difference in revenue between years is calculated auto-
matically), you can remove these calculations from the columns and fields. These
fields are not editable by default; however by removing the associated business
logic, you can use them as you would use any numeric field.

Furthermore, you can determine that those fields that otherwise display percentages
are displayed as standard numerical fields. In practice, it makes little sense to
change the field type unless you also allow these fields to be edited.

Do not determine prices/discounts

This option is used to remove the connection between a field or column and the
associated business logic. You need to enter the numbers corresponding to the
fields or columns separated by a semicolon. For example, entering "1" would prevent
the deviation from the previous year from being calculated as a percentage and the
fields in the column can be edited.

Revenue StatisticsSales StatisticsValue

Rev.Dev.%Qty.Dev.%1

Rev.Dev.Abs.Qty.Dev.Abs.2

Act.Rev.Cum.Act. Qty. Cum.3

58AUREA CONFIDENTIAL

Chapter 2: Configuration



Revenue StatisticsSales StatisticsValue

Rev.PY Cum.Qty.PY.Cum.4

Rev.Dev.Cum.%Qty.Dev.Cum.%5

Rev.Dev.Cum.Abs.Qty.Dev.Cum.Abs.6

Rev.Plan DatePrev.Qty.Date7

Tot. Act. Rev.Tot. Act. Qty.8

Total Rev.PYTot.Qty.PY9

Total Rev.Dev.%Tot.Qty.Dev.%10

Total Rev.Dev.Abs.Tot.Qty.Dev.Abs.11

Act. Rev. Plan.Qty. Act. Plan12

Rev.Plan PYQty.Plan PY13

Act. Rev. Targ. %Qty.Targ.Perf. %14

Rev.Targ.Perf.PY %Qty.Targ.PY %15

Numeric Field

This option is used to define percentage fields as a numeric fields. The values in
the field are then no longer displayed with a percent sign.

The following values are used by the Numeric Field option:

Rev.Dev.%Qty.Dev.%1

Revenue StatisticsSales StatisticsValue

Total Rev.Dev.%Tot.Qty.Dev.%2

Rev.Targ.Perf.Curr %Qty.Targ.Perf. %3

Rev.Targ.Perf.PY %Qty.Targ.PY %4

59AUREA CONFIDENTIAL

Configuration Info Area



Sales Territory Management (BTB, FS)
Learn about sales territory management configurations.

The options in this category are applied globally.

Disable sales groups from the Allocation table (BTB only)

Enable this option to determine that the Rep 1-10 and Area fields are not transferred
from the Allocation table when adding new records in the Sales Group info area.

Variable Copied Fields

Use this option to determine additional fields in the Sales Territory Management
info area that are transferred to sales groups or property management (BTB only)
records.

Enter the desired combination in the Value field using the following syntax:

Info area, target field ID, source field ID; Info area, target field ID,
source field ID ;...

Example:

SB ,10,12 ;...

In the above example, field 12 in the Sales Territory Management info area is
copied to field 10 in the Sales Group info area.

Alternatively, select Add/edit value from the context menu to access the Copy
Fields dialog:

1. Click on  (New).

2. Select the field to be transferred from the Sales Territory Management info area.

3. Click on OK.

4. Select the target info area (Sales Group, Property Management (BTB only)

Only fields of the same type as the source field are displayed.

5. Select the desired target field and click OK.

The selected combinations are displayed in the Copy Fields dialog, and can be
edited from there.

6. Click OK.

The selected combinations are transferred to the Value field.

Variable Criteria

Use this option to define additional criteria used to allocate reps or account man-
agers.

Enter the desired combinations in the Value field using the following syntax:

Info area ID, source field ID, target field ID; Info area ID, source field
ID, target field ID ;...
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Example:

FI ,12,7000 ;...

In the above example, field 12 in the Company info area is compared to the value
in (the user-defined) field 7000 in the Sales Territory Management info area

Alternatively, select Add/edit value from the context menu to open the Copy Fields
dialog:

1. Click on  (New).

2. Select the desired field in one of the available info areas (Company, Person,
Person in Company, Property (BTB only)).

3. Click on OK.

Only fields in the Sales Territory Management info area of the same type as the
source field are displayed in the Field Selection dialog.

4. Select the desired field and confirm with OK.

5. The selected combinations are displayed in the Copy Fields dialog and can be
edited from there.

6. Click OK.

7. The selected combinations are transferred to the Value field.

Sample (OTC)
Learn about the Sample configurations settings.

The options in this category are applied globally.

Date-based quota

Enable this option to determine that quota periods last one year from the end of the
introductory phase rather than until the end of the calendar year.

Quota after initial distribution

Enter the number of years over which samples may be distributed and the number
of samples that may be distributed per year. Separate the values using a semicolon.

Quotas based on calendar years, e.g. where 2 years are divided into 3 par ts, can
be depicted. In order to enable this function, "C;" needs to be entered at the star t
of the entry in the Value field.

Example: C ;2 ;2

Quota exceeded

Enable this option to allow sample records to be added even if the quota is exceeded
as a result. For fur ther details, refer to Sample in the OTC Business Logic Manual.

This setting is applied globally.
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Search
Learn about search configurations settings.

Note: These settings apply to Aurea CRM win only.

Identical characters

Use this entry to define that cer tain (combinations of) letters are treated as identical
characters.

Example: "ä=ae" allows users without umlauts to enter "ae" instead.

The settings are used in the search (company, person, property in the BTB version)
and during match up. The settings are applied recursively (e.g. ä=ae ae=a). You
can also use this setting to determine that cer tain strings are ignored (Ltd. = '').

Separate multiple entries using a comma.

You need to rebuild the indices before the settings take effect.

Output message if no hits

Enable this option to display a message if no hits are found in the company, person
or property search.

Synonym without wildcard

Use this option to determine that users need not enter a wildcard (*) in the Synonym
field.

Security
Learn about security configurations settings.

Certificate

This entry currently has no function.

Login Filter

You can add an additional stage to the login procedure for Aurea CRM win if authen-
tication by another system is required. To do so, you can configure a so-called login
filter. After successfully logging in (either via single sign-on or explicitly logging in),
the login filter is called.

A login filter requires a specific interface in order to be called from Aurea CRM.
Login filters can be called exclusively from the Aurea CRM win main module, but
not from the administrative modules. A detailed description can be found in the
technical white paper "login filter" available from https://support.aurea.com.
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Password Blacklist

The PW may not be in blacklist option in the Station Configuration info area de-
termines whether passwords can be blacklisted. The blacklist is defined here.

Enter the words (separated by a semi-colon) in the value field, or select Add/edit
value from the context menu to load a text file containing the blacklist.

The blacklist is not case-sensitive.

The comparison is always performed for the entire string, not for a par t of the string.

Leading and trailing blanks are stripped before comparison, e.g. if the blacklist
contains the word "God", the user is not allowed to change his password to " God",
"God ", "God" or " God ".

Single Letter

You can define security settings used to digitally sign and/or encrypt single letters.
Aurea CRM users cannot read encrypted documents - they require the cer tificate's
private key to be decrypted.

Prerequisites:

• Encrypting single letters requires a digital cer tificate (available from an official
source like Verisign). For testing purposes, you can create a cer tificate using MS
.NET Framework SDK (makecert.exe).

For Aurea CRM web, the cer tificate must be installed in the "Machine Certificate
Store" on the web server. The server runs as a service (without user context).

• To digitally sign a document, add one or more signature lines to the document
template. For more information, refer to your Microsoft Word documentation. For
details, see the <property> tag description under >> XML Code for Signing/En-
cryption Settings on page 64.

The Single Letter entry can only be defined globally. If you do not define any single
letter security settings, the Encrypt/Sign check box in the Connection with Word
Processor dialog box is unavailable to users.

You can define several option, each with a different ID. When defining single letter
formats, these names are displayed in the Security Settings drop-down list in the
Connection with Word Processor dialog box, >> Defining Transfer Formats in the
Aurea CRM win User Manual.

Enter the XML code defining the security settings in the Value field, >> XML Code
for Signing/Encryption Settings on page 64.

You can use CRM.cryptographic tool to decrypt multiple documents at once,
>> CRM.cryptographic tool on page 472.
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XML Code for Signing/Encryption Settings
Example code for win and web for Signing/Encryption Settings.

Example (Aurea CRM win):
<SecurityOptions>
<Sign method='Microsoft/Office'>
<SignatureLine name='Rep'>
<Property name='Name' relationName='$currentRep' fieldId='3'/>
<Property name='Title' xml:space='preserve'>update Software AG</Property>
<Property name='Email' relationName='$currentRep' fieldId='27'/>
</SignatureLine>
<SignatureLine name='Customer'>
<Property name='Name' rel='MA' fieldId='108'/>
<Property name='Title' rel='KP' fieldId='65'/>
<Property name='Email' rel='FI' tableCaptionName='$reference'/>
</SignatureLine>
</Sign>
<Encrypt method='Update/Server'>
<CertificateReference>u7.test</CertificateReference>
</Encrypt>
</SecurityOptions>

Example (Aurea CRM web):
<SecurityOptions>
<Sign method='Microsoft/Office'>
<SignatureLine name='Rep'>
<Property name='Name' relationName='$CurrentRep' tableCaptionName='ID' />
<Property name='Title' relationName='$CurrentRep' fieldId='Title' />
<Property name='Email' relationName='$CurrentRep' fieldId='E-mail1' />
</SignatureLine>
<SignatureLine name='Customer'>
<Property name='Name' relationName='$Link[FI]' tableCaptionName='FI' />
<Property name='Title' xml:space='preserve'> </Property>
<Property name='Email' relationName='$Link[FI]' tableCaptionName='FI.Email' />
</SignatureLine>
</Sign>
<Encrypt method='Update/Server'>
<CertificateReference>u7.test</CertificateReference>
</Encrypt>
</SecurityOptions>

The following XML elements are available for defining signature and encryption
settings:

• <SecurityOptions>: Contains the security options used to digitally sign and encrypt
documents.

• <Sign method="Microsoft/Office">: Only required when digitally signing
documents. Contains one or more <SignatureLine> tags.

• signatureLineDelayMillis (optional, default = "1000") defines the delay (in
milliseconds) with which placeholders are replaced. If problems occur when
replacing placeholders, increase this value.

• <SignatureLine name="NameofLine">: Defines the properties of a signature line.

The name attribute is mandatory and must be unique.

• <Property>: Defines the contents of a signature line (a field value of the record
used to create the single letter).

A unique name must be assigned to the <Property> tag using the name attribute.
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The following attributes are optional:

• rel:

Aurea CRM win only: Refers to the info area via its table code.

• relationName:

Aurea CRM web only: Defines the relation to the record that contains the value
of the property. If not specified, the record used to create the single letter is
used.

Aurea CRM win and Aurea CRM web: $currentRep refers to the current rep.

• tableCaptionName:

Aurea CRM web only: Contains the table caption used to format the value.

Aurea CRM win and Aurea CRM web: If $Reference is specified, the reference
text defined in Aurea CRM is used.

• fieldId:

Aurea CRM web only: Field ID or XML field name of the value.

Aurea CRM win only: Field number.

If both the tableCaptionName and fieldId are specified, fieldId is used. If
neither tableCaptionName nor fieldId are defined, the contents of the <Proper-
ty> tag is used:

<Property name='Title' xml:space='preserve'>Aurea Software</Property>

• xml: space='preserve': Determines that white space is retained. Without this
option, white space is trimmed.

Define the Signature line properties in Microsoft Word in the Signature Setup
dialog:

Each field in this dialog must be formatted as follows:

/update/security/signaturelines/[NameofSignatureLine]/properties/[Name-
OfProperty]

where [NameofSignatureLine] is the name attribute of the <SignatureLine> tag
and [NameOfProperty] is the name attribute of the <Property> tag.
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The placeholders are then replaced by the contents defined in the <Property>
tag of a <SignatureLine> element.

• <Encrypt method='Update/Server'>: Only for encryption. Defines that the document
should be encrypted before it is saved. The document is encrypted using the
digital cer tificate. Encrypted documents are given the file extension .p7m, following
Public Key Cryptographic Standard (PKCS #7).

• <CertificateReference>[Value]</CertificateReference>: Contains the reference
to the cer tificate, where [Value] is the cer tificate’s subject.

• <UseInformationRightsManagement>: By default, this option is enabled. If you do
not have IRM installed in your system, set this attribute to False to disable the
InformationRightsManagement feature.

Telephone Number/E-Mail Search
Learn about the Telephone Number/E-Mail Search configurations.

Display Person (PE/CP)

This option determines which person records are considered as a result if in tele-
phone number or e-mail search a hit is found in the Person info area (PE).

Default: Contact persons (CP) that are linked to the PE record are displayed instead
of the person (PE). If there are no linked CP records, the PE record is displayed.

To change the default, use one of the following values:

• PE_NO_CP: No contact persons (CP) are determined for the person (PE). The
search result contains only the PE record.

Note:  If there's a hit found directly in a CP record, this record is also part of the
search result.

• PE_WITH_CP: Contact persons (CP) are displayed in addition to the person (PE).
If there are no linked CP records, only the PE record is in the search result.

Display Person (PE/CP)

This option determines which person records are considered as a result if in tele-
phone number or e-mail search a hit is found in the Person info area (PE).

Default: Contact persons (CP) that are linked to the PE record are displayed instead
of the person (PE). If there are no linked CP records, the PE record is displayed.

To change the default, use one of the following values:

• PE_NO_CP: No contact persons (CP) are determined for the person (PE). The
search result contains only the PE record.
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Note:  If there's a hit found directly in a CP record, this record is also part of the
search result.

• PE_WITH_CP: Contact persons (CP) are displayed in addition to the person (PE).
If there are no linked CP records, only the PE record is in the search result.

TransferFields
If this option is enabled, field names in transfer fields formats beginning with a
number retain the leading digits.

Leading Digits

If this option is disabled, leading digits are truncated from field names in transfer
fields formats that begin with a number.

Note: This parameter solves problems arising during migration: The behavior of
marketing.manager 5.x corresponds to enabling Leading Digits. From version 6.0
onwards, Leading Digits is disabled by default.

Triggers
Learn how to configure trigger settings.

Below are the available trigger configurations:

Do not add activity when sending e-mail via a trigger

Enable this option to prevent activity records from being added automatically when
sending e-mails from triggers. This setting can be defined globally, or per station,
group or rep.

Log triggers

Enable this option to log the execution of triggers, see Logs and Error Messages
on page 506.

Enter "only call" in the Comment field to limit the information written to the log file
to the following:

• the time the trigger is initiated

• the time the trigger begins executing

• the time the trigger finishes executing

You can also determine the recursion depth when processing stacks using this
configuration entry, see Recursion Depth.

To do so, enter RECURSION-DEPTH=<0-100> in the Comment field. (You can use RE-
CURSION-DEPTH / RECURSIONDEPTH / RECURSION_DEPTH)
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Note: The Log triggers option does not need to be active for the recursion depth
to be applied.

You can define this setting globally or for each station.

MSSQL
Learn to configure MSSQL setting.

COLLATION

Determine the sor t order assigned to users or their user groups.

Enter the sor t order in the Value field and select a user of group. For fur ther infor-
mation, see Multi-language Sort.

ORACLE
Learn to configure ORACLE configuration settings.

NLS_SORT

Determine the sor t order assigned to users or their user groups.

Enter the sor t order in the Value field and select a user of group. For fur ther infor-
mation, see Multi-language Sort.

Word Processor
Learn how to configure Word Processor settings.

Do not add activities when sending e-mails

Enable this option to prevent activity records from being added automatically when
sending single letters by e-mail. This setting can be defined globally, or per station,
group or rep.

Document Types

Use this option to define the document types that are available when saving single
letters, see Defining Transfer Formats in the Aurea CRM win User Manual.

Depending on your version of Microsoft Word, you can use the following values
(format: 'Text;MIME Type'):

CommentsExplanationText;MIME Type

MS Word document
(*.doc)

application/msword

MS Word document
(*.docx)

application/vnd.openxml-
formats

-officedocument .wordpro-
cessingml.document
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CommentsExplanationText;MIME Type

PDF documentapplication/pdf

HTML documenttext/html

Document in Rich Text
Format

application/r tf

Plain text document
(*.txt)

text/plain

MS Office 2010 and higher,
requires a plug-in

XPS document (XML Pa-
per Specification)

application/vnd.ms-xps-
document

You can download the necessary plug-ins from Microsoft's web page.

Workflow
Enable this option to log the execution of workflows.

For fur ther details, see Logs and Error Messages on page 506.

Log Workflows

As this option has an impact on performance, use it only for testing purposes.

Enter "only call" in the Comment field to limit the logged information to the following:

• the time the workflow is initiated

• the time the workflow begins executing

• the time the workflow finishes executing

Note: The above option of limiting the logged information works only when the
Active checkbox is not selected, see the screenshot below:
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mm.ini File
The mm.ini file is used to determine system settings that need to be specified
before Aurea CRM is loaded.

The mm.ini file is located in each user's directory and in the .. \system\sys di-
rectories of your Aurea CRM win and Aurea CRM web installations (for global set-
tings).

Note:  Many of the settings that used to be configured in the mm.ini file (up to and
including version 6) are now configured from the Configuration info area,
see Configuration Info Area on page 20.

Entries in the mm.ini file are grouped in sections, specified by square brackets.

[Option]

ID_72=off

Use this option to allow reps to be entered as their own superior in the Superior
field.

CatalogLockOnBaseLanguage=off

Use this option to determine that a lock applied to the catalog base language is not
applied to all other languages. This setting also affects validity periods defined for
a value in the catalog base language, see Editing Variable Catalogs on page 273 and
Behavior of Lock and Validity with Hierarchical Languages.
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mmdb.ini and mmodbc.ini Files
The mmdb.ini and mmodbc.ini files contain Aurea CRM's database settings.

They consist of sections, designated by square brackets.

The entries in the mmdb.ini file for Oracle databases are different from those for
MS SQL databases and are therefore described separately.

The [General] section in the mmdb.ini file determines the type of database:

[General]

MMDB=mss

or

MMDB=ora

If this option has not been configured, the system checks whether the mmdb.ini
file contains either the [MM ORA] or [MM ODBC MSS] section, in order to determine
the database type. If both sections are present, Aurea CRM checks whether the file
mmora.dll or mmmss.dll is present. If both files are present, you can select the
database type from a dialog box when the application is star ts.

You can determine which database type is used via command line parameter (--db),
see General Aurea CRM Parameters on page 11.

The mmodbc.ini file applies to MS SQL databases only.

The mmdb.ini and mmodbc.ini files are located in the …\system\sys directory.

mmdb.ini file for MS SQL databases
MS SQL databases settings for Aurea CRM.

Below are some of the mmdb.ini file for MS SQL database:

[MM SQL]

MULTIDBS=ON

If this entry is set to "ON", the parameters are first read from this section and applied.
Otherwise, the parameters are read from the [MM ODBC MSS] section.

[MM ODBC MSS]

LOGINID=MM

This entry contains the name of the database user.

PASSWORD=MM

This entry contains the password of the database user. You can use MM_PWD_FILE
or PWD_TO_ENCRYPT to encrypt this password (see below).
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DATASOURCE=MMDB

This entry contains the name of the data source on the server.

DATABASE=UPDATE7

Assign the name of the MS SQL database used to add Aurea CRM tables to this
parameter. This setting overwrites the default database in the ODBC definition. If
the database entered in this parameter is not present on the MS SQL sever, the
default database is used.

CONNECTION=Driver=SQL Server ;Server =mmdb;Database=UPDATE7;UID=mm;PWD=MM;

Use this parameter to specify the database connection as an ODBC connection
string (maximum length: 1024 characters).

Use CONNECTION instead of

LOGINID=mm

PASSWORD=MM

DATASOURCE=MMDB

DATABASE=UPDATE7

Any installed ODBC driver can be specified as the driver, e.g.

Driver=SQL Server Native Client 10.0 for MS SQL Server 2008.

Use PWD_TO_ENCRYPT to encrypt the password (see below).

MM_PWD_FILE=OFF

If this entry is set to "OFF", Aurea CRM uses the password specified using the
PASSWORD parameter. If the entry is set to "ON", a temporary password file is created
in the .. \system\sys directory.

PWD_TO_ENCRYPT=<plain pwd>

Use this entry to store the database password in encrypted form: enter the password
in plain text. The next time Aurea CRM is star ted, the password is encrypted and
written to the PWD _ENCRYPTED entry. The PWD_TO_ENCRYPT entry is deleted automati-
cally.

Each time Aurea CRM is star ted, the system checks whether the file mmdb.ini
contains an encrypted password. If this is the case, the password is used.

You need to use Aurea CRM win to encrypt passwords using PWD_TO_ENCRYPT for
other Aurea CRM products.

TABLE_PREFIX=MMDB

This entry specifies the prefix for the Aurea CRM tables. There is no default value;
you therefore need to assign a value to this parameter.

SCHEMA=<schema name> (e. g.: SCHEMA=dbo)

As of MS SQ L2005, this parameter is set automatically.

Use this entry to specify the name of the database schema. If the Aurea CRM login
ID does not correspond to the MS SQL default schema assigned to the database
user, you need to enter SCHEMA=<ms sql default schema> in order to use all
database functions.
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If you use a reserved name (e.g. UPDATE) as a schema name, you need to place
the entry in square brackets for all functions to work correctly.

TIMEZONE=110

This parameter specifies the time zone used by the database. The value is determine
using the system settings and may not be edited.

SEGMENT_DAT=MMDAT

If the database has been split (e.g. over several hard disks), the "Filegroup" for
Aurea CRM's database tables is defined in this entry.

If the database has not been split, this entry should be set to "NONE".

SEGMENT_IDX=MMIDX

If the database has been split (e.g. over several hard disks), the "Filegroup" for
Aurea CRM's indices is defined in this entry.

If the database has not been split, this entry should be set to "NONE".

SEGMENT_SELDAT=MMSELDAT

If the database has been split (e.g. over several hard disks), the "Filegroup" for
Aurea CRM's selection tables is defined in this entry.

If the database has not been split, this entry should be set to "NONE".

SEGMENT_SELIDX=MMSELIDX

If the database has been split (e.g. over several hard disks), the "Filegroup" for
Aurea CRM's selection indices is defined in this entry.

If the database has not been split, this entry should be set to "NONE".

CASE_SENSITIVE=ON

If the database was installed on the server as case-insensitive, then this parameter
should be used, as it can increase performance (set to "ON").

NDEX_MANDNR=ON

This entry causes each generated index to include the tenant number (only applicable
to info areas that include the <xx>-TenNo field). As a result, access time is improved
for large tables that include non-uniform tenant distribution.

The default value is "OFF"

MM_PACKET_SIZE=4096

This entry defines the network packet size (in bytes) for ODBC access.

JOIN_ID=OFF

In SQL queries including conditions applied to "fiid" and "kpid" but sor ted according
to an mmKey field, the optimiser accesses the mmKey field using an index. This
can impact negatively on performance. By setting JOIN_ID=OFF, the condition also
accesses the mmKey fields. The optimized SQL query would look like the following:

SELECT ... FROM table WHERE keyxxx LIKE '...' ORDER BY keyxxx

SELECT_LEFTOUTERJOIN=OFF

Disables the use of "left outer join" when reading records using a transfer fields
format. The default setting is ON.

73AUREA CONFIDENTIAL

mmdb.ini and mmodbc.ini Files



SELECT_INNERJOIN=OFF

Disables the use of "inner join" when reading records using a transfer fields format.
The default setting is ON.

COLLATION = German_phonebook_CI_AS, Czech_CI_AS ,…

This entry is used to define the possible sor ts applied to the MS SQL database
during the current session. This parameter should only be assigned a value if multiple
languages are used to sor t, see Multi-language Sort.

CACHE_READ_CURSOR=OFF, CACHE_WRITE_CURSOR=OFF, CACHE_CURSOR=OFF

Use these entries to turn cursor sharing on or off. The default value for all entries
is "ON".

The CACHE_CURSOR entry turns both modes (read and write) either on or off.

ERRORnn=<Error Message>

Use this setting to translate SQL error messages (e.g. "Cursor was not closed"), if
you are using an operating system in another language.

Examples:

Error20=Cursor was not closed.

Error20_1=Der Cursor wurde nicht geschlossen.

Error20_2=...

...

Error21=Connection is busy with results for another hstmt.

Error21_1=Die Verbindung ist mit Ergebnissen von einem anderen hstmt belegt.

Error21_2=...

...

NOLOCK_HINT=ON

Use this entry to generate Select statements using the hint NOLOCK.

Example: SELECT columnA FROM tableA WITH (NOLOCK)

This allows queries to be run on tables that are being updated, which improves the
system's performance.

SELECT_INNER_JOIN=ON

This entry determines that the INNER JOIN parameter is used when creating a se-
lection from a base selection. This improves performance. The default value is OFF.

SQL_UPDATE_SELECTIONSTATISTICS=n

If the number of records found in a selection is equal to or greater than the number
entered here, the selection statistics are updated.

AGGREGATE_CURRENCY=ON

This entry ensures that sor ting by sum total fields works correctly when using multiple
currencies. The default setting is OFF.

NO_CURRENCY=ON
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This entry ensures that sor ting by sum total fields works correctly if you are not
using multiple currencies. The default setting is OFF.

COLLATE=OFF

If different sor t orders (collations) are defined in the Configuration info area
(see MSSQL on page 68) and database, the sor t order defined in the Configuration
info area is used when evaluating conditions applied to string fields. Set COLLATE=OFF
to use the database's sor t order.

ORDER_CATALOG_FUNCTION=OFF

By default, when sor ting records by catalog fields (e.g. "select Firma,Land,Ort from
FI order by Land") Aurea CRM generates a more or less complex SQL statement
without accessing the Catalog info area.

Set ORDER_CATALOG_FUNCTION=ON to use the SQL function "prefix"_ CatText( ) in-
stead. However, this sor ting method is much slower because the function accesses
the Catalog info area.

[STATIC CURSOR]

Use this section to disable static database cursors. This can solve problems with
performance when reading large volumes of data (e.g. when exporting).

To disable static cursors for individual info areas, specify the info area using the
info area ID, e.g.:

MA=off

To disable static cursors for all tables:

AllTables=off

Multi-language Sort

Aurea CRM supports unicode character sets and therefore the input of data using
different codepages. Using multi-language sor ts, each user can determine their own
language-specific sor t settings.

Types of Sort

• Data is sor ted by field

• by selecting Data > Sort from the menu

• by clicking on the column header in a list

• in the dialog box used to select catalog values

The sor t order for text fields is based on the Windows regional settings (Start
> Settings > Control Panel > Regional and Language Options).
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• Data is sor ted by index

• by selecting Data > Sort from the menu

• when sor ting in selections

The sor t order used for indices is defined in the index itself. The index is construct-
ed using the sor t order used by the MS SQL database. This allows all users to
access the same sort independent of their regional settings.

In order to allow users of an MS SQL database to use a language-specific sor t order
for indices, define the following sor t order:

1. Enter all the sor t orders you require additionally in the mmdb.ini file. These options
need to be supported by MS SQL server (see MS SQL documentation on
"Collations"):

Example: Aurea CRM installation using the "SQL_Latin1_General_CP1_CI_AS"
sort order on a central database with users in three countries (Austria, the Czech
Republic and Russia).

[MM ODBC MSS]

COLLATION= German_phonebook_CI_AS, Czech_CI_AS, Cyrillic_General_CI_AS

Note:  Each new index impacts negatively on the performance of the database.
Consider whether using a "Multilingual Linguistic Sort" would also meet your
requirements (see Oracle documentation). If you do need to add language-specific
sor ts, only add those that you definitely require.

2. When star ting one of Aurea CRM's modules, a message is displayed informing
you that the necessary indices need to be added ("ADD").

3. Switch to the SQL tool and click on the Rebuild NLS_SORT-Indexes to add the
indices for the selected info area, see SQL Tool on page 469. Click on Rebuild
ALL NLS_SORT-Indexes to add indices for all info areas.

Note:  Aurea recommends always using the Rebuild ALL NLS_SORT Indexes
option.

Only those indices are affected that access text fields.

Note: To remove an index that is no longer required, delete the corresponding
value from the MM_NLS_SORT parameter. When star ting one of Aurea CRM's
modules, a message is displayed informing you that the indices need to be deleted
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("REMOVE"). Click on either the Rebuild NLS_SORT-Indexes or Rebuild ALL
NLS_SORT-Indexes buttons in the SQL tool.

4. Assign a sor t order to users and rights groups in the Configuration info area in
the Rights module:

ContentsField

MSSQLCategory

COLLATIONOption

<Sort order>, e. g. ENGLISHText

Enter the desired rep or groupRep/Group

Note:  If different sor t orders (collations) are defined in the Configuration info
area (see MSSQL on page 68) and database, the sor t order defined in the
Configuration info area is used when evaluating conditions applied to string
fields. Enter COLLATE=OFF in the mmdb.ini file (see [MM ODBC MSS]) to use the
sort order defined in the database.

mmdb.ini File for Oracle Databases
Oracle databases settings for Aurea CRM.

Below are some of the mmdb.ini file for MS SQL database:

[MM SQL]

MULTIDBS=ON

If this entry is set to ON, the parameters are first read from this section and applied.
Otherwise, the parameters are read from the [MM ORA] section.

[MM ORA]

• MM_PWD_FILE=OFF

If this entry is set to OFF, Aurea CRM uses the string entered under PASSWORD as
the default value. If this entry is set to ON, a temporary password file is generated
in the .. \system\sys directory.

• ID=MM

This entry contains the name of the database user.

• PASSWORD=MM

This entry contains the password of the database user.
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• HOSTSTRING=MMDB

This entry contains the name of the data source on the server. The maximum
length is 127 characters.

• TABLESPACE_DBS=MMDAT

This entry defines the Oracle table space for the data tables in Aurea CRM.

• TABLESPACE_IDX=MMIDX

This entry defines the Oracle table space for the indices in Aurea CRM.

• TABLESPACE_SEL=MMSELDAT

This entry defines the Oracle table space for the selection tables in Aurea CRM.

• TABLESPACE_SELIDX=MMSELIDX

This entry defines the Oracle table space for the selection indices in Aurea CRM.

• TABLESPACE_RBS=RBS

This entry defines the Oracle table space for rollback segments in Aurea CRM.

• TABLE_PREFIX=MMDB

This entry contains the table prefix for the Aurea CRM tables.

Note: This value must be in upper case and numbers must not be entered at the
beginning. There is no default value, so this entry must contain a value.

• TIMEZONE=110

This entry specifies the time zone used by the database. Transferred from the
system and may not be changed.

• MM_NLS_LANGUAGE=AMERICAN

This entry contains the Oracle database language information.

• MM_NLS_TERRITORY=AMERICA

This entry contains the Oracle database country information.

• MM_NLS_CHARSET=WE8ISO8859P1

This entry contains the character set information for the Oracle database. This
value must correspond with the character set used by the Aurea CRM database
and with the Oracle client's registry entry.

• MM_NLS_SORT=BINARY,GERMAN,CZECH,...

This entry defines the Oracle database's available sor t order(s) for the current
session.

The first value determines the default value and must always be specified. Addi-
tional values (such as GERMAN and CZECH in the example above) should only be
entered if multi-language sor ting is used, see Multi-language Sort.

• USE_NLSSORT=on
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Add this entry to Aurea CRM web's mmdb.ini file to enable linguistic sor t (e.g.
MM_NLS_SORT=GERMAN) for Aurea CRM web.

• USER_ROLLBACK_SIZE=100

This entry defines the number of database blocks used by the selection rollback
segment. If this value is set to "0", no user rollback segments are used.

• CASE_INSENSITIVE=ON

If the database was installed on the server as case-insensitive, then this param-
eter should be used. Otherwise problems can occur when communicating data if
the entries are stored in both upper and lower case. Additionally, the entry can
lead to a performance increase as well (set to "ON").

• OPTIMIZER_GOAL=RULE/CHOOSE/ALL_ROWS/FIRST_ROWS

OPTIMIZER_MODE = ALL_ROWS/FIRST_ROWS/ FIRST_ROWS_n

This entry activates the optimizer for the current session. OPTIMIZER_MODE is used
as the standard optimizer, see Optimizing Access on page 89.

• INDEX_MANDNR=ON

This entry causes each generated index to include the tenant number (only appli-
cable to info areas that include the <xx>-TenNo field).

The default value is OFF.

• CACHE_READ_CURSOR=ON

CACHE_WRITE_CURSOR=ON

CACHE_CURSOR=ON

Use these entries to enable cursor sharing. The default value for all three entries
is OFF.

CACHE_CURSOR toggles both modes (read and write).

• EXT_SELECTION_OLD=on

Use this entry to interpret AND links in extended selection conditions as in earlier
versions of marketing.manager.

Behavior up to Version 6.0 Service Pack 5: If sub-criteria defined for a depen-
dent info area are linked with a logical AND, the condition is only met, if at least
one independent record meets the first sub-criteria, and at least one record meets
the second sub-criteria.

Current behavior (default setting): Without brackets, the condition is evaluated
as before. However, if brackets are used, at least one dependent record needs
to meet both sub-criteria.

• SELECT_INNER_JOIN=ON

This entry determines that the INNER JOIN parameter is used when creating a
selection from a base selection. This improves performance. The default value
is OFF.

• SELECT_LEFTOUTERJOIN=OFF
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Disables the use of "left outer join" when reading records using a transfer fields
format. The default setting is ON.

• SELECT_INNERJOIN=OFF

Disables the use of INNER JOIN when reading records using a transfer fields format.
The default setting is ON.

• AGGREGATE_CURRENCY=ON

This entry ensures that sor ting by sum total fields works correctly when using
multiple currencies. The default setting is OFF.

• NO_CURRENCY=ON

This entry ensures that sor ting by sum total fields works correctly if you are not
using multiple currencies. The default setting is OFF.

• COLLATE=OFF

If different sor t orders (collations) are defined in the database and configuration
see ORACLE on page 68), the sor t order entered in the configuration is used
when evaluating conditions applied to string fields. Set COLLATE=OFF to use the
database's sor t order.

• ORDER_CATALOG_FUNCTION=OFF

By default, when sor ting records by catalog fields (e.g. "select Firma,Land,Ort
from FI order by Land") Aurea CRM generates a more or less complex SQL
statement without accessing the Catalog info area.

Set ORDER_CATALOG_FUNCTION=ON to use the SQL function "prefix"_ CatText( )
instead. However, this sor ting method is much slower because the function ac-
cesses the Catalog info area.

• ORACLE_NO_DECODE=1

By default (ORACLE_NO_DECODE undefined or 0), when sor ting data via indices and
in descending order a DECODE( dummy,...) command is added to the SQL statement
to allow for a correct result when additional sor ting is used. This method impacts
performance since a full table scan is executed.

Add ORACLE_NO_DECODE=1 to Aurea CRM web's mmdb.ini file to prevent the gener-
ation of the DECODE( dummy,...) command. Please note that the query result may
be incomplete and/or sor ted incorrectly if this setting is active.

• ORACLE_NO_ROWNUM=1

By default (ORACLE_NO_ROWNUM undefined or 0) query results displayed in lists may
be sor ted incorrectly. As documented by Oracle, Oracle applies the ROWNUM
clause before the sor ting, i.e. first the number of rows is limited and only the re-
sulting rows are sor ted.

If you add ORACLE_NO_ROWNUM=1 to Aurea CRM web's mmdb.ini file the statement
is generated without the ROWNUM clause. This ensures correct sor ting of lists
but leads to considerable performance loss.
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Note:  Both NO_DECODE and NO_ROWNUM can be activated globally (in Aurea CRM
web's mmdb.ini file) and per cursor (noOracleRownNum and NoOracleDe-
code).Activating NO_ROWNUM automatically activates NO_DECODE as well.

[Communication]

TimezoneTransformation=OFF

If this entry is set to "OFF", combined date and time fields (type: "date,time") are
not converted to the target station's time zone when communicating between stations
in different time zones.

The time stamps (modification date and time) are always converted to the target
station's time zone when inputting communication data.

Note: This entry needs to be added on all communicating stations to prevent times
from being converted.

This setting only affects the input process. It has no effect on Aurea CRM web
(conversion between the server and client).

Multi-language Sort

Aurea CRM supports unicode character sets and therefore the input of data using
different codepages. Using multi-language sor ts, each user can determine their own
language-specific sor t settings.

Types of Sort

• Data is sor ted by field

• by selecting Data > Sort from the menu

• by clicking on the column header in a list

• in the dialog box used to select catalog values

The sor t order for text fields is based on the Windows regional settings (Start
> Settings > Control Panel > Regional and Language Options).

• Data is sor ted by index

• by selecting Data > Sort from the menu

• when sor ting in selections
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The sor t order used for indices is defined in the index itself. The Oracle database
parameter MM_NLS_SORT entered in the mmdb.ini file is used to construct the
index. This allows all users to access the same sort independent of their regional
settings.

In order to allow users of an Oracle database to use a language-specific sor t order
for indices, define the following sor t order:

1. Enter all the sor t orders you require additionally in the mmdb.ini file. These need
to be "Linguistic Sorts" defined by Oracle (>> Oracle documentation). The first
value must always be present and is used as the default value.

Example: Aurea CRM installation using a central database with users in three
countries (Austria, the Czech Republic and Russia).

[MM ORA]

MM_NLS_SORT=BINARY,CZECH,RUSSIAN,GERMAN

Note:  Each new index impacts negatively on the performance of the database.
Consider whether using a "Multilingual Linguistic Sort" would also meet your
requirements (see Oracle documentation). If you do need to add language-specific
sor ts, only add those that you definitely require.

2. When star ting one of Aurea CRM's modules, a message is displayed informing
you that the necessary indices need to be added ("ADD").

3. Switch to the SQL tool and click on the Rebuild NLS_SORT-Indexes to add the
indices for the selected info area, see SQL Tool on page 469. Click on Rebuild
ALL NLS_SORT-Indexes to add indices for all info areas.

Note:  Aurea recommends always using the Rebuild ALL NLS_SORT Indexes
option.

Only those indices are affected that access text fields.

Note: To remove an index that is no longer required, delete the corresponding
value from the MM_NLS_SORT parameter. When star ting one of Aurea CRM's
modules, a message is displayed informing you that the indices need to be deleted
("REMOVE"). Click on either the Rebuild NLS_SORT-Indexes or Rebuild ALL
NLS_SORT-Indexes buttons in the SQL tool.

4. Assign a sor t order to users and rights groups in the Configuration info area in
the Rights module:

ContentsField

ORACLECategory

NLS_SORTOption
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ContentsField

<Sort order>, e. g. ENGLISHText

Enter the desired rep or groupRep/Group

You cannot assign the sor t order to a station in the Configuration info area. In
order to assign a sor t order to a station, define the MM_NLS_SORT parameter
when adding the tables.

If no sor t order has been assigned to a user (neither individually nor for the user's
group or station), the default value is used (i.e. the first value entered under
MM_NLS_SORT).

If a user is assigned a sor t order for which no index exists, an error message is
displayed when Aurea CRM is star ted. The user can proceed, but uses the default
value instead.

Note:  If different sor t orders (collation) are defined in the Configuration info area
(see ORACLE on page 68) and database, the sor t order defined in the Configuration
info area is used when evaluating conditions applied to string fields. Enter COL-
LATE=OFF in the mmdb.ini file (see [MM ORA]) to use the sor t order defined in the
database.

Replacing NLS_SORT With a Custom Function

To replace all references to the built-in NLS_SORT function in Oracle with a custom
function in the database:

1. Define your function externally. (The function is not par t of Aurea CRM.)

2. To activate the function add the following entry to mmdb.ini file ([MM ORA]
section):

NLS_FUNCTION=...functionname<col>...<len>

Replace functionname with the name of the external function.

<col> is placeholder for the affected column(s)

<len> is the (optional) placeholder for the column length

Example:

NLS_FUNCTION =cast(german_lower(<col>) as varchar2(<len>))

3. Make sure the following entry is present in the mmdb.ini file ([MM ORA] section):

NLS_SORT=BINARY

4. Recreate all indexes via SQL Tool (Drop All Indexes, Create All Indexes).

The statement

(NLSSORT(UPPER(Firma),'NLS_SORT=GERMAN')

is replaced with
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cast(german_lower(Firma) as varchar2(120))

[STORAGE PARAMETERS]

• STORAGE_DAT= storage( initial 1M next 1M minextents 1 maxextents unlimited
pctincrease 0)

This entry defines the extents' dimensions for new Oracle objects (tables, indices).
It refers to objects in the table space that correspond to the value under TA-
BLESPACE_DBS.

• STORAGE_IDX= storage( initial 100k next 100k minextents 1 maxextents un-
limited pctincrease 0)

This entry defines the extents' dimensions for new Oracle objects (tables, indices).
It refers to objects in the table space that correspond to the value under TA-
BLESPACE_IDX.

• STORAGE_SELDAT= storage( initial 100k next 1M minextents 1 maxextents un-
limited pctincrease 0)

This entry defines the extents' dimensions for new Oracle objects (tables, indices).
It refers to objects in the table space that correspond to the value under TA-
BLESPACE_SELDAT.

• STORAGE_SELIDX= storage( initial 100k next 1M minextents 1 maxextents un-
limited pctincrease 0)

This entry defines the extents' dimensions for new Oracle objects (tables, indices).
It refers to objects in the table space that correspond to the value under TA-
BLESPACE_SELIDX.

• STORAGE_PCT_DAT=PCTFREE 20 PCTUSED 60

These two parameters define the filling of the blocks in the table space that cor-
respond with the value under TABLESPACE_DBS.

• STORAGE_PCT_IDX=PCTFREE 10

These parameters define the filling of the blocks in the table space that correspond
to the value under TABLESPACE_IDX.

• STORAGE_PCT_SELDAT=PCTFREE 5 PCTUSED 80

These two parameters define the filling of the blocks in the table space that cor-
respond with the value under TABLESPACE_SELDAT.

• STORAGE_PCT_SELIDX=PCTFREE 5

These parameters define the filling of the blocks in the table space that correspond
with the value under TABLESPACE_SELIDX.

[STORAGE]

• INITIAL=1M
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This entry concerns the dimensions of the extents for temporary rollback segments
(selections, rebuilds). The initial size of the first extent is defined here.

• NEXT=1M

This entry concerns the dimensions of the extents for temporary rollback segments
(selections, rebuilds). The size of the subsequent extents is defined here.

• MINEXTENTS=10

This entry concerns the dimensions of the extents for temporary rollback segments
(selections, rebuilds). The minimum number of extents is defined here.

• MAXEXTENTS=UNLIMITED

This entry concerns the dimensions of the extents for temporary rollback segments
(selections, rebuilds). The maximum number of extents is defined here.

• PCTINCREASE=0

This entry concerns the dimensions of the extents for temporary rollback segments
(selections, rebuilds). The increase in size of the extents is defined here.
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[LOCAL INDEX]

• Local Indexes

Use the [LOCAL INDEX] section to determine which indices should be used.

Syntax: <Info area code> =( <Field number>)

If the specified fields are contained in a Select statement, no index hint and
ROWNUM statement are generated, and the optimizer can choose the index itself.

You can use either the sequential field numbers or field IDs, see ID, Name, Type,
Reference on page 340.

You can specify up to 8 fields. If you specify multiple fields, all fields must be in-
cluded in the statement for the index hint to be disabled.

[LOCAL INDEX]

PR =( 24,25)

If fields 24 (Sales Rep ID) and 25 (Rep ID) in the PR (Offer) info area are included
in the Select statement (e.g. Select [...] from xxx_PR where Sales Rep ID=1234
and Rep ID=123456), the index hint is disabled.

A line defined for an info area in the mmdb.ini file can be up to 1024 characters
long.

Note:  If the ID of a linked info area is used to access data, an index hint is always
generated, e.g. from xxx_KP where ID_FI=:1 (all persons in a company).
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• Disabling Hints

You can disable the Oracle hints in Aurea CRM if you are suffering problems with
performance.

Note:  SQL statements without hints also do not include ROWNUM statement.
As a result, processing the SQL statement can take longer (depending on the
data volume).

Note:  Disabling hints can cause performance problems when applying conditions
to tables without additional indices.

• AllTables=off

Disables hints in all tables.

• AllTables=web_off

Disables hints in all tables for Aurea CRM web, CRM.interface and CRM.server.

• FI=off

Disables hints in the Company (FI) table.

• MA =( off,8)

Disables hints in the Activity (MA) table if field 8 is included in the condition.

• FI =( off,5,6)

Disables hints in the Company (FI) table if fields 5 and 6 are included in the
condition.

• FI =( off,126)(off,127)

Disables hints in the Company (FI) table if field 126 or field 127 is included in
the condition.

• AllTables=off

NO=on

Disables hints for all tables apart from the Note (NO) table.

• MA =( on,index_11,4)

Generates a hint for a custom index with the number 11 in the Activity (MA)
table, if field 4 is contained in the condition.

Note: You can only define hints for indices created in the Maintenance module
(and not for indices created directly in the database).

Explanation of Oracle Parameters
Explaining extents, space usage and optimizing access for oracle database.
Extents
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Learn about using the extents oracle parameters.

Initial:

This parameter determines the size of the first extent of an object. The minimum
value corresponds with the size of one database block, the standard value with the
size of five database blocks.

Next:

This parameter determines the size of the next extent assigned to an object. The
minimum value corresponds with the size of one database block, the standard value
with the size of five database blocks.

Pctincrease:

This parameter contains the value as a percentage by which each extent (from the
second one) grows in comparison to the previous one. The default value for this
parameter is "50", i.e. each subsequent extent is 50% bigger than the previous one.

Minextents:

This parameter determines the number of extents assigned immediately the segment
is added. The default value is "1", for rollback segments "2".

Maxextents:

This parameter determines the total number of extents (including the first one) that
an Oracle database can assign to an object. The values "unlimited" and "value" can
be used.

• Unlimited: This option allows any number of extents to be generated. They are
restricted only by the free space available to a table space.

• Value: This option is used to define the maximum number of extents. If no value
is entered, the default value is used. The default value depends on the size of
the database block. You can enter any integer > 0. For rollback and temporary
segments, the value "unlimited" should be used in order to prevent a restriction
on growth.

Data block:

Database blocks represent the smallest storage unit administrated by Oracle. The
size of the database blocks can only be defined using the initialization parameter
"db_block_size" when the database is created.

Space Usage
Space usage oracle parameters can be used to define free space and setting limit
for the capacity of database blocks.

Pctfree:

This parameter is used to define the free space (as a percentage) in each database
block of an object reserved for future updates. You can enter a value between "0"
and "99". The default value for this parameter is "10".
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Pctused:

This parameter is used to set a limit for the capacity of the database blocks, allowing
the block to be fur ther filled if the capacity is not used up. You can enter a value
between "0" and "99". The default value is "40" (%). This parameter cannot be used
for indices.

Optimizing Access
Central instances, or optimizers, can be used to optimize database access.

Optimizers can be used in two ways and are configured on different levels.

The old method of rule-based optimization selects access operations based on fixed,
predefined rules.

The cost-based method uses previously generated statistics.

The optimizer is activated for the current session using the entry OPTIMIZER_GOAL.
Four values are used to activate the optimizer:

• ALL_ROWS: This value enables cost-based optimization and optimizes the entire
throughput.

• FIRST_ROWS: This value also enables cost-based optimization and optimizes
response times, i.e. the first rows are output as quickly as possible.

• RULE: This value enables rule-based optimization.

• CHOOSE: This value enables cost-based optimization if statistics are available,
otherwise it enables rule-based optimization. CHOOSE is the default value.

The OPTIMIZER_GOAL parameter is no longer supported by Oracle 10g and must be
replaced with the OPTIMIZER_MODE parameter (OPTIMIZER_MODE was also supported
prior to Oracle version 9i). The following settings can apply to the optimizer:

• ALL_ROWS: enables the statistical optimization for the entire throughput.

• FIRST_ROWS: also works based on statistical information and optimizes for the
optimum response time; i.e. the onus is on outputting the first rows as quickly as
possible.

• FIRST_ROWS_n

• RULE: no longer supported

• CHOOSE: no longer supported

Statistics

Statistics, such as the number of rows per table or the distribution of values in a
table's column provide the optimizer with valuable core values that allow decisions
on the access strategy to be made according to a concrete situation and not based
on general rules.
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Tuning

You can use the following parameters in the [MM ORA] section to influence the for-
mation of statements:

TUNE_STMT_ORDER=on

All statements receive an order by clause.

TUNE_STMT=<flags>

The following flags are available:

1: All statements receive an ORDER BY clause (corresponds to TUNE_STMT_ORDER=on).

2: The ROWNUM clause is nested for readfirst/readlast (safe, but slow method).

4: The ROWNUM clause is nested for readgreater/readless (safe, but slow method).

7: The ROWNUM clause is applied outside of the order statement. You can use the
settings in the [LOCAL INDEX] section to disable index hints in the subselect state-
ment, >> [LOCAL INDEX].

128: An index hint is generated in the statement that includes the keyword "Rule".
This causes the Oracle optimizer to process this statement as rule-based. This flag
only works up to Oracle version 9.x. As of version 10g, there is no rule-based opti-
mizer, and the hint is ignored.

Flags can be combined. TUNE_STMT=6 would mean that flags 2 und 4 are set.

TUNE_STMT_REL=TABLE_INDEX_flagAllgemein_FirstFlag_ GreaterFlag ; ...

Transfers all table index combinations with special flags, e.g. FI_1_1_F2_G4.

If you star t mmba.exe with the parameter -q stmttune, suitable TUNE_STMT_REL
settings are determined automatically, >> Aurea CRM Parameters on page 10.

Secure Login
How to login to Aurea CRM database securely.

A separate administration program is available that allows you to generate SQL
source code for Microsoft SQL or Oracle database, in order to configure secure logins
for your Aurea CRM database.

1. Contact support@aurea.com to obtain the necessary key_admin.exe and
mmkey2.dll files.

2. Copy these files to the \system\exe directory.

3. Enter the following command line:

key_admin [mss|ora] [-prefix:TABLE_PREFIX]

mss|ora is the database in use (MS SQL oder Oracle)

TABLE_PREFIX is the desired table prefix
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Note: key_admin.exe writes to stderr. Append 2>file.txt to the command
line to pipe the output to file.

4. Enter the desired database user's login and password. This user requires full
access to the database.

5. Create the stored procedure and table in the database using this user name.

6. Enter the generated record in the tables.

7. Assign access to only this stored procedure (i.e. not to all tables in the database)
to users in the mmdb.ini file.

8. To use the stored procedure, enter the following in the mmdb.ini file:

[secure_login]

sl=1

Note:  Other values of sl disable the secure login.

mmodbc.ini File for ODBC MS SQL Database Access
This topic contains the placeholders' system names in statements, used by ODBC
access to MS SQL Server.

Below are the placeholders' system names in statements, that are used by ODBC
access to MS SQL Server:

• ALL_TABLES=sysobjects

• TABLE_NAME=name

• ALL_INDEXES=sysindexes

• INDEX_NAME=name

• ALL_SEQUENCES=none

• SEQUENCE_NAME=none

• SEQUENCES=FALSE

• PROCEDURES=TRUE

• FIXCHAR= CHAR( %d)

• VARCHAR= VARCHAR( %d)

• SMALLINT=INTEGER

• INTEGER=INTEGER

• FLOAT=FLOAT

• DOUBLE=FLOAT
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• BINARY= BINARY( %d)

• VARBINARY= VARBINARY( %d)

• TEXT=TEXT

• IMAGE=IMAGE

• ID=INTEGER

• MAXVARLEN=255

SMTP Connection Settings
Learn to configure SMTP Connection settings to be able to send e-mails from within
Aurea CRM.

In order to be able to send e-mails from within Aurea CRM via SMTP, you need to
determine the connection settings. The settings are used:

• to send e-mails in Aurea CRM win

• by clicking on an e-mail address in a database field

• by selecting File > E-Mail from the menu, see Sending E-mails via SMTP in
the Aurea CRM win User Manual

• by selecting File > Single Letter from the menu, see Single Letters in the Aurea
CRM win User Manual

• to send mass mailings within the scope of marketing activities, see Planning and
Preparing Marketing Activities in the Aurea CRM win User Manual

• to send mass mailings via CRM.server, see Automatically Executing Marketing
Activities on page 466.

• to send e-mails via triggers, see E-Mail on page 208.

Note: You need to configure SMTP as the E-mail Client in order to send e-mails
via SMTP, see General Settings on page 41.

Note:  Note: To send email in a language other than the default languages, you
should use UTF-16 encoding for the template document. For example, to send a
mail in Cyrillic, encode the HTML template document in UTF-16.

You can define the SMTP settings for Aurea CRM users as follows:
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Using the Configuration Entry

Use the Connection Settings for SMTP configuration entry to specify the connection
settings. You can define settings globally or for individual stations, groups and reps,
see General Settings on page 41. These settings are saved in the database and
can be distributed using Aurea CRM's communication mechanisms.

Using the smtp.cfg File

The smtp.cfg file can be used to define the connections globally or for individual
users:

1. Select File > E-Mail from the menu in the main module.

The following dialog is displayed the first time an e-mail is sent via SMTP:

Note: You can open the Connection Settings dialog at any time by holding down
Shift while selecting File > E-Mail from the menu.

Enter the desired connection settings:

• Sender: Your name

• E-Mail: Your e-mail address

• User name: Your SMTP user name

• Password: Your SMTP password

• Authentication method (optional): the login authentication method; possible
options: AUTH_NONE, AUTH_CRAM_MD5, AUTH_LOGIN, AUTH_PLAIN,
AUTH_NTLM

• Server / IP: Name or IP address of the SMTP server
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• SMTP Port: The SMTP port; default is 25

• SSL: Enable the SSL check box to encrypt your e-mails using SSL. Click on
Flags to configure the settings used to verify the validity of the cer tificate.

• Format: E-mail format (TEXT or HTML)

• Priority: The priority with which the e-mail should be sent

2. Enable the Store credentials check box to save the settings in the smtp.cfg
file.

3. Click on OK.

The settings are saved in encrypted form in the smtp.cfg file in the current
user's directory, see \<user name> in the Aurea CRM win Administrator Guide.
Copy the smtp.cfg file to the \system\sys directories (of Aurea CRM win and
Aurea CRM web) to use the settings for all users for whom no individual connection
settings are defined.

Using the mm.ini File

You can use the mm.ini file to define SMTP settings for Aurea CRM win globally
or for individual users, depending on whether the file is located in the \system\sys
or user directory, see [SMTP] in the Aurea CRM win Administrator Guide.

The SMTP settings in the mm.ini file are used as default values the first time an
e-mail is sent using the File > E-Mail menu option and as long is the Store creden-
tials check box is not enabled.

These connection settings are used by Aurea CRM win when sending mass mailings
and e-mails via triggers if no suitable configuration entry is present and no suitable
smtp.cfg file can be found.

When sending e-mails via SMTP, the system searches for valid connection settings
for the current user in the following order:

1. In the smtp.cfg file in the user directory (Aurea CRM win only)

2. In a configuration entry (first searching for an entry for the current rep, then the
rep's group, then the station, and finally the global entry)

3. In the smtp.cfg file in the \system\sys directories of Aurea CRM win and
Aurea CRM web

4. In the mm.ini file (Aurea CRM win only) (first searching for an entry for the
current rep, then for a global entry)

Calendar Definition Info Area
Learn how to create calendar definition and holidays using CD info area.

Use the Calendar Definition info area (CD) to:

• create records for each day of a calendar definition containing attributes for
weekday, workday and holiday. You can use these records in read-engine formats,

94AUREA CONFIDENTIAL

Chapter 2: Configuration

https://help.aurea.com/crm/crm-win-admin-guide/crm-win-admin-guide/dita/topics/c_win_adm-1_3_3-user-name_crm.html
https://help.aurea.com/crm/crm-win-admin-guide/crm-win-admin-guide/dita/topics/c_win_adm-5_1-Configuration_crm.html


queries and conditions to create reports, analyses and workflows, e.g. for call
planning or to create a work performance report for each user.

• define extra holidays for specific dates, e.g. holidays that do not occur every year
or company-specific holidays. These holidays are displayed as holidays in the
calendar in addition to the holidays defined by the Holidays configuration entry
(MC).

Note: To display Calendar Definition records defining holidays (= Workday
unchecked) in the user's calendar, a calendar with the selected ID must be defined
in the Configuration info area (MC), see Calendar on page 24.

To create records in the Calendar Definition info area you can:

• create records manually, e.g. to just create a company-specific holiday for the
next year

• create a to-do that generates records for a large number of days, i.e. one or more
years.

To generate records via a to-do:

1. Create a to-do record of To-Do Type "Calculate" e.g. with the following text:
17;2013-09-01,2013-12-31,1,2,10

This creates Calendar Definition records for the specified time span (max. 10
years) for the calendars 1, 2 and 10. The IDs must correspond to catalog value
IDs of the fixed catalog "Calendar". If no catalog value exists for the specified
ID, no records are created. For more details, see To-Do Types on page 444.

2. If the to-do record is assigned to the current user, it is executed immediately upon
saving the record. Otherwise it is executed by CRM.server.

The to-do is executed with the rights of the user who created the to-do.

After completing the to-do, the Calendar Definition info are contains a record for
each day and calendar as specified in the to-do:
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Disable check for mandatory field in company
conditions
Learn how to disable check for mandatory field in company conditions.

The configuration setting Disable check for mandatory field in company
conditions is located in Right Module > Configuration.

When enabled, this configuration setting becomes active during price calculation,
taking into account the volume scales in company condition, even when the fields
Discount vol. in kind or bulk discount (%) are empty.
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3
Using CRM Core
CRM.Core is easy to use and offers numerous features to facilitate your daily
activities.

Rights Module
Here you can learn about the CRM process and the core settings for the Aurea CRM.

Use the Rights module to:

• Define which CRM processes are available across the entire system, see CRM
Process Configuration on page 98

• Define roles used by your company's employees to log on to the system,
see Login Roles on page 106

• Define languages and stations, see Languages on page 109 and Station on page
111.

• Depict your company’s internal structure by defining reps, groups and resources,
see Rep on page 114

• Define data access rights for stations, groups and users, see Rights on page 136

• Log data access and changes, see Tracking on page 242, Logging Read and Write
Access on page 245 and History on page 258

• Define new functions and processes, see Triggers on page 169.

• Separate data by tenants, see Tenants on page 221

To prevent concurrent changes of the same format (e.g. a rights definition or a
trigger), each time a format is opened a check is performed if this format is currently
being edited by another user. In this case a message is displayed and the current
user can only view the format but not change anything.

This applies to the following formats:

• CRM Process Configuration

• CRM Process Configuration (login role)

• Rights

• Trigger

• Tenant Rights
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CRM Process Configuration
You can use the CRM Process Configuration level to define which CRM processes
and functions are available across the entire system (i.e. on all stations).

For fur ther details, see Configuring CRM Processes on page 98.

"CRM Processes" in this sense refer to business processes depicted in Aurea CRM.

You can also configure access to CRM processes for individual roles, providing you
with a greater level of granularity, see Login Roles on page 106 and CRM Process
Configuration for Login Roles on page 108.

Note: You can only configure system-wide CRM processes on the main office. By
default, only the administrator (SU) can make any changes.

By default, some CRM processes are locked for all users apart from the administrator
(SU), e.g. "Data Model", "System Lock" etc. You can grant access to these CRM
processes using role-specific configurations, in order to delegate individual admin-
istrative tasks without needing to share the SU password.

The administrator (SU) always has access to all areas in the database and all Aurea
CRM functions, irrespective of the current CRM process configuration.

Configuring CRM Processes
Learn how to configure CRM process.

To configure CRM processes across the entire system:

1. Start the Rights module on the main office, see Starting Modules in the Aurea
CRM win Administrator Guide.

2. Switch to the CRM Process Configuration level using the Info menu or icon bar.
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All CRM processes are displayed in a hierarchy. Use the Lock column to lock (or
grant access to) individual CRM processes, sub-processes and functions.

Information on the individual CRM processes is displayed in Tooltips, see CRM

Process Information on page 101. Click on  (Find) to search for a CRM process
in the tree, see Searching for CRM Processes on page 102. Use the context menu
to determine how information is displayed and edit the CRM process tree,
see Context Menu Entries on page 103.

3. Select either Deny (overridable) or Allow in the Lock column of the root element
("CRM Process Configuration") to define the general behavior of the CRM process
configuration:

• Select Deny (overridable) if you wish to deny access to CRM processes by
default, and only grant access to cer tain CRM processes to various login roles
in a targeted manner.

• Select Allow if all CRM processes should be available to all users by default,
and you only wish to lock cer tain CRM processes for cer tain login roles.
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4. You can configure access to fur ther CRM processes, sub-processes and functions.
Each setting affects the CRM process itself and all child processes. The following
options are available:

• Deny (overridable): Access to the CRM process (and all child processes) is
denied. You can grant access to child processes by selecting Allow in the Lock
cell of the sub-process.

Note: Variable locks can also be overridden in role-specific CRM process
configurations, see CRM Process Configuration for Login Roles on page 108.

• Deny: Access to the CRM process (and all child processes) is denied. The lock
cannot be overridden by sub-processes.

• Allow: Overrides a lock (applied to a parent process) for the selected
sub-process.

• Deny all (overridable): Access to the CRM process (and all child processes)
is denied. You can grant access to child process by selecting Allow in the Lock
cell of the sub-process. This setting is context-independent; if the CRM process
appears in the tree in various places, all instances of the CRM process (identical
CRM process ID) are locked using this option.

• Deny all: This setting is context-independent and locks the CRM process. The
lock cannot be overridden.

Note: The all options apply to all CRM processes with the same ID.

If a CRM process ID contains wildcards (*, ?), the settings are applied to all sub-
processes with matching IDs, see Adding New CRM Processes on page 103.

To change the default setting for an existing core process (Deny vs. Deny over-
ridable): Select the process in the tree, select New from the context menu and
clear the No. field: This disables all fields except the Lock and Overridable Lock
fields, allowing you to set a new default lock.

Locked CRM processes are displayed in gray. The corresponding levels, pages
and functions (menu options and buttons) are not displayed on the user interface.

5. Click on  (OK) to apply the selected settings to the system-wide CRM process
configuration. The CRM process configuration is automatically saved as a
nameless format of the type "CRM Process configuration".

Click on  (Cancel) and answer the prompt with No to exit the CRM Process
Configuration level without saving your changes.

Click on  (Delete) to remove all settings from the Lock column.
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Click on  (Save) to save the process configuration under a name of your choice
(see Saving, Loading and Deleting Formats in the Aurea CRM win User Manual)
in order to use the settings later.

Click on  (Load) to load a previously saved CRM process configuration. The
format name is displayed in the header ("Last used format").

Note:  Settings you have confirmed by clicking on  (OK) are always applied,
irrespective of the formats you have loaded or saved.

CRM Process Information
Learn about CRM process information.

The following information is displayed in Tooltips for the individual CRM processes:

• The name of the CRM process

• The Vertical the CRM process is used by. If no ver tical is specified, the process
is used by all ver ticals ("Base")

• The CRM Process ID, which identifies the CRM process:

• Level ID (e.g. 11001 for the Activity level) in Aurea CRM win. Wildcards (*, ?)
are used for CRM processes that contain several sub-processes (e.g. 1200?
for the "Mailing" process affects the levels Mailing (12001) and Edit Mailing
(12002)), see Level Properties in the Aurea CRM win Administrator Guide.

• CRM Process ID in Aurea CRM web (menu options, direct buttons).

• Button or context menu option IDs in Aurea CRM win (e.g. B_1088 (Function)
for the Tel ./ E-Mail button in the Company+Person level).

• Aurea CRM win menu option ID (e.g. M_78 (Menu Command) for Load List
Format).

• Settings: <win/web> indicates whether the CRM process is used in Aurea CRM
win or one of the web products (Aurea CRM web, CRM.pad) and whether it can
be locked.

• Available from version is only relevant for user-defined CRM processes. You
can enter the version that the CRM process is available from in the corresponding
field in the CRM Process info area (just for info, no functionality), see Adding
New CRM Processes on page 103.

• Root info area: Displays the root info area used by the CRM process.

• Further info areas: Displays fur ther info areas used by the CRM process.

Note:  If all CRM processes that reference a particular info area are locked in
the system-wide CRM process configuration (visible under Root info area and
Further info areas), access is denied to this info area and all child info areas.
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Links to this info area are also no longer displayed. This behavior corresponds
to enabling the Deny Access option in the access rights, see Defining Rights at
the Info Area level on page 140.

Searching for CRM Processes
Learn how to search for CRM processes.

To search for a process in the CRM Process Configuration level:

1. Click on  (Find).

2. Enter a search term in the Text field.

3. Determine whether to search for a CRM Process name or CRM Process ID using
the Search drop-down list.

4. The following search options are available:

• Case sensitive: Enable this option to use a case-sensitive search.

• Wildcards ( * ?  ): Enable this options to use wildcards in the search (* for
multiple characters, ? for a single character).

Note:  Note: You can use literal character values of ‘*‘ and ‘?’ using the escape
sequences ‘\*’ and ‘\?’.

• Hidden Processes: Enable this option to search the contents of process groups
even if the sub-processes are hidden.

• Search Up: Enable this option to change the search direction: The system
searches upwards from the current cursor position.

5. Click on Find to star t the search.

6. Click on Close to exit the search.
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Context Menu Entries
Learn about context menu entries.

The context menu in the CRM Process Configuration level contains the following
options:

• Sort alphabetically: Sorts entries alphabetically within groups. Select this option
again to revert to the original sor t order.

• Show number: Displays the numbers of entries in the CRM process tree. Select
this option again to hide the numbers.

• win/web : Use these options to hide or show all Aurea CRM win or Aurea CRM
web CRM processes.

• Select user group: Use this option to determine the number ranges used when
adding user-defined processes: Update (400-599), Partner (600-799) and
Customer (800-999), see Adding New CRM Processes on page 103. A password
is required to use the update and Partner options.

• New: Select this option to add a new CRM process to the process tree, see Adding
New CRM Processes on page 103.

• Edit: Select this option to edit the selected user-defined CRM process in the CRM
Process info area.

• Delete: Select this option to remove a user-defined CRM process from the process
tree.

• Expand/Collapse all: Select this option to expand or collapse all entries below
the currently selected entry.

• <-/->: Use these options to navigate to the previous/next entry in the tree where
an option has been selected in the Lock cell.

• Transfer to Spreadsheet: Select this option to output information on all CRM
processes as an .xls file.

Adding New CRM Processes
Learn how to add new CRM processes.

You can define additional CRM processes and functions in order to extend Aurea
CRM's functionality and tailor the application to meet your individual needs. In Aurea
CRM win, you need to define new levels and integrate them in a desktop format,
see Desktop in the Aurea CRM win Administrator Guide. In Aurea CRM web, the
CRM processes are defined as menu options and direct buttons, see Aurea CRM
web Administrator Guide. You can also enable or disable triggers and workflows
(that have been assigned in the rights definition) in the process tree by referencing
a format.

You can add these user-defined CRM processes to the CRM process configuration
in order to control access to these processes:

1. Click on the new process's parent in the CRM Process Configuration level.
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Select Select user group from the context menu to determine the number ranges
used by user-defined CRM processes: update (200-599), Partner (600-799) and
Customer (800-999). You require a password for the update and Partner options.
For the update user group, the process tree displays all processes including
those currently without children (displayed in red).

If you do not select a user group, the CRM process number is assigned according
to the current station number, >> Number Ranges in Aurea CRM on page 398.

2. Select New from the context menu.

The CRM Process info area is opened.

3. Enter a name for the CRM process in the CRM Process field. This name is
displayed in the CRM Process Configuration level. This field accesses a variable
catalog, allowing you to enter CRM process names in multiple languages,
see Catalogs on page 270.

4. Select the Format Type ("empty", Trigger, Workflow).

5. Enter the desired ID in the CRM Process ID and/or Web CRM process ID fields:

• The level IDs can be determined in the level settings, or you can output a list
of all available levels and their IDs in a module using the --writeprocesslist
parameter, see Defining New Levels in the Aurea CRM win Administrator Guide
and General Aurea CRM Parameters on page 11.

You can use wildcards (*, ?) to define a CRM process that affects several levels
in Aurea CRM win. You can also enter predecessor levels for such CRM pro-
cesses (using the syntax "Level;Parent1;Parent2" or "Level;Parent1;*") if the
settings should only apply to a par ticular constellation.
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If a CRM process ID contains wildcards, access settings are applied to all sub-
processes with matching IDs. Exception: If the lock is overridden for one of
these sub-processes in a role, the sub-process is accessible, irrespective of
the Priority entered in the role, see Login Roles on page 106.

• Button IDs must be specified using the syntax B_<ID>. Button IDs can be
determined in the mask generator, see Button Properties in the Aurea CRM
win Administrator Guide. User-defined context menu entries cannot be integrated
in the process tree.

• IDs for new Aurea CRM web CRM processes can be freely defined. After
transferring the CRM process configuration to Aurea CRM web, you need to
assign the CRM process ID to the corresponding functions in CRM.designer
(menu options, direct buttons), see Roles & CRM Processes in the Aurea CRM
web Administrator Guide.

Note:  Use the Web CRM Process ID field for CRM processes that should only
be used in Aurea CRM web or that have a different ID in Aurea CRM web and
Aurea CRM win.

• If you have selected a trigger or workflow, select the desired format in the
CRM Process ID field or use wildcards (*, ?) to define a CRM process that
affects several trigger/workflow formats.

6. Select the Root info area used by the CRM process. Select the other info areas
used by the CRM process in the Further  info areas field.

Note:  If all CRM processes that reference a particular info area are locked in
the system-wide CRM process configuration (visible under Root info area and
Further info areas), access is denied to this info area and all child info areas.
Links to this info area are also no longer displayed. This behavior corresponds
to enabling the Deny Access option in the access rights, see Defining Rights at
the Info Area level on page 140.

7. Use the win and web check boxes to determine whether access can be denied
to the CRM process in Aurea CRM win and/or web products (Aurea CRM web,
CRM.pad). Only CRM processes for which the web check box is enabled are
transferred to CRM.designer along with the process configuration.

8. Use the Overridable Lock and Lock check boxes to define the process as either
variable of fix by default in the CRM process configuration, see CRM Process
Configuration on page 98.

9. Click on  (Save).

You are returned to the CRM Process Configuration level.

105AUREA CONFIDENTIAL

Rights Module

https://help.aurea.com/crm/crm-win-admin-guide/crm-win-admin-guide/dita/topics/c_win_adm-4_2_9_3-Button-Properties_crm.html


Select Edit from the context menu to edit the currently selected user-defined CRM
process in the CRM Process info area.

Select Delete from the context menu to remove the currently selected user-defined
CRM processes from the CRM process tree.

Note:  Aurea recommends that new CRM processes are only added on the main
office, see Defining a Station on page 112.

Login Roles
Depending on their current tasks, employees often operate in various roles, e.g. in
some cases as a sales rep, in other situations as a support agent. Some employees
may occasionally undertake administrative tasks in the system.

The Login Role info area allows you to define roles for these various situations.
You can define a separate CRM process configuration for each role, restricting the
CRM processes to only those immediately necessary. This requires a valid system-
wide CRM process configuration, see Configuring CRM Processes on page 98.

You can assign up to 16 roles to Aurea CRM users, and users can select a role
when logging on to the system, see Rep Roles on page 123. Each role can be assigned
different access rights, desktop formats and CRM process configurations.

To define a login role:

1. Switch to the Login Role level in the Rights module (using the Info menu or icon
bar).

2. Click on  (New).

3. Enter a Name for the role. This name must be specified when using the --role
parameter, see General Aurea CRM Parameters on page 11.

4. Enter a name for the login role in the Login role field. This field accesses a
variable catalog, allowing you to enter role names in multiple languages,
see Catalogs on page 270. The login role name is displayed when selecting a role
at logon, see Logging on to Aurea CRM in the Aurea CRM win User Manual.
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Note:  Each catalog value in the Login role catalog can only be used by a single
login role record.

5. Use the Rights Format field to assign an access rights format to the login role,
see Rights on page 136.

6. Use the Desktop Format field to assign a desktop format to the login role,
see Desktop in the Aurea CRM win Administrator Guide.

7. Enter an integer value in the Priority field. The priority determines the order in
which rights, desktop formats and CRM process configurations are applied if a
rep logs on using several roles at once.

8. Enable the Inactive check box to disable a login role without deleting the record.
Inactive login roles are not loaded or displayed for selection when logging in.

9. Use the Read only check box to define a role that only grants read access to the
available CRM processes (i.e. those processes for which Allow is selected in the
Lock field).

For more information on read only roles in Aurea CRM web, see Aurea CRM web
Administrator Guide.

10.Save the record.

11.Select CRM Process configuration (login role) from the context menu to assign
a specific CRM process configuration to the role, see CRM Process Configuration
for Login Roles on page 108.

The login roles defined here must be assigned to the desired reps in the Rep Role
info area, see Rep Roles on page 123.

If a rep logs on to Aurea CRM using one or more roles, the settings in the system-
wide CRM process configuration are combined with the CRM process configuration(s)
assigned to the selected role(s): The system-wide CRM process configuration has
the highest priority, followed by role-specific CRM process configurations according
to the Priority entered in the login role records. Exception: If access is granted to
a CRM process for a role (Allow option), access can only be denied to the CRM
process using the Deny option in a child role (higher Priority). Overridable locks
are ignored in this case.

The access rights and desktop formats assigned to roles are also combined with
the access rights and desktop formats assigned to stations, groups and reps,
see Rights Hierarchy and Extended Desktops in the Aurea CRM win Administrator
Guide.

The roles cache (i.e. the login role records) is refreshed every 60 seconds.

107AUREA CONFIDENTIAL

Rights Module

https://help.aurea.com/crm/crm-win-admin-guide/crm-win-admin-guide/dita/topics/c_win_adm-4_3_7-Extended-Desktops_crm.html


CRM Process Configuration for Login Roles
You can define a CRM process configuration for each login role, which only includes
the CRM processes required by that role.

For example, a rep in the role of a support agent does not require access to market-
ing processes.

To define the CRM process configuration for a login role:

1. Switch to the Login Role level in the Rights module (using the Info menu or icon
bar).

2. Switch to the login role that you wish to define the CRM process configuration
for.

3. Select CRM Process configuration (login role) from the context menu.

The CRM Process configuration (login role) level is displayed. The current
system-wide CRM process configuration's settings are transferred, i.e. CRM
processes that have been locked in the system-wide CRM process configuration
are grayed out.

4. Define the role-specific CRM process configuration as you did the system-wide
CRM process configuration, see CRM Process Configuration on page 98.

Overridable locks defined in the system-wide CRM process configuration (Deny
(overridable) or Deny all (overridable) in the Lock column) can be overridden
in the role-specific CRM configuration using the Allow option. The Deny and
Deny all locks cannot be overridden.If access is granted to a CRM process for a
role, access can only be denied to the CRM process using the Deny option in a
child role (higher Priority).

5. Click on  (OK) to apply the current settings and return to the Login Role level.

Click on  (Cancel) and answer the prompt with No to exit the CRM Process
configuration (login role) level without saving your changes.

Click on  (Delete) to remove all settings from the Lock column (except those
inherited from the system-wide CRM process configuration).

Click on  (Save) to save the CRM process configuration under a name of your
choice (see Saving, Loading and Deleting Formats in the Aurea CRM win User
Manual) in order to use the settings later.

Click on  (Load) to load a previously saved CRM process configuration.
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Languages
You need to define all languages used by Aurea CRM in the Language info area
and assign all stations the necessary languages.

For fur ther details, see Defining Languages on page 109 and Assigning Languages
on page 113.

You can:

• Manage catalogs and texts in formats (field names, messages etc.) in multiple
languages, see Catalog Info Area on page 271 and Text Info Area on page 368.

• "Derive" languages from existing languages (e.g. to depict different variants of
English), see Defining Language Variants on page 110.

• Assign a language to each rep. Aurea CRM is then star ted in this language by
default, see Defining Reps on page 114

Use CRM.translation tool to translate custom texts, see CRM.translation tool on
page 474.

Defining Languages
Learn how to define languages.

To define a language:

1. Switch to the Language info area.

2. Click  (New).

3. Enter a number for the language in the Language No. field. This number uniquely
identifies the language record. If you do not enter a number, a number is assigned
automatically. This number is used to assign languages to reps, groups and
stations, see Assigning Languages on page 113 and Defining Reps on page 114.

Note: This number has no connection with the Aurea CRM's internal language
IDs, see Language IDs on page 389.

Number ranges are available for languages (but not automatically used),
see Number Ranges in Aurea CRM on page 398.
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4. Enter the name of the language in the Lang .( Text) field. This name is displayed
in when entering (multi-language) catalog values and texts.

5. Assign the language to a language in the language catalog using the Lang .(
Cat.) field. This entry is used to determine the catalog language for labels used
in word processor formats with language transformation (see Word Processor in
the Aurea CRM win User Manual) and for multilingual item master texts in the
BTB vertical, see Item Master in the BTB Business Logic Manual.)

6. Assign the language to an Aurea CRM language in the Lang .( Aurea.CRM) field.

Note:  Language numbers can be relevant when determining the login language:
If a user logs on with a language assigned to another Aurea CRM language than
his default language (as defined in the Rep record), the language with the highest
Language No. defined for this Aurea CRM language is used.

7. Enable the Catalog Base Language field to define the language as the catalog
base language (for variable catalogs). The catalog base language forms the basis
for translations of catalog values to other languages, see Catalog Info Area on
page 271.

Note:  Only enable this field for a single language and do not change this setting
once defined. Irrespective of the language number you have assigned to the
catalog base language in this info area, the catalog base language always uses
language number 0 in the Catalog info area.

8. Enable the Catalog Lang. check box if the language should be used as a catalog
language. Catalog values can then be entered and displayed in this language.

Disable the Catalog Lang. check box to use the catalog base language for vari-
able catalogs and the Aurea CRM language for fixed catalogs.

9. Save the record.

Defining Language Variants
You can define language variants, e.g. to depict US and UK English.
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To define language variant:

1. Define the language as described in Defining Languages on page 109.

2. Enter the number of the language that the variant is derived from in the Parent
Language No. field.

3. Save the record.

Defining language variants has the following effects:

• If no translation of variable catalog values or texts is entered for the variant, the
text defined for the parent language is used.

• If no translation is entered in the parent language for variable catalog values, the
value in the catalog base language is used.

• If no translation is entered for a text in the parent language, the
language-independent text is used, see Data Model on page 280 and Text Info
Area on page 368.

Note: Texts and catalog values are searched for in the parent language, the parent
language's parent language and so on. The parent language(s) must be assigned
to the current station. Up to 16 levels can be present in this hierarchy (including the
base language).

Catalog settings (e.g. the Sort Order) inherit values from the parent language or
catalog base language, see Editing Variable Catalogs on page 273.

Station
A station in Aurea CRM is the equivalent of a database.

Each station is assigned a station number, which is used to track the source of data
and coordinate communication between stations. Information such as the station
number, location, position in the communication system and settings for communi-
cation cycles is stored in the Station info area, see Communication in the Aurea
CRM win Administrator Guide.

The Station info area is present in both the Aurea CRM win Rights and Communi-
cation modules, see Station in the Aurea CRM win Administrator Guide.

You can define station-specific system locks, tracking and password settings, and
blocking mechanisms in the Station configuration info area, see Station Configu-
ration on page 233.

You can define locks for each station in the System Lock info area, see System
Locks on page 236.
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Defining a Station
Learn how to define a station.

To define a station:

1. Switch to the Station info area.

2. Click  (New).

3. Enter the number of the station in the Stat.No. field.

Each station is assigned a unique station number, either during installation (in
the Configuration module) or when inputting a data stock download, see Base
Configuration and Data Stock Download in the Aurea CRM win Administrator
Guide. The station number in the station record must be identical to the station
number in the Configuration module.

The station number uniquely identifies the station. It is used to track which data
was added on which station, see Communication in the Aurea CRM win Adminis-
trator Guide.

Note:  Never assign a station the number 0 (zero)!

4. Enter a name used to identify the station in the Stat. Name field; e.g. "London
main office", "Plymouth branch office", "Smith laptop" etc.

5. Use the Main Office check box to identify the central station where all data is
stored and maintained. The data model can only be edited on the main office.
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6. Enable Aut.Cat.Maintenance on the station that should be used to maintain
variable catalogs (in many cases, this is also the main office). This option must
be enabled in order for the Catalog Maintenance info area to be updated,
see Catalogs on page 270.

Note: The Main Office and Aut.Cat.Maintenance flags cannot be changed on
client installations, i.e. without a serial number.

7. Assign Station Access Rights to the station, see Rights on page 136.

The station access rights apply to all users logging on to this station.

8. Assign a Default Telephone Profile to the station, see CRM.phone on page 261.

9. Enter information on the location of the station on the Address tab. The remaining
tabs are described in conjunction with the communication settings, see Station
in the Aurea CRM win Administrator Guide.

10.Save the record.

Assigning Languages
You can assign languages to stations.

You need to assign all available languages to the main station. The languages as-
signed to a station determine the following:

• languages in which catalog values and user-defined texts are displayed

• languages for which fixed catalogs are available

• languages for which new variable catalog values and user-defined texts can be
defined.

To assign a language to a station:

1. Switch to the Station info area.

2. Select Languages from the context menu.

The Station Language info area is displayed.

3. Click  (New).

4. Enter the number of the language you wish to assign to the station in the
Language No. field.

5. Click  (Save).

Alternatively, select Languages from the context menu in the Station info area a
second time while the Station Language info area is open. A dialog box is displayed
listing all languages defined in the Language info area. Enable the check boxes
next to the languages you wish to assign to the station, or enable Select All to select
all the languages.
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Rep
Use the Rep info area to manage and depict your internal company structure
(employees, groups, resources).

You can:

• Define reps, see Defining Reps on page 114

• Configure Aurea CRM logins, see Configuring Logins on page 115

• Assign roles to reps based on their tasks, see Rep Roles on page 123

• Add groups and resources, see Defining Groups on page 125 and Adding Resources
on page 130

• Assign access rights to reps and groups, see Defining Reps on page 114 and
Defining Groups on page 125

Defining Reps
Learn how to define reps.

To define a rep:

1. Open the Rights module and switch to the Rep Info area.

2. Click  (New).

3. A unique ID number is generated in the Rep/Group ID field (composed of the
station number and a serial number). This number is used to link the rep to the
login name and to the specified access rights. The ID cannot be changed.

4. Select "Employee" from the Type drop-down list.
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5. Enter the Name of the rep. The rep's name is displayed in the rep list, see Rep
List in the Aurea CRM win User Manual.

6. Enter the Rights Format you wish to assign to the rep, see Rights on page 136.

7. Select a Desktop Format to assign to the rep. This desktop format is loaded
when Aurea CRM is star ted, see Desktop in the Aurea CRM win Administrator
Guide.

Note:  If desktop formats have also been assigned to the rep's group or station,
the desktop format assigned to the rep takes precedence over the group and
station settings; group settings take precedence over station settings,
see Assigning Desktops in the Aurea CRM win Administrator Guide.

8. Enter the Rights Group that the rep belongs to. The access rights defined for
this group are applied to the rep.

9. Enter the organizational group the rep belongs to in the Org. Group field. Reps
are grouped accordingly in the rep list. Whenever a rep is entered in a record
(e.g. an activity), the Org. Group and Org Group ID are automatically entered
in the corresponding group fields.

The variable condition "Rep's extended group" is applied to the group entered in
this field and groups directly allocated to the group in the Group Allocation area,
see Defining Variable Conditions in the Aurea CRM win User Guide and Assigning
Reps to a Group on page 126.

Note:  Groups are also defined in the Rep info area, see Defining Groups on page
125.

10.If necessary, select the language to be assigned to the rep in the Language field
(select View > All Mask Fields). Aurea CRM is then star ted in this language when
the rep logs on.

11.Enter the ID-TenNo to assign tenant rights to the rep, see Tenants on page 221.

12.Enter fur ther information (for details on the fields, refer to the online field help).

13.Save the record.

14.Define a login for the rep, see Configuring Logins on page 115.

15.You can assign one or more login roles to the rep, see Login Roles on page 106.

Configuring Logins
Learn how to configure logins.

Select Configure Login from the context menu in the Rep info area to link a rep
record to an Aurea CRM login for the current station. Use the Central Login Con-
figuration info area to define logins for other stations, see Central Login Configura-
tion on page 120.
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Note: The Configure Login entry in the context menu is only available for the SU
and for users who have access to the Configuration module (mmcfg.exe),
see Configuration Module in the Aurea CRM win Administrator Guide.

By default, the Configure Login context menu entry is only available for a user's
own rep record (except for the SU), i.e. a user can only create/update/delete his
own login (US) record. (Only the Password (US:38) and Encrypted Password
(US:47) fields can be updated.)

Access to all US records is controlled via the CRM process 1.5.2.2.1.6. "Manage
Logins" (CRM process ID 70000310).

The "Manage Logins" CRM process is disabled by default.

However, access to the Configuration module (mmcfg.exe) needs to be controlled
via module access rights.

To configure the Aurea CRM login for a rep:

1. Switch to the desired record in the Rep info area.

2. Select Configure Login from the context menu.
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3. Enter the Name used to log on to Aurea CRM (login name).

The name is limited to a maximum of eight characters and may not contain spaces
or special characters. You may not use reserved device names (COM2, LTP1
etc.) as login names.

4. Enter a login password for the user in the Password field.

The maximum password length is 128 characters. The password is saved as it is
entered (i.e. case-sensitive).

Passwords entered in the Password field (US:38) are encrypted upon saving the
record. To import an already encrypted password, use the Encrypted Password
field (US:47).
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For more information on password security, see Password Security.

5. Enter the desired password settings, see Password Settings on page 118.

6. Assign the desired module access rights and configure lock and process tracking
settings, see Module Access Rights, System Locks and Process Tracking on page
120.

7. Click Save.

A user directory (and the corresponding sub-directories) is added with the same
name as the user's login name. The user settings are saved in the Login (US)
info area.

8. Click Close to return to the Rep info area.

When deleting a rep record (ID), all linked US records are deleted as well (except
for the SU). The SL and OS (BTB only) tables are deleted as well. The respective
user directory is not deleted.

Password Settings
Learn how to set password in the configuration settings.

You can configure the following password settings in the Configuration module or
the Configure Login dialog box:

• Enter the user's Windows user name and Windows domain in the Domain and
Windows User Name fields to allow the user to log on to Aurea CRM from their
computer without needing to enter their Aurea CRM user name and password
(single sign-on). Users can still log on using their Aurea CRM login when working
on a different machine. If you do not wish users to be able to log on from other
machines, enter an Aurea CRM password that is unknown to the user.

You can specify multiple domains (separated by a semicolon), provided the user
has the same user name in all domains.

• Enter an Alias to prevent users from logging on using their user name (8
characters). Users need to use their alias to log on instead.

The alias can be up to 64 characters long and may not contain any special char-
acters. This option provides added security at login.

Although users cannot log on using their user name, the user name is still used
internally, e.g. as the name of the user directory.

Note: The alias cannot be used in conjunction with single sign-on.

• Enter a value in the Frq. PW Update in days field to determine that the user
must change their password at the interval specified.

• Enable the PW Update next login check box to determine that the user must
change their password the next time they log on to Aurea CRM. This option is
automatically disabled once the password has been changed.
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Note:  If you are entering (initial) passwords for your users, the PW Update next
login check box is deactivated upon saving. Make sure to re-check it, if you want
a user to change the password at the next login.

• Use the Passwords in History field to determine the number of different
passwords stored in the password history. A user cannot reuse a password still
stored in the history (maximum: 10).

• Enable the Ignore PW Settings check box to determine that the settings defined
in the Configuration module and in the Station configuration info area do not
apply to this user, see Station Configuration on page 233.

• Enable Deactivate Password to deactivate the password. The user can then log
on to Aurea CRM without a password, and can enter a new password by enabling
the Change password check box in the expanded login prompt.

Disable the Deactivate Password check box once the password has been
changed.

• Use the Max no. of failed login attempts field to determine the maximum number
of failed login attempts before a user is blocked from logging on by the system.
To use this function, you also need to enable the Max. Blocking check box in
the Station configuration info area, see System Blocking.

• The No. of failed login attempts field stores the number of failed login attempts.
Set the value in the No. of failed login attempts field to "0" (zero), to unblock a
user who has exceeded the maximum number of login attempts.

• Enable the Ignore max. no . of failed login attempts check box to ignore the
value specified in the No. of failed login attempts field. The user is exempted
from the blocking mechanism.

• The Date Open field stores the date and time when a user can use the system
again if they are blocked by the exponential blocking mechanism.

Note: The Frq. PW Update in days and Passwords in History settings are also
available in the Station configuration info area, see Password Security.

The Max no. of failed login attempts can be defined per station in the Station
configuration info area, see System Blocking.

User-specific settings take precedence over station-specific settings.
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Module Access Rights, System Locks and Process Tracking
Learn how to perform settings in configuration module.

You can configure the following settings in the Configuration module or the Con-
figure Login dialog box:

• Enable the check boxes under Module Access Rights to determine which modules
(e.g. Import) and products (e.g. Aurea CRM web) a user can access.

Note:  Be restrictive when assigning module access rights. For security reasons,
users should only be able to access those modules they require to complete their
work.

• Enable the Lock Windows modules and Lock Web modules check boxes to
deny the user access to all Windows modules (see Aurea CRM win Modules in
the Aurea CRM win Administrator Guide) and all other Aurea CRM products.

• If the No multiple access to Windows modules check box is enabled, a user
may only log on to a Aurea CRM win module once at a time. If the check box is
disabled, the user can log on any number of times.

Note:  If No multiple access to Windows modules is enabled for the SU, the
setting is applied to all users.

• Enable the Process tracking check box to activate process tracking for individual
users, see Process Tracking on page 243.

• The Ignore system lock, Ignore system lock date, and Ignore daily system
lock check boxes are used to exempt users (e.g. communication or import users)
from system locks, see System Locks on page 236.

Central Login Configuration
Use the Central Login Configuration (ES) info area to create and manage logins
for all stations.

Logins are included in the data stock download generated when first setting up a
station, see Data Stock Download in the Aurea CRM win Administrator Guide.
Configure the logins for the branch offices on the main office before outputting the
data stock downloads. For more information on communicating logins, see Commu-
nicating System Tables in the Aurea CRM win Administrator Guide

You can:

• either add a separate record for each station that a login is valid for, or use the
login on the current station as a template for all stations, see Configuring Logins
Centrally on page 121.
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Note:  Use templates if users require logins for several stations. This allows
changes to be communicated between the stations, allowing the logins to be
synchronized. If password changes should also be communicated, enable the
Manage password globally check box as well.

• delegate the administration of logins using the Central Login Configuration info
area; in large installation (e.g. involving multiple head offices in various countries),
"local" administrators can manage logins for the stations they are responsible for
without requiring access to the Configuration module or Login info area,
see Configuring Logins without mmcfg.exe Access on page 122.

For details on deleting logins configured centrally, see Deleting Logins on Branch
Offices in the Aurea CRM win Administrator Guide.

Configuring Logins Centrally
Learn how to configure logins centrally.

To configure a login centrally:

1. Select the desired rep in the Rep info area in the Rights module.

2. Select Central Login Configuration from the context menu.

3. Click on  (New).

4. Enter the number of the station that the login applies to in the Stat. No field or
click  (Search) to search for the desired station.

If you wish to define a login that is valid for all stations (e.g. for administrative
users such as COM, WWW, IMP etc.), leave this field empty.

5. If a login has been configured for a user on the current station and you wish to
use this login on all stations, enter the number of the current station in the
Template (Station No.) field. The user's login data (from the Login (US) info
area) is then transferred to the Central Login Configuration (ES) record.
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If you do not want to use templates, you can define individual logins for individual
stations, see Configuring Logins without mmcfg.exe Access on page 122.

6. Enable Manage password globally to manage the password centrally; any
changes to the password in the template login record are communicated to all
other stations that this login is present on. If you do not enable the Manage
password globally option, all changes except the password are communicated.

Note: This function is only available if you are using a template.

7. If you are not using a template, you can configure a login for a specific branch
office:

a. Enter the user's login name in the Name field.

b. Enter fur ther login details (as described in Configuring Logins on page 115)

c. Switch to the Module tab and select the modules the user should be granted
access to.

d. Switch to the Password tab and enter the password settings.

8. Save the record.

Once the login has been communicated, the user can log on to the corresponding
station(s).

Configuring Logins without mmcfg.exe Access
The Central Login Configuration can be used by reps without access to the
Configuration module (and consequently the Login (US) info area) to define and
manage logins.

This allows you to delegate the administration of logins and passwords for individual
user groups to "local" administrators. You can fur ther restrict access to the Central
Login Configuration info area using access rights, if necessary, see Defining Access
Rights on page 138.

To configure logins in the Central Login Configuration info area using a template:

1. Add a central login configuration record for the current station (see above).

2. Enter the number of the current station in the Template (Station No.) field as
well.

3. Enable Manage password globally to manage the password centrally; any
changes to the password in the template login record are communicated to all
other stations that this login is present on. If you do not enable the Manage
password globally option, all changes except the password are communicated.

4. Save the record.

5. Add a central login record for the desired branch office.
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If you wish to define a login that is valid for all stations, leave the Station No.
field empty.

6. Enter the template number (i.e. the current station number) in the Template
(Station No.) field.

7. Enable the Manage password globally option.

8. Save the record.

Once the login has been communicated, the user can log on to the corresponding
station(s).

Rep Roles
Use the Rep role info area to assign up to 16 login roles (including associated
access rights and desktop formats) to reps.

For fur ther details, see Login Roles on page 106.

The login roles only contain the CRM process required for a specific role, see CRM
Process Configuration for Login Roles on page 108.

You can assign the same roles to reps in different departments and with different
job descriptions.

Depending on the role(s) selected by a user when logging on to Aurea CRM:

• Different CRM processes are available

• Different access rights are applied

• The desktop format is configured differently

To assign roles to reps:

1. Switch to the desired rep record.

2. Select Rep role from the context menu.

The Rep Role info area is displayed.

3. Click on  (New).

4. Click on the  (Search) in the Login role field.

5. Search for the desired login role, see Executing the Search in the Aurea CRM
win User Manual.
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6. Click on OK.

The role is transferred to the rep role record.

7. You can determine whether the role is fixed or whether the role can be selected
when logging on to the system:

• Enable the Active check box to determine that the role is permanently assigned
to the rep: When logging on to Aurea CRM, the rep is automatically logged on
in this role.

If you do not enable the Active check box, the user can select the role when
logging on, see Logging on to Aurea CRM in the Aurea CRM win User Manual.

• If you enable the Default check box, the role is enabled by default when
selecting roles at login. The rep can however choose to disable the role.

• If you enable both the Active and Default check boxes, the role is permanently
assigned to the user and is displayed as active when selecting roles. The role
cannot be disabled.

8. Enable the Read only check box to restrict access to the available CRM processes
to read only for the current login role.

9. Save.

If a rep logs on to Aurea CRM using one or more roles, the settings in the system-
wide CRM process configuration are combined with the CRM process configuration(s)
assigned to the selected role(s): The system-wide CRM process configuration has
the highest priority, followed by role-specific CRM process configurations according
to the Priority defined in the login role records.

The access rights and desktop formats assigned to roles are also combined with
the access rights and desktop formats assigned to stations, groups and reps.

You can also assign login roles to organizational groups, see Defining Groups on
page 125. If a rep assigned to this group logs on to Aurea CRM, the group roles are
combined with the rep-specific roles based on the roles' priorities. If the same login
role is assigned to both a rep and the rep's group, the role settings (e.g. Read only)
defined for the rep in the rep role record are applied.

Skills
Use the Skill info area to define a rep's special skills.

You can define any number of skills for a rep (e.g. foreign languages, fields of
specialization, knowledge of products etc.). These skills can be taken into account
when dispatching service tasks, see Customer Service in the Business Logic Manual.

To add a rep's skills:

1. Navigate to the desired record in the Rep info area.

2. Select Skill from the context menu.
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3. Enter the data.

4. Save the record.

You can define conditions in the Configuration info area which determine which
reps are available from the resource view when dispatching service tasks, see Re-
sources on page 56. When allocating tickets to reps, only those reps with the appro-
priate skills are then displayed in the resource view.

Setting a Rep as Inactive
Learn how to set a Rep as inactive.

If a rep leaves the company, you can continue using the rep's data but set the rep
as inactive. This prevents fur ther data from being linked to the rep, while ensuring
that important customer related information is retained. Inactive reps can no longer
log on to Aurea CRM.

To set a rep to inactive:

1. Switch to the desired record in the Rep info area.

2. Enable the Inactive check box.

3. Save the record.

If you set a rep as inactive, the data linked to the rep is still displayed by the system.
However, the rep is no longer displayed in the rep list. Exception: when defining
conditions, inactive reps are also available as a comparison value.

Enter a deputy for the rep, to prevent his tasks and data from being ignored until a
replacement can be found or customers have been allocated to different employees,
see Deputy and Superior on page 127.

Defining Groups
Learn how to define groups.

You can group reps according to their department or duties in the Rep info area.
You can assign desktop formats and access rights to groups, as well as assigning
entire groups to an activity or task. You can also filter and distribute appointments
by group in the calendar, see Managing Appointments in the Aurea CRM win User
Manual.

To define a group:

1. Open the Rights module and switch to the Rep Info area.

2. Click  (New).

3. A unique ID number for the group is generated in the Rep/Group ID field. The ID
cannot be changed.

4. Select "Group" from the Type drop-down list.

125AUREA CONFIDENTIAL

Rights Module

https://help.aurea.com/crm/crm-win-user-manual/crm-win-user-manual/dita/topics/c_win_UsrMan-5-Managing-Appointment_upd.html


5. Enter the Name of the group. This name is displayed in the rep list, see Rep List
in the Aurea CRM win User Manual.

6. Enter the Group Leader (select View > All Mask Fields to access this field)

7. Enter the group's Rights Format, see Rights on page 136.

8. Assign a Desktop Format to the group. This desktop format is loaded whenever
group members log on to Aurea CRM (provided no user desktop format has been
defined), see Desktop in the Aurea CRM win Administrator Guide.

9. Enter a ID-TenNo, if desired, to assign tenant rights to the group, see Tenants
on page 221.

10.Enter fur ther information (for details on the fields, refer to the online field help).

11.Save the record.

Assigning Reps to a Group
Learn how to assign Reps to a group.

You can assign reps to the following groups:

• Rights groups (using the Rights Group field in the Rep info area), see Defining
Reps on page 114.

• Organizational groups (using the Org. Group field in the Rep info area),
see Defining Reps on page 114.

• One or more (temporary) project groups (using the Group Allocation info area).

To assign a rep to a project group:

1. Switch to the desire record in the Rep info area.

2. Select Group Allocation from the context menu.

The Group Allocation info area is displayed.

3. Click  (New).

4. Select the Group you wish to assign the rep to.

5. Enter the time period the rep should be assigned to this group for in the From
and To fields.

6. Save the record.

In the rep list, reps are available from both their organizational groups and all
groups they are currently assigned to in the Group Allocation info area. Reps
can view their own appointments and those of their group members in the calendar
by enabling the Group option in the Appointment Settings, see Managing Ap-
pointments in the Aurea CRM win User Manual.
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Groups can also be allocated to groups in the Group Allocation area (e.g. allocate
"Call Center Agents" and "Service Technicians" to the "Support" group). The "Rep's
extended group" variable condition is applied to the group entered in the Org. Group
field in the Rep info area, and to all that group's immediate sub-groups, see Defining
Variable Conditions in the Aurea CRM win User Guide and Defining Reps on page
114.

Public Reps and Groups
Public reps and groups are visible to all users, even if individual users only have
been granted access to their own group.

To define a rep or group as public:

1. Switch to the desired record in the Rep info area.

2. Enable the Public field (select View > All Mask Fields from the menu).

3. Save the record.

Deputy and Superior
Learn how to assign a deputy or a superior to a rep.

You can enter a deputy for each rep. The deputy can view activities, tasks and To-
Do records belonging to this rep, despite logging on to Aurea CRM with their own
login, >> Managing Appointments in the Aurea CRM win User Manual.

You can also enter a deputy for resources. In this case the deputy is the rep respon-
sible for administrating the resource, see Adding Resources on page 130.

Each rep can also be assigned a superior, see Rep Hierarchy on page 127.

To assign a superior or deputy to a rep:

1. Switch to the desired record in the Rep info area.

2. Click on  (Rep) in the Deputy or Superior field (select View > All Mask Fields
from the menu).

3. Select the desired deputy or superior. Click OK.

4. Save the record.

Rep Hierarchy
The rep hierarchy is displayed as a tree on the left. Each rep's hierarchy code is
displayed on the right. Reps whose hierarchy code does not correspond to their
current superior are displayed in red.

Select Rep hierarchy from the context menu or icon bar in the Rep info area to
open the rep hierarchy.
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If a new rep is added (in the Rep info area), the rep is assigned the next free hier-
archy code:

• When added without a superior: on the top-most level

• When added with a superior: on the level below the superior

Note:  Superiors cannot be defined for groups and resources.

You can move reps within the hierarchy to assign a new superior.

You can add a hierarchy code field to any info area in the data model containing
rep fields (Type "hierarchy code"), see Adding New Fields on page 317.

The following options are available from the context menu in the Rep hierarchy
info area:

• Generate Code: Recalculates the hierarchy code for all reps that are not up to
date. This option is only available if at least one hierarchy code is outdated.

• Count References: Counts the number of records containing the currently selected
rep's hierarchy code.

• Count Incorrect References: Counts the number of records containing incorrect
hierarchy codes (for all reps).
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• Correct References: Updates all incorrect hierarchy codes for all reps in all
records.

• Hierarchy Change: Opens the Hierarchy Change info area, see Hierarchy
Changes on page 129.

Hierarchy Changes
The Hierarchy Change info area logs all changes to the rep hierarchy.

You can also add hierarchy change records manually and then apply the changes
manually or automatically.

Manual Changes

1. Add a new hierarchy change record and select the new superior in the Superior
ID field.

2. Select Apply Hierarchy Changes or Apply all open Hierarchy Changes from
the context menu to carry out the following for the selected record or all open
hierarchy change records:

• Recalculate the rep's hierarchy code

• Recalculate the hierarchy code of all directly and indirectly subordinate reps

• Update the changed hierarchy codes in all records containing the old code

The Error No. field in the hierarchy change record stores any errors that occur
during the process, see General Error Codes on page 508.

Automatic Changes

Hierarchy codes are automatically updated by CRM.server, see CRM.server on page
438.

Applying Conditions to Hierarchy Codes
Learn how to apply conditions to hierarchy codes.

You can apply conditions to hierarchy codes, for example in access rights and se-
lections. When defining a condition applied to a hierarchy code field, you can deter-
mine how two codes are compared with each other.

• Enable the Ignore hierarchy option to carry out the comparison exactly.

Example: The condition "= 4.3.2" is only met by hierarchy code 4.3.2.

• If you leave the Ignore hierarchy option disabled, the condition is met by the
specified hierarchy code and all its children.

Example: The condition "= 1.2" is met by hierarchy codes 1.2, 1.2.1, 1.2.2, 1.2.3
etc. and all subordinate hierarchy codes.

• If you enable the Variable check box and select Report Hierarchy from the
drop-down list, the condition is met by all of the current rep's direct or indirect
superiors.
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Example: The current rep's hierarchy code is "1.3.2.1". The condition is met by
hierarchy codes 1, 1.3 and 1.3.2.

• If you enable the Variable check box and select Superior from the drop-down
list, the condition is met by all of the current rep's superior and all the superior's
subordinates.

Example: The current rep's hierarchy code is "1.3.3". The condition is met by
hierarchy codes 1.3, 1.3.1 and 1.3.2, 1.3.3, 1.3.4 etc. and all "subordinate" hier-
archy codes.

• The condition "=" is met by empty hierarchy code fields.

For information on defining variable conditions, see Defining Variable Conditions
in the Aurea CRM win User Manual.

Adding Resources
You can add resources from the Rep info area, e.g. meeting rooms or equipment
used for events.

Resources can be reserved for appointments, see Adding Reps and Resources to
an Activity/Task in the Aurea CRM win User Manual. Enter a deputy for the resource.
The deputy is responsible for administrating the resource, see Deputy and Superior
on page 127. Activity and To-Do records relating to the booking of this resource are
displayed for this rep.

To add a resource:

1. Switch to the Rep info area.

2. Click  (New).

3. Select "Resource" from the Type drop-down list.

4. Enter the name of the resource into the Name field.

5. Enter the rep you wish to administrate the resource in the Deputy field (select
View > All Mask Fields from the menu).

6. Save the record.

Aurea CRM License
Your Aurea CRM license enables you to use Aurea CRM products.

The serial number is used to identify a server installation, i.e. if you have e.g. a
development, a testing and a productive system, you need three serial numbers. If
you copy an Aurea CRM database to a different server, you need to request a new
serial number: Contact your Aurea representative.

Serial number and license type (Server, Client, Demo) are displayed in the Config-
uration module and in the About box of all Aurea CRM win modules.
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For information on activating a server installation, see Aurea CRM win Installation
Guide.

Maximum number of concurrent users per Aurea CRM win module:

• Server license: unlimited (9999)

• Client license: only one user per module (except Communication: 99 users)

For both server and client licenses the concurrent use of the Configuration and
Rebuild modules is restricted to 1.

To avoid that simultaneously logged in users overwrite each other's data, the
following items (i.e. formats) can only be edited by one user at a time (additional
users have read-only access):

• Maintenance module: Data Model

• Rights module: CRM Process Configuration (global and per role), Rights,
Triggers, Tenant Rights

Each time a format is opened, a check is performed if this format has already
been opened by another user.

Additional information about your installation (used Aurea CRM products, number
of users etc.) is collected by the license report, see License Report on page 131.
You need to submit the license report either by sending it to Aurea or via the licensing
portal https://licenseportal.update.com/.

License Report
As licensor, Aurea has the right to determine the used Aurea CRM products and
languages and the number of users per module/product etc. in regular intervals.

On May 1st and November 1st, the SU is prompted to star t the license report (for
each server installation) upon logging on to an Aurea CRM module (except the Import
and Export modules). The prompt continues to be displayed until the license report
has been submitted.

Note: You can only create the license report on the main office and with the SU
user.

To determine when the next license report is due:

1. Select Help > About  Aurea.CRM from the menu.
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The month the next license report is due is displayed after the version number
("May" or "Nov."); "Nb" is displayed on client installations.

The license report is generated as an XML file. It contains the following information:

• Number of users who were logged on to an Aurea CRM module/product during
the last six months

• Languages used by these users

• Number of stations which have communicated with the server (station with flag
Main Office)

• Industry solution version if applicable

To view the current license information, select Help > About  Aurea.CRM and click
on the License Information link.

To create the license report:

1. Click Yes when prompted to register, or select Edit > License Report from the
menu in the Rights module.

The following options are available:

• Send e-mail: Enable this check box to send the information to email:support@au-
rea.com (instead of uploading it to the license database). This option requires
MS Outlook.

• Delete file: This check box can only be enabled if the Send e-mail check box
is enabled. Enable the Delete file check box to delete the license report file
immediately after sending.

• Anonymize user names: Instead of outputting the user name+ID, USER0,
USER1 etc. is output. The following user names are not anonymized: COM,
MMSERVER, SU and TEST.

2. Click Start to generate the license report.
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The license report file mmsystemlog_YYYYMMDD_HHMM.xml is written to the ..
\system\sys directory.

3. Click on View to open and view the license file.

4. Click License Database to directly upload the license report to the database.

Use the licensing portal (https://licenseportal.update.com/) to manage your licens-
es.

License Report in an SaaS Environment
In an SaaS environment the license report is automatically executed once a month
via CRM.server.

The task and interval are configured via CRM.server's settings.xml file,
see Scheduling CRM.server Jobs.
CRM.server
[...]
<Jobs>
<Job schedule="* * * * * "
type="update.Crm.Server.Jobs.GenerateLicenseReportJob,update.Crm.Server">
<ExportPath>..\LicenseReport</ExportPath>
<EncodeUserNames>false</EncodeUserNames>
</Job>
[...]
</Jobs>
</Server>

The value of <ExportPath> determines the target directory for the license report
files (mmsystemlog_<service_name>_YYYYMMDD_HHMM.xml). You can specify
a relative or absolute path. The path may contain an environment variable. If the
directory does not exist, it is created.

If <ExportPath> is undefined, a .. \LicenseReport directory is created on the
same level as the .. \runtime directory, >> See the ar ticle HOW TO Configure
the u8.server to process To Do jobs on the Aurea support por tal https://support.au-
rea.com.

If <EncodeUserNames> is set to true, the user names are anonymized, i.e. instead of
outputting user name+ID, USER0, USER1 etc. is output. The names of technical
users (WWW, SU, COM etc.) are not anonymized.

The automated license report can be executed by another user than the SU. It has
to be executed on the main office station.

The license report is created for the current month (monitored timespan: 1st day of
current month plus one month).

In the SaaS context all users active in the monitored interval are counted as "active"
(irrespective of whether a user has actually logged on to a Aurea CRM module
during that time). The Billable (ID:6000), Billable from (ID:6002) and Billable to
(ID:6003) fields are taken into account.

Example:
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A license report is created on August, 18th, i.e. the monitored timespan is August
1st to 31st.

• USER1: Both 6002 and 6003 are empty; the user is counted as active.

• USER2: Field 6002 is set to "20130905"; the user is no counted as he is not active
in August.

• USER3: Field 6003 is set to "20130910"; the user is counted as active.

Users with Inactive = true are not counted.

The used modules are counted based on the user's module access rights.

Contents of the License Report
Learn about the contents of license report.

The license report file mmsystemlog_YYYYMMDD_HHMM.xml contains the following
information:

General Information

• Date: Creation date of the license report

• LastLicenseCheck: Date of the last license report creation

• CheckDate: Star t date from which data was collected for the current report

• StationNumber: Current station number

• Version: version number of Aurea CRM win

• Vertical: used ver tical (BTB, OTC, FS)

• Database: used database (mss, ora)

Version Information

• SerialNumber

• SaaS: Yes for Saas serial numbers.

• TemplateName: Name of the package created with CRM.cockpit (TE_ISI_*, TE_LSI_*,
TE_FSI_*)

• TemplateVersion: Version number of the cockpit package format

• Templates/Template: List of all cockpit package formats existing in the current
database (max. 25)

Communication

Lists all stations that have communicated with the main office since the last license
report creation.

• Station/number: station number

• Sent: Number of communication outputs to this station
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• Received: Number of inputs from this station

• Lastcommunicationdate: Date of the last communication to/from this station

User Information

Lists all users that were logged in during the reporting period (except for Saas li-
censes, >>  ). The data is retrieved from the User Tracking info area (T1).

• User/name: Login name (if Anonymize user names/<EncodeUserNames> is enabled,
the names are output as USER1,USER2 etc.)

• User/type: TechnicalUser (WWW, SU, TEST etc.), LightUser, ClientUser

The user types are defined as follows:

• Technical user: WWW, SU, MMSERVER, TEST, COM. If the installation is
based on an Industry Solution and the Billable (ID:6000), Billable from
(ID:6002) and Billable to (ID:6003) fields are available in the rep info area,
users with Billable = false are counted as technical users as well.

For technical users the user names are never anonymized.

• Light user: These user can only create/update company, person and activity
records.

Light users are defined as follows:

1. Assign the login role (R2) "TE_Light_User" (as delivered with the Industry
Solution) to the respective rep record as a rep role (R3), >> Rep Roles on
page 19.

The role must be active, i.e. the Inactive flag (R2:8) must not be checked.

2. The rights format assigned to the "TE_Light_User" login role must be defined
as follows:

- Write access (New/Upd) for company, person and activity records (FI, PE,
KP, CP, MA,TD, MD, ER).

- To allow for correctly using Aurea CRM web write access is also required
for I9, II, Q1, Q2, Q3, Q4, D1, D3, FV, C5.

- Read only access to all other info areas.

• Client user: All other users.

• User/repid: Rep ID of this user.

• User/repname: Rep name of this user (not output if Anonymize user names is
checked).

• User/inactive: true for reps with inactive flag.

• User/deleted: true for deleted users, i.e. US record with DeletCode flag or US
record without ID record.

• User/offline: true for users with a rep record containing entries in the Offline
user (115) and the Offline Station No. (117) fields.

• User/billablefrom: The date entered in Billable from (ID:6002).

• User/billableto: The date entered in Billable to (ID:6003).
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Note: billablefrom and billableto apply to SaaS licenses only.

• Usage/id: number of the module to which the user was logged on.

• Usage/name: name of the module to which the user was logged on.

• Usage/templatelangid: number of the language (as defined in 00) with which the
user last logged on to this module.

• Numberoflogins: number of logins on this station in this module.

• Lastlogin: Date of the last login to this module in this language.

• Station: station to which the user was logged on.

Language Information

List all languages as defined in the Language info area (00), see Defining Languages
on page 109.

• Language: Number of the language (as defined in 00: Language No. field)

• Language/langid: ID of the Aurea CRM language, see Language IDs on page 389

• Language/parent: Number of the parent language, see Defining Language Variants
on page 110. Only the direct parent is output.

• Language/name: Name of the language (as defined in 00: Lang.(Text) field)

Rights
Learn how to define access rights.

It is extremely important for any company to ensure that information on clients, po-
tential clients as well as potential customers and competitors is only accessible to
a restricted group of people and protected against editing or deletion.

Access rights are defined in the Rights info area in the Rights module (see Defining
Access Rights on page 138) and saved as a format (see Formats in the Aurea CRM
win User Manual). Access rights can be used to restrict the data the users can dis-
play, add, edit and delete. Rights can be assigned to stations, groups, reps and
roles in the Station, Rep and Login Role info areas, see Assigning Rights on page
158.

Note: The administrator (SU) is largely excepted from the access right settings:All
catalog entries are visible, irrespective of access rights and tenant rights.Restrictions
on accessing, adding, editing and deleting data at the field and info area levels are
not applied to the SU. Conditional info area and field access rights, mandatory fields
and default values are also not applied to the SU.Conditional field access rights are
also applied to the SU in Aurea CRM web.

136AUREA CONFIDENTIAL

Chapter 3: Using CRM Core

https://help.aurea.com/crm/crm-win-user-manual/crm-win-user-manual/dita/topics/c_win_UsrMan-4_11-Formats_upd.html


Rights in Aurea CRM
Access rights for reps, rep groups and stations must be defined in accordance with
your company structure and communication model.

You need to ensure that the responsibilities for maintaining data are clearly defined
to guarantee that data can be communicated and that new and edited records can
be integrated correctly.

• Module access rights are determined for each user when configuring their login,
see Configuring Logins on page 115.

• CRM Process access rights can be defined in both the system-wide process
CRM configuration and for each login role, see CRM Process Configuration on
page 98.

• Info area and field access rights are defined for stations, groups, reps and login
roles in the Rights info area, see Defining Access Rights on page 138 and Assigning
Rights on page 158. Access rights are cumulative and can be extended either
globally or locally, see Rights Hierarchy.

• You can also split by tenants, see Tenants on page 221.

Rights Hierarchy

Aurea CRM's rights system operates on multiple levels. Access rights are combined
at runtime and are applied in the following order:

• Station access rights apply to all users who log on to the station the access rights
are assigned to, see Defining a Station on page 112.

Note:  For all Aurea CRM products apart from Aurea CRM win, Station rights are
defined in the database of the current station. However, you can also apply the
station rights of another station. Create a file $$AS in the \system\sys directory
e.g. of Aurea CRM web. If this file contains another station number than that of
the current station, the access rights defined for that station apply. This $$AS file
created should be in plain text encoded in ASCII or UTF8 without BOM. It must
not be encoded in UTF8+BOM as this results in errors.

• Group access rights apply to all members of the (rights) group the access rights
are assigned to, see Defining Groups on page 125.

• Rep access rights apply to individual reps, see Defining Reps on page 114.

• If a rep logs on using one or more roles, the access rights assigned to the login
roles are also applied with the priority defined in the login roles, see Login Roles
on page 106.

You can merge two or more rights formats in a single rights format in order to display
or test the combined settings, see Merging Access Rights on page 169.
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By default, the restrictions defined are cumulative and combined using a logical
AND. You cannot remove a restriction defined in station access rights using rep
access rights. To partially or completely override the rights hierarchy, you need to
inherit access rights, see Inheriting Access Rights on page 159.

Rights restrictions are not automatically propagated to child infoareas and elements.
The rights in such cases need to be inherited and configured specifically in the in-
heritance settings. To understand inheritance properties for access rights, see In-
heritance Properties per Element on page 163. To configure access rights, see Inher-
itance Settings on page 161.

Rights and Communication

The access rights defined in the Rights info area are not applied during communi-
cation.

For fur ther details, see Communication in the Aurea CRM win Administrator Guide.

If a user has been granted the privileges necessary to log on to the Communication
module and initiate communication, the rep's access rights are not applied during
communication.

This is necessary in order for new catalog values to be exchanged and for new in-
formation to be added to records the user can read but not edit.

Note:  Aurea recommends adding a user (e. g. "COM") that is used exclusively to
access the Communication module, and to deny access to the Communication
module to all other users, see Module Access Rights, System Locks and Process
Tracking on page 120.

Rights and Import/Export

All restrictions defined for a rep in the rights format also apply during the import or
export of data, see Import/Export in the Aurea CRM win Administrator Guide.

For example, if mandatory fields are defined for a rep, all imported records where
the mandatory field is empty are rejected. Conditional access rights (Condit. Update)
can also affect the import, for example restrictions on editing or adding records.

In contrast, no restrictions are imposed on the administrator when importing and
exporting data. However, triggers defined for the station are still initiated.

When importing, values are only entered in the Upd and Updated at fields if a new
record is added.

Defining Access Rights
Learn how to define access rights.

To define access rights:

1. Start the Rights module, see Star ting Modules in the Aurea CRM win Administrator
Guide.

2. Switch to the Rights info area.

138AUREA CONFIDENTIAL

Chapter 3: Using CRM Core

https://help.aurea.com/crm/crm-win-admin-guide/crm-win-admin-guide/dita/topics/c_win_adm-2_1-ImportExport_crm.html
https://help.aurea.com/crm/crm-win-admin-guide/crm-win-admin-guide/dita/topics/c_win_adm-1_4_1-Starting-Modules_crm.html


3. Select Display info area abbreviations from the context menu to display the
info area IDs in front of the info area names.

Click  (Find) to search for info areas (by name or ID). The search works as
described for the CRM Process search, see Searching for CRM Processes on
page 102.

4. Click in a cell to make your settings.

You can:

• deny access to an info area and prevent records from being added, edited or
deleted, see Defining Rights at the Info Area level on page 140.

• grant access conditionally, see Conditional Access to Info Areas on page 142.

• specify cer tain field contents as default values to be used when adding new
records, see Default Values when Adding Records on page 152.

• Prevent users from accessing, adding, editing and deleting data at the field
level, see Defining Rights at the Field Level on page 153.

• Initiate triggers and workflows based on access rights, see Triggers on page
169 and Workflow on page 156.

• Activate various log functions, see Logging Read and Write Access on page
245 and History on page 258.

• Determine the behavior when deleting records, see Mark as Deleted on page
155.

• Extend access rights globally or locally, see Inheriting Access Rights on page
159.
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5. Select one of the following options to suppress access rights in the current context:

• Enable the Override station rights check box to override the station access
rights; the station access rights are not applied to the rep or group that the
current access rights are assigned to.

• Enable the Override group rights check box to override the group access
rights; the group access rights are not applied to the rep that the current access
rights are assigned to.

• Enable the Override rep rights check box to override the rep access rights;
the rep access rights are not applied to the rep that the current access rights
are assigned to.

Note:  Station, group and rep access rights can only be overridden by the
administrator (SU).

6. Click on the Further Settings check box or select the option from the context
menu to define fur ther settings (e.g. override the desktop), see Defining Further
Settings on page 156.

7. Click  (Save), see Saving, Loading and Deleting Formats in the Aurea CRM win
User Manual.

8. Assign the rights format to a station, group, rep or login role, see Assigning Rights
on page 158.

Note:  Click on  (Load) to load an existing format for editing. Click on  (Delete)
to clear the current settings in the mask.

Defining Rights at the Info Area level
Learn how to define rights at the info area level.

You can deny access to single or all info areas as follows:

• Deny Access: This info area and any child info areas are not visible to the user.

• Deny New: The info area is displayed, but the user is unable to add any records.

• Deny Update: The info area is displayed, but the user is unable to edit existing
records.

• Deny Deletion: The user may not delete records from this info area.

Note:  If access to a par ticular info area has been denied to a user, this info area
is not included in the Search Crit. column in the Selection info area, >> Selections
in the Aurea CRM win User Manual.The rights format denies access to an entire
info area, whereas the desktop format only denies access to specific levels,
see Denying Access to Levels in the Aurea CRM win Administrator Guide.
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Defining Access Rights for Variable Catalogs

Variable catalogs are catalogs that can be edited without requiring the data model
to be edited, see Catalog Info Area on page 271. You can control access to variable
catalogs by defining access rights for the Catalog info area. In distributed systems
(e.g. with various regional headquarters), this allows you to determine that a local
administrator can only change catalog entries in a specific language, for example.
(For information on separating variable catalogs by tenants, see Tenants and Catalog
Maintenance on page 228.)

Rights applied to the Catalog info area have the following effects:

• Deny Access: The Catalog level in the Maintenance module cannot be accessed
by the rep.

Note: To prevent individual catalog fields from being displayed, deny access to
the field itself, see Defining Rights at the Field Level on page 153.

You can lock individual catalog values in the Catalog info area, see Editing
Variable Catalogs on page 273.

• Deny New: Reps cannot add new catalog values.

• Deny Update: Reps cannot edit catalog values.

• Deny Deletion: Reps cannot delete catalog values.

• Condit. Access: Only those catalog values that meet the defined conditions are
displayed. Conditions are only applied to catalog values in the catalog base
language. Consequently, you cannot restrict access to specific languages.

• Condit. New: Reps can only add catalog values that meet the defined conditions.
Otherwise a corresponding message is displayed and the catalog value cannot
be saved.

• Condit. Update: Reps can only edit catalog values that meet the defined
conditions. If the user clicks on a catalog value that does not meet the condition,
a corresponding message is displayed.

• Condit. Delete: Reps can only delete catalog values that meet the defined
conditions. If the user clicks on a catalog value that does not meet the condition,
a corresponding message is displayed.

Note:  Use Condit. New/Update/Delete to restrict access to catalog values by
language.

If you define conditions on the language for Condit. New/Update/Delete, the
conditions evaluate to false if the selected language is the catalog base language.
In this case, Condit. New/Update/Delete is identical to Deny New/Update/Dele-
tion.

• Fields: Use the Fields option to control access to individual variable catalogs,
>> Defining Rights at the Field Level on page 153.
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Access restrictions are applied to the following functions:

• The dialog used to enter/select catalog values in Aurea CRM win, Aurea CRM
web etc.

• Maintaining variable catalogs (Aurea CRM win: Catalog level in the Maintenance
module; Aurea CRM web: Administration > Catalog Maintenance menu option)

• When importing catalog values: Records that cannot be imported due to access
restrictions are written to the log file (*.fal).

Note:  All catalog values are always visible to the administrator (SU).

Special Case: Lead Status Info Area (BTB, FS)

By default, changes to the Lead Status field (in the Company, Person, Person
in Company and Sales Group info areas) are logged in the Lead Status info area.
You can also add, edit and delete data in the Lead Status info area itself.

To deactivate the logging of changes:

• Deny Access: The Lead Status info area is not accessible. The Reason dialog
box is not displayed if the Lead Status is changed. Changes to the Lead status
(in the Company, Person, Person  in Company and Sales Group info areas)
are not logged.

• Deny New: The Lead Status info area is accessible, but no new records can be
added. The Reason dialog box is not displayed if the Lead Status is changed.
Changes to the lead status (in the Company, Person, Person  in Company and
Sales Group info areas) are not logged.

To suppress the Reason dialog box:

• If you wish to suppress the Reason dialog box when adding new records, enable
the Deny New cell for the Reason field in the Lead Status info area (Fields
column).

• To suppress the Reason dialog box completely, enable the Deny Access cell for
the Reason field.

Use the Do not log lead status changes configuration entry (General Settings
category) in the Configuration info area to determine that records should never be
automatically added to the Lead Status info area, see General Settings on page
41.

Conditional Access to Info Areas
Learn how to define the conditional access rights to info areas.

Use the Condit. Access, Condit. New, Condit. Update and Condit. Delete columns
to define access rights for info areas based on conditions.

• Condit. Access: The user can only access those records in this info area that
meet the condition.
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Note: The conditions defined in the rights format determine which records are
displayed at the info area level; use a desktop format to define conditions applied
to levels, see Conditions Tab in the Aurea CRM win Administrator Guide.

• Condit. New: The user can only add new records to this info area that meet the
condition.

• Condit. Update: The user can only edit records in this info area that meet the
condition.

• Condit. Delete: The user can only delete records in this info area that meet the
condition.

Defining Conditional Access Rights

To define conditional access rights (see Defining Access Rights on page 138):

1. Click e.g. in the Condit. Access cell for Company.

The following settings are available:

• Info Area: The info area that the condition applies to, see Conditions Applied
to Other Info Areas on page 145. For information on adding and grouping rows,
see Context Menu Entries.

• Index Relationship: The index used to establish the relationship with the
referenced info area. For details on all available links, see Link IDs on page
394.

Example: If you define a condition applied to the Relationship info area for
the Company info area, you can determine whether the condition applies to
the source or target company:

• With Conditions: Click in this cell to define the conditions under which records
can be displayed, edited, added or deleted, see Conditions in the Aurea CRM
win User Manual.
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• Indirect: Enable this option to apply the rights defined for the corresponding
info area, see Indirect on page 150.

• All: Enable this option to determine that all records in the referenced info area
must meet the condition.

• Person/Both: Use these options to differentiate between company- and
person-dependent records in info areas with an n:1 relationship with a person
record (CP/KP/PE), see Person-related/Both on page 149.

• Description: Enter a textual description that is displayed if a user tries to edit
a record that he can not access. If you do not enter a message, a default
message is displayed.

2. Click in the With Conditions column and define a condition (e.g. "Rep 1 ID =
Current User").

3. Click on  (OK).

4. Save the rights format.

A rep with these rights can only access company records where he is entered as
Rep 1.

Context Menu Entries

The following context menu entries are available when defining conditional access
rights:

• Info Area: Select this option to define conditions that are applied to another info
area, see Conditions Applied to Other Info Areas on page 145.

The number of levels for conditional rights is not restricted, i.e. you can define
conditions for any number of info areas that are linked to each other:

In this example the user can access

• companies with "Rep 1 ID = Current User"

• companies that are related to a company with "Rep 1 ID = Current User" via a
specific kind of relationship, e.g. with "Business Area = Software".

Note: To add an info area as a sub-node, double-click the parent info area.

• Add new AND/OR group: Use these options to group conditions.

You can move rows using drag&drop in order to assign them to other AND or OR
groups.
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• AND <-> OR: Click on an AND or OR node and select this option to switch the
operator.

• Copy line: Copies the current row to the clipboard.

• Paste line(s): Inser ts the contents of the clipboard at the current position.

• Delete line: Deletes the current row.

Note:  If you copy or delete a node, that node's children are also copied or deleted.

Conditions Applied to Other Info Areas
You can define access rights based on conditions defined for other (linked) info
areas.

Depending on the relation between info areas you have the following possibilities:

• Define a condition for one or more linked info areas.

• Define a condition for the Rep Reference info area to restrict access depending
on rep data in related info areas, see Rep-Based Access Rights on page 146.

• Use indirect links (via relationships and item structures), see Conditions Applied
via Indirect Links on page 148.

Conditions For Linked Info Areas
Learn about the conditions for linked info areas.

To define a conditional access right where the condition applies to a linked info
area:

1. In the Condit. Access level select Info Area from the context menu. (This example
extends the definition from above, see Defining Conditional Access Rights.)

2. Select the desired info area from the Select Info Areas window (e.g. Ticket).

3. Click on OK.

A new row is added to the Condit.Access :Company level.

By default, new rows are linked using a logical AND

4. Click on the AND node and select AND <-> OR from the context menu to switch
the operator to OR, see Context Menu Entries.

The rep can access companies where he is entered as Rep 1 plus companies to
which a ticket record is linked via the default link.
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5. Select a different Index Relationship if desired, see Link IDs on page 394.

Example: If you select e.g. link no. 3, only companies entered as Company
Billing Address are taken into account.

The rep can access companies where he is entered as Rep 1 plus companies to
which a ticket record is linked via link no.3.

6. Click in the With Conditions column to define a condition for the info area if
desired:

Example:

The rep can access companies where he is entered as Rep 1 plus companies to
which a ticket record is linked where "Problem Group = Software".

7. Enable the All option if all records in the referenced info area should meet the
condition. In this example, this would mean that all tickets stored for a company
must belong to the same Problem Group.

8. Click on  (OK).

9. Save the rights format.

Rep-Based Access Rights
Use the Rep Reference info area (10) to define conditional access rights based on
rep data in linked info areas.

That way, evaluating the rights definition at runtime involves only one table instead
of checking for a rep being entered in various linked info areas.
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To define a conditional access right using the Rep Reference info area:

1. Configure the creation of rep reference records for the desired info areas (e.g.
for MA and SB), see Depict Rep Reference on page 347.

2. Add the Rep Reference info area to your conditional access rights definition.
(Again this example extends the definition from above, see Defining Conditional
Access Rights.)

3. Define the desired conditions:

The rep can access companies where he is entered as Rep 1 plus companies for
which a rep reference record with that rep exists. (Rep reference records for all
info areas are taken into account.)

4. Click on  (OK).

5. Save the rights format.

Depending on how you configured the creation of rep reference records you may
need to define fur ther conditions, e.g. consider only a sub-set of linked info areas.

Example:

The rep can access companies for which one of the following child record exists:

• an activity record (MA) with the current rep entered as required participant

• a sales group (SB) record containing the current rep.
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To define access rights based on hierarchy codes, you can add a hierarchy code
field to the Rep Reference info area, see Adding New Fields on page 317.

To define rep-based access rights for other independent info areas, add the desired
links to the Rep Reference info area; e.g. add a link to the Campaign (CM) info
area in order to be able to define rep-based access to campaigns.

Conditions Applied via Indirect Links
You can define conditional access rights using indirect links (via relationship records).

For fur ther details, see Link IDs on page 394 and Relationships in the Business
Logic Manual.

Example: A rep can view companies where he is entered as Rep 1. To enable him
to see offers linked to these companies and to companies that are related to "his"
companies (e.g. within a corporate structure) you can use an indirect link.

To define conditional access for the above example (displaying offers depending
on conditions on companies):

1. Click in the Condit. Access cell for Offer.

2. Select Delete line from the context menu to delete the default row ("Offer (1-1)").

3. Select Info Area from the context menu.

4. Select the Company info area and click on OK.

5. Double-click on this newly created row ("Company (N-1)").

6. Select an info area (in this case Company again) and click on OK.

7. Select the desired Index Relationship, e.g. via link no. 32,000. This link reads
the parent record(s) within a corporate structure.

8. Click in the With Conditions cell and define a condition (e.g. "Rep ID = Current
User").

9. Click on  (OK).

10.Save the rights format.
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A rep to whom this rights definition applies, sees the following offers (e.g. in the
Offer search in Aurea CRM web):

• Offers linked to companies that fulfill the condition (i.e. where the current rep is
entered as Rep1).

• Offers linked to companies of which a company fulfilling the condition is a parent
within a corporate structure. For more information and a complete example,
see Corporate Structure in the Business Logic Manual.

Using e.g. link 30,000 instead would return all companies within the corporate
structure, thus allowing the rep to see all offers linked to those companies, link
28,000 would return all companies where the company fulfilling the condition is the
target record in a relationship record, etc.

The same indirect links are used to access item master (AR) records in product hi-
erarchies,see Product Hierarchies in the CRM.core Info Letter SP2.

Person-related/Both
Use the Person and Both options to fur ther differentiate access rights for info areas
that are person-dependent.

For example, reps should only be able to edit Interest records if the rep is entered
in a Sales Group assigned to the corresponding company or person record.

1. Click in the Condit. Update cell for the Interest info area.

2. Select Info Area from the context menu.

3. Select the Sales Group info area and confirm with OK.

4. Click in the With Conditions cell and define the condition "Rep 1 ID = Current
User".

(Since the rep fields in SB are defined as an array, this condition is applied to all
rep fields.)

5. You have the following options for the Person and Both columns:

• Both: Disabled; Person: this setting is irrelevant in this case.

If the rep is entered in a person-related sales group, the rep can edit the cor-
responding person-related interest records.
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If the rep is entered in a company-related sales group, the rep can edit the
corresponding company-related interest records.

• Both: Enabled; Person: disabled

Any sales group (both company and person-related) can edit all interest records
(both company and person-related).

• Both: enabled; Person: enabled

Person-related sales groups: can edit all interest records.

Company-related sales groups: can edit company-related interest records.

Indirect
Use the Indirect option to reference the access rights defined for another info area.

Note:  Use this option (instead of multi-level conditional rights and indirect links as
used in the previous examples) to reference one (complex) definition from multiple
points in your rights definition.

Example: A rep can view persons with "City = Berlin" and persons who have attended
an event that took place in Berlin.

1. Define the following for the Person info area (PE):

The rep can access persons that meet the following conditions:

• Person records with "City = Berlin"

• Person records that are linked to an attendee record to which the access rights
defined for the Attendee info area apply.

2. Define the following for the Attendee info area:
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Make sure you select link no.1 as Index Relationship for the Company node.
This reads companies entered as Hotel.

The rep can access attendee records that meet the following conditions:

• The access rights defined for the Person info area apply to the person entered
as attendee.

• "Hotel: City = Berlin"

3. Save the rights format.

The same example defined with multiple levels (see Context Menu Entries):

Implicit Hierarchy
Learn about the implicit hierarchy.

Access rights are checked hierarchically, e.g. when accessing an activity record,
the system checks whether the rep:

1. Has the appropriate access rights for the parent company

2. the parent person

3. the activity record

This "implicit" hierarchy can be disabled, which improves performance when access-
ing large volumes of data. Access rights need then to be defined for the dependent
info areas.

To disable the implicit hierarchy, e.g. for the Activity info area:

1. Click in the Implicit Hierarchy cell for the Activity info area in the Rights info
area, see Defining Access Rights on page 138.
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The Select Info Areas dialog box is displayed.

2. Disable the check boxes next to the Person in Company, Person and Contact
Person info areas.

3. Click OK.

4. Save the rights definition.

The rep is now granted access (by selecting Data > Both) to all activity records
stored for a company, irrespective of whether he has access rights for the persons
or not.

Note:  Settings in the Implicit Hierarchy column can only be edited by the
Administrator (SU).

Disabling the implicit hierarchy for custom info areas: If a custom child info area
contains an additional link to Company (FI) and Selection (SL), the company link
is treated as mandatory if the link to the parent info area has been overridden via
implicit access rights. To disable this behavior, make sure the Included in Selections
checkbox is disabled in the data model, see Properties on page 299.

Default Values when Adding Records
To prevent errors when inputting data, it is possible to predefine default values.
Default values are automatically entered in the corresponding fields when a new
record is added.

Note:  Defaults defined in the access rights take precedence over the defaults
defined in the Aurea CRM win main module under View > Default Values,
see Defining Default Values in the Aurea CRM win User Manual.

To define default values:

1. Switch to the Rights info area.

2. Click in the Create Default cell of the desired info area.

A list of all fields in the selected info area is displayed.

3. Enter default values in the desired fields.

4. Click  (Save).

Note:  If the default value should be mandatory, you need to enable the Deny New
and Deny Update check boxes for that field in the info area. Otherwise the user
can overwrite the default values, see Defining Rights at the Field Level on page 153.
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Defining Rights at the Field Level
Use the Fields column to define rights at the field level as well as mandatory fields
(i.e. fields where data must be entered in order to save a new record).

To define access rights for fields:

1. Switch to the Rights info area.

2. Click in the Fields cell of the desired info area.

A table containing all fields in the info area is displayed, see Tables in the Aurea
CRM win User Manual:

3. Use the Inheritance cell to determine how access rights are inherited for each
field, see Inheritance Settings on page 161.

4. Define the access rights as for an info area, see Defining Access Rights on page
138.

• Deny Access: The field is not displayed for the user.

• Deny New: The user cannot enter new data in this field.

• Deny Update: The field contents cannot be changed.

• Deny Deletion: The field contents can be edited, but cannot be deleted.

Only the Deny Access option is available for system fields, see System Fields
on page 392.

Note: When inputting communication files, fields to which access is denied on
the source station are not written during input.

5. You can define Mandatory fields to prevent incomplete records from being added
to the database (e.g. the Company, Country and Postal Code fields in the
Company info area). When adding a new record, the system verifies that data
has been entered in these fields. Only if this is the case is the new record added.
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Mandatory fields can be highlighted visually using borders and the "*" or "!"
characters, see Masks Tab in the Aurea CRM win Administrator Guide.

If you enable the Mandatory option for a field, the visual highlighting is only dis-
played in new mode. Field contents can be deleted when editing records at a
later date.

If you enable the options Deny  Deletion and Mand. Field, the visual highlighting
is always displayed (new, edit and view modes). The field contents can subse-
quently be edited but the contents can no longer be deleted.

If you enable the options Deny  Deletion, Mand. Field, Deny New and Deny
Update, the visual highlighting is not displayed (edit and view modes). In edit
mode the field is grayed out. In new mode the visual highlighting is displayed and
the field is grayed out.

6. Enable the Do not log updates field to determine that changes to the field should
not be logged (in the Log - Write info area), see Logging Read and Write Access
on page 245.

7. Click on  (OK) to save the settings and to return to the Rights info area.

Note:  A rep field consists of four interlinked fields (Rep, Rep ID, Rep Group, Resp.
Rep Group ID). If you enable the RepOff option in the Configuration info area,
denying access to one of these fields automatically denies access to all of the fields,
see General Settings on page 41.

Conditional Field Rights
Use the Cond. Fields column in the Rights info area to define conditions for field
access rights.

These access rights are only applied if the record meets the corresponding condition.

The condition is tested before the record is edited. If fields tested by the condition
are edited, the condition is not tested again.

To define conditional field access rights:

1. Click in the Cond. Fields cell of the desired info area.

The Cond. Fields level is displayed:

2. Click in the With Conditions column and define a condition, see Conditions in
the Aurea CRM win User Manual.

3. Click in the Fields column and select the fields.
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4. The following options are available:

• Deny Access: Field values are not displayed. However, users can still enter
values. If you wish to prevent users from entering data, you need to enable the
Deny Update cell as well.

• Deny Update: The field contents cannot be edited.

5. Click in the Description cell to enter a description in all available languages. If
a user clicks into a field to which access is denied, this text is displayed.

6. Click on  (OK) to keep your settings and return to the Rights info area.

Note:  Conditional field access rights are also applied to the SU in Aurea CRM web.
To prevent this, you need to assign an empty rights format to the SU with access
denied to Station Access Rights in the rights format's Further Settings.

Mark as Deleted
By default, records that have not been communicated (i.e. the CmCd field is empty)
are immediately deleted from the database when the record is deleted.

Dependent records are also deleted immediately, provided the station number on
which the record was added (Added on StNo. field) is the same as the current
station number. On the other hand, records that have been communicated are first
marked as deleted (DelCd field) and are only physically deleted once the change
has been communicated to all affected stations, see Communicating Deleted Records
in the Aurea CRM win Administrator Guide.

Use the Mark as Deleted column to change this behavior per info area if cer tain
data should never be physically deleted (e.g. in order to track changes). In this
case, the affected records are not physically deleted, but instead the DelCd field
is enabled and the records are retained in the database.

To change the default behavior when deleting records:

1. Click in the Mark as Deleted column of the desired info area.

The Mark as Deleted level opens.

2. Enable the Mark as deleted cell.

If a record is deleted in the selected info area (e.g. Person in Company) the
DelCd field is enabled in the record.
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3. The following options are available:

• Including parent data: If this option is enabled, settings defined for a child
info area (e.g. Person in Company) are applied to its parent info area (e.g.
Company). If a record in the parent info area is deleted, the record is also
marked as deleted using the DelCd field instead of being physically deleted.

• Including child data: If a parent record is deleted (e.g. a person), all child
records are also marked for deletion (e.g. activities).

• With Conditions: Click in this cell to define conditions that determine when
the record should be marked as deleted, see Conditions in the Aurea CRM win
User Manual. Records that do not meet the condition are deleted immediately.

4. Click on  (OK) to apply the settings and return to the Rights level.

5. This setting overwrites the Do Not Communicate Deleted Records option in the
Delete level in the Maintenance module, see Delete Level on page 383.

Defining Additional Settings per Info Area
Learn how to define additional settings per info area.

Use the Additional Settings per info area column to determine that cer tain info
areas are not displayed when defining queries and filters in Aurea CRM web:

1. Click in the Additional Settings per info area cell of the desired info area.

The Additional Settings per info area window is displayed.

2. Enable the Do not display the info area used to define filters and queries
(web) check box.

3. Click on OK to apply the settings and return to the Rights info area.

For information on defining queries and filters, see Defining Queries and Filters in
the Aurea CRM web Administrator Guide.

Workflow
Use the Workflow column in the Rights info area to assign workflows created using
Aurea CRM's workflow engine to info areas.

Workflows allow you to implement complex processes.

Refer to the Aurea CRM automator User Manual for information on workflows.

If you want to execute triggers and workflows in a par ticular order, enter workflows
in the Trigger level, see Defining Database Events on page 189.

Defining Further Settings
Learn how to perform extra settings.

You can define fur ther settings for existing access rights:
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Note: These settings do not apply to the administrator (SU).

1. Define the rights settings, or click  (Load) to load an existing rights format,
see Defining Access Rights on page 138.

2. Right-click anywhere outside the table. The context menu is displayed. Select
Further Settings... from the context menu.

3. Determine how the distribution of appointments is restricted under Appointment
Distribution Settings, see Rescheduling Appointments in the Aurea CRM win
User Manual. The following options are available:

• Own appointments only: Only the user's own appointments are displayed for
the rep.

• Own group's appointments only: If the rep is a member of a group, only
appointments for members of that group are displayed.

• Subordinate group's appointments: If the rep is assigned to a group as the
group leader, all subordinate reps' appointments are displayed.

• All appointments: All appointments for all reps are displayed.

Note: The settings defined here do not affect how the appointments in the
Calendar or Day Overview are displayed. They apply to appointment distribution
only. If a user clicks on the  (Distribute) button in the daily overview or calendar,
only those reps and groups are displayed that meet the selected criteria are
displayed in the Distribution of Appointments, irrespective of the reps and
groups selected in the Appointment Distribution dialog box.
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4. Use the options under Deny access to deny access to functions by the rep, group,
station or login role:

• Transfer to word processor / Single letter / Transfer to spreadsheet:
Prevents users from transferring data to a word processor or spreadsheet
application.

If you enable only the Transfer to word processor and Transfer to spread-
sheet options, users can create single letters but cannot transfer multiple
records to external applications.

• Mask generator / Desktop: Prevents users from customizing masks and defining
desktops.

• Define levels: Disables the Define Levels button in the desktop settings,
preventing reps with these access rights from defining new levels.

• Triggers in automatic selections: Prevents the use of triggers in automatic
selections.

• Station Access Rights: Station access rights are not applied to the rep or
group.

• Group Access Rights: Group access rights are not applied to the rep.

Note:  Station and group access rights can only be overridden by the administrator
(SU).

5. Click OK.

6. Save.

Assigning Rights
Learn how to assign access rights to a station, group or rep.

After defining the access rights settings, you need to assign them to a station, group
or rep.

To assign access rights to a station:

1. Switch to the Station info area, see Station on page 111.

2. Double-click in the Station Access Rights field.

3. Select the rights format you wish to assign to the station.

4. Click OK.

5. Save the record.

To assign access rights to a rep or group:

1. Switch to the Rep info area, see Rep on page 114.

2. Switch to the desired record.
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3. Double-click in the Rights Format field.

4. Select the access rights format you wish to assign to the rep or group.

5. Enable the Station Access Rights, Group Access Rights and User Access
Rights check boxes. Upon logging onto the database, the system verifies that
the assigned access rights formats are present. If not, the rep is denied access
to the module.

6. Save the record.

To assign access rights to a login role:

1. Switch to the Login Role info area, see Login Roles on page 106.

2. Double-click in the Rights Format field.

3. Select the rights format you wish to assign to the login role.

4. Click OK.

5. Save the record.

Inheriting Access Rights
Learn how access rights can be inherited.

In addition to the general hierarchical concept behind access rights (access rights
for stations, groups, reps and roles), access rights can also be inherited. This allows
you to define access rights that apply to your entire company, and allow local ad-
ministrators to extend or edit the access rights as necessary. In the process, you
can partially or completely override restrictions in the original access rights or extend
the restrictions fur ther.

Access rights assigned to a station, group, rep or role can be extended globally or
locally, see Defining Extensions on page 160. Global extensions are valid for all
stations, groups, reps and roles where the root access rights are entered. Local
extensions only apply to a specific station. In the root format, you can determine
which settings can be changed in the extensions, see Inheritance Settings on page
161.You can also determine which Further settings can be changed in the extensions,
see Inheriting Further Settings on page 166.

Define additional access rights applied to the Format info area, for example to de-
termine that local administrators can view but not edit the parent access rights,
see Conditional Access to Info Areas on page 142.

The various applicable access rights are combined at runtime and applied as follows:
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You can merge one or more access rights format to display or test the combined
settings, see Merging Access Rights on page 169.

Defining Extensions
Learn how to define an extension.

To define a global extension for an existing rights format:

1. Switch to the Rights level in the Rights module.

2. Load the access rights format that you wish to extend.

• Select View: Rights Settings from the context menu to edit the root format’s
settings if necessary, see Defining Access Rights on page 138.

• Select View: Inheritance Settingsfrom the context menu to define the
inheritance settings for the root format, see Inheritance Settings on page 161.
This allows you to determine which settings can be overridden in the extensions.

• Select Further Settings Inheritance from the context menu to define the fur ther
inheritance settings for the root format, see Inheriting Further Settings on page
166. You can determine the fur ther settings to override in the extensions.

3. Enter a name for the extension in the Global Extension field. (The name cannot
be in use by an existing rights format.)

4. Save the access rights. A new rights format with the name of the extension is
added in the process.

5. Select Global Extension from the context menu.

The global extension’s rights settings are displayed.
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6. Define the desired access rights, see Defining Access Rights on page 138 and In-
heritance Settings on page 161.

7. Save the extended rights format.

Select Root Format from the context menu to switch to the parent rights format.

To define a local extension for an existing rights format:

1. Load the access rights format that you wish to extend.

2. Enter a name for the extension in the Local Extension field. (The name cannot
be in use by an existing rights format.)

3. Save the access rights.

4. Select Local Extension from the context menu.

The Search: Station dialog is displayed.

5. Select the station you wish to define or display the extension for. If you do not
select a station, the local extension is added or displayed for the current station.

6. Click on OK.

The local extension’s rights settings are displayed.

7. Define the desired access rights (see above).

8. Save the extended rights format.

The access rights are saved using the name entered in the Local Extension field
and with the station number in brackets.

Select Root Format from the context menu to switch to the parent rights format.

Global extensions are valid for all stations, groups, reps and roles where the root
access rights are entered. Local extensions only apply to a specific station.

Inheritance Settings
The inheritance settings determine how settings in the root format and local/global
extensions are combined.

You can use these settings to par tially or completely override the rights hierarchy,
see Rights Hierarchy.

To define inheritance settings:

1. Load the access rights format that you wish to define the inheritance settings for.

2. You can define inheritance settings at the following levels:

• For the entire rights format: Enable the Inheritance check box (below the
access rights names).

161AUREA CONFIDENTIAL

Rights Module



• For each info area: Right-click on the name of the desired info area in the tree
and select the desired inheritance settings from the pop-up menu.

• For each setting: Right-click on the desired cell or setting and select the desired
inheritance settings from the pop-up menu. Alternatively, select View:
Inheritance Settings from the context menu and click in the desired cell.The
Inheritance properties are then displayed in a dialog.

Inheritance settings on info area-level are indicated by the info area name in blue
(in both Rights Settings and Inheritance Settings views). Inheritance settings
on cell-level are displayed as red check marks (in Inheritance Settings view
only).
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3. The following options are available:

• Link with parent rights using AND: The rights settings are combined with the
settings in the parent access rights using a logical AND (default). This option
can be enabled for all settings where conditions can be applied.

• Link with parent rights using OR: The rights settings are combined with the
settings in the parent access rights using a logical OR.

• Replaces parent rights: Settings replace the settings in all parent access
rights where the option Allow settings in child rights is enabled.

• Link with child rights using AND: The rights settings are combined with the
settings in the child access rights using a logical AND (default). This option
can be enabled for all settings where conditions can be applied.

• Link with child rights using OR: The rights settings are combined with the
settings in the child access rights using a logical OR.

• Replaces child rights: Settings in child rights are ignored. The parent settings
can thus not be overridden.

• Allow settings in child rights: If this option is enabled, settings can be
overridden or changed in child access rights. If this setting is not enabled,
corresponding setting in child access rights are not applied.

Note: The Replaces child rights and Allow settings in child rights options
are mutually exclusive. If you enable both options, the Replaces child rights
option is applied.

Not all inheritance properties are available in all contexts. A list of the inheritance
settings for each setting in the access rights can be found under Inheritance
Properties per Element on page 163.

Inheritance properties are only saved if settings are defined for the affected ele-
ment in the access rights, i.e. if no default values are defined for an area, inheri-
tance properties defined in this cell are not saved.

4. Save the access rights.

The inheritance settings are evaluated hierarchically from bottom to top at runtime:
For example, if default values are defined for a specific info area, the associated
inheritance settings are evaluated. If no suitable settings are present, but inheri-
tance properties have been defined at the info area level, these inheritance
properties are evaluated. If no settings are defined there either, the inheritance
settings defined for the entire rights format are evaluated.

Inheritance Properties per Element
List of available inheritance settings.

The following table lists the available inheritance settings for each element in the
access rights:
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Inheritance PropertiesSetting

Link with parent rights using AND

Link with parent rights using OR

Replaces parent rights

Link with child rights using AND

Link with child rights using OR

Replaces child rights

Allow settings in child rights

Info Area

Link with parent rights using OR

Replaces parent rights

Link with child rights using OR

Replaces child rights

Allow settings in child rights

Deny Access /New /Update /Deletion

Link with parent rights using AND

Link with parent rights using OR

Replaces parent rights

Link with child rights using AND

Link with child rights using OR

Replaces child rights

Allow settings in child rights

Condit. Access /New /Update /Deletion

Link with parent rights using OR

Replaces parent rights

Link with child rights using OR

Replaces child rights

Allow settings in child rights

Implicit Hierarchy
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Inheritance PropertiesSetting

Replaces parent rights

Replaces child rights

Allow settings in child rights

Note: Settings in multiple access rights
formats are always combined using a
logical OR.

Create Default

Link with parent rights using OR

Replaces parent rights

Link with child rights using OR

Replaces child rights

Allow settings in child rights

Note: The same settings also can be de-
fined per field (in the Fields level)

Fields

Replaces parent rights

Replaces child rights

Allow settings in child rights

Cond. Fields

Replaces parent rights

Replaces child rights

Allow settings in child rights

Note: Additional settings are available
for triggers and workflows relating to
processing the stack, >> Further Settings
for Triggers and Workflows.

Triggers/ Workflow

Link with parent rights using AND

Link with parent rights using OR

Replaces parent rights

Link with child rights using AND

Link with child rights using OR

Replaces child rights

Allow settings in child rights

Log – Read/ Write
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Inheritance PropertiesSetting

Link with parent rights using AND

Link with parent rights using OR

Replaces parent rights

Link with child rights using AND

Link with child rights using OR

Replaces child rights

Allow settings in child rights

History

Link with parent rights using AND

Link with parent rights using OR

Replaces parent rights

Link with child rights using AND

Link with child rights using OR

Replaces child rights

Allow settings in child rights

Mark as deleted

Link with parent rights using OR

Replaces parent rights

Link with child rights using OR

Replaces child rights

Allow settings in child rights

Further Settings (general and at the
info area level)

Inheriting Further Settings
The inheritance settings determine how Further settings in the root format and
local/global extensions are combined.

You can use these settings to par tially or completely override the fur ther settings
in the rights hierarchy, see Rights Hierarchy.

To define fur ther settings inheritance:

1. Load the access rights format that you wish to define the fur ther settings
inheritance for.

2. You can define fur ther settings inheritance at the following levels:

• For the entire rights format: Enable the Further Settings Inheritance check
box (below the Further Settings checkbox).
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• For each info area: Right-click on the name of the desired info area in the tree
and select Further Settings from the pop-up menu.

The Further Settings dialog displays.

3. The following options are available:
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Under Appointment Distribution Settings:

• Own appointments only: Only the user's own appointments are displayed for
the rep.

• Own group's appointments only: If the rep is a member of a group, only
appointments for members of that group are displayed.

• Subordinate group's appointments: If the rep is assigned to a group as the
group leader, all subordinate reps' appointments are displayed.

• All appointments: All appointments for all reps are displayed.

Note: The settings defined here do not affect how the appointments in the
Calendar or Day Overview are displayed. They apply to appointment distribution
only. If a user clicks on the  (Distribute) button in the daily overview or calendar,
only those reps and groups are displayed that meet the selected criteria are
displayed in the Distribution of Appointments, irrespective of the reps and
groups selected in the Appointment Distribution dialog box.

Use the options under Deny access to deny access to functions by the rep, group,
station or login role:

• Transfer to word processor / Single letter / Transfer to spreadsheet: Pre-
vents users from transferring data to a word processor or spreadsheet applica-
tion.

If you enable only the Transfer to word processor and Transfer to spread-
sheet options, users can create single letters but cannot transfer multiple
records to external applications.

• Mask generator / Desktop: Prevents users from customizing masks and
defining desktops.

• Define levels: Disables the Define Levels button in the desktop settings,
preventing reps with these access rights from defining new levels.

• Triggers in automatic selections: Prevents the use of triggers in automatic
selections.

• Station Access Rights: Station access rights are not applied to the rep or
group.

• Group Access Rights: Group access rights are not applied to the rep.

Note:  Station and group access rights can only be overridden by the administrator
(SU).

4. Click Ok.

5. Click Save.
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Merging Access Rights
Learn how to merge access rights.

You can merge access rights (e.g. station + rep access rights or station + local ex-
tension etc.), in order to display and test the combined settings. To do so:

1. Load the parent access rights.

2. Select Merge from the context menu.

The Load dialog box opens.

3. Select the (child) rights format that you wish to combine with the current right
format.

All settings in the two rights formats are displayed.

4. Save the access rights under a new name.

You can select Merge again and select fur ther access rights to merge, if neces-
sary.

5. Assign the combined access rights to a station etc. to test the effects of settings.

Triggers
Triggers allow you to configure Aurea CRM to meet your needs without any
programming knowledge.

You can define new functions and processes, carry out calculations with data in the
database and star t external programs.

Triggers are initiated when cer tain events (trigger events) occur in the database.
These events in turn trigger cer tain actions. Both elements are independent, i.e.
you can assign the same action to several events and vice versa.

You can log the execution of triggers by enabling the Log triggers option (Triggers
category) in the Configuration info area, see Triggers on page 67. With Aurea CRM
win logs are created per user and module, see Logs and Error Messages on page
506. For information logging triggers in Aurea CRM web, see https://support.au-
rea.com/wiki/index.php?title=HOWTO_troubleshoot_Trigger_in_Web.
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Trigger Events
Learn about the events that can activate triggers.

The following events can activate triggers:

• Clicking buttons. Buttons can be defined using the Mask Generator and assigned
triggers, see Button Properties in the Aurea CRM win Administrator Guide.

• Selecting context menu entries, defined in the desktop format, see Adding Actions
to the Context Menu in the Aurea CRM win Administrator Guide. Selecting the
entry initiates the associated trigger.

• Clicking buttons in the header, defined in the desktop format. Clicking the button
initiates the associated trigger, see Defining Actions Buttons in the Aurea CRM
win Administrator Guide.

• Via the New button in the general toolbar, defined in the desktop format. Use the
button to initiate triggers with the Add new action, see New - Template in the
Aurea CRM win Administrator Guide.

• Database events (adding, editing or deleting a record): These events are defined
in the Rights module, see Defining Database Events on page 189. You can
determine which triggers are initiated for which users. You can also specify that
triggers are only activated when cer tain fields are updated, or if a record satisfies
a condition before or after it is updated.

• Events in action plans (BTB only) or workflows.

• Generating automatic selections: You can determine that triggers are executed
for the selected companies, persons or properties (BTB only) and child info areas
when generating automatic selections, see Automatic Selections in the Aurea
CRM win User Manual.

For fur ther information on trigger events, see Defining Trigger Events on page 187.

Trigger Actions
Learn about the trigger actions.

The following actions can be carried out by triggers:

• Show: Display a record, see Show on page 194.

• Add new: Add a new record, see Add New on page 196.

• Edit/update: Edit the contents of a record, see Edit/Update on page 197.

• Delete: Delete a record, see Delete on page 200.

• Program Call: Open an external application. You can also transfer parameters,
see External Program Calls on page 201.

• Single/serial letter: Transfers data from Aurea CRM to your word processor in
order to create a letter or mass mailing, see Transferring Data to a Word Processor
on page 204.
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• Default Values: Enter default values when adding a new record, see Default
Values on page 205.

• WEB level: Display a web page in Aurea CRM, see Displaying Web Pages on
page 206.

• E-mail: Create and send an e-mail, see E-Mail on page 208.

• Abort: Cancels saving a record if a condition is (not) met. This allows you to
implement conditional mandatory fields, see Abort on page 211.

• SMS: Create and send a text message, see SMS on page 212.

You can specify whether a trigger should be initiated each time a field is edited, or
only upon saving, and whether the trigger is interactive or runs in the background.
Errors that occur when executing a non-interactive trigger are logged in the System
Event info area, see System Event Info Area on page 508.

You can copy fields from different info areas, e.g. to transfer company data to the
Activity info area.

You can also specify that fields should only be copied when cer tain conditions are
met. You can also prevent data from being entered into cer tain fields and define
error messages to be displayed if the user attempts to enter data in these fields.

As triggers can themselves cause events in the database, you can define conditions
for chains of triggers, see Trigger Chains and Branches.

Defining Triggers
Learn to define triggers.

To define a trigger:

1. Switch to the Triggers info area in the Rights module.
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The mask is divided into two areas:

• The upper section contains a number of options for defining the trigger action.

• The lower section defines which fields are affected by the trigger.

2. Select the target info area in the Info Area field; i.e. the info area that the trigger
is applied to, see Trigger, Target and Reference Info Areas on page 215.

3. Select the action the trigger should executed from the Action field, see Trigger
Actions on page 170.

4. Enable the following settings as necessary:

• Search Condition: Enable this option to determine conditions that need to be
met in order for the trigger to be executed, see Conditions in the Aurea CRM
win User Manual. The trigger is only executed for those records that meet the
condition.

Note: The condition is only tested once the trigger is executed, see Processing
Triggers on the Stack on page 219.

• Plausibility check: Enable this option to execute the trigger each time a field
is changed, rather than once the record is saved, see Plausibility Check on
page 200. The target info area must be the same as the trigger info area (the
info area from which the trigger is initiated).

Note: Triggers for which the Plausibility Check option is enabled are not
processed using the stack, but directly after each field update. These triggers
cannot initiate fur ther triggers, see Processing Triggers on the Stack on page
219.

• Prior to Saving: Enable this option to initiate the trigger after the Save button
is clicked but before the record is actually saved. The target info area must be
the same as the trigger info area. Use this option to enter mandatory fields
using a trigger, for example.

Note: Triggers for which the Prior to Saving option is enabled are not
processed via the stack, but immediately upon choosing to save or delete the
record. These triggers cannot initiate fur ther triggers, see Processing Triggers
on the Stack on page 219.

• Interactive: Interactive triggers are run in the foreground and users can make
changes to fields.
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A mask should be entered in the Mask field for interactive triggers. This mask
is displayed while the trigger is executed. If you do not specify a mask, the
custom mask is displayed.

Note:  Access rights are applied when using interactive triggers, i.e. all
applicable user, group, station and role access rights. These restrictions do
not apply to non-interactive triggers, as these triggers are executed as automatic
functions. This allows non-interactive triggers to write data to fields that the
current user is prevented from accessing. Similarly, records can be added,
edited or deleted using the trigger, even if the current user does not have the
necessary access rights to do so. Errors that occur when executing
non-interactive triggers are logged in the System Event info area, see System
Event Info Area on page 508.

• Abort: Enable this option to display the  (Cancel) button in addition to the

 (Save) button. This allows users to abort the trigger.

• Suppress subsequent triggers: Enable this option to prevent the trigger from
initiating fur ther triggers. This also prevents infinite loops from occurring.
(Example: A trigger logs every change to the database, including the user
making the changes, and tracks the total number of changes. This trigger should
not trigger subsequent triggers.)

• Record prior to change: Enable this option to use the original field contents
in an Edit/update tr igger. The original record contents are used to form keys
and references, see Record Prior to Change.

5. If you require data from associated records when using the Edit/update or Delete
actions, select a Search Index which is used to find linked records. The search
index determines how the relationship from the trigger info area to the target info
area is determined, see Delete on page 200.

6. If you enable the Interactive option, enter a mask in the Mask field, see Mask
Generator in the Aurea CRM win Administrator Guide. Otherwise the custom mask
is displayed.

7. Enter a transfer format in the Format Name field when defining triggers using
the Single/serial letter or E-mail actions, see Defining Transfer Formats in the
Aurea CRM win User Manual.

8. Enter a text in the Accomp. Text field. This text is displayed above the trigger
mask for interactive triggers. The company (and person) for which the trigger is
currently being executed is displayed above this text.

9. Define the desired trigger functions, see Defining Trigger Functions on page 174.
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10.Save the trigger, see Saving, Loading and Deleting Formats in the Aurea CRM
win User Manual.

11.Define the event that should initiate the trigger, see Defining Trigger Events on
page 187.

Note:  Additional index fields are ignored when reading data within a trigger (same
behavior as elsewhere in the business logic), see Index on page 302.

Defining Trigger Functions
You can use triggers to enter values in the database.

You can transfer fixed values, variable values (date, rep) and the contents of other
fields (references). Fur thermore, you can carry out arithmetic and string operations
and determine conditions under which the fields should be updated.

You can process a field several times in one trigger, allowing for intermediate cal-
culations and if-then-else chains.

To define trigger functions:

1. Define a new trigger or load a trigger using  (Load), see Defining Triggers on
page 171.

2. Click on New Line in the Field Name column.

A dialog box is displayed with all available fields. The fields listed are dependent
on the Info Area and Action defined in the upper section of the mask.

Fields which cannot be selected in this column (Z-fields, see Data Types in Aurea
CRM on page 391) can be selected in the Direct Reference column (e.g. the Person
and Company fields in the Activity info area).

3. Select the fields whose contents should be changed by the trigger and click OK.

4. Define the desired changes in the Function, Field Contents, Reference Function,
Variable , Direct Reference or Reference columns.

Note: The columns are applied from right to left: Reference – Direct Reference
– Variable – Field Contents.

• Select an operator in the Function column to perform string or arithmetic
operations, see Functions on page 177. The current field contents are combined
with the contents in the Field Contents, Variable, Direct Reference or
Reference columns using this operator. If you do not select a function, the
current field contents are overwritten by the value you entered in the Field
Contents, Variable, Direct Reference or Reference columns.

• Use the Field Contents column to define fixed content to be written to the field
by the trigger. The system immediately checks whether the value entered is in
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a valid format for the field, see Field Types on page 177. Invalid values cannot
be saved.

Double-click to open the catalog for catalog fields. Double-click to access the
calendar for date fields.

Use variable expressions to enter field contents that are dependent on when
the trigger was initiated or by whom (e.g. $curDay for the current date or $cur-
Superior for the current rep's superior), see Default Variables on page 178 and
User-defined Variables on page 182.

To create line breaks in text fields: Use "\10" for LF, "\13\10" for CRLF. (Use
"\13\10" to automatically enter the Line Break 1-3 fields in company records.)

• Use the Reference Function column to:

- select functions that are applied to a date or time, see Date and Time on page
184.

- enter regular expressions, see Regular Expressions on page 185.

• Use the Variable column to define field contents that depend on the time or
date the trigger is executed or the current user, see Default Variables on page
178 and User-defined Variables on page 182. When creating the trigger, the
system does not test whether the content is in a valid format for the field type.
You need to ensure this yourself.

• Use the Direct Reference column to copy or edit fields in the record processed
by the trigger. When creating the trigger, the system does not check whether
the content is in a valid format for the target field. You need to ensure this
yourself.

Fields which cannot be selected in the Field column can be selected in the
Direct Reference column (e.g. the Person and Company fields in the Activity
info area).

• Use the Reference column to copy data from other info areas. If you click in a
cell in this column, the Field Reference level is opened, see Field References
on page 185.

Once you have defined a reference, a tick is displayed in the cell. You can then
click in the field to edit or delete the reference.

5. Use the With Conditions column to determine that changes to this field are only
applied if the target record meets specific conditions, see Conditions in the Aurea
CRM win User Manual.

Once you have defined a condition, a tick is displayed in the cell. You can then
click in the field to edit or delete the condition.

Note:  If you apply conditions to fields copied using references within the same
trigger, the condition is applied to the record before the reference is copied. For
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example, if you want to copy fields from a company to a person and fill in other
fields in the Person record based on the contents of these fields, this must either
be done using two separate triggers or by executing the trigger twice, i.e. call the
trigger a second time from within the trigger.

6. Use the Message column to enter messages that are displayed when this line is
changing the contents of fields.

Requirements:

• The Plausibility Check option must be enabled.

• The trigger must be initiated via a database action, not a button.

7. Click on New Line in the Field Name column to define fur ther functions.

Note: The lines are executed in the order they are defined.

8. Save the trigger.

Moving, Inserting and Deleting Lines
Learn how to move, inser t and delete lines.

To move a line:

1. Click in the left-most column containing the line numbers, and drag the line to
the desired position. You need to hold down the mouse button for a while before
you can drag the line.

To insert a new line:

1. Add the line to the end and then drag it to the desired position as described above.

To delete a line:

1. Click on the corresponding cell in the Field column.

2. Disable the check box next to the field or parameter in the dialog box.
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Field Types
Learn about the field types.

Values entered in fields must be compatible with the field type, e.g.:

• Numeric fields may not contain letters and have a fixed length.

• Only a limited number of entries are valid for catalogs. You can transfer the
contents from another field to a catalog field if the source field contains a catalog
entry. New catalog values cannot be added using triggers.

You should ensure that the value written to a field is compatible with the field type.
Otherwise the line is ignored.

Functions
Learn about the different types of functional operators.

The following operators are available in the Function column:

• Arithmetic operators (integer and floating point fields only):

• Add: Adds a value to the existing field content.

• Sub: Subtracts a value from the existing field content.

• Mul: Multiplies the existing field content by a specified value.

• Div: Divides the existing field content by a specified value.

• String operators (alphanumeric fields only):

• Remove: Removes a string from the existing field entry. If the string occurs
more than once, all occurrences are deleted.

• Insert: Inser ts a string at the star t of the existing field entry.

• Append: Appends a string to the end of the existing field entry. You can use
multiple trigger lines to append multiple strings to one another.

Calculations using Dates and Times

You can add and subtract fixed values (days) to and from date fields. For example,
to add 7 days to the current contents of the Date field (e.g. in an activity record),
enter the following:

You can add and subtract time values. You can access the current time using the
"Time" option in the Variable column.
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In this example:

1. The current time is added to the star t time (Time field),

2. The duration is calculated (end time - star t time).

Note: The fields used in this example or not included in the default configuration.

Default Variables
Learn about the Aurea CRM includes predefined variables that you can use in
triggers.

There are two ways of using variable field contents in triggers:

• Using the Variable column:

1. Select a field from the Field column, e.g. FreeC1.

2. Select the desired option in the Variable column, e.g. "Group".

Once the trigger is initiated, the name of the current rep's group is output to
the FreeC1 field.

• Using a variable expression in the Field Contents column:

1. Select a field from the Field column, e.g. FreeC2.

2. Select "Var. expression" in the Variable column.

3. Enter the variable expression in the Field Contents column, e.g. "$curTenant".

Once the trigger is initiated, the current tenant number is output to the FreeC2
field.

The following options and variable expressions are available:

ExplanationVar. expression
in the Field

Contents col-
umn

Option in the
Variable col-

umn

Current date$curDayToday's Date

Current week$curWeekStar t of the
week

Current month$curMonthStar t of the
month

Current quarter$curQuarterStar t of the
quarter
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ExplanationVar. expression
in the Field

Contents col-
umn

Option in the
Variable col-

umn

1st Quarter$quarter1-

2nd Quarter$quarter2-

3rd Quarter$quarter3-

4th Quarter$quarter4-

Current year$curYearStar t of the year

Yesterday$prevDay-

Previous week$prevWeek-

Previous month$prevMonth-

Previous quarter$prevQuarter-

1st Quarter of the previous year$pyQuarter1-

2nd Quarter of the previous year$pyQuarter2-

3rd Quarter of the previous year$pyQuarter3-

4th Quarter of the previous year$pyQuarter4-

Previous year$prevYear-

Current time (depending on the field format, ex-
act to the nearest minute, second or millisec-
ond).

-Time

Current time (hh:mm)$curTimeMin-

Current time (hh:mm:ss)$curTimeSec-

Current time (hh:mm:ss:ttt)$curTimeMs-
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ExplanationVar. expression
in the Field

Contents col-
umn

Option in the
Variable col-

umn

Note:  If you append "UTC" to $curTimeMin/Sec/Ms, the time is output in UTC
rather than the local time.

ID of the current rep$curRepRep ID

Name of the current rep-Rep

Login name of the current rep-User

E-mail address of the current rep: E-mail 1 field
or E-mail 2 (if E-mail 1 is empty).

-Current rep's e-
mail address

ID of the current rep's group$curGroup-

IDs of all groups in the rep’s extended group:
the group entered in the Org. Group field and
all groups directly allocated to this group in the
Group Allocation info area.

$curExtGroup-

Name or ID of the current rep's group-Group

Name or ID of the current rep's group leader-Group Leader

Name or ID of the current rep's deputy-Deputy ID

Name or ID of the current rep's superior-Superior ID

Note: The result of the Group, Group Leader, Deputy ID and Superior ID options
is dependent on the type of target field. Names are written to text fields, the person
or group's ID is written to numeric fields.

ID of the current rep's superior$curSuperior-
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ExplanationVar. expression
in the Field

Contents col-
umn

Option in the
Variable col-

umn

IDs of all groups that the current rep is entered
as group leader for

$curLeader-

IDs of all reps for whom the current rep is en-
tered as deputy

$curDeputy-

Current tenant$curTenant-

Current station-Station

FI_StaNo, FI_SerNo and reference of the current
company; alphanumeric

-Company

As for company, but for persons-Person

As for company, but for properties-Property (BTB
only)

Name of the current Windows user$curWinUserWindows User
Name

Windows computer name$curComputerWindows comput-
er name

Includes a link to the trigger record in e-mails,
see E-Mail on page 208.

Using the corresponding entries in the Configu-
ration info area, links to Aurea CRM products
other than Aurea CRM win can also be created,
see Links on page 50.

-Reference as
link

Use the Variable default values for conditions configuration entry (MC) to define
additional fields in the Station, Rep and Rep Addnal Info (OTC only) info areas
that should be available from this list, see General Settings on page 41.

You can also add or subtract time periods from variable date expressions. The fol-
lowing units are available:
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ExplanationFunction

dayd

weekw

monthm

quarterq

yeary

Examples:

ExplanationFunction

Tomorrow in one year$cur-
Day+1y+1d

The last day in January of this year.$curYear+1m-
1d

User-defined Variables
In addition to the default variables available in Aurea CRM, you can define your
own variables.

The following options are available:

Defining additional variable rep and station fields in the Configuration info
area

Use the Variable default values for conditions configuration parameter (General
Settings category) in the Configuration info area (MC) to define additional fields
in the Rep, Station and Rep Additional Info (OTC only) info areas to be available
as variables, see General Settings on page 41.

Defining variables in the Variable info area

You can define variables in the Variable info area, see Variables on page 253.

To write a variable value to a field using a trigger, define the function, and select
"Variable" in the Variable cell. You can enter the variable in the Field Contents
cell using the following options:

• Enter the name of the variable

• Double-click in the cell and select the variable
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• Enter the variable's station number and serial number ("ID = sno,lno")

• Enter the variables record ID ("ID=recid")

Example:

Define default values for the daily rate in expense records for Austria, Italy and
Germany in the Variable info area, and a default value for all other countries.

Define a trigger that uses the daily rate defined for a rep's country as the default
value in new expense records:
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Date and Time
Learn to output information regarding date and time.

To output specific information concerning a given date (weekday, calendar week
etc.) or time:

1. Select a field in the Field cell, e.g. FreeC1.

2. Select a function in the Reference Function field:

• Day (1-31): Day of the month; numeric

• Month: Month; numeric

• Year: Year; numeric

• Quarter (1-4): Quarter; numeric

• Calendar Week: Calendar week; numeric

• Weekday: The day of the week (1 = Monday, ..., 7 = Sunday)

• Weekend: 1 if a Saturday and Sunday, otherwise 0; Boolean

• Holiday: 1 if a holiday (according to the calendar defined under Extras > Other
Options), otherwise 0; Boolean

• Hours (Time): Returns the hours entered in a time field as an integer.

• Minutes (Time): Returns the minutes entered in a time field as an integer.

• Milliseconds (Time): Returns the milliseconds entered in a time field as an
integer.

• Time Period in Days (0-1): Returns the value entered in a time field in days
(decimal value from 0 to 1).

3. Enter the date/time (or select the date/time field) that the function should be
applied to in the Field Contents, Reference or Direct Reference columns.

Example:

Changing the date in an activity (see Database Events on page 189) should enter
the calendar week in a free field. Define the following trigger:
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Regular Expressions
You can use regular expressions to search for par ticular string patterns in fields
and write the results of the search to another field.

To search for a string using a regular expression:

1. Select a field in the Field column.

2. Select a variable, reference or direct reference.

3. Select Regular Expression in the Reference Function field.

4. Enter the regular expression in the Field Contents cell.

For more information on the syntax used by regular expressions, see Regular
Expressions Syntax on page 401.

When executing the trigger line, the system searches for text that matches the
regular expression in the source value. The result is written to the field.

Example:

The following results are written to the free fields when searching in the E-mail 1
field (in this example john.doe@example.com):

• Free C1: The first occurrence of a string consisting purely of letters ("john")

• Free C2: The second occurrence of a string consisting only of letters ("doe")

• Free C3: Any string following the '@' character; line 3 then removes the '@'
character ("example.com")

Field References
References allow you to copy field contents (Field column) from other info areas
(Info Area column).

You can determine that fields are only copied if the trigger is initiated from a specific
info area (Root info area) or define that the source record needs to meet (With
Conditions column).

Each time the trigger is called, the lines are tested in order to see whether the cor-
responding fields can be copied.

If no suitable reference is found, the field contents are deleted. To prevent this from
happening, use the Direct Reference field to re-enter the contents of the field.
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To define field references:

1. Define a new trigger or load a trigger using  (Load), see Defining Triggers on
page 171.

2. Click on the corresponding cell in the Reference column.

The Field Reference info area is displayed.

3. The Root info area column allows you to make triggers react differently depending
on the info area that initiated the trigger.

• If you do not specify an info area, Aurea CRM attempts to copy the field,
irrespective of the info area that initiated the trigger.

• If you enter an info area in the Root info area column, Aurea CRM only attempts
to copy the field if the trigger is initiated from the specified info area.

4. Enable the = Trigger Info Area cell to define the root info area as the trigger info
area. The record that initiated the trigger is then used as a reference,
see Counting Dependent Records.

5. Select the reference info area in the Info Area column (i.e. the info area containing
the field you wish to copy).

Field contents can only be copied if a connection to the data model can be estab-
lished when the trigger is initiated. For fur ther information, see Trigger, Target
and Reference Info Areas on page 215.

6. If you select a root info area, the default index relationship between the root and
reference info areas is displayed in the Index Relationship column. This index
is used to access the reference info area. If multiple indices are available, click
in the cell to select an alternative index.

If you have not selected a root info area, enter the index you wish to use to access
the reference info area here.

7. Click in the With Conditions column to determine conditions for the reference
info area, >> Conditions in the Aurea CRM win User Manual. The reference field
is only copied if the condition is met.

If several records meet the condition, the field contents are copied from the first
record that meets the criteria. If no suitable record is found, Aurea CRM moves
on to the next line of the trigger.

If none of the fields in any of the lines could be read, Aurea CRM attempts to
enter data in the field using the Direct Reference, Variable and Field Contents
columns. If these columns are blank or copying is not allowed, the field contents
are deleted, except for alphanumeric fields.
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If you want to overwrite a field with references under cer tain conditions, you need
to enter the field in the Direct Reference column.

8. Select the field from the reference info area to be copied in the Field Name
column.

9. If you wish to apply fur ther calculations to the value in this field, select one of
the following options from the Function column:

• Number of records: Returns the number of referenced records.

• Sum: Returns the sum of the values in the field in all referenced records (only
makes sense for numeric fields).

• Average: Returns the average field value in all referenced records (only makes
sense for numeric fields).

• Minimum: Returns the minimum field value in all referenced records (only
makes sense for numeric fields).

• Maximum: Returns the maximum field value in all referenced records (only
makes sense for numeric fields).

• All: The field values in all referenced records are copied (only makes sense
for text fields). In addition, you need to select the Append option from the
Function field in the Trigger info area.

10.Enable the Optional cell to use the first valid reference (i.e. the root info area is
correct and at least one record is found that meets the condition).

If you leave the Optional cell disabled, all references are used.

11.Click on  (OK) to save the field reference.

You are returned to the Trigger info area.

Defining Trigger Events
Learn how to define trigger events.

In order for a trigger to be executed, you need to define an event that initiates the
trigger, see Trigger Events on page 170.

Trigger Buttons
Triggers can be initiated using buttons.

You can trigger multiple triggers one after another using a single button and can
add any number of trigger buttons to masks, see Adding Elementsand Button
Properties. Adding Elements and Button Properties in the Aurea CRM win Adminis-
trator Guide.

Note: Trigger buttons only work in the Aurea CRM main module.
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Trigger Buttons in Masks with Several Info Areas

Some masks contain information from several info areas (e.g. the Company+Person
levelor the Opportunity Overview level in the BTB version).

Trigger buttons added to such masks treat the child info area (e.g. Person in
Company or Opportunity) as the trigger info area.

For example, if you add an activity using a trigger button in the Company+Person
level, the activity is added for the person.

If you want to add an activity record for a company, you have the following options:

• Hide the Person in Company info area (View > Mask Area).

• Create a dummy trigger. Clicking on the button initiates the dummy trigger, which
applies a change to the Company info area; e.g. entering the time in a free field.
The "real" trigger then responds to this change and adds the activity (for the
company, as the second trigger was initiated by a change in the Company info
area).

"Conditional" Trigger Buttons

You cannot define conditions that are directly applied to the trigger info area if the
trigger is initiated by a button. In order to do so, you have the following options:

• If you define a trigger using the Edit/update option where the trigger and target
info areas are identical, you can use the Search Condition option, see Defining
Triggers on page 171.

• In all other cases, you can achieve the desired effect using a dummy trigger: The
dummy trigger makes a change to a field; e.g. the time is entered in a free field.
The "real" trigger reacts to this change: if this free field is updated and the record
meets the condition, the trigger is executed.

Context Menu Entries
Triggers can be initiated by entries in the context menu.

You can add any number of entries to the context menu that initiate triggers, deter-
mine in which view and which mode (list view, edit mode etc.) and under which
conditions the entry is displayed, see Adding Actions to the Context Menu in the
Aurea CRM win Administrator Guide.

Buttons in the Level Header
Triggers can be initiated using buttons in the header.

You can define any number of trigger buttons in the header, assign icons and deter-
mine which modes the buttons are available in, see Defining Actions Buttons in the
Aurea CRM win Administrator Guide.

New Button in the General Toolbar
Learn how to add new button in general toolbar.

Triggers whose action is set to Add new can be initiated using the New button in
the general toolbar, see New - Template in the Aurea CRM win Administrator Guide.
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Database Events
Use the Rights level to determine that triggers are initiated when cer tain events
occur in the database.

You can also star t triggers from automatic selections or the Workflow Designer (BTB
only).

The following events can initiate triggers:

• Manual changes by the user

• Merging companies or persons (see Merging Companies and Merging Persons in
the Aurea CRM win User Manual):

• Deleting the source company or person

• Updating the target company or person when merging

Note: When merging companies or persons, no triggers are initiated in dependent
info areas if they are just "re-linked" but not changed otherwise.

• Changes made by workflows

• Changes made by triggers

• Aurea CRM functions

• Importing data

• Data maintenance in the Maintenance module

Note: Triggers cannot be initiated during communication or when making changes
using CRM.cockpit.

Defining Database Events
Use the Rights info area to define which database events initiate which triggers (or
workflows).

These triggers or workflows apply to all users (including the administrator) assigned
these access rights as either their station, group, user or login role access rights.

When a database action initiates a trigger, the triggers is added to the trigger stack,
which stores all tr iggers yet to be executed (see Processing Triggers on the Stack
on page 219). Triggers are added to the stack in the order they are entered in the
list. (Workflows entered in the Trigger info area (see below) are also added to the
stack.) The order in which you enter triggers can therefore be important, see Inserting
Database Events on page 193.

To define a database event as a trigger event:

1. Switch to the Rights info area in the Rights module.

2. Click in the Triggers cell of the desired trigger info area.
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The Trigger info area is displayed for the selected info area.

3. Double-click on New Line to add a new trigger. Alternatively, click in the Workflow
column in the new line to add a new workflow. The Load dialog box opens.

4. Select a trigger or workflow.

5. Click on OK.

6. Click in the Index Relationship column to display the default index relationship
between the trigger and target info areas, see Trigger and Target Info Areas when
Updating, Displaying or Deleting Records on page 217. This index is used to access
the target info area. If multiple indices are available, enable the check box next
to the desired index to use it. The new index relationship is then displayed in the
Index Relationship column.

7. Click in the With Conditions cell to define a condition. The trigger is only executed
if this condition is met, see Conditions in the Aurea CRM win User Manual.

The condition is tested as soon as the trigger is initiated, and not only once the
trigger is processed on the stack, see Processing Triggers on the Stack on page
219.

8. Enable the New cell to initiate the trigger when a new record is added. The trigger
is executed once the new record is saved. If a condition is defined in the With
Conditions cell, the condition is tested before the trigger is executed.

If the Plausibility Check option is enabled in the trigger, the trigger is initiated
immediately after the record is added (i.e. before saving).

9. Enable the Upd cell to initiate the trigger when an existing record is updated. The
trigger is executed once the record is saved.

If the Plausibility Check option is enabled in the trigger, the trigger is initiated
immediately once data is entered (i.e. before saving).

Note:  Changes are only present if the record has changed since the last time it
was saved.If the Plausibility Check option is enabled in a trigger, the trigger is
initiated whenever records are edited and added, irrespective of which options
are enabled (New, Upd). To determine that the trigger should only be executed
for new records, for example, define the condition New = "<empty>" in the With
Conditions field. Conversely, if the record is being updated, the New field contains
data.

10.Enable the Del cell to initiate the trigger when a record is deleted. If a condition
is defined in the With Conditions cell, the condition is tested before the trigger
is executed.
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Note: Triggers are only initiated after a record is deleted and therefore cannot
access information stored in the record's child records (as these records no longer
exist).

11.If you have enabled the Upd column, you can define conditions in the Old
Condition column that are applied to the record before the trigger is executed.
This condition does not affect the New or Del cells.

12.If you enable the Upd, Old Condition and With Conditions cells, the trigger is
only executed if the record was changed from the status defined under Old
Condition to the status defined under With Conditions.

Example: A trigger should be used to send an e-mail if the Status of an activity
record is changed from "Scheduled" (Old Condition) to "Completed" (With Con-
ditions).

13.If the Upd cell is enabled, you can use the Upd Fields column to determine that
the trigger is only initiated after cer tain fields are updated.

Click in the Upd Fields cell to open the Trigger Fields info area which displays
all fields in the info area.

• All the fields with a tick in only the Trigger cell (and not the Optional cell)
must be changed before the trigger is initiated.

• At least one of the fields with a tick in the Optional column must be changed
before the trigger is initiated.

In the above example, the trigger is only initiated once changes are made to the
Date field and at least one of either the Activity or Status fields (or both).

This condition does not affect the New and Del columns.

14.Click in the Properties cell to define inheritance settings for the trigger or workflow
and determine how the workflow/trigger is handled by the stack, see Further
Settings for Triggers and Workflows on page 192.

15.Click on  (OK) to return to the Triggers mask.

16.Click on  (OK) to return to the Rights info area.

17.Save the access rights.

Triggers and workflows are executed in the order they are entered, see Inserting
Database Events on page 193.
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Further Settings for Triggers and Workflows
Learn about the additional settings for triggers and workflows.

You can define the following additional options for triggers and workflows by clicking
in the Properties cell (from either the Trigger or Workflow level, accessed from
the cell with the same name in the Rights level, see Defining Database Events on
page 189 and Workflow on page 156).

• Replaces parent rights: The trigger/workflow is not executed in the parent access
rights. For this setting to work, the Apply in child rights (if present) or Transfer
the settings from the child rights option must be enabled in the parent access
rights.

• Do not apply: The trigger/workflow is not executed. For this setting to work, you
need to explicitly define the events for which the trigger should not be executed.
In addition, the Transfer the settings from the child rights option must be
enabled in the parent access rights. Use this option in combination with the
Replaces parent rights option to deactivate triggers that would be executed by
parent rights.

Note: To completely deactivate a trigger in the child right, no Upd Fields must
be defined in the child right. If Upd Fields are defined, the trigger is not executed
for the Upd Fields of the child right, however it is executed for the Upd Fields
defined in the parent right.

• Apply in child rights (if present): If the trigger/workflow is also entered in child
access rights, the trigger/workflow is only initiated from the child access rights.

• Transfer the settings from the child rights: The workflow/trigger is executed
according to the settings in the child access rights. This means that settings may
be defined/edited for the trigger/workflow in the child rights.

• Execute follow-up triggers recursively: Follow-up triggers or workflows are
executed recursively (i.e. not added to the stack). This setting corresponds to the
default behavior in Aurea CRM win. The recursion depth can be defined using
the Log triggers configuration entry, see Recursion Depth.

• Execute follow-up triggers non-recursively: Follow-up triggers are added to
the stack. This setting corresponds to the default behavior in Aurea CRM web.

Note: The Execute follow-up triggers recursively and Execute follow-up triggers
non-recursively options are only available in the Trigger column, but can be enabled
for workflows from there. The Execute follow-up triggers recursively and Execute
follow-up triggers non-recursively options are only applied when the
trigger/workflow is actually executed.
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Inserting Database Events
Learn how to inser t database events.

To insert a trigger:

1. Switch to the Rights info area.

2. Click in the Triggers cell of the desired trigger info area.

The Triggers info area is displayed for the selected info area.

3. Double-click on the name of the trigger you wish to inser t the new trigger in front
of.

The Load dialog box opens.

4. Select the desired trigger.

5. Click OK.

The dialog box is displayed:

• Answer the prompt with Yes to inser t a line containing the selected trigger.

• Click on No to overwrite the current line.

6. Click on  (OK) to return to the Rights info area.

7. Save the access rights.

To enter a workflow:

1. Switch to the Rights info area.

2. Click in the Triggers cell of the desired info area.

The Triggers info area is displayed for the selected info area.

3. Click in the Workflow cell of the row that the workflow should be entered in.

The Load dialog box opens.

4. Select the desired workflow.

5. Click OK.

The dialog box is displayed:

• Answer the prompt with Yes to inser t a line containing the selected workflow.

• Click on No to overwrite the current line.

6. Click on  (OK) to return to the Rights info area.

7. Save the access rights.
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To subsequently change the order of lines:

1. Click in the left-most column containing the line numbers, and drag the line to
the desired position. You need to hold down the mouse button for a while before
you can drag the line.

Deleting Database Events
Learn how to delete database events.

To delete a trigger/workflow:

1. Switch to the Rights info area.

2. Click in the Triggers cell of the desired info area.

The Triggers info area is displayed for the selected info area.

3. Click on the trigger/workflow you wish to delete.

4. Delete the name of the trigger/workflow using the keyboard.

5. Click in another line.

The trigger/workflow is deleted.

6. Click on  (OK) to return to the Rights info area.

7. Save the access rights.

To delete all tr iggers/workflows:

1. Switch to the Rights info area.

2. Click in the Triggers cell of the desired info area.

3. The Triggers info area is displayed for the selected info area.

4. Click on  (Delete).

5. Click on  (OK) to return to the Rights info area.

6. Save the access rights.

Trigger Examples
You can find some examples for trigger in this topic.

Below are some of the examples for trigger:

Show
The 'show' trigger.

Displaying Messages for Field Updates

If a person is not assigned to a department, a message should be displayed when-
ever a field is edited.

1. Define the following trigger:
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2. Define the following conditions for line 0:

3. Define the following conditions for line 1:

As long as no department has been entered, the values "1" and "2" are entered
alternatively in the FreeN1 field.

4. Save the trigger.

5. Switch to the Rights info area.

6. Click in the Triggers cell for the Person in Company info area.

7. Define the following database event:

8. Save the access rights and assign it (to a station).

Each time a person record is edited where the Department field is empty, the value
in the FreeN1 field is updated and the message is displayed.

Note: This example is intended for Aurea CRM win only.
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Add New
Learn how to add new activity.

An activity should be added interactively. The rep should be taken from the Compa-
ny, Person in Company or Activity info area depending on availability (this example
uses the FS version).

1. Define the following trigger:

2. Define the following references:

3. Save the trigger.

4. Define trigger buttons in the Company+Person and Activity levels used to initiate
the trigger, see Trigger Buttons on page 187.

The first valid reference found is used (Optional column):

• If the trigger is initiated from an activity record, the rep associated with that activity
is transferred (provided one has been entered). The trigger then attempts to
transfer the Account Manager 1 entered for the person, and then the Rep entered
for the company. If these fields are also empty, the current rep is copied (Variable
column).

• If the trigger is initiated from a person, the system first attempts to transfer the
Account Manager 1 entered for the person and then the Rep in the company. If
these fields are also empty, the current rep is copied (Variable column).
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Default Values for New Records

If you add a new record using a trigger, the following applies:

• Default values do not apply to non-interactive triggers.

Fields that are normally entered automatically by Aurea CRM (e.g. rep, current
date and time in activities) are not entered by non-interactive triggers. Key fields,
such as the company group and number are automatically entered by all non-in-
teractive triggers. Fields which are calculated automatically (e.g. activity costs)
are entered.

• All default values apply to interactive triggers:

• those configured by the user

• those defined in the access rights

• all fixed default values such as Date and Rep in the activities

• Default values are overwritten by field updates defined in the trigger.

You can define situation-dependent default values. For example, you can use refer-
ences to determine that the rep entered in the Rep field in the Person in Company
info area is entered in the Activity info area. If no rep is entered for the person,
the rep entered in the Rep 1 field in the Company info area is used instead. You
can also define variable default values, such as "current rep" or "in 7 days",
>> Defining Trigger Functions on page 174.

Edit/Update
Example for editing and updating trigger.

Calculations using a Trigger

A trigger calculates the sum of the FreeN1 and FreeN2 fields in the Company info
area, multiplies the result by the factor entered in the Free% 1 field (e.g. 50%) and
writes the result to the FreeN3 field.

1. Define the following trigger:

2. Save the trigger.

3. Switch to the Rights info area.

4. Click in the Triggers cell for the Company info area.

5. Define the following database event:
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The trigger is executed whenever the FreeN1 and FreeN2 fields are changed
(Upd Fields cell), provided the Free%1 field is not empty (With Conditions cell).

6. Save the access rights and assign it (to a station).

The lines in the trigger are processed from right to left and top to bottom:

Value stored in FreeN3

500FreeN1After first line

700FreeN1+FreeN2After second line

35000(FreeN1+FreeN2)*Free%1After third line

350(FreeN1+FreeN2)*Free%1/100After four th line

Counting Dependent Records

The number of activities stored for a company should be entered in a free field in
the company record. Each time a change is applied to the Activity info area, the
number should be recalculated.

1. Define the following trigger:

2. Define the following reference:

Only those records are counted that are dependent on the current record (Root
info area column).

3. Save the trigger.

4. Switch to the Rights info area.

5. Click in the Triggers cell for the Activity info area.
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6. Define the following database event:

7. Save the access rights and assign it (to a station).

Each time a activity is edited, deleted or added, the number of records stored for
the parent company is written to the FreeN1 field in the company record.

Record Prior to Change

Upon changing the value of an offer, a trigger should write the old Offer Value and
the date of the change (Upd field) to two free fields in the corresponding company
record.

1. Define the trigger as follows:

2. Define the references:

3. Save the triggers.

4. Switch to the Rights info area.

5. Click in the Trigger cell of the Offer info area.

6. Define the database event:

7. Save the access rights and assign it (to a station).

Each time that the Offer Value is changed in an offer, the old value and the date
of the change are written to the appropriate free fields.
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Plausibility Check
When a new activity is created or an existing one is updated, the system should
check whether the status ("Scheduled", "Completed" or "Missed") is consistent with
the date.

Activities in the future are set to "Scheduled", activities in the past are changed
from "Scheduled" to "Missed" and corresponding messages are displayed.

1. Define the following trigger:

2. Enable the Plausibility Check option.

3. Define the following condition for the first line: Date = Today's Date

4. Define the following condition for the second line: Status = Scheduled AND Date
<= Today's Date.

5. Save the trigger.

6. Switch to the Rights info area.

7. Click in the Triggers cell for the Activities info area.

8. Define the following database event:

9. Save the access rights and assign them (to a station).

Each time an activity is added or edited, the Status is checked against the current
date. Activities in the future have their status set to "Scheduled". Activities in the
past not set to "Completed" have their status set to "Missed".

Delete
Triggers using the Delete action are used to delete dependent records once the
parent record has been deleted.

In this example, deleting an activity should delete all follow-up activities as well.

1. Define the trigger and select a suitable Search Index:
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2. Save the trigger.

3. Switch to the Rights info area.

4. Click in the Trigger cell for the Activities info area.

5. Define the following database event:

6. Save the access rights and assign them (to a station).

Each time an activity is deleted, all follow-up activities linked to the activity via the
MA_1_StaNo and MA_1_SerNo fields are deleted.

External Program Calls
You can use triggers to star t external applications. Fixed values or data from the
database can be transferred as parameters.

To use a trigger to star t an application:

1. Define the following trigger:
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2. Enter a text in the Accomp. Text field. This text is displayed while the application
is star ting.

3. Click on New Line in the Field column. A dialog box is displayed.

4. Select the Program Name entry.

5. Click OK.

6. Enter the name of the program you wish to call in the Field Contents field or
using a reference to a field in the database, >> Field References on page 185. If
you do not specify a path, Aurea CRM win first searches the .. \system\db
directory and then the .. \system\exe directory for the application. If the
program is located in a different directory, you must either enter the complete
path or the path relative to the .. \system\db or .. \system\exe directories.

Note: The path name must be specified, even if the path is entered in your
Windows environment variables.

If the trigger is initiated in another module or another Aurea CRM application (e.g.
Aurea CRM web), the program is searched for in the .. \system directory first.
If the program is located in a different directory, you must either enter the complete
path or the path relative to the .. \system directory.

7. You can enter additional parameters in other lines by entering Parameter( #) in
the Field Name cell. These parameters can likewise be assigned fixed values
(Field Contents cell), referenced from the database or be situation-dependent
(Variable column), see Defining Trigger Functions on page 174.

Note: Special case: If you wish to transfer the FI-SerNo field from the Company
info area and the Last Name field from the Person info area, for example, you
additionally need to have selected the Person info area in the Info Area cell when
defining the trigger. Otherwise, initiating the trigger always passes the first person
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in the current company, not the person currently displayed on screen. This special
case only applies to the Company+Person level.

8. Save the trigger.

9. Add a trigger button, e.g. to the Company+Person level, used to star t Notepad
and open or add the file <FI_SerNo>.txt, see Trigger Buttons on page 187.

Note:  By default, program call tr iggers initiated by database events (see Database
Events on page 189) react to changes made to data in the main and Maintenance
modules, as well as changes made by CRM.server and importing data using the
Import module. You can change this behavior by specifying the desired modules,
see Module Parameters.

For information on sending XML messages to a 3rd-party tool via COM trigger (HTTP
or Message trigger), see CRM.interface Technical Guide.

Module Parameters

By default, program call tr iggers initiated by database events (see Database Events
on page 189) react to changes made to data in the main and Maintenance modules,
as well as changes made by CRM.server and importing data using the Import
module.

Use the Module parameter to change this behavior or to initiate program calls from
other Aurea CRM modules or applications:

1. Define the program call.

2. Add a new line, and select Module from the dialog box.

3. Enter the modules you wish to allow the program call for in the Field Contents
cell, or double-click in the field, and select the desired module.
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You can define multiple lines or separate modules in single line using a semicolon.

The program call tr igger is only star ted from the specified modules.

Note:  Caution is advised when calling programs from the web server, for example.
Applications with a GUI or which require user interaction should not be star ted in
this case.

Transferring Data to a Word Processor
You can use triggers to transfer data from Aurea CRM to your word processor.

You can then edit, print and/or save the document in Aurea CRM's document man-
agement system, see Word Processor in the Aurea CRM win User Manual.

To transfer data to a word processor using a trigger:

1. Define the trigger:

2. Select a transfer format in the Format Name field, see Defining Transfer Formats
in the Aurea CRM win User Manual.

3. Enter a text in the Accomp. Text field. This text is displayed in a dialog box while
the data is transferred.
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4. Switch to the Single/serial letter tab.

5. Enable the Print Document option to print the document.

6. Enable the Save Document option to save the document in Aurea CRM's document
management system, see Document Management in the Aurea CRM win User
Manual.

7. Use the Global Formats option to determine whether to load a private or global
format, see Formats in the Aurea CRM win User Manual.

8. Save the trigger.

9. Define trigger buttons, e.g. in the Company+Person level, used to initiate the
trigger, see Trigger Buttons on page 187.

Note: The trigger must be initiated from the info area that the transfer format was
defined for.

Default Values
When creating a new expenses record, the current rep's license plate (stored in the
FreeC1 field) should be entered as the default value.

When adding new records, individual fields can be filled with data from other info
areas. Field contents are applied immediately when the record is added (as with all
default values) and can be changed.

1. Define the following trigger:

2. Define the following reference:

3. Save the trigger.

4. Switch to the Rights info area.

5. Click in the Triggers cell for the Expenses info area.

6. Define the following database event:
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7. Save the access rights and assign them (to a station).

Each time a new expense record is added, the current rep's license plate is entered
in the Car No. field.

Displaying Web Pages
You can use triggers to display web pages in Aurea CRM.

Fixed values or data from the database can be transferred as parameters.

To use a trigger to open a web page:

1. Define the following trigger:

2. Click on New Line in the Field column.

A dialog box is displayed. You can choose between URL and Parameter( #).

3. Select the URL entry.

4. Click OK.

5. Enter the URL in the Field Contents column or reference a field in the database
(Direct Reference or Reference fields)

6. Save the trigger.

7. Define trigger buttons or similar in the levels that you wish to be able to open the
web page from, see Trigger Buttons on page 187.

You can configure the display of web levels, see Level Properties in the Aurea CRM
win Administrator Guide.
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To display the web page in the user's default browser instead of in Aurea CRM:

1. Switch to the WEB Level tab in the trigger definition.

2. Enable the Open in Browser option

3. Save the trigger.

When executing the trigger, the default browser is star ted and the web page dis-
played in the browser.

Note: You need to disable User Account Control (Windows Vista and higher) in
order to use this feature.

Transferring Parameters

To transfer parameters when opening a web page:

1. Define a trigger with the WEB level action, see Displaying Web Pages on page
206.

2. Add a new line, and select Parameter (#) in the Field column.

3. Enter a string to be used as a parameter in the Field Contents column.

4. Save the trigger.

To transfer data from the database as a parameter:

1. Define a trigger with the WEB level action.

2. Select the source info area from which data should be transferred in the Info
Area cell.

3. Add a new line, and select Parameter (#) in the Field cell.

4. Select the field containing the parameter in the Direct Reference cell or reference
a field in another info area (Reference cell).

5. Save the trigger.

Note:  If you transfer field contents as parameters, they are automatically encoded
as a URL. All other texts must be encoded as A URL (Field Contents column); i.e.
you need to enter %20 for spaces or %22 for quotation marks.

Parameter Examples

The following screenshots only serve as examples. If you wish to incorporate the
web pages of the companies listed below, contact the respective companies.

Searching for Names:
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Search for Address:

The conditions (With Conditions columns) apply to the country codes. If "Country
= Austria" then "AT" is transferred. If "Country = Germany" then "DE" is transferred.

Neutral Data Types

The Neutral data types option causes numeric values to be transferred in a con-
stant, language-independent format (i.e. without digit grouping symbols and a period
is used as the decimal symbol). This setting applies to all field contents that are
formatted based on the regional settings, i.e. including date and time fields.

E-Mail
You can use triggers to create and send e-mails in the background.

Before you can use such a trigger, you need to specify your e-mail client in the
Configuration info area, see General Settings on page 41 (E-Mail Client option).

In this example, any changes to the Processed by field in the Ticket info area
should cause an e-mail containing all necessary information to be sent automatically
to the new owner of the ticket.

1. Define the following trigger:

The following parameters are available:

• From: The sender, defined here using a reference:
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• To: The recipient. Separate recipients using a semicolon. A reference is used
here:

• CC (optional): Carbon copy. Separate recipients using a semicolon.

• BCC (optional): Blind carbon copy. Separate recipients using a semicolon.

• Subject (optional): The e-mail's subject. Use the Append function to combine
multiple entries to form the subject line. Use the Reference as link option in
the Variable column to include a link to the trigger record in the subject.

• Text (optional): The e-mail's body text. Use the Append function to combine
multiple entries to form the body text. Use "CRLF" to inser t line breaks. You
can also enter the text in HTML format.

• Use the Reference as link option in the Variable column to include a link to
the trigger record in the e-mail.

Select the corresponding format (TXT or HTML) on the E-Mail tab. If you do
not select an option, the setting is read from the SMTP connection settings,
see SMTP Connection Settings on page 92.

Use the Reference as Link option in the Variable column to add a link to the
source record to the e-mail.

Instead of using the Text parameter, you can also define a global transfer format
for the e-mail's body text (Format Name field), see Defining Transfer Formats
and Global Formats in the Aurea CRM win User Manual. The transfer format
must include a transfer fields format, even if the e-mail body text does not ref-
erence any fields.

The settings entered in the transfer format for the subject and sender are
overwritten if suitable parameters are defined in the trigger.

• Attachment( optional): A document in Aurea CRM's document management
system or the path to a local file. You can use the Append function to generate
the path and file name. In this example, a document is taken from an order
record and included as an attachment.
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• Module: By default, E-Mail tr iggers are only executed in the main module
(mmba.exe). Use the Module option to specify the modules where the E-Mail
trigger should be executed.

Double-click in the Field Contents field to get the module list:

Enable the check boxes for the desired modules.

2. Enable the Save e-mail in 'Sent Items' option on the E-Mail tab if you want to
save e-mails sent via triggers to the current rep's Sent Items folder in their e-mail
client.

3. Save the trigger.

4. Switch to the Rights info area.

5. Click in the Trigger cell for the Ticket info area.

6. Define the following database event:

A change to the Processed by field initiates the trigger.

7. Save the access rights and assign them (to a station).
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If an e-mail tr igger is initiated from either the Company or Person in Company info
areas, an activity record is created containing the contents of the e-mail. If the e-
mail is sent in HTML format, a customer document containing the body text is also
created.

Note:  Use the Do not add activity when sending e-mail via a trigger configuration
option to prevent activity records from being added automatically, >> Triggers on
page 169.

E-mail tr iggers cannot be executed as part of automatic selections, >> Automatic
Selections in the Aurea CRM win User Manual.

Aurea CRM web only supports triggers that send e-mails via SMTP. A valid
configuration entry (General Settings -> Connection Settings for SMTP) is required
or the smtp.cfg file must be copied to the web\system\sys directory to be able
to execute e-mail tr iggers in Aurea CRM web, >> SMTP Connection Settings on
page 92 and Aurea CRM web Technical & Installation Guide.

Abort
You can define triggers that check the contents of records before saving it and
cancel save if the defined conditions are not met.

To e.g. allow users to save an activity only if the Purpose field contains a cer tain
value:

1. Define the following trigger:

2. To display the Message text (without changing a field value), you need to enter
the same field as Direct Reference as well.

3. Define the following conditions:
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If one the conditions evaluates to true, the record can not be saved.

4. Save the trigger.

5. Switch to the Rights level.

6. Click on the Triggers cell for the Activity info area.

7. Define the following database event:

The trigger is initiated upon creating or updating an activity. In the Upd Fields
cell you can define which fields must be updated to initiate the trigger.

8. Save the rights format and assign it e.g. to a station.

SMS
You can use triggers to create and send text messages (SMS).

Before you can use such a trigger, you need to specify the connection settings for
sending SMS, see General Settings on page 41 (SMS option).

In this example, any changes to a ticket entered by a rep other than the ticket's
owner cause an SMS to be automatically sent to the owner.

1. Define the following trigger:
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2. Available parameters:

• From (optional): Telephone number or arbitrary text to be used as the sender.
This parameter is optional since not all SMS providers support the "from"
information.

• To: The recipient's telephone number.

• Text: The text message. Use the Append function to concatenate text. The text
can not be generated from a Word template.

• Module: Select the modules which should execute the trigger, see E-Mail on
page 208.

To and Text are mandatory. If no Module is specified, the trigger is only executed
in the Aurea CRM win main module.

3. The recipient and part of the text are defined using references:

• The ticket owner's (Processed by ID field in KM) mobile phone number is
retrieved from that rep's rep record (Mobile tel. field in ID):

• The ticket's number is retrieved from the ticked record that has been updated
(No. field in KM)
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4. Save the trigger.

5. Switch to the Rights info area.

6. Click in the Triggers cell for the Ticket info area.

7. Define the following database event:

8. Save the access rights definition and assign them (to a station, group or user).

The SMS trigger is initiated if a rep other than the one entered in the Processed
by ID field of a ticket updates that ticket.

Note:  No activity records (MA) are created when sending SMS.

Initiating Several Triggers from one Event
You can assign multiple triggers to a trigger event.

For example, if you wish to execute multiple trigger actions using a single button,
you can do so using a dummy trigger:

• The trigger button initiates a dummy trigger, which makes a specific change to
the database, e.g. entering the time in a free field.

• Changes to the database made by the dummy trigger then initiate (possibly
conditional) trigger actions.

Applying Triggers to Several Records
Learn to apply triggers to multiple records.

You can execute a trigger for several records:

• If a trigger is executed for a dependent info area (e.g. Person in Company) from
the parent info area (e.g. Company), the trigger is executed for all child records
(all persons in the company).

• If you want to execute a trigger for all companies or all activities (for all companies
and persons), you can achieve this by exporting and then re-importing the data.
Triggers are then initiated for each record during the import process,
see Rescheduling Missed Activities on page 215.

• You can execute triggers as part of automatic selections, see Automatic Selection
in the Aurea CRM win User Manual.
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Rescheduling Missed Activities
Learn to reschedule missed activities.

To reschedule all missed activities to a future date, or to set their status to "Missed":

1. Export the keys for all activities with the status "Scheduled" and lying in the past.
Also export a free field. The free field is used as a flag to ensure that each record
is updated when the record is imported.

2. Import the keys automatically (match up companies and persons, update activities).
During the import process, a value is entered in the free field.

3. The trigger reacts to the value entered in the free field. (Define an appropriate
condition and select the field in the Upd Fields column.)

4. The trigger moves all activities to the current date if they have been marked as
movable, and sets the status to "Missed" if they cannot be moved (similar to the
"Activity Check" trigger, >> Plausibility Check on page 200).The trigger also deletes
the value stored in the free field.

5. You can combine automatic import and export processes in batch files and call
the batch file using a button in Aurea CRM.

Note:  Separate command lines in the batch file using the "pause" command.

Trigger, Target and Reference Info Areas
Learn about the info areas involved when trigger is executed.

Three info areas are involved whenever a trigger is executed:

• Trigger Info Area: The info area from which the trigger is initiated. This can be
the info area for which a trigger is defined in the Rights info area (Triggers
column) or the root info area of the Reference defined in the Trigger info area,
see Defining Database Events on page 189 and Reference and Root Info Area on
page 216.

• Target Info Area: The info area that is updated by the trigger. This is the info
area entered in the Info Area field in the Trigger info area, see Defining Triggers
on page 171.

• Reference Info Area: This is the info area from which data is copied using a
reference. The info area is entered in the Reference field in the Trigger info area,
see Field References on page 185 and Reference and Root Info Area on page 216.

The trigger, target and reference info areas can be the same.

When using the Plausibility Check or Prior to saving options in a trigger, the
trigger and target info areas must be the same.
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Reference and Root Info Area
The reference info area is the info area entered in the Reference field in the Trigger
info area.

The root info area should either be left empty or be the same as the trigger info
area.

Any info area with the same key as the trigger or target info area can be used as a
reference info area.

Whether the key is taken from the trigger or target info area depends on the trigger
actions and the entry in the Root info area column. Apart from when adding new
records using a trigger, only one of the two info areas is possible, as the records
must be identical in all common parent info areas. For example, if an activity record
is added from a note record, both are dependent on the same person, and by exten-
sion, the same company.

When adding records, the reference refers to the trigger record.

An entry in the Root info area column means that the line is only used if the trigger
is initiated from that info area.

Trigger and Target Info Areas when Adding Records
When the New button is clicked in an info area, Aurea CRM automatically fills in a
number of key fields (e.g. the company group and number in companies and all
company-dependent info areas).

You can use triggers to add records from any other info area. In some cases, it is
not clear from the context where Aurea CRM should take the key information from.

When adding new records via triggers, all relevant keys are automatically copied
from the trigger info area to the target info area.

As a result, you can add records from info area A to info area B automatically (i.e.
without worrying about the key information), as long as one of the following conditions
applies:

• B is an independent info area

• B is dependent on A

• B is directly dependent on an info are which is hierarchically above A

If B is not dependent on A, but on another info area, you need to enter the key using
the Field Contents, Variable or Reference columns.

Example: Adding Activities to Notes

For example, if you add an activity from a note, the key fields of the company (and
possibly the person) are transferred. The activity is added for the same company
or person as the note. Because the date is a key field in both cases, and notes are
associated with activities (the text in activities is copied to notes with the same
date), the date is transferred to the activities.
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The rep entered in the activity is not a key field, and is therefore not copied auto-
matically. You need to use reference fields to copy the rep, see Field References
on page 185.

Trigger and Target Info Areas when Updating, Displaying or Deleting
Records
Triggers with the Edit/update, Show or Delete actions access the database.

These actions are carried out for all possible records. For example, if you apply
changes to a dependent info area from a parent info area, the changes are applied
to all dependent records that meet the defined conditions.

Default options:

• Trigger info area = target info area: The changes are applied to the record from
which the trigger was initiated.

• Trigger info area is a parent of the target info area: The changes are applied
to all dependent records, irrespective of whether they are directly or indirectly
dependent on the trigger info area.

• Target info area is a parent of the trigger info area: The changes are applied
to the parent record, irrespective of whether the trigger info area is directly or
indirectly dependent on the target info area.

Special cases:

Changes to recordsTarget Info AreaTrigger Info Area

Dependent on the same company (if Data
> Company-Related is selected) or person

Dependent on Per-
son in Company
or Company

Company or Per-
son in Company

Dependent on the company (only company-
dependent)

Dependent on Per-
son in Company
or Company

Dependent on
Company or Per-
son in Company,
only company-de-
pendent

All persons within the companyPerson in Compa-
ny

Company or Per-
son in Company,
only company-de-
pendent

All for this companyOnly company-de-
pendent

Dependent on Per-
son in Company
or Company
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You can change the default index relationship between the trigger and target info
areas (Index Relationship column in the access rights, see Defining Database
Events on page 189). For example, if you wish to apply changes to the Company
info area from the Relationship info area, by default, the trigger would apply to the
parent company. If you select FI_1_StaNo, FI_1_SerNo -> FI_StaNo, FI_SerNo as
the index relationship, the trigger affects the target company.

You cannot edit, delete or display records in independent info areas from other in-
dependent info areas. Consequently, you cannot apply changes to the Document
info area from the Company info area.

Example: Updates Between Info Areas

The trigger in the following examples applies the following changes:

Company >

• Ext. Company Key (1:n)

• Person in Company (1:n) > Activity (1:n)

• Activity (1:n)

Key:

Ext. Company KeyActivityPerson in Company

FI_StaNoFI_StaNo.FI_StaNo.

FI_SerNoFI_SerNoFI_SerNo

Ext. SystemKP_StaNoKP_StaNo

Ext. KeyKP_SerNoKP_SerNo

Date

MA_SerNo

• If you want to apply changes to the Activity info area from the Person in
Company info area, only activities associated with this person can be changed.
Conversely, you can only apply changes to the person from person-dependent
activity records, not from company-dependent ones.

• You can apply changes to external company keys, despite these being
company-dependent and not person-dependent. Conversely, you can make
changes to all persons and company-dependent records from the Ext. Company
Key info area.
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Processing Triggers on the Stack
Learn how to process triggers on stack.

An event can initiate several triggers, which in turn can initiate fur ther triggers,
see Trigger Chains and Branches. Aurea CRM stores the triggers on an internal
stack. Whilst a trigger is being executed, any number of other triggers can be stored
on the stack waiting to be processed.

If the execution of a trigger initiates a fur ther trigger, the new trigger is added to
the top of the stack ("First In First Out"). This behavior can be changed globally
using a configuration entry (Log triggers) or per trigger in the access rights definition
(Execute follow-up triggers recursively option), see Recursion Depth.

Trigger conditions (see Defining Database Events on page 189) are tested when
triggered, and not before the trigger is actually executed. However search conditions
(see Defining Triggers on page 171) are only tested once the trigger is actually exe-
cuted.

The situation in which the trigger was initiated is also stored on the stack: which
records need to be edited or deleted; or from which record new records should be
added.

When executing triggers, Aurea CRM's multi-tier system of access rights applies,
see Rights Hierarchy. Triggers defined in the station access rights are initiated first,
followed by those in the group and rep access rights, and finally those in the role
access rights. If you are inheriting access rights, you can configure this behavior
for each trigger, see Further Settings for Triggers and Workflows on page 192.

Note: Triggers for which the Plausibility Check or Prior to Saving options are
enabled are not processed using the stack, but directly after each field update. They
cannot initiate fur ther triggers.

Trigger Chains and Branches

It is possible to define chains of triggers, with one trigger calling the next. Take care
to avoid infinite loops: If you want one or more triggers to be initiated repeatedly,
ensure that process also terminates at some point (Suppress subsequent triggers
option).

If you want to call several external programs or transfer several records to the word
processor at once, you can define dummy triggers. The dummy trigger applies a
change to a specific field which in turn initiates the trigger containing the program
call or used to transfer data to the word processor.

Triggers containing the actions Program Call, Single/serial letter, WEB level or
E-mail cannot initiate other triggers, as they do not apply any changes to the
database.
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Recursion Depth

The recursion depth determines the depth up to which follow-up triggers are pro-
cessed directly and not added to the stack.

In the following example, a database event initiates triggers 1 to 3. Trigger 1 updates
2 records (X and Y), the remaining triggers update a single record each. The triggers
1a, 1b and 2a are follow-up triggers that are initiated by the changes applied using
the first trigger.

The orange lines depict the order in which triggers are executed; the large blue
rectangle represents the stack.

Recursion depth 1 (default in Aurea CRM win):

Recursion depth 0 (default in Aurea CRM web):
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You can configure the default recursion depth globally or per station using a config-
uration entry (Log trigger). The maximum recursion depth is 100.

Recursion depth 2:

Note:  If the recursion depth is changed (i.e. from 1 in Aurea CRM win or 0 in Aurea
CRM web, this setting is also applied to triggers initiated when adding new records.

You can also determine whether follow-up triggers or workflows are executed recur-
sively or not for each trigger/workflow, see Further Settings for Triggers and Work-
flows on page 192.

Tenants
Learn how to configure the Aurea CRM database for multiple tenants.

All Aurea CRM products support tenants.

To configure the Aurea CRM database for multiple tenants:

1. Define which info areas and catalogs should be tenant-dependent, see Defining
Tenant Rights on page 222.

2. Define tenants and assign them to reps, groups or stations, see Defining Tenants
on page 225 and Assigning Tenants.

Preparations
Pre-requisites for defining tenants and tenant rights.

Consider the following before defining tenants and tenant rights:

• Which tenants are required, i.e. which user groups work with joint or separate
data.

• Which users should have access to the data of multiple tenant and the relationships
between tenants. For example, you need to identify whether a tenant can access
other tenants' data but not vice versa, and whether individual users should be
able to edit data assigned to multiple tenants, see Assigning Data/Catalogs to
Several Tenants on page 226.
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• Which data and catalogs are tenant-independent. In general, this applies to
companies, persons and their dependent data (e.g. catalogs such as Marketing
Activity, Product Group etc.), see Defining Tenant Rights on page 222.

• Whether existing catalogs and data should be separated and to which tenants
they should be assigned, see Changing the Tenant Structure on page 231.

• Whether data needs to be imported for multiple tenants simultaneously, in which
case the import user requires access to all tenants' data, see Import on page 230.

• How data is entered. You should ensure that data is always assigned to the correct
tenant irrespective of how the data is added (manually in the Aurea CRM win
main module, via import etc.).

• Which users are responsible for entering catalog values. You should ensure that
catalog values are always assigned to the correct tenant irrespective of how the
data is added (manually in the Aurea CRM win main module, via import etc.),
see Tenants and Catalog Maintenance on page 228.

Defining Tenant Rights
The Tenant Rights info area is used to specify which data and catalogs are
separated by tenants.

In general, the following tenant rights should suffice:

• "Standard", for most users

• "Admin", for collective imports etc.

Defining Tenant Rights for Info Areas

To define tenant rights for info areas:

1. Open the Tenant Rightd info area in the Rights module.

2. Select Info Area from the context menu.

3. Click in the Tenant No. Field column and select the field that contains the tenant
number. When accessing a record in this info area, the contents of this field are
compared to the tenant number of the user, group or station. When adding new
records, the appropriate tenant number is entered in this field, see Assigning
Tenants.

You can choose to index the field in the SQL database in order to optimize per-
formance when accessing this field.
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The <InfoAreaID>-TenNo field is available in the most important independent
info areas (Company, Person, Campaign, Marketing Activity, Expenses,
Property (BTB), Conditions (OTC) etc.). For other info areas, you can select a
free field to use instead or define a field of type "mno" in the data model. If no
field is available from the drop-down list in the Tenant No. Field column, you
need to define a field of the type "mno" in the data model for that info area,
see Aurea CRM Field Types.

4. Enable the desired options:

• View: Reps can only view those records that contain their tenant number (or
contain no tenant number).

• New: When a new record is added, the user's tenant number is entered in the
field selected in the Tenant No. Field column upon saving. Default values or
values entered manually are overwritten. You can deny access to tenant fields
using access rights, in order to prevent subsequent changes to these fields,
see Defining Rights at the Field Level on page 153.

Note:  If tenant rights are assigned to a parent info area, its child info areas are
not automatically separated by tenant.

• Update: Users can only edit those records that contain their tenant number (or
contain no tenant number).

• Delete: Users can only delete those records that contain their tenant number
(or contain no tenant number).

The following combinations are common:

• View + New + Update + Delete: Read and write access is tenant-dependent.

• New + Update + Delete: Write access is tenant-dependent. All users can view
the records of other tenants.

5. Define the tenant rights for all necessary info areas.

6. Click  (Save), see Saving, Loading and Deleting Formats in the Aurea CRM win
User Manual.

7. Assign the tenant rights to the desired tenant, see Defining Tenants on page 225.

Defining Tenant Rights for Catalogs

You can define which (variable) catalogs are identical for all tenants and which are
different. For example, the Currency catalog is identical for all users, but the Mar-
keting Activity catalog is separated by tenant.

Note:  Fixed catalogs cannot be separated by tenant, see Catalogs on page 270.

To define tenant rights for catalogs:

1. Open the Tenant Rights info area in the Rights module.

2. Select Catalog from the context menu.
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3. Enable View or New for the appropriate catalogs.

• View: Reps can only select catalog values containing their tenant number (or
containing no number).

Note:  All catalog values are always visible to the administrator (SU).

• New: The user's tenant number is entered when adding a new catalog value.

4. Save the tenant right and assign it to the appropriate tenant, see Defining Tenants
on page 225.

Note:  If you separate a catalog by tenants, you should also do the same for those
info areas that access the catalog. Otherwise, records may be displayed or saved
with incomplete data. For example if a user edits a record containing a catalog value
assigned to another tenant, the catalog value is deleted upon saving the record.

You can determine that cer tain values in catalog separated by tenants are available
to all tenants, whereas others are only available to a single tenant.

Example: Standard activities in the Marketing Activity catalog should be available
to all users, but not cer tain specific activities, see Tenants and Catalog Maintenance
on page 228.

Access Rights and Tenant Rights

Data

You can separate data by tenants using either the Rights or Tenant Rights info
areas:

• You can configure tenant access rights with some effor t in the Rights info area:

1. For each info area, define a field (catalog, alphanumeric or numeric) used to
store the tenant number.

2. Define access rights for each tenant, which differs in terms of default values
and conditions for this field.
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Note: This method is relatively cumbersome and prone to errors: access rights
must be defined for each tenant and the correct values and conditions must be
entered for all cases. Changes need to be applied to all access rights.

• Defining tenant rights in the Tenant Rights info area has the advantage that
separate access rights do not need to be defined for each tenant and default
values and conditions are much clearer and easier to define.

• If you have previously defined tenant rights using the Rights info area (using an
appropriate field (catalog, alphanumeric or numeric) per info area), you can
continue to use these fields or discard them and use the Maintenance or Import
module to transfer existing data.

You do not need to do this immediately when switching, but can subsequently
update your settings in steps or only for some info areas.

All settings in the Tenant Rights info area are applied as those you had defined
access rights in the Rights info area with conditions applied to the <xx>TenNo
field.

Catalog Values

For catalogs, the settings in the Rights and Tenant Rights info areas do not overlap:

• The Rights info area is used to define which catalogs new entries can be added
to.

• The Tenant Rights info area is used to specify those catalogs for which the tenant
number should be entered when new values are added.

Defining Tenants
Use the Tenant info area to define tenants and assign tenant rights to the tenants.

In general, a single administrator tenant with administrator tenant rights combined
with several tenants with standard tenant rights suffices.

To define tenants:

1. Open the Tenant info area in the Rights module.

2. Click  (New).

3. Enter a number (integer; up to 9 digits) in the Tenant No. field. The tenant number
forms a tenant's unique key.

4. Enter a name for the tenant in the Tenant Name field.

5. Select the desired Tenant Rights that apply to this tenant.
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6. Save the record.

7. Assign the tenant to a station, group or rep, see Assigning Tenants.

Assigning Tenants

To assign tenants to reps and groups:

1. Open the Rep info area in the Rights module.

2. Switch to the desired record.

3. Enter the appropriate tenant number in the ID_TenNo field.

4. Save the record.

Depending on the options in the selected tenant rights:

• Reps can only view, edit or delete data containing their tenant number or no
tenant number.

• Reps can only select catalog values containing their tenant number or no tenant
number.

• The current rep's tenant number is automatically entered in the appropriate tenant
number field (type: "mno") when adding new records to tenant-dependent info
areas.

• The current rep's tenant number is automatically entered when adding new catalog
values to tenant-dependent catalogs, .

You can also assign tenant rights to stations (AS-TenNo field in the Station info
area).

If you wish to grant individual users or groups access to other tenants' data, you
need to define additional tenants, see Additional Tenants on page 227.

Assigning Data/Catalogs to Several Tenants
Learn how to assign data/catalog to several tenants.

Data

To make data accessible to several or all tenants:

• Data with no tenant number can be accessed by all tenants (tenant-independent).

• You can assign additional tenants to users, allowing users to access the data of
several tenants, see Additional Tenants on page 227.

• You can assign additional tenants to tenants, allowing all users assigned to the
parent tenant to also access the child tenant's data (e.g. reps at a parent company
should be able to access the subsidiary's data, but not vice versa), see Additional
Tenants on page 227.
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• The same companies or persons should not exist multiple times for several tenants,
if one tenant is an additional tenant of the other. Otherwise companies belonging
to different tenants is merged when importing data and matching up by name and
address, see Import on page 230.

• If several tenants should have access to cer tain data, you can again use additional
tenants. Define a single tenant that accesses the shared data, and assign this
additional tenant to all tenants that require access, see Additional Tenants on
page 227.

Catalogs

To allow catalog values to be accessed by multiple tenants:

• Catalog values without a tenant number are available to all tenants
(tenant-independent). Aurea recommends leaving "general" catalogs (e.g.Country,
Currency etc.) as tenant-independent.

• Define the same catalog value for all tenants that require it. This is recommended
if catalog values only use the same name. Deleting the catalog value for one
tenant does not affect the value for other tenants, see Tenants and Catalog
Maintenance on page 228.

• Enter the catalog value only once, but use additional tenants to allow several
tenants to access this catalog value, see Additional Tenants on page 227.

Note:  Aurea recommends keeping the number of tenant-dependent catalogs and
catalog values to a minimum.

Additional Tenants
Use the Additional Tenant and Rep Add. Tenant info areas to assign additional
tenants to reps or tenants, granting access to other tenants' data.

This allows you to grant individual reps (e.g. regional managers, branch managers)
or groups (e.g. parent company, campaign managers) access to other tenants' data.

Example: A parent company has 3 subsidiaries with data separated by tenants (i.e.
3 tenants). Employees at the parent company have access to data of the subsidiaries
(one main tenant and 3 additional tenants assigned to the main tenant). A standard
employee is responsible for two tenants and therefore has access to both tenants'
data (one main tenant + an additional tenant). A regional manager has access to
several tenants' data (one main tenant + several additional tenants assigned to the
main tenant).

Note: The tenant rights assigned to the main tenant always apply, i.e. when adding
new records or catalog values, the number of the main tenant is entered.

You cannot assign additional tenants to rep groups via Rep Add. Tenant. You need
to define additional tenants for the group's (main) tenant instead.
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To assign additional tenants to tenants:

1. Open the Tenant info area in the Rights module.

2. Switch to the desired record.

3. Select Additional Tenant from the context menu.

4. Click  (New).

5. Enter the number of the desired additional tenant in the Add. Tenant No. field.

6. The tenant's name is transferred automatically.

7. Save the record.

Reps assigned to the main tenant (number 6) have access to tenant-independent
data and all data assigned to additional tenants 7,8 and 9. When adding new data,
the number of the main tenant (6) is entered.

Note:  Additional tenants are not inherited. Example: Tenant A includes additional
tenants B and C. Tenant A is assigned to tenant D as an additional tenant. Tenants
B and C are not added as additional tenants of D.

This is not possible for performance reasons. As such, there is no means of defining
that tenants 110-199 are additional tenants of tenant 100.

To assign additional tenants to reps:

1. Open the Rep info area in the Rights module.

2. Switch to the desired record.

3. Select Additional Tenant from the context menu.

4. Define the additional tenants.

Tenants and Catalog Maintenance
Tenant numbers are saved for each catalog value in the Catalog info area in the
Maintenance module.

For fur ther details, see Catalog Info Area on page 271.

Reps can only select catalog values they can access according to their tenant rights
in catalogs that are separated by tenants.
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A maximum of 65535 entries can be defined per catalog. This number also cannot
be exceeded by the total entries for all tenants. Furthermore, performance suffers
when opening catalogs containing around 1,000 entries. This results in the following
guidelines for the number of entries:

• Up to 50 tenants: a maximum of 1,000 entries per tenant

• Up to 100 tenants: a maximum of 500 entries per tenant

• Up to 200 tenants: a maximum of 200 entries per tenant

Catalog values must be unique within a tenant. You can define identical catalog
values for different tenants. However, avoid adding catalog values without a catalog
number that are identical to catalog values assigned to a tenant, as all tenants can
also access catalog values with no tenant number assigned.

You can edit the tenant numbers of catalog values in the Catalog info area,
see Editing Variable Catalogs on page 273.

Note:  If catalog texts or tenant numbers are updated when importing data into the
catalog table, the Catalog Maintenance info area is updated automatically.

If you use additional tenants to depict catalog values common to several tenants,
mix tenant-independent and tenant-dependent catalog values in one catalog, or
additional tenants are used to grant have access to other tenant's data, you should
ensure that entries in the additional tenants' catalogs are not the same as in the
main tenant's catalogs. Firstly, this avoids confusing the user, and secondly, the
catalog value assigned to the tenant entered in the record is always used during
import, see Import on page 230.

If a condition is defined for a tenant-dependent catalog value and a format containing
the condition is distributed, users must be able to access the catalog value. In some
cases, it may therefore be necessary to duplicate the format for each tenant. You
should therefore avoid using conditions applied to tenant-dependent values in formats
defined for several or all users.

If configured incorrectly, a user may be able to view catalog values that should be
hidden. In this case, for performance reasons, the catalog value is displayed in the
mask and the list. When the catalog is opened, the catalog value is not visible.

This can be caused by the following:

• A catalog is tenant-dependent but appears in an info area which is
tenant-independent.

Solution: Define the info area as tenant-dependent as well.

• The record contains a catalog value assigned to a different tenant than the record.
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Import
Aurea CRM allows you to import data for a single tenant (i.e. using the tenant's
rights) or to import data assigned to multiple tenants at once.

Note:  If you have used the Rights info area to define tenant rights and switch to
using the Tenant Rights info area, you need to update your import formats
accordingly.

If you import data for a single tenant, you need to do so as a user assigned to the
tenant. This means that you need to define an import user for each tenant. During
the import, all tenant rights are applied, i.e. only data assigned to the tenant can
be added or accessed. In this case, you do not need to update your import or export
formats.

To import data for several tenants at once:

1. Define an import user and assign administrator tenant rights to the user, granting
read and write access to all data.

2. Define an import format, see Defining an Import/Export Format in the Aurea CRM
win Administrator Guide:

The tenant number must be included in each line of the import file.

Import the tenant numbers into the Tenant info area (matching up with the data
in the Tenant info area and adding new tenants as necessary). Define the Tenant
info area as the first info area in the Info Area Properties (number 0):

Aurea CRM then assumes that data in this line is meant for this tenant. The tenant
rights assigned to this tenant are applied, i.e. data is added or matched up using
this tenant number.

You can define other tenant numbers for individual records, e.g. the number of an
additional tenant. Ensure that the main tenant number is imported into the Tenant
info area and matched up there. This ensures that the system is aware of which
data is tenant-dependent and which fields are used for the tenant number.

Note: The system checks whether an identical catalog values exists that is
accessible by the tenant. If so, the existing value is used. If multiple values exist,
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those values assigned directly to the tenant or without a tenant take precedence.
You should therefore ensure that no identical catalog values exist for the tenant
entered in the record when entering or importing catalog values. If no corresponding
value exists, the catalog value is added. Depending on the settings in the tenant
rights, the current tenant number is also entered.

Import Tips

• If an user with administrator rights imports a tenant number (e.g. 100) into the
tenant table, and no restrictions have been defined in the tenant rights for this
info area, and the user also imports tenant number 110 into the Company info
area, the system checks whether tenant 100 has access to tenant 110.

• If restrictions have been defined and you import as a user of tenant (e.g. 200),
the system checks whether you have access to tenants 100 or 110.

• You should avoid matching up by name and address if tenants have access to
the data of other tenants and if there is a chance identical companies exist. When
matching up by name and address, any data is displayed that your tenant or the
tenant for which you are importing can access.

Example: Restrictions apply, and you import as a user of tenant 200, with identical
companies existing for tenants 100 and 110. When matching up by name and
address, the first company found is matched up if identical companies exist for
both tenants.

Changing the Tenant Structure
Learn how to change the tenent structure.

Changing Tenants

You can transfer records and catalog values from one tenant to another by changing
the tenant numbers in the record or value:

• Records can be transferred manually in the Aurea CRM info area (see Update
Level on page 385) or by exporting and importing.

Note:  Only the administrator can change the <xx>-TenNo field in individual info
areas. Other users can add new values, but cannot change existing entries.

• Catalog values can be transferred individually in the Catalog info area
(see Editing Variable Catalogs on page 273) or by exporting and importing.

Note:  Use the Maintenance module to maintain catalog values and determine
which catalog values are shared by all tenants.
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You can merge data assigned to several tenants in the following ways:

• Define a tenant as an additional tenant of another. The tenant structure is retained
for existing data.

• Companies and persons added separately for both tenants can be merged selecting
Edit > Merge Company/Person from the menu in the main module, see Managing
Companies and Persons in the Aurea CRM win User Manual.

Changing Additional Tenants

If you change the tenant access rights defined for a rep or tenant, you also need to
update the additional tenants.

Note: Whenever you allow a rep or tenant to access the data of another tenant,
you should also allow access to the data of all that tenant's additional tenants.

Keys

Keys are not tenant-dependent:

• If a user can access data assigned to several tenants, the key is always unique
for each record, irrespective of the number of tenants.

• If the data allocated to a tenant is changed (e.g. allocated to another tenant,
merged, separation of tenants), this does not change the (primary) key.

This should be taken into account for the following types of keys:

• Serial numbers (e.g. company, person, order etc.): the only visible effect for the
user is that serial numbers are not necessarily assigned continuously. However,
since the purpose of serial numbers is simply to identify records uniquely, this
should not be a problem.

• Keys which contain catalogs (external company key, questionnaire etc.): by
separating the relevant catalogs, tenants can assign keys independently of one
another.

• Assignable keys (item / product master etc.): If these areas are separated by
tenant, you should ensure that the various tenants' keys are different, e.g. by
automatically assigning item numbers using a trigger for each tenant.

Communication

The <xx>-TenNo field is not par t of the key, so it is not used for match-up purposes
during communication. If companies which differ only by tenant number exist on
different stations and you match up companies by name and address during commu-
nication, these companies are merged during communication. This cannot happen
if you match up records during communication using the primary key (FI_StaNo +
FI_SerNo), as recommended by Aurea, see Match-up in the Aurea CRM win Admin-
istrator Guide.

Note:  In principle, all catalogs are available on the stations. To check which stations
should receive which tenant's catalogs would be too complex and so no check is
performed during communication. The catalogs data volume is low in comparison
to the rest of the data, and should therefore be of no consequence.
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Station Configuration
Use the Station configuration (T0) info area to define the tracking of sessions and
processes, password settings and blocking mechanisms for individual stations.

Only one configuration record can be added per station.

To add a new record:

1. Switch to the Station Configuration info area.

2. Click on  (New).

3. Enter the station number in the Stat. No. field.

4. Configure the following settings on the General tab:

• Session tracking/Session tracking Web: Enables session tracking for Windows
or Web clients on this station, see Session Tracking on page 242.

• Process tracking/Process tracking Web: Enables process tracking for
Windows or Web clients on this station, see Process Tracking on page 243.

• Windows Trace/Web Trace: Enable these fields to activate the SQL logs for
Aurea CRM win and Aurea CRM web.

• Cat. refresh  frq.: Determines how often (in minutes) Aurea CRM should check
whether catalogs have been updated by other users (manually, via import or
catalog maintenance), see Catalogs on page 270.The default value is 30 minutes.

The value in this field is also used to query for changes to the Configuration
table (MC), see Configuration on page 10, and for variables, see Defining
Variables on page 253. Deleted catalogs and configuration entries are refreshed
every 120 minutes.

The user cache is refreshed at the frequency defined in Cat. refresh  frq. (the
roles assigned to a user are stored here).

The roles cache (i.e. the login role records) is refreshed every 60 seconds.

• Format refresh frq.: Applies to Aurea CRM web only. Indicates how often
formats should be refreshed.

• User Tracking Frequency/User tracking frq. Web: Determines the interval
in which Aurea CRM updates records in the User Tracking info area.

• Last system check: Date on which the license report was last executed,
see License Report on page 131.

• Domain: Default domain for the station, i.e. domain for all users for whom no
domain is entered.

5. Use the Password tab to configure the password settings for the station,
see Password Security.
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6. Configure the blocking mechanism applied when users log on using an incorrect
password, see System Blocking.

7. Save the record.

The system checks for updates of these settings once per minute.

Password Security

To guarantee greater security, Aurea CRM allows you to specify that passwords
must be changed at regular intervals and must meet cer tain criteria. In addition,
you can enable the blocking mechanism, which prevents a user from attempting to
log in after a specified number of failed attempts, see System Blocking.

You can configure the following settings on the Password tab in the Station Con-
figuration info area:

• Frq. PW Update in days: Number of days after which users must change their
passwords.

• Minimum PW Length: The minimum password length. The maximum length is
128 characters, which is sufficient to prevent against brute force attacks.

• Passwords in History: The number of passwords stored in the history that may
not be used again (maximum: 10).

• Password History: The number of characters in the next password that may not
be repeated in the same order (possible values: 0 = no limit; 3, 4, ...)

• PW must contain digits: If enabled, the password must contain at least one digit.

• PW must contain letters: The password must contain at least one letter.

• PW must not contain user name: The password must not contain the user name.

• PW must contain upper and lower case: New passwords must contain both
upper and lower case.

Note:  If you enable this option and export or import users in the Export/Import
modules (Login/US info area), you need to include the Password and Encrypted
Password fields in the export/import format.

• PW may not be in blacklist: Words entered in the blacklist may not be used as
passwords. The blacklist is defined in the Configuration info area, see Security
on page 62.

Note: You can configure cer tain password settings for individual users,
see Password Settings on page 118. User-specific settings take precedence over
station-specific settings.

You can exclude cer tain users from the password settings (e.g. the communication
user) by enabling the Deactivate Password or Ignore PW Settings option in the
Configure Login window.
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When Aurea CRM is star ted, the system checks whether the user's password must
be changed and whether it meets the defined security criteria. If one of these criteria
is not met, the user is prompted to change their password. The systems also checks
whether the new password meets the security criteria.

System Blocking

Aurea CRM provides a variety of blocking mechanism to protect the system against
unauthorized access.

If one of the blocking mechanisms is enabled, a neutral message is displayed in-
forming the user that a login error has occurred (instead of a specific error message).

The following options are available for each station on the Blocking tab in the
Station Configuration info area:

• Max. no  of failed login attempts: Number of failed login attempts before the
user can no longer log in.

Note: The maximum number of login attempts can be defined for both stations
and users (in the Configuration module or in the Configure Login window).
User-specific settings take precedence over station-specific settings.The maximum
number of failed login attempts also applies to the SU.

• Track Login Attempts: Failed login attempts are logged in the Process Tracking
info area (Process: "(8000) Login", Text: "<Computer name>: Incorrect
password").

• Max. Blocking: Enables the blocking mechanism for the maximum number of
failed login attempts on this station.

If a user enters an incorrect password, the value in the No. of failed login at-
tempts (in the Configuration module or the Configure Login window) is increased
by 1. Once the number of attempts reaches the value in the Max. No. of failed
login attempts field (in the Configuration module or the Configure Login win-
dow), the user is no longer allows to log in.

Reset the value in the No. of failed login attempts to 0 (zero) in the Configura-
tion module or Configure Login window to allow the user to log in again.

If the Ignore max. no  of failed login attempts option is enabled for a user, the
user is exempted from this blocking mechanism.

• Exponential Blocking: Enables exponential blocking for the station.

If a user enters an incorrect password, the value in the No. of failed login at-
tempts (in the Configuration module or the Configure Login window) is increased
by 1. The system is locked for 2n seconds (where "n" is the number of failed login
attempts).

Once the correct password has been entered, the value in the No. of failed login
attempts is reset to 0 (zero).

Note: The maximum time that the SU is blocked is limited to approximately 17
minutes (210 seconds).

235AUREA CONFIDENTIAL

Rights Module



System Locks
Learn how to use the system lock info area.

You can lock the system for some or all users, allowing you to:

• Back up your database

Note:  Use the programs supplied with MS SQL or Oracle to back up the Aurea
CRM database.

• Edit the data model, see Data Model on page 280.

• Rebuild corrupt indices, see Rebuild module on page 468

• Perform maintenance, see Maintenance Module on page 265

• Reduce system load if you are experiencing performance issues (e.g. by logging
off cer tain users and locking them out of the system for a period of time)

You can:

• Define system locks for specific dates or weekdays, see System Lock Info Area
on page 237.

• Lock the system on the fly, see Lock System Dialog Box on page 239.

Note: The system can only be locked by the system administrator (SU) or users
assigned roles with access to the "System lock" process, see CRM Process Config-
uration on page 98.
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System Lock Info Area
Use the System Lock info area to define system locks at specific times.

To add a new record:

1. Open the Rights module and switch to the System Lock info area.

2. Click on  (New).

3. Enter the number of the station to be locked in the Stat. No. field.

4. You can define system locks for specific days or time periods, as well as define
regular system locks on specific weekdays:

• To lock the system at a specific time, enter dates in the System lock from/to
(date) fields and times in the System lock from/to (time) fields.

• To define a regular system lock, switch to the Daily tab. Enable the check
boxes for the desired weekdays (System lock Monday - System lock Sunday
fields) and enter the times the system is locked in the Daily system lock
from/to fields.
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5. Specify the Type of system lock:

• Log off and lock: Users affected by the lock are logged off and can only log
on again once the system is no longer locked.

• Log off: Users affected by the lock can immediately log back on to the system.

6. Click on  (Rep list) in the Locked reps field and select the users and/or groups
that should be affected by the system lock. If you do not select any users, the
system lock is applied to all users.

Note:  Enable the Ignore system lock date or Ignore daily system lock to
exempt individual users (e.g. communication or import users) from system locks,
see Module Access Rights, System Locks and Process Tracking on page 120.

System locks defined in the System Lock info area do not apply to the adminis-
trator (SU).

7. Enter a message used to notify the affected users of the system lock. If you do
not specify a message, the following default message is displayed: "The system
is being locked. You have x minutes to finish working.", where x is the value
entered in the Time to lock (in minutes) field.

8. Enter the number of minutes after which the system lock come into effect in the
Time to lock (in minutes) field. Once this time period has expired, active users
are logged off automatically. If there are currently no active users, the system
lock takes effect "immediately" (i.e. the next time the system polls for a lock).

Note: The system checks whether a system lock has been defined once per
minute. The time of the system lock can therefore differ slightly from the time
entered in the System lock from (time) field.

9. Use the Module tab to determine which Aurea CRM modules and applications
should be locked for the selected users. If you do not make any settings, all
modules and applications are locked.

10.Save the record.

The system is locked according to your settings:

• The affected users are notified of the system lock using the message entered
in the Text field. If a user has not exited the system within the time period
entered in the Time to lock (in minutes) field, Aurea CRM is closed
automatically.

• If you have entered Log off and lock in the Type field, users can only log on
to the system again once the system is unlocked.
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Note:  System locks defined in the System Lock info area are not displayed in
the Lock System dialog box in the list of Active Locks, see Lock System Dialog
Box on page 239.

The system is unlocked at the time entered in the System lock to (date) and System
lock to (time) fields. The system lock record is not automatically deleted, but is
instead set as inactive (the Inactive field in the record is enabled, visible using
View > All Mask Fields).

Lock System Dialog Box
You can also lock the system on the fly, for example if you are experiencing
performance issues or need to use the Rebuild module.

To lock Aurea CRM on the current station:

1. Select Extras > Lock System from the menu in the main module. (When editing
the data model in the Maintenance module, select Lock system from the context
menu.)
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The following information is displayed:

• Active Users: Lists all currently active users and the modules they are currently
using. Once a system lock is active and selected in the list of Active Locks,
only those users affected by the lock are listed.

• Active Processes: Lists all active processes. Once a system lock is active
and selected in the list of Active Locks, only those active processes belonging
to users affected by the lock are listed.

• Active Locks: Lists all active system locks initiated by the current user from
this dialog box.

Note:  If you have enabled Session tracking in the Station Configuration
info area, the Windows User Name and Windows Computer Name is also
displayed for each entry in these lists.

2. Determine the type of lock under Reps/Groups Lock Settings:

• Log off and lock: Users affected by the lock are logged off and can only log
on again once the system is unlocked.

• Log off: Users affected by the lock are logged off and can log back on
immediately.

3. Click on Reps/Groups to select the reps and groups that should be locked.

Enable the Ignore system lock check box for individual users in the list of Active
Users to exempt these users from the system lock. If the Ignore system lock
option is enabled in a user's login configuration, the user is exempted from the
system lock by default, see Module Access Rights, System Locks and Process
Tracking on page 120.

Note: The current user is automatically exempted from the system lock, unless
specifically selected in the list of reps. In this case, the current user is also logged
off, but can log back on immediately.

4. Enter the number of minutes until the system is locked in the Minutes to lock
field. Once this time period has expired, all users still active in the system are
logged off automatically. If no users are active, the system lock is applied
"immediately" (i.e. the next time the system polls for a lock).

Note: The system polls for new system locks once per minute.

5. You can enter a message in the Prompt field that is used to notify users of the
upcoming system lock. If you do not enter a message, the following default
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message is used: "The system is being locked. You have x minutes to finish
working.", where x is the value entered in the Minutes to lock field.

6. Click on Lock System.

The system is locked according to your settings:

• The affected users are notified of the system lock using the message entered
in the Prompt field. If a user has not exited the system within the time period
entered in the Minutes to lock field, Aurea CRM is closed automatically.

• If you have entered Log off and lock in the Type field, users can only log on
to the system again once the system is unlocked.

• A new record is added to the System Lock info area (the Interactive field is
enabled, visible using View > All Mask Fields).

Note:  System locks defined in the Lock System dialog always apply to all
modules. You cannot define additional system locks for individual users if a global
system lock is active. If you are locking the system as the result of a change to
the data model, the Reps/Groups Lock Settings are inaccessible; you can only
lock the system globally for all users.

The system lock is displayed with a gray background in the list of Active Locks.

To unlock the system:

1. Click on the desired entry in the list of Active Locks.

2. Click on Unlock System.

The system is unlocked. The corresponding record in the System Lock info area
is deleted.

3. Click on Reset to reset the settings in the Reps/Groups Lock Settings pane.

4. Click on Refresh to refresh the lists of Active Users, Active Processes and
Active Locks.

5. Click on Rebuild to rebuild database tables, see Rebuild module on page 468.

Note: The Reset and Refresh buttons are only active if no entry is selected in
the list of Active Locks.The Rebuild button is only active for global system locks
using the option Log off and lock.

6. Click on Close to close the dialog box.
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Tracking
Learn about user, session, process tracking.

User Tracking

User Tracking
The User Tracking (T1) info area tracks the number and duration of logins per user,
station and module.

The User Tracking (T1) info area is used to determine the active user (e.g. for a
system lock, or to verify the number of allowed users concurrently logged-in to a
Aurea CRM win module etc.). In addition, T1 is used to verify if a process (tracked
via T3) is still active, see Process Tracking on page 243.

Default interval for checking if a user is still active: 1 minute.

You can specify another interval in the Station configuration info area (User
Tracking Frequency and User Tracking Frequency Web fields), see Station
Configuration on page 233.

The data in the User Tracking info area are created automatically and cannot be
edited or deleted.

Information on the fields in this info area can be found in the online field help.

Session Tracking
Session tracking is used to keep a track every time a user logs in.

If the Session tracking check box in the Station configuration info area has been
enabled, a record is created every time a user logs on to an Aurea CRM module,
see Station Configuration on page 233.

If the volume of data is too large, you can define conditions that allow you to focus
the data on a specific day or user, for example.
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• Stat. No.: Station being tracked.

• User name: Name of the user being tracked.

• Module: Module being tracked.

• Date, Time: Login date and time.

• Logout date, Logout time: Logout date and time.

• Login duration: The login duration is stored in milliseconds and converted to
days, hours and minutes when displayed.

Process Tracking
Process tracking keeps the CRM data base secure from multiple access to same
data and documents critical processes.

The Process Tracking (T3) info area is used:

• to track (and document) critical processes that affect the Aurea CRM database

• to prevent multiple users from concurrently star ting a process that can only be
executed once, e.g. modifying the data model.

Whenever cer tain processes are executed, a T3 record is created. Some processes
are always tracked. Other processes are only tracked if the Process tracking check
box in the Station configuration info area or in the Login record of the current
user is enabled.

The T3 records can be deleted via maintenance.
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• Station Number: Station being tracked.

• User name: Name of the user being tracked.

• Date, Time: Date and time the process was star ted.

• Module: Module from which the process was star ted.

• Process: The process being tracked. For detailed information on all process
types, see https://support.aurea.com/wiki/index.php?title=Process_Tracking_Types.

Note:  System locks are not added as records to the process tracking, even if
the Process tracking check box had been enabled in the Station configuration
info area, see System Locks on page 236.

• End Date: Date on which this process was ended.

• Duration: The duration of the process is stored in milliseconds, and converted
to days, hours and minutes when displayed.

• Status: Fixed catalog:

• open: the process is being executed right now

• completed: the process has been completed successfully

• aborted: the process was aborted by the user

• error: an error occurred and the process was aborted

If an error occurs when executing an activity, the error number is written to the
Status No. field, see Error Codes for Marketing Activities on page 514.

• exception: Aurea CRM crashed while the process was being executed

• Text: Text relating to the process is added automatically (e.g. for selections, the
name of the selection).

Note: The text displayed in this field is always in English.
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Repairing Processes

To view all currently active processes:

1. Start the Aurea CRM win main module.

2. Select Extras > Active Processes.

3. To abort invalid processes click Repair.

You can access the T3 info area and "repair" invalid processes in Aurea CRM web
as well, see Process Tracking in the Aurea CRM web Administrator Guide.

Note: The Repair button is only available for the SU and users who have access
to the CRM process 1.5.2.6.2.1. "Repair active processes" (CRM process ID
70000280).

This CRM process is disabled by default.

You can also use the mmba.exe command with the option –cleanup to abort invalid
processes, >> mmba.exe Parameters.

Logging Read and Write Access
Aurea CRM allows you to log access to the system.

The following types of access can be logged:

• Write access (i.e. adding, editing or deleting records) by users in the main module,
as well as in the Import, Maintenance, Communication and Rights modules
and via Aurea CRM web, CRM.pad, CRM.interface, CRM.cockpit,
CRM.webservices, CRM.connector and CRM.server.

• Write access via the Web or XML interfaces or DDE server

• Read access (only in Aurea CRM win):

• Displaying data in lists and masks

• Displaying data in a dialog box (e.g. search engine, person or company search)

• In the Export module

• By the DDE server

• Printing from the main module

• Data transfer to Microsoft Word or Microsoft Excel

245AUREA CONFIDENTIAL

Rights Module

https://help.aurea.com/crm/crm-web-administrator-guide/crm-web-administrator-guide/dita/topics/c_crm_webAdmin-2_11_2-Process-Tracking_crm.html


The following do not count as access:

• Rebuild

• Selections

• Reading in workflows or triggers (in the background; i.e. not interactive)

Note:  Log records are not communicated; i.e. they need to be added, exported and
deleted per station.

Enabling and Executing Logs
Steps to configure and execute access logs.

The following steps are necessary to configure and execute access logs.

• Read and write access logging is enabled in the Rights info area in the Rights
module, see Log - Read and Log - Write.

• The rights format is assigned to the users whose read and write access should
be logged.

• Logs are generated according to various criteria (for cer tain users, info areas
etc.) in the Log - Read and Log - Write info areas in the Rights module. Logs
can be and can be exported and deleted from here, see Exporting Access Logs
on page 249 and Deleting Log Entries on page 252.

Note:  Only the administrator has access to the Log - Read and Log - Write info
areas. You can specify the separator used by log entries in the Configuration info
area, see General Settings on page 41.

Log - Read

To enable read access logs:

1. Open the Rights info area in the Rights module.

2. Click in the Log - Read column of the info area you wish to log.
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3. The following options are available:

• Log: Enable this cell to activate logging for read access in general. If you
enable this option, the Module and Functions cells are also enabled.

• With Conditions: Click in this cell to define a condition for logging read access,
see Conditions in the Aurea CRM win User Manual.

• Module: Determines which modules are logged. Click on the  to display the
individual modules. If the Module cell is enabled, then logging is automatically
enabled for all modules. You can disable logging for individual modules.

• Functions: Determines which functions (masks, lists etc.) are logged. Click on
the  to display the individual functions. If the Functions cell is enabled, then
logging is automatically enabled for all functions. You can disable logging for
individual functions.

• Windows User Name/Windows computer name: Enable these cells to include
the corresponding Windows user name and/or computer name in read access
logs.

4. Click on  (OK).

5. Save the rights format and assign it to a station, group, rep or login role,
see Assigning Rights on page 158.

The corresponding access logs are stored in the Log - Read info area and can be
exported as a log file, see Read Access

Log - Write

To enable write access logs:

1. Open the Rights info area in the Rights module.

2. Click in the Log - Write column of the info area you wish to log.
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3. The following options are available:

• Log: Enable the Add new, Edit or Delete cells to enable write access logs.

• With Conditions: Enable the corresponding cell to define conditions that dictate
when adding, editing or deleting records should be logged, see Conditions in
the Aurea CRM win User Manual.

• Conditional (prior to changes): This option is only available for the Edit
column. Click on the cell to define a condition that should apply to the record
before it is edited   Conditions in the Aurea CRM win User Manual.

• Module: Determines which modules are logged. Click on the  to display the
individual modules. If the Module cell is enabled, then logging is automatically
enabled for all modules. You can disable logging for individual modules.

• Functions: Determines which functions (masks, lists etc.) are logged. Click on
the  to display the individual functions. If the Functions cell is enabled, then
logging is automatically enabled for all functions. You can disable logging for
individual functions.

• Only the changed fields: If this option is enabled for New or Edit, then only
those fields that are edited are logged, not the entire record.

• Attachment: Enable the Attachment option for info areas that store data in
binary form (documents, formats) to log any changes to the length of the binary
code.
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• Windows User Name/Windows computer name: Enable these cells to include
the corresponding Windows user name and/or computer name in write access
logs.

• Fields: You can specify which fields in the info area should be logged. Click
on the  to display all the fields in the info area. If the Field cell is enabled in
either the New, Edit or Delete columns, then logging is automatically enabled
for all modules in that column. You can disable logging for individual fields.

4. Click on  (OK).

5. Save the rights format and assign it to a station, group or rep, see Assigning
Rights on page 158.

6. The corresponding access logs are stored in the Log - Read info area and can
be exported as a log file, see Write Access.

Exporting Access Logs
Learn how to export access logs.

Read Access

To export read access logs:

1. Open the Log - Read info area in the Rights module.

2. Enter a File Name for the log file.

3. Configure the desired settings:

• Start Date: Enter the star t date here, if you wish to limit the log file to a specific
time period.

• End Date: Enter the end date here, if you wish to limit the log file to a specific
time period.

• User name: Enter the user name here, if you wish to limit the log file to a
specific user.

• Info Area: Choose an info area from this catalog if you wish to limit the log file
to a specific info area.

4. Click on Export.
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The log entries are exported to the specified log file. The log file is saved in the
\system\db directory if not otherwise specified. The number of log entries ex-
ported is displayed in the Rec. No. field.

The log file includes the following information:

20031113Date (YYYYMMDD)

132054Time (HHMMSS)

LEAUser (Login Name)

10000018Rep / Grp. ID

Aurea CRM winModule

ListFunction

FIInfo Area

1Record ID

F0Field No.

F1;6Field

The following fields are logged:

• The fields containing the records unique key, e.g. F0 ;1 ;F1;167; for company
records (FI_StaNo = 1; FI_SerNo = 167).

• If you have defined that the Windows user name and computer name should be
included in the log, fields 4198 and 4199, >> Log - Read.

Write Access

To export write access logs:

1. Open the Log - Write info area in the Rights module.
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2. Enter a File Name for the log file.

3. Configure the desired settings:

• Start Date: Enter the star t date here, if you wish to limit the log file to a specific
time period.

• End Date: Enter the end date here, if you wish to limit the log file to a specific
time period.

• User name: Enter the user name here, if you wish to limit the log file to a
specific user.

• Info Area: Choose an info area from this catalog if you wish to limit the log file
to a specific info area.

• Add new: Enable this check box if you wish to export logs for new records.

• Edit: Enable this check box if you wish to export logs for edited records.

• Delete: Enable this check box if you wish to export logs for deleted records.

Note: You need to enable at least on of Add new, Edit or Delete, otherwise no
log file is created.

4. Click on Export.

The log entries are exported to the specified log file. The log file is saved in the
\system\db directory if not otherwise specified. The number of log entries ex-
ported is displayed in the Rec. No. field.

The log file includes the following information:

20031113Date (YYYYMMDD)

132054Time (HHMMSS)

LEAUser
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10000018Rep / Grp. ID

Aurea CRM winModule

N for new records

U for edited records

D for deleted records

Mode

e.g. ImportFunction

FIInfo Area

1Record ID

F0Field No.

F1;6Field

The following fields are logged:

• The fields containing the records unique key, e.g. F0 ;1 ;F1;167; for company
records (FI_StaNo = 1; FI_SerNo = 167).

• All fields defined for logging in the rights format, see Log - Write.

Note:  Interactive triggers are treated and logged as manual changes.

Deleting Log Entries
Learn how to delete log entries.

To delete log entries:

1. Open the Log - Read or Log - Write info area in the Rights module.

2. If you wish to delete the entries in a specific time period, enter the desired dates
in the Start Date and End Date fields.

Note: You cannot restrict the logs to be deleted to specific reps or info areas.

3. Click Delete.

The log entries are deleted.
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Variables
Use the Variable info area to define variables with values that change according to
the current rep's data (e.g. country, tenant etc.).

You can use variables in many areas of Aurea CRM, see Using Variables on page
256. Example: You could define a trigger that uses revenue thresholds for company
classifications based on the country the company is located in. The variable is used
with the appropriate value for each rep.

Variables can be maintained in Aurea CRM win (see Defining Variables on page 253)
and Aurea CRM web (see Variables in the Aurea CRM web Administrator Guide).

Defining Variables
Learn how to define variables.

Each variable consists of a "header" record (in the Variable (Z5) info area) that
determines the name and type of the variable and an arbitrary number of child
records (in the Variable Value (Z6) info area) containing the criteria and possible
values of the variable.

To define a variable:

1. Switch to the Variable info area in the Rights module.

2. Click on  (New).

3. Enter a Name for the variable.

Note:  Ensure that the name is unique, since it is used to reference the variable.

4. Select an Info Area and Field Name. Selecting an info area and field name only
serves to determine the data type of the variable; the variable can be used for
any field (of the same type).

Select "Condition" in the Type field if you want to define the variable as a condi-
tion, see Defining Conditions as Variable Values.

Enable the Lock field to lock an entry. The variable is then ignored.
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5. Save.

6. Define the required values, see Defining Variable Values.

Note:  Changes to variables and values are not active immediately but only after
the time specified as Cat. refresh  frq. (default: 30 minutes), see Station Configu-
ration on page 233.

Defining Variable Values

You can define any number of variable values based on a combination of criteria
applied to the current rep or station.

To define a value:

1. Select Variable value from the context menu.

2. Click on  (New).

3. In the upper section of the mask, define the criteria that need to apply for the
value to be used. In order for a variable to be used for a cer tain rep, the criteria
must be either empty or match the values entered in the rep or station record.

The following values are taken into account when searching for a suitable variable
value:

• Tenant: The tenant number of the current rep (additional tenants are ignored)

• Station number: Current station number
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• Rep Group: The group the current rep belongs to. (The Org. Group in the Rep
info area (ID) and groups assigned via the Group Allocation info area (GZ)
are taken into account.)

• Rep: The current rep's ID

• Login role: One of the login roles assigned to the current rep

• Country: The country entered in the current rep's record

• Language: The current Aurea CRM language

In addition, you can use Info Area and Condition for info area fields, to define
conditions on data from the Rep, Station and Rep Addnal Info (OTC only) info
areas that must be met by the current rep or station in order for the variable value
to be applied.

Note:  If there are several suitable entries, the entry with the most matching
criteria is used. If no suitable entry is found, but an entry is present where the
Default check box has been enabled, this entry is used. If the entry flagged as
Default has the highest number of matching criteria, it takes precedence over
other entries with the same number of matching criteria.

4. In the lower section of the mask, enter the actual value of the variable. If you
have selected a field in the parent record (Z5), different input fields are available
depending on the selected field's type: Text, integer, catalog, rep, date, time,
decimal, logical (Boolean, i.e. true or false), link (allowing you to select a link to
a record).

Note:  If you do not select an info area and field for a variable (which is not a
"Condition"), only the Var. Text value is taken into account. You can only define
string or numeric values in this field.

Link fields defined as variable values are evaluated as follows (depending on the
field to which the value is written):

• The complete reference text is transferred if the target field is a reference field.

• The complete link is transferred if the target field is a generic link.

• The complete link is transferred if the target field is par t of a link and a link
exists between the two info areas (i.e. target info area and link).

• If the target field is a text field, the link to the record is copied in the format
"<info area code>-<station number>-<serial number>".

5. Save.

Defining Conditions as Variable Values

In some cases, the operator used in a condition is also variable, not just the com-
parison value:
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If you select "Condition" as the Type in the variable definition, you can enter condi-
tions (in the Var. Text field) as variable values:

• Enter the condition as text (e.g. F35='A').

• Or click on the arrow and define the condition in the Define Search Conditions
dialog (Aurea CRM win only).

Note: Variables of type "Condition" can only be used in conditions (and not in
workflows or triggers).

Example

You define a country-dependent variable with different criteria for A-customers:
Revenue for companies in Germany must exceed 100,000, while "A" must be entered
in the ABC field for companies in Austria.

The condition can be applied to any field, as the condition is replaced by the condition
defined in the Variable Value record.

For reps in Germany, the condition is applied to the company's revenue, but for
reps in Austria to the ABC field.

Using Variables
Learn how to use variables.

Variables can be used in the following areas:
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Workflows

When defining a workflow, parameters can be directly initialized with a variable. For
details, see Defining Parameters in the Aurea CRM automator User Manual.

Triggers

You can define triggers that write variable values to fields, see User-defined Variables
on page 182.

XML Reports

If you enable the Output variables option (EmitVariables=true) in a report format,
all variable values valid in the current context are included in the XML output
(<Variables> node). For details, see Reports in the Aurea CRM win User Manual.

Conditions

Variables can be used as comparison values in conditions, see Defining Conditions
in the Aurea CRM win User Manual.

Note: Variables cannot be used in extended conditions or selections.

Aurea CRM web: Variables can be used in filters and queries defined in CRM.de-
signer.

Example: A variable with values defined for different rep groups. The variable can
be used to define a condition that determines the minimum revenue for category A
customers.

When defining the condition, select "Variable" from the Compare with field and
enter the name of the variable or click on  (Select variable value) to select the
variable.
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When evaluating the condition, the value defined for the current user's rep group
is used as the comparison value.

History
The history tracks who made which changes to a record, and when.

This provides an overview of the history of the record. Adding and deleting records
is not tracked by the history, >> Log - Write.

The history needs to be enabled for each info area in the rights settings, >> Enabling
the History on page 259.

A history record is added for each record. Changes are saved in a BLOB (Binary
Large Object) and can be displayed in the History level, see Displaying the History
on page 260. The history is written irrespective of the write access rights of the current
user, i.e. Deny Upd is ignored when applied to the History info area.

Note:  No history is displayed or output in reports for fields that the current user is
unable to access due to their access rights.

You can configure which changes are displayed in the history,see Conditional Access
to Info Areas on page 142. For example, if you define "Updated by = Current rep",
only changes made by the current rep are displayed in the history. If you define
"Created by Rep ID = Current rep", only those records that were initially added by
the rep are displayed in the history.

You can use the following vir tual fields to output history records in XML reports or
to export data in the history: ID, Stat.No., Date, Time, Rep ID, Rep, Windows User
Name, Windows computer name, Version, Module, Field Number, Field Name,
Old Value, New Value, Time Zone.

Note: These fields are only available for XML reports and export purposes and
otherwise have no function.

258AUREA CONFIDENTIAL

Chapter 3: Using CRM Core



For more information on outputting the history in XML reports, see XML Format in
the Aurea CRM win User Manual. For more information on exporting the history,
see Selecting Fields in the Aurea CRM win Administrator Guide.

History records can be communicated if the primary key of the record the history
refers to consists of the station number plus serial number. This allows you to track
changes to records other stations, see Communicating System Tables in the Aurea
CRM win Administrator Guide.

Enabling the History
Learn how to enable history for an info area.

To turn on the history for an info area:

1. Switch to the Rights info area in the Rights module.

2. Click in the History cell for the desired info area.

The History area is displayed

3. Enable Log History.

4. The following options are available:

• Log History: Enable this option to turn on the history for the selected info area.
The Module and Functions cells are automatically enabled if you enable this
option.

• Archive History: Enable this option to determine that history records are
retained even if the record they refer to is deleted. To export archived history
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records, the History info area must be the first info area in the export format,
see Selecting Fields in the Aurea CRM win Administrator Guide.

• With Conditions: Enable this option to determine conditions for the history,
see Conditions in the Aurea CRM win User Manual.

• Conditional (prior to changes): Enable this option to determine conditions
that should be tested before the record is updated.

• Module: Use these options to determine the modules that the history tracks.
Click on  to display the individual modules. Enable the Module cell to enable
all modules. Disable those modules that you do not wish to track in the history.

• Functions: Use this option to determine which functions (marketing activity,
catalog maintenance etc.) the history tracks. Enable the Functions cell to
enable all functions. Disable those functions that you do not wish to track in
the history.

Note:  Aurea recommends to disable the history for triggers and/or workflows
for info areas where a lot of triggers and/or workflows are executed. Otherwise
the history may grow very fast and have a negative impact on performance
when updating records.

• Attachment: This option is available for those info areas in which compressed
data is stored in binary form within fields (documents, formats). Any change to
the length of the binary code is logged in the history.

• Exclude the following fields from history: Use this option to determine which
fields are excluded from the history. Click on  to display all fields.

5. Click on  (OK).

6. Save the rights format.

Once the rights have been assigned to a station, group, rep or login role, changes
to the selected info areas are logged according to your settings.

Displaying the History
Learn how to display history for an info area.

To display a record's history:

• Select Data > Display History from the menu in the Rights, Maintenance and
Communication modules.

• Define context menu options in the desktop settings used to open the history from
the main module, see Accessing the History from the Context Menu in the Aurea
CRM win Administrator Guide.

For information on the view options, see History in the Aurea CRM win User Manual.
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For information on displaying a record's history in Aurea CRM web, see Displaying
a Record's History in the Aurea CRM web Administrator Guide.

CRM.phone
CRM.phone for Aurea CRM is a telephone-based solution.

If you have installed CRM.phone, you need to configure the component in the Rights
module.

Note:  If you have not installed CRM.phone, you still need to enter the telephone
prefixes used by Aurea CRM to search for telephone numbers, see Basic Settings
for CRM.phone on page 261.

Further information on CRM.phone can be found in the CRM.phone User Manual
and in the CRM.phone Administrator Guide.

Basic Settings for CRM.phone
The options used to configure CRM.phone are accessed from the Extras menu in
the Rights module.

Note:  If you do not use CRM.phone, you still have to set the basic settings using
the Telephone Profile option. You need these basic settings to search for phone
numbers and e-mail addresses in Aurea CRM.

To determine the basic settings:

1. Open the Rights module.

2. Select Extras > Telephone Profile from the menu.

The Telephone Profile dialog box opens.
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3. You can enter the following information under Incoming Call and Outgoing Call:

• International: The leading digits used for international calls.

Country codes are standardized, e.g. Germany 49, United Kingdom 44, Austria
43. When dialing you must add a prefix to this country code. In Europe, a double
zero is generally used; in Australia, '011' is used.

Depending on the telephone system, you can enter the symbol + instead of the
prefix of the corresponding country.

• National: The leading digits used for national calls. In most countries, a leading
zero is used.

• External number prefix: The prefix required to call an external number. The
prefix can include * or #.

Note: Whether you need to enter the External number prefix depends on
whether your telephone system includes the external prefix with incoming calls.
If an external prefix has been configured in your telephone system, the prefix
is included with phone numbers and you need to enter the prefix here. If your
system is not configured to use a prefix, leave this field blank. You must always
enter the prefix for external calls.
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4. Enter your country and area code and company number under Local Settings:

• Country code: Your international country code

• Area code: Your area code

• Own company no.: Your local telephone number (without area or country code
or extensions)

5. Use the settings under Search Algorithm Settings to determine how telephone
numbers are searched for, see Searching Using the Complete Number.

• Truncated digits: The maximum number of digits that are removed from the
end of the telephone number during the search.

• Do not check hits for company number: Enable this option to terminate the
search even if only a person number is found.

6. Click  (Save).

The Save dialog box opens.

7. Enter a name for the profile.

8. Click OK.

9. Click Close.

Telephone Number Search
Users can search for telephone numbers in Aurea CRM win and Aurea CRM web.

If CRM.phone is installed, telephone numbers can be searched for automatically
when an incoming call is received.

Telephone numbers of companies and persons are stored in a standardized and
indexed format in the Tel.No./E-mail (TN) info area. The search always takes place
in this info area.

Determining the Complete Number when Searching

The logic described here is used:

• when manually searching for telephone numbers in the company and person
search in Aurea CRM win.

• in Aurea CRM web, if the Original Number check box is enabled.

Example settings:

• Country code: 0043

• Area code: 01

• Own company no.: 87855

• International: 00

• National: 0
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• External call prefix: 0

• Internal call length: 5

In contrast to the method used to determine the number of an incoming call, no
prefix is used for external numbers, to save users from needing to enter the prefix
when searching manually. In addition to the values entered under International,
the following prefixes are also used:

• International prefix: 00 or +

• National prefix: 0

Using the above the settings, the telephone numbers are transformed as follows:

100 > 43187855100

444444 > 431444444

0732333333 > 43732333333

004989222222 > 4989222222

Searching Using the Complete Number

Aurea CRM carries out the following steps when searching:

1. Generate the complete number.

2. Search for one or more identical telephone numbers in the Tel.No./E-mail info
area (TN):

• If the number is found in a company, the company is displayed.

• If a the number is found in the Tel 1, Tel 2 or Mobile Tel. fields of a contact
person (CP), the contact person is displayed.

• If for a contact person (PE) the number is found in the Private Tel. field, the
system also searches for links to the Contact Person (CP) info area:

• If the person is linked to at least one Contact Person (CP), all linked contact
persons are displayed.

• If the matching PE record is not linked, the PE record is displayed.

Note:  Instead of the standard algorithm you can also set the Display Person
configuration option to PE_NO_CP (if a PE record is found, no linked contact
person (CP) records are displayed) or PE_With_CP (all linked contact persons
(CP) and the PE record are displayed). You can define these options in the
Configuration info area in the Rights module (Telephone/E-Mail Search
category).

The search continues until a person record (PE or CP) is found.

If no person is found, the search continues with the following step.

3. The database is searched for telephone numbers star ting with the given number.
If matching numbers or numbers star ting with the given numbers are found, the
hits are listed. A number that was found in the previous step is not listed twice.

If no matching telephone number is found, the search continues with the following
step.
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Note:  If you uncheck the Do not check hits for company number check box in
the telephone profile, the hits must contain at least one company. If this option
is enabled, only persons are listed as hits.

4. If no matching number is found, the last digit is truncated and the remaining
number is searched for.

The search stops:

• When a matching telephone number is found.

• After a specified number of truncated digits (as defined in the telephone profile,
by default 3), >> Basic Settings for CRM.phone.

• When the number has 6 digits left.

Maintenance Module
Here you learn to perform basic configurations in the database and maintain and
upgrade it as per your need.

Use the Maintenance module to maintain your database. You can:

• add and maintain new countries and cities, see Country Info Area on page 265 and
City Info Area on page 268

• define and update catalog values, see Catalogs on page 270.

• change the data model (edit or define info areas, fields and catalogs), see Data
Model on page 280.

• manage the user-defined texts, see Text Info Area on page 368

• change or delete large quantities of data, see Update Level on page 385 and Delete
Level on page 383

Before you star t working with this module, star t a data back up to save all Aurea
CRM data.

Country Info Area
All the information on countries and cities used in your database is stored in the
Country info area and in the City info area.

Each country is added to the Country catalog when it is added to the database for
the first time, see Catalogs on page 270.

Cities are linked to countries using the language catalog:
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The Maintenance module is used to maintain these links, which result in automatic
entries in the database whenever new records are added.

Adding a New Country

Use the Country info area to store country details.

To add a new country:

1. Start the Maintenance module, see Star ting Modules in the Aurea CRM win
Administrator Guide.

2. Switch to the Country info area.

3. Click  (New).

4. Enter the name of the country in the Country field or select an entry from the
country catalog.

5. Enter the number of digits in the post code that should be compared when matching
up addresses in the Match-up Length field, see Match-up in the Aurea CRM win
Administrator Guide.

For example, in Austria postal codes are made up of four digits, with the first
three defining the federal province and the area, and the last digit specifying the
post office. In this case, the Match-up Length is "3". In Germany, postal codes
are five digits (star ting with a zero) so "5" should be entered.

6. Select View > All Mask Fields from the menu. Enter the language for the country
in the Language field.

Each country is also linked to its own catalog of academic titles, see Title Catalogs
on page 278.

7. Enter fur ther information on the country (for details on the individual fields, refer
to the field help).

8. Save the record.

If this country is now entered when adding a new record (e.g. companies, persons,
additional addresses, properties (BTB only)), the international dialing code (Country
Code field) and Label (for companies and persons) are transferred automatically
from the country table. Subsequent changes to records in the Country info area
are not automatically propagated.

You can add an entry to the Configuration info area which prevents fields from the
country table being transferred to other info areas, see Country Table on page 34.

If a new country is entered while adding a record, the new country is automatically
added to the Country info area, see Adding a New Country (Aurea CRM win Main
Module).
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Cities (Context Menu)

Every city entered in the City info area is linked to a country using the Country
catalog.

To display all cities in a specific country:

1. Select the country in the Country info area.

2. Select Cities from the context menu.

All the currently available cities in this country are displayed.

Conditions defined for the City info area are not applied when switching to this view.
Either define a new condition or click  (Find) to search for the desired city.

Adding a New Country (Aurea CRM win Main Module)

New countries can be added from the Aurea CRM win main module in the Company,
Person, Person in Company, Additional Addresses and Property (BTB only) info
areas.

To add a new country from the Aurea CRM win main module:

1. Add a new record, e.g. a company.

2. Enter a country not yet present in the Country info area in the Country field.

3. Save the record.

The country is added to the Country info area.

If a company or person was added, the following information is also transferred to
the Country info area:

CountryCompany/Per-
son

Country CodeCountry CodeCountry Code

LabelLabelLabel

Subsequent changes to the data in the Aurea CRM win main module are not auto-
matically transferred to the Country info area.

You can prevent new countries from being added from the Aurea CRM win main
module by configuring the data model appropriately, see Mapping on page 307.

Note:  Aurea recommends adding new countries from the Country info area. A
country that has been added from the Country info area is always available from
the country catalog. An entry in the Country catalog does not however mean that
the country is automatically available in the Country info area. If you enter a new
country in a record, but then do not save the record, the new country is added to
the country catalog but not to the Country info area.
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City Info Area
Information relating to the cities in the database is stored in the City info area.

Note:  Unlike for countries, there is no city catalog.

Adding a New City

To add a new city:

1. Open the Maintenance module and switch to the City info area.

2. Click  (New).

3. Select the country the city is located in from the Country field. This field is used
to link the city with the Country info area.

Note:  Do not add new countries from the City table, as these are not transferred
to the Country table.

4. Enter the name of the city in the City field.

5. Enter the range of postal codes applicable to the city in the From Postal Code
and To Postal Code fields.

If several cities have been added with the same post code, a serial number is
automatically assigned in the Postcode ID field.

6. Enter fur ther information on the city. For more information on the individual fields,
refer to the field help.

7. Save the record.

When adding new records in the Aurea CRM win main module (companies, persons,
additional addresses, properties (BTB only)), fur ther information is transferred from
the Country and City info areas once the city and postal code have been entered,
see City Table and Database.

Note:  In order for users to be able to use these functions, they require read access
to the City info area, >> Defining Rights at the Info Area level on page 140.

If several cities have been entered with the same postal code, a list of the cities is
displayed and the user can choose the desired entry.
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Subsequent changes to data in the City info area are not automatically propagated.

You can add an entry to the Configuration info area which prevents fields from the
city table being transferred to other info areas, see City Table on page 30.

If a new city is entered while adding a record, the new city is automatically added
to the City info area, see Adding New Cities (Aurea CRM win Main Module).

Adding New Cities (Aurea CRM win Main Module)

To add a city from the Aurea CRM win main module (from the Company, Person,
Person in Company, Additional Address and Property (BTB only) info area):

1. Add a new record, e.g. a company.

2. Enter the country in the Country field.

3. Enter the postal code and City.

4. Save the record.

The city is added to the City info area.

Note:  In order for users to be able to use these functions, they require read access
to the City info area, see Defining Rights at the Info Area level on page 140.

Upon saving the record, the Country, City, Postal Code and Postcode ID are
transferred to the City info area (the Postcode ID is not displayed in the Aurea
CRM win main module). The entry in the Postal Code field is transferred to the
From Postal Code and To Postal Code fields in the City info area. Further fields
are also transferred depending on the info area and ver tical, see City Table and
Database.

Subsequent changes to the data in the Aurea CRM win main module are not auto-
matically transferred to the City info area.

You can prevent new cities being added from the Aurea CRM win main module by
configuring the data model appropriately, see Mapping on page 307.

City Table and Database

The Company, Person, Person in Company, Additional Address and Property
(BTB only) info areas are linked to the Country and City tables via the country and
postal code.

The following fields are transferred both to and from the City table when new records
are added (depending on the info area and ver tical):
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FSOTCBTBInfo
Area

Rep, County, AreaRep, Block Name, Block
No., Block Segment,
County, Area, Office Rep,
Nielsen Area, Area Code

Rep 1, Rep 2, County,
State, Area, Jurisdic-
tion, Pol. District,
Area Code

Compa-
ny

County, Area CodeCounty, Area CodeState, Area CodePerson /
Person
in Com-
pany

Area CodeArea CodeState, Area CodeAddition-
al Ad-
dress

--Rep 1, Rep 2, County,
State, Area, Jurisdic-
tion, Pol. District

Property

You can add an entry to the Configuration info area which prevents fields from the
city table being transferred to other info areas, see City Table on page 30.

You can prevent new cities being added from the Aurea CRM win main module by
configuring the data model appropriately, see Mapping on page 307.

Cities and Communication

During communication city records are only matched up if the following fields are
identical: Country, From Postal Code, Postcode ID, City, Area  Code.

When inputting company records, no new records are added to the City info area.

For information on communicating records, see Communication in the Aurea CRM
win Administrator Guide.

Catalogs
Catalogs are lists of predefined values you can select when entering data.

For fur ther details, see Catalogs in the Aurea CRM win User Manual.

Fixed catalogs are par t of the data model. They are predefined by the system (e.g.
Status and Priority) and cannot be edited by users. You can edit and create fixed
catalogs as part of the data model, see Editing Predefined Fixed Catalogs on page
286 and Adding New Fixed Catalogs on page 289.

Variable catalogs can be created and renamed as part of the data model, see Adding
New Variable Catalogs on page 292 and Renaming Predefined Variable Catalogs on
page 291.
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Variable catalog values are stored in the Catalog (KA) info area, see Catalog Info
Area on page 271. Catalog values can be added, edited and deleted in the Catalog
info area, see Editing Variable Catalogs on page 273.

Changes to catalogs are saved in the Catalog Maintenance (KW) info area on the
catalog maintenance station and transferred to other stations in your setup during
communication, see Defining a Station on page 112 and Communicating Catalogs in
the Aurea CRM win Administrator Guide.

Note:  Access to the Catalog Maintenance info area is controlled via the CRM
process 1.5.2.1.1. "Catalog Maintenance" (CRM process ID 312600?) which is
disabled by default. Only the SU and users for whom this CRM process is enabled
can edit values of variable catalogs (via the Catalog level in the Aurea CRM win
Maintenance module or via catalog maintenance in Aurea CRM web).Aurea
recommends that you never add/change catalog values to the database directly and
prevent or restrict users from editing and deleting catalog values on all stations
other than the catalog maintenance station, to prevent data inconsistencies,
see Defining Access Rights for Variable Catalogs.

The following actions to not create catalog maintenance records:

• Creating a new catalog value directly in the Catalog selection dialog in Aurea
CRM win or Aurea CRM web

• Creating a new catalog value during import

Catalog values that have been added in such a way can not be deployed correctly
via CRM.cockpit.

Catalog Info Area
Variable catalog values in all languages are stored in the Catalog info area.

Languages are defined in the Language info area, see Languages on page 109.
Catalog values can be edited, deleted and added in catalog infoarea.

Information including the following is saved for each catalog value:

• Catalog No.: The catalog number (corresponds to the No. column in the data
model). For example, the Country field in the Company info area accesses the
Country catalog (number 2).

Note: The Catalog No. is displayed in square brackets after the catalog name
in the drop-down list.

• Language No.: The number of the language the catalog value was added in. The
catalog base language always uses language number 0 in the Catalog info area.

• Code: The number of the catalog value.

• Text: The text of the catalog value.
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• Ext. Key: Key of the catalog value in an external system.

• KA-TenNo: The number of the tenant the catalog value was added for, see Tenants
and Catalog Maintenance on page 228.

The following combinations are unique keys for catalog values:

• Catalog No. + Language No. + Code

• Catalog No. + Text (in the base language) + KA-TenNo

Only the catalog value's code is stored in records. You can display the codes by
clicking on  (Number) in dialogs containing catalog values. Catalog values are
displayed in the current language, see Multi-Language Catalogs on page 277.

Catalog values in formats are saved using the tenant number and catalog text in
the catalog base language. The catalog base language is defined in the Language
info area (Rights module), see Defining Languages on page 109.

Communication and CRM.cockpit match up catalog values by the tenant number
and catalog text in the catalog base language. On the target station the codes are
generated again, i.e. they may differ between stations.

It may be necessary to use absolute references (reports, additional programming)
to catalog values in distributed systems (separate development, test and live sys-
tems). As the value in the catalog base language may be changed, you can use the
Ext. Key in the catalog base language to reference the catalog value. The external
key can be created automatically using a configuration entry, see Unique System-
wide Identification of Catalog Values.

When importing catalog values into the Catalog info area, you can either match up
values directly using the Language No. field (see Selecting Fields in the Aurea
CRM win Administrator Guide) or using the external key(see Importing Catalog
Values using External Keys in the Aurea CRM win Administrator Guide). When im-
porting values into other info areas, catalog values can be matched up using the
text in the catalog base language and/or using the external key.

Unique System-wide Identification of Catalog Values

The combination of Catalog No. + Text (in the catalog base language) + KA-TenNo
serves as the system-wide key for catalog values (e.g. when communicating). As
the catalog base language is generally a language that is used in the system, the
catalog text may be prone to changes.

To uniquely identify catalog values you can use the external key in the base lan-
guage. The external keys remain unchanged when transferring data between devel-
opment and live systems (e.g. using CRM.cockpit), so that for example reports that
query specific catalog values work on all stations.

You can prevent users of the live system from editing or deleting these external
keys in the access rights, see Defining Access Rights for Variable Catalogs. You
can thus ensure that no keys are overwritten when communicating between the live
and development systems.
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To automatically create external keys for the catalog base language when adding
catalog values:

1. Enable the Automatically  enter external keys configuration entry, see Catalogs
on page 30.

To create external keys for the catalog base language for existing catalog values:

1. Start mmba.exe on the catalog maintenance station using the --genextkey
parameter, see mmba.exe Parameters on page 13.

Existing external keys are not overwritten.

External keys are generated using the following format: <station>_<catno>_<code>
or <station>_<catno>_<code (parent)>_<code>.

Examples:

1_2_37: Station 1, Country catalog, catalog value with code 37

100_46_1_2: Station 100, Interests catalog, parent catalog code 1, catalog value
with code 2

If an external key is already present in the database as the external key of another
catalog value, no key is created for the current catalog value. In this case, the fol-
lowing message is written to the active module's log file: Catalogs ;Warning ;Gener-
ated external key already exists: '1_18_2'. In this case, you need to enter the
external key manually, see Editing Variable Catalogs on page 273.

Editing Variable Catalogs
Learn how to edit variable catalog.

To edit catalog values:

1. Open the Maintenance module and switch to the Catalog level.

The drop-down list at the top of the page contains all available variable catalogs.

2. Select the catalog you wish to edit from the list or click on  (Find) to search for
the catalog (by name or number). The search works as described for the CRM
process search, see Searching for CRM Processes on page 102.

The catalog values are displayed. The number of catalog entries is displayed in
the Records field.
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3. Make the desired changes:

• Click  (New) to add a new catalog value. Enter the new catalog value (and a
tenant number if applicable) in the dialog box, see Tenants and Catalog Main-
tenance on page 228. Click OK.

• Select a catalog value and click  (Edit) to edit a catalog value: Enter the new
value in the dialog box, and click OK. The edited value is displayed in blue.

Note:  Catalog fields have a maximum length of 80 characters. A catalog should
consist of a maximum of 1,000 entries: The more values a catalog contains,
the longer it takes to load the catalog.

• Select a catalog value and click  (Delete) to delete a catalog value. (You may
need to specify a parent catalog.)

The Replace with? dialog box is displayed:

• If you simply wish to delete the value, leave the field empty.

• If you wish to replace the value with an existing value, double-click in the
field to open the catalog and select the desired value.

Click OK. The catalog value is displayed in red.

• Select Delete All from the context menu to delete all the entries in a catalog.

• Tenant: Enter the tenant number in the Tenant column, see Tenants and Cat-
alog Maintenance on page 228. The tenant number and the catalog value are
displayed in blue.

• Ext. Key: You can enter an external key for each language in the Ext. Key
column, if you are using external keys for catalog values.
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External keys can be used to match up catalog values when importing data,
see Importing Catalog Values using External Keys in the Aurea CRM win Ad-
ministrator Guide.

The external key for catalog values in the catalog base language can be created
automatically, allowing catalog values to be identified uniquely in distributed
systems, see Unique System-wide Identification of Catalog Values

• Sort Order: You can define the sor t order of catalog values in catalog fields
for each language. Enter numbers in the Sort Order cells of the desired
language. If two values have the same number, these values are sor ted
alphabetically.

When selecting catalog values from catalog fields, catalog values for which a
sort order has been defined are displayed first (and sor ted numerically according
to the sor t order). Values without a sor t order are sor ted alphabetically at the
end of the list of values.

• Description: Enter a description of the catalog value.

• Valid from/to: Enter dates in these fields to define the time period the catalog
value is valid for. The catalog value is unavailable outside the defined time
period. Catalog values in existing records and formats (e.g. conditions) are not
affected by this setting.

Note:  Use the External Key, Sort Order, Description and Validity entries in
the context menu to hide/show the corresponding columns in the table. If no
value is entered in the Ext. Key, Sort Order, Description, Valid from and
Valid to fields, the value entered in the parent language is used (if available).
If this value is not present, the corresponding value in the catalog base language
is used.

• Lock: Click in the Lock column to lock the catalog value. Locked values are
no longer visible when selecting a value from this catalog. Catalog values in
existing records and formats (e.g. conditions) and the import of catalog values
are not affected by this setting.

Note:  If a catalog value is locked in a language using the Lock column, the
lock applies to this language, and the value in the parent language is used. If
the parent language's value is also locked, the value in the catalog base
language is used. If this catalog value is also locked, the lock applies to all
languages. For more details, >> Behavior of Lock and Validity with Hierarchical
Languages.Use the CatalogLockOnBaseLanguage=off entry in the mm.ini file
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to determine that a lock and/or a validity period applied to the catalog base
language is not applied to all other languages, >> [Option].

4. Select Apply Changes from the context menu, >> Applying Changes to Catalogs
on page 276.

Applying Changes to Catalogs
Learn how to apply changes to catalogs.

To apply the changes to the catalogs:

1. Select Apply Changes from the context menu in the Catalog level.

2. Verify that the correct values are displayed in the list.

• Click on  (OK) to return the catalog without performing any changes.

• Click on a catalog value in the Catalog column to remove an entry from the list
and cancel any changes made in the Catalog info area. Confirm the prompt
with Yes.

3. Click on  (Start) to begin applying catalog changes.

For each change a catalog maintenance record (KW) is created and the catalog
values are deleted or replaced accordingly. Changes only take effect once Aurea
CRM win has been restar ted or the time period entered in the Cat. refresh  freq.
field has expired, see Station Configuration on page 233.

The catalog maintenance records are automatically communicated to other stations,
see Communicating Catalogs in the Aurea CRM win Administrator Guide.

If catalog values are used in formats (e.g. conditions), the pro*.cfg file that stores
user-defined settings may need to be deleted for the module that uses the format,
see \<user name> in the Aurea CRM win Administrator Guide
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Multi-Language Catalogs
International companies generally work with various language versions of Aurea
CRM, making it important that catalog values are available in all languages.

To work with multi-language catalog values:

1. Define the desired languages in the Language info area, see Defining Languages
on page 109.

2. Enable the Catalog Lang. check box for all languages that you wish to use for
catalog values.

3. Enable the Catalog Base Lang. check box for one of the languages. The catalog
base language forms the unique catalog key together with the tenant number,
and is used as the basis for translating catalog values into other languages.

If a catalog value has not been defined for a specific language (or the language's
parent language), the entry in the catalog base language is displayed when using
that language.

Note:  Only enable this check box for a single language and do not subsequently
change the catalog base language.

4. Assign the desired languages to stations, see Assigning Languages on page 113.

Note:  If you have defined a language as a catalog language and have not
assigned the language to a station, catalog values on that station in the missing
language are displayed using the catalog base language.

5. Assign all defined languages to the catalog maintenance station.

A column is displayed for each language in the Catalog info area. The first column
contains the catalog base language, see Editing Variable Catalogs on page 273.

New catalog values should always be added on the catalog maintenance station in
the catalog base language, and translations should be entered in the corresponding
language columns.

If new catalog values may be added on other stations, check catalog values after
communicating and add any missing translations. Catalog changes are communicated
to other stations in the next communication cycle, see Communicating Multi-language
Catalog values in the Aurea CRM win Administrator Guide.

If you are using different external keys for catalog values in different languages,
this is taken into account when importing data, see Importing Catalog Values using
External Keys in the Aurea CRM win Administrator Guide.
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You can define fixed catalog values in multiple languages in the data model,
see Editing Predefined Fixed Catalogs on page 286 and Adding New Fixed Catalogs
on page 289.

Use CRM.translation tool to translate variable catalog values and user-defined texts
in the data model, see CRM.translation tool on page 474.

Behavior of Lock and Validity with Hierarchical Languages

If you have defined sub-languages (language "variants") you can define catalog
values for each sub-language, see Defining Language Variants on page 110.

The following logic applies for locked catalog values within a language hierarchy:

• catalog value locked in the current language > not displayed in catalog selection
dialog

• catalog value locked in the parent language > the first available (i.e. not locked)
value from the hierarchy (i.e. the parent's parent etc.) is displayed

• catalog value locked in catalog base language > the value is locked for all
languages

• catalog value locked in base language and mm.ini entry CatalogLockOnBaseLan-
guage=off > the value is displayed for all child languages (where it is defined),
see [Option]

• no catalog values defined in the current (child) language > the first parent language
containing values (no matter if locked or not) is used.

The same logic applies for validity periods defined for catalog values.

Note:  Locks and validity periods do not affect catalog values used in existing
records and formats (e.g. conditions).

Title Catalogs
Learn about the logic to enter academic titles in the Person in Company info area.

Aurea CRM uses the following logic to enter academic titles in the Person in
Company info area:

The Acad. Title (or Abbr. Title in the FS ver tical) and Full Title catalogs are lan-
guage-dependent and linked with one another via a 1:1 link.

A language needs to be selected before entering values in the Acad. Title catalog
(Abbr. Title in the FS ver tical).

Use the Full Title catalog to store the corresponding full title in each language:

1. Select the Full Title catalog from the drop-down list.

2. Select the desired Language.

The current entries in the Acad. Title (Abbr. Title in the FS ver tical) catalog are
displayed in a separate column.
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3. Enter the desired values in the corresponding language column, see Editing
Variable Catalogs on page 273.

The entries in the Full Title catalog are output in labels if you include the Full title
placeholder in labels, see Defining Label Formats in the Aurea CRM win User
Manual

Note:  Entries can only be added to the Full Title catalog from the Maintenance
module; they cannot be added from the Person in Company info area. All other
title catalogs are assigned to fields in the Person in Company info area.

The BTB and OTC verticals include the following additional title catalogs:

• Full Acad. Title: language-dependent catalog with no connection to the Full
Title catalog.

• Title: language-independent catalog with no special business logic

• Long Title: language-independent catalog with no special business logic

These additional catalogs can be used to define labels using different forms of
academic and other titles. The Full Title placeholder is redundant if you use the
Full Acad. Title.

279AUREA CONFIDENTIAL

Maintenance Module



Data Model
The Data Model level allows you to configure Aurea CRM's data model (info areas,
fields and catalogs) to meet your individual requirements.

You can either edit the "core" elements supplied by update or add and edit newly
"generated" elements. The data model is saved as a format, see Formats in the
Aurea CRM win User Manual.

The current design is displayed under Design. The currently active data model used
by Aurea CRM is displayed under Active. Any backups you may have made are
displayed under Archive.

A diagram of the default data model can be downloaded from https://support.au-
rea.com.

Use the --writexmldef parameter to output the current data model (info areas,
fields, catalogs, links and indices) as XML, see mmba.exe Parameters on page 13.

Accessing the Data Model Level

The data model can only be edited on the main office and only by the SU or a user
who has access to the CRM process 1.5.1.6. "Data Model", see CRM Process
Configuration on page 98.

The SU and users with appropriate roles can open the data model on other stations
in read-only mode.

The Data Model level is not available to other users.

To grant users read-only access to the data model on the main station, assign a
read-only role to these users granting access to the "Data Model" process, see Rep
Roles on page 123.

The data model can only be edited by a single user at a time: Once a user begins
editing the data model, other users can only access the data model in read-only
mode, irrespective of their roles.
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Fixed Catalogs

Fixed catalogs are predefined by the system (e.g. Status and Priority fields) and
cannot be changed by users.

Fixed catalogs can be edited in the Data Model level, see Editing Predefined Fixed
Catalogs on page 286.

Variable Catalogs

Entries in variable catalogs can be added, edited and deleted, provided a user has
the necessary access rights, see Defining Access Rights for Variable Catalogs.

You can only define or rename variable catalogs in the Data Model level.

Use the Catalog info area to edit catalog value and configure fur ther settings,
see Catalogs on page 30.

Info Areas

You can edit and add info areas in the Data Model level.

Editing the Data Model - General Procedures
Learn about the identical steps needed to be carried out for all info areas, fields
and catalogs you wish to edit, when editing the data model.

If you make changes in the data model of an info area and the changed fields are
also listed in another info area, then you should ensure that similar data model
changes are performed on the second info area.

For example, if you make changes in the data model for the CP or PE info areas
and if the changed fields are listed in the KP info area, you should ensure that the
same changes are made in the KP info area.

To edit the data model, perform the following steps:

1. Click on the desired entry in the tree view (Core or Generated under Fixed
catalog, Variable catalog or Info Area).

The selected level is displayed.
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2. Click in the cell to define settings, see Tables in the Aurea CRM win User Manual.
You can:

• Edit existing elements, see Editing Predefined Fixed Catalogs on page 286,
Renaming Predefined Variable Catalogs on page 291, Editing Predefined Info
Areas on page 297 and Renaming Fields on page 340.

• Define new elements, see Adding New Fixed Catalogs on page 289, Adding New
Variable Catalogs on page 292, Adding New Info Areas on page 293 and Adding
New Fields on page 317.

• Delete elements, see Deleting Entries on page 354.

Note:  Enable the Sort selection lists alphabetically option under Extras > Other
Options in the main module to sor t options (info area type, field type, link etc.)
alphabetically in dialog boxes. If you open a sub-level, you need to click in the
newly opened level to ensure it has focus before scrolling etc.

Any changes you make are color-coded as follows:

New entries are yellow, edited entries pink and deleted entries red.

Note:  Note: If you make changes to fields used in a View, then you have to make
manual changes in the View.

When closing the Data Model level, any changes you have not yet applied to the
data model are saved in the design data model. Click on  (Save) to save the
current state of your design data model without applying the changes.

3. To apply changes to the active data model, right-click on a new, edited or deleted
entry to access the context menu. The following options are available:
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For catalogs:

• Select Apply change to apply the change to the current line to the active data
model.

• Select Apply  all changes to apply all changes to catalogs and catalog entries
to the active data model.

• Select Undo to undo any changes in the design. The line is displayed in its
original color.

For fields:

• Select Apply field format to apply the change to the field definition to the
active data model.

• Select Apply  all field formats to apply all changes to fields in this info area
to the active data model.

For info areas:

• Select Test info area to test the info area.

• Select Apply info area to apply all changes to the info area to the active data
model.

Note: You need to lock the system for all active users before applying changes
to info areas to the active data model see System Locks on page 236.

• Select Apply attribute to apply changes to the Properties field to the active
data model.

• Select Apply text to apply the changes in the Text column to the active data
model.

• Select Apply  all texts to apply changes to all fields in the Text column to the
active data model.

For details, see Applying Text Changes.

• Select Undo to undo all changes to this info area in the design. The line is
displayed in its original color.

For variable catalogs, info areas and fields:

• Select Reference search to check which formats etc. refer to a catalog (value),
an info area or field, see Reference Search on page 353.

Changes to "core" info areas that have been applied to the data model are high-
lighted in green.

4. Click on  (OK) to close a level.

5. The following options are used to manage your data models:
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Right-click on a data model under Design:

• Archive Design: Saves a back-up copy of the selected design data model in
the Archive.

• Delete design: Deletes the selected design data model.

• Import Data Model to Design (<- E-mail): Imports a data model from a suitable
e-mail in the current user's inbox, see Merging Data Models on page 523.

Right-click on the data model under Active:

• Archive current data model: Stores a backup of the current data model. The
backup is listed under Archive.

• Verify current data model: Tests whether the active data model and the
database are identical. If an error message is displayed, you need to remedy
the problem to guarantee the consistency of your data.

• Export Data Model (-> E-mail): Exports the current data model as a file. An
e-mail is created with the subject "MM_BLOB_2" and a file with the same name
is added as an attachment. This file can be imported on other stations and
merged with the data model used on the target station, see Merging Data
Models on page 523.

Right-click on a data model under Archive:

• Copy archive to design: Copies an archived data model to the design. The
current design is overwritten. The data model is only copied once the
Maintenance module is closed and after answering a prompt. After copying,
the differences to the current data model are highlighted accordingly. These
changes is then transferred to the active data model the next time changes are
applied.

• Delete Archive: The selected archived data model is deleted.
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Right-click on a data model under Data Model:

• Lock system: Opens the Lock System dialog box where you can lock the
system for active users. This is necessary to apply changes to info areas to
the active data model, see Lock System Dialog Box on page 239.

• Select user group: You can log in as an Aurea partner or user if you have the
necessary password. Depending on the selected user group, IDs for new
catalogs, info areas, fields, links and indices are assigned from different number
ranges, see Number Ranges in Aurea CRM on page 398.

Note:  On a station with a number > 10000, do not select a user group when
modifying the data model. The station number already determines the number
ranges to be used.

• Analysis: Opens the Analysis level, where you can analyze the structure and
contents of your Aurea CRM database, see Database Analysis on page 358. The
Analysis option is only available to the SU or users granted access to the "Data
Model" process in the process configuration, see CRM Process Configuration
on page 98.

• Migration: Opens the Migration level, see Migrating Data on page 407. The
Migration context menu option is only available to Aurea and its par tners (select
Select user group from the context menu to enter your password).

Communicating Data Model Changes
Learn about communicating with data model changes.

The data model is either defined on a central server or a test system. After applying
the changes to the active data model, these changes are available on the server:
you need to communicate changes to the data model to branch offices and/or other
Aurea CRM products. The entire data model is transferred and overwrites the current
data model on the target station. For more information on merging data models,
see Merging Data Models on page 523.

Communicating changes to branch offices

The data model is saved as a format. It is communicated to branch offices (irrespec-
tive of the settings in your communication format) whenever the data model is up-
dated.

When communicating, the system checks whether the data model on the main office
and target station are identical. If not, the data model is updated on the target station
before importing any other data, see Input in the Aurea CRM win Administrator
Guide.

During manual communication, the changes to the data model are input first. You
are then prompted to restar t the communication process. You need to close and
reopen the Communication module and restar t the input process.

This step is carried out automatically during automatic communication.
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Note:  Aurea recommends completing any communication cycles before editing the
data model to guarantee data consistency, see Outdated Data Model at Branch Of-
fices in the Aurea CRM win Administrator Guide.Changes to the data model can
also be communicated without problems between Oracle and MS SQL versions.

Transferring Changes via CRM.cockpit

For information on communicating data model changes using CRM.cockpit, refer to
the CRM.cockpit documentation.

Transferring Changes to other Aurea CRM Products

Apply the changes to the CRM.designer database using CRM.bulkloader, see Data
Model, CRM Processes, Roles and Catalogs in the Aurea CRM web Administrator
Guide. To immediately transfer changes to the data model to other Aurea CRM
products, the corresponding application pool needs to be stopped and restar ted.

For information on transferring changes to formats to Aurea CRM web, see Station
Configuration on page 233.

Editing Predefined Fixed Catalogs
Learn how to edit predefined fixed catalog.

1. Start the Maintenance module.

2. Switch to the Data Model info area.

3. Click on the Core entry under Fixed  catalog in the tree view.

The Fixed Catalogs table is displayed.

4. Click on the catalog you would like to edit.

The Fixed Catalog table is displayed with the original catalog entries.

5. To edit a catalog value, enter the new text in the Language Independent and
language columns. For information on applying text changes, see Applying Text
Changes.
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Note: The languages are those defined in the Language info area, see Languages
on page 109.

The value entered in the Language Independent column is used as the default
value for languages for which no specific value is defined (including in the parent
language). If nothing is entered in the Language Independent column as well,
the entry in the Original column is used.

If the value is linked to a record in the Text info area, the key of this record is
displayed in the Reference (Text) column.

6. You can determine the order in which catalog values are sor ted for each language.
Enter numbers in the desired language's Sort Order column. If a number is not
entered for a catalog value in a specific language, the value entered in the
Language Independent column is used instead. However, if a value is locked
(Lock cell), the catalog value's sor t order is ignored. If two catalog values are
assigned the same number, these values are fur ther sor ted by catalog code.

When selecting catalog values from catalog fields, catalogs assigned a sor t order
are displayed at the top of the list (sor ted numerically). Catalog values with no
sort order assigned are displayed at the end of the list and are sor ted by catalog
code.

Note:  Select Sort Order from the context menu to hide or show the Sort Order
column.

7. Enable the Lock cell to lock a catalog value in a specific language. The lock is
applied to the entire database and takes effect immediately. Once the lock is
applied, the catalog value is no available for selection, but is retained in existing
records. The catalog value can also continue to be used when defining conditions.

Note:  If a lock is applied to a language-independent value, that value is locked
in all languages.

8. Click in the Icon column to select an icon for the catalog value.

Note: You can define how icons are displayed for fixed catalogs in the desktop
settings, see Masks Tab in the Aurea CRM win Administrator Guide. Icons are
only displayed correctly if an icon is defined for the first value in a catalog.

9. Click in the yellow cell below the last defined entry to add a new entry. You cannot
add entries if the cell is not yellow but gray.
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Note:  Certain catalogs cannot be expanded, as the values are linked to Aurea
CRM's internal functions, see Non-extensible Fixed Catalogs.

10.Enter the desired value.

Note: The maximum number of entries in the Activity catalog is 20; the limit for
all other fixed catalogs is 255.Enter data in all columns for new entries, as in this
case there is no original value. Otherwise users sees an empty catalog value
when selecting from the catalog.

11.The catalog is displayed in pink. Select Apply change from the context menu to
apply the change to the active data model. Select Undo from the context menu
to undo all changes to this catalog in the design.

12.Close the opened tables using the OK ( ) button.

Non-extensible Fixed Catalogs

The following fixed catalogs cannot be expanded, as the values are linked to Aurea
CRM functions:

CatNo.Info areaCatalog

1Person in CompanyUnit

2Person in CompanyVisit Day

5ActivityStatus

7ActivityUnit

8RepetitionMonth

30CommunicationExecution

31Communication LogStatus

32Communication LogLog Type

33TaskStatus

36FormatType

37DocumentFormat
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CatNo.Info areaCatalog

40Marketing ActivityExecution Status

41TaskExecution Type

42User TrackingModule

43Process TrackingStatus

45RepType

46Log (Marketing Activity)Process

47Response (Marketing Activity)Connection Type

48OfferReaction Time
Units/SLA

49Execution (Marketing Activity)Execution Type

52To-DoTo-Do Type

53To-DoPart. Type

54AbsenceStatus

55To-DoTo-Do Status

56MessageMessage Type

58TaskType

59PersonPreferred Channel

60Execution (Marketing Activity)Base

Adding New Fixed Catalogs
Learn how to add new fixed catalogs.

1. Start the Maintenance module.

2. Switch to the Data Model info area.

3. Click the Generated entry under Fixed Catalog.

The Generated Fixed Catalogs table is displayed.
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4. Click in an empty row.

A new catalog is added and displayed in yellow. The catalog is automatically as-
signed a number.

5. Double-click in the Text column and enter a name for the catalog in all available
languages. Click OK.

6. Click in the No. column in the same row.

The Fixed Catalog table is displayed.

7. Double-click in the Code or Original columns to add a new catalog value.

8. Enter the new value in the Language Independent column and in the various
languages.

Note: The languages need to be defined in the Language info area in the Rights
module, see Languages on page 109.

The entry in the Language Independent column is used if a value is not entered
for a specific language (or its parent language). Make sure you always at least
enter a value in the Language Independent column, otherwise users may see
empty catalog entries when using catalogs.

9. You can determine the order in which catalog values are sor ted for each language.
Enter numbers in the desired language's Sort Order column. If a number is not
entered for a catalog value in a specific language, the value entered in the
Language Independent column is used instead. However, if a value is locked
(Lock cell), the catalog value's sor t order is ignored. If two catalog values are
assigned the same number, these values are fur ther sor ted by catalog code.

When selecting catalog values from catalog fields, catalogs assigned a sor t order
are displayed at the top of the list (sor ted numerically). Catalog values with no
sort order assigned are displayed at the end of the list and are sor ted by catalog
code.

Note:  Select Sort Order from the context menu to hide or show the Sort Order
column.

10.Enable the Lock cell to lock a catalog value in a specific language. The lock is
applied to the entire database and takes effect immediately. Once the lock is
applied, the catalog value is no available for selection, but is retained in existing
records. The catalog value can also continue to be used when defining conditions.
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Note:  If a lock is applied to a language-independent value, that value is locked
in all languages.

11.Click in the Icon column to select an icon for the catalog value.

Note: You can define how icons are displayed for fixed catalogs in the desktop
settings, see Masks Tab in the Aurea CRM win Administrator Guide.Icons are
only displayed correctly if an icon is defined for the first value in a catalog.

12.Select Apply change from the context menu to apply the change to the active
data model. Select Undo from the context menu to undo all changes to this catalog
in the design.

13.Close the tables using the  button (OK).

Renaming Predefined Variable Catalogs
Entries in variable catalogs are defined in the Catalog info area.

You can only change the name of variable catalogs in the Data Model.

1. Start the Maintenance module.

2. Switch to the Data Model level.

3. Click on the Core entry under Variable catalog in the tree structure.

The Variable Catalog info area is displayed.

4. Enter the new catalog name in the Language Independent column and the
columns for the available languages. For information on applying text changes,
see Applying Text Changes.

Note: The languages need to be defined in the Language info area, see Lan-
guages on page 109.

The value entered in the Language Independent column is used if no entry is
defined for a language (including its parent language). If no entry is made in the
Language Independent column, the value in the Original column is used instead.

5. Click in an empty field after making an entry to save your changes.

6. The catalog is highlighted in pink. Select Apply change from the context menu
to apply the change to the active data model. Select Undo from the context menu
to undo all changes made to this catalog in the design.

7. Close the Variable Catalog table.

To edit variable catalog values, switch to the Catalog info area, see Catalog Info
Area on page 271.
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Adding New Variable Catalogs
Learn to add new variable catalogs.

1. Start the Maintenance module.

2. Switch to the Data Model info area.

3. Click the Generated entry under Variable catalog in the tree structure.

The Variable Catalog table is displayed.

4. Click in an empty row.

A new catalog is added and highlighted in yellow. The catalog is automatically
assigned a number.

5. Enter a name for the catalog in the Language Independent column and for each
of the available languages and click OK.

Note: The languages need to be defined in the Language info area, see Lan-
guages on page 109.

Note: The Text column is empty for generated catalogs.

The value in the Language Independent column is used if a value is not entered
for a specific language (including its parent language). Make sure you always at
least enter a value in the Language Independent column, otherwise users does
not see a catalog name when selecting catalog values.

6. If you wish to define a parent catalog, click in the Parent Catalog column and
choose the parent catalog.

7. The catalog is highlighted in pink. Select Apply change from the context menu
to apply the change to the active data model. Select Undo from the context menu
to undo all changes made to this catalog in the design.

8. Close all tables using the  button (OK).

To add entries to a variable catalog, switch to the Catalog info area, see Catalog
Info Area on page 271.

Note: You need to delete the catalog entries in the Catalog info area before deleting
a variable catalog in the data model. Otherwise the catalog entries are retained in
the database.
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Adding New Info Areas
Learn how to add new info areas.

1. Start the Maintenance module.

2. Switch to the Data Model info area.

3. Click the Generated entry under Info Area in the tree view.

The Info Area: Generated table is displayed.

4. Click in the No. or Name column in the first free row.

The Selection dialog box opens.

5. Select the type of info area:

• root: Independent info area; i.e. not a child of any other info area

• primary  index: sno, lno: The primary key is composed of the station number
and serial number. A column named ID of the type long integer is added to the
database and stores the two values together. When a new record is added, the
station number is automatically entered and a serial number generated.

This type of index is used to generate unique system-wide keys. Data of this
type can also be linked. For this reason, the Gen.ID field is automatically en-
abled for info areas of this type.
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Note:  Aurea recommends using this index for all independent info areas. In
contrast to other primary keys it guarantees that data is communicated correctly
between stations without any undesired merging of records.

• primary  index: date, time(ms): The primary key is composed of the Date and
Time fields. A column named ID of the type long integer is added to the
database and stores the two values together. The time is displayed including
milliseconds. When a new record is added, the current date and time are entered
automatically.

• primary  index: date, time(sec): As above, except the time is displayed with
seconds.

• primary  index: date, time (min): As above, except the time is displayed with
minutes.

• primary  index: long int: The primary key is composed of the ID field of the
type long integer.

• primary  index: int: As above, but the ID is an integer.

• primary  index: short int: As above, but the ID is a short integer.

• primary  index: small int: As above, but the ID is a small integer.

• primary  index: fix catalog: An ID field of the type long integer is created.
Assign this field to a fixed catalog: Click in the Info Area column in the Info
Area table. The associated Info Area table is displayed. Click in the Catalog
column in the Info Area table. Select the desired catalog from the list.

Note: The first value in all fixed catalogs has the ID '0'. If you use a fixed
catalog as an index, records with the first catalog value cannot be saved as
there is no primary key for '0'.

• child  N-1: The new info area is a child info area, and any number of records
in the new info area can be assigned to a record in the parent info area. The
station number (sno) and a serial number (lno) are used to form the primary
key. The LINK_XX_Sno and LINK_XX_Lno fields are added as a link to the
parent info area, with XX the abbreviation of the parent info area. Two columns
are added to the database, ID and ID_XX, which store the station and serial
number together as a long integer.

• child  1-1: The new info area is a child info area, and each record in the parent
info area can be associated with a single record in the child info area. This
allows info areas to be defined that function as an extension of other info areas.
The LINK_XX_Sno and LINK_XX_Lno fields are added as a link to the parent
info area, with XX the abbreviation of the parent info area. The ID column is
added to the database, which stores the station and serial number together as
a long integer.
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Note:  Info areas that have a different primary key than the station number and
serial number should not be communicated. Without a unique station and serial
number, records could be merged incorrectly. If you wish to define an info area
that should be communicated, use the primary index: sno, lno option to form
the primary key.

Depending on the type of info area, system fields are added automatically, for
example DelCd. (delete code) and the station number, see System Fields on page
392.

6. Select Test info area from the context menu to test the info area for errors. Select
Apply info area from the context menu to apply all changes to the info area to
the active data model.

Note: You need to lock the system for all active users before you can apply the
info area to the active data model.

7. Close all tables.

More information on editing info areas can be found under Info Area Options on
page 298 and Field Options on page 340.

You need to integrate the new info area in a level in order to use it in Aurea CRM,
see Defining New Levels in the Aurea CRM win Administrator Guide.

Note: The data model can contain a maximum of 512 info areas.

Note:  Aurea recommends using the existing data model as much as possible, for
example by renaming free fields. Only define new info areas and fields if the standard
info areas cannot meet your requirements.

Integrating External Tables
To display additional data from another database in Aurea CRM (e.g. statistics of
website visits, additional product information etc.) you can integrate external tables
into the Aurea CRM data model.

Note: These external tables are available as read-only info areas in Aurea CRM.

Non-unicode tables are automatically converted to unicode.

To link an external table to the Aurea CRM data model:

1. Create a new info area: In the Select Info Area Type dialog select the type
matching the key of the external table.
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In this case you would have to select "root, primary index: int".

2. Click OK.

3. Select the External column.

4. Enter the database, schema and name of the external table.

Note: The external table must be accessible via the settings defined in the
mmdb.ini file of your Aurea CRM win installation, i.e. it must be located on the
same database server.

5. Click OK.

6. Select the Fields column.

7. Delete the automatically generated fields (no. 4011-4016).

8. Add the desired fields, see Adding New Fields on page 317.

Note:  Make sure the data types of the internal and external fields match since
this is not automatically checked by the system.

9. Select the DB Column column to define the "mapping" between external and
internal fields:
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10.For each field select the field from the external table: Make sure you assign the
unique key field(s) from the external table to the unique key field(s) of the new
info area.

11.Click OK.

12.Click  (OK) to close the Fields level.

13.Select Test info area from the context menu:

You can page through the data from the external table using the arrow buttons.

After applying the data model changes you can use the new info area in customiza-
tions like any other info area (links to other info areas, reference fields, configuring
the info area for Aurea CRM web etc.).

Since info areas displaying data from external tables are read-only you do not need
to define additional access rights for them.

Note:  External tables are not communicated, i.e. an error message is displayed if
the info area mapped to the external table is accessed by an offline client.

Editing Predefined Info Areas
Learn how to edit predefined info areas.

1. Start the Maintenance module.

2. Switch to the Data Model info area.
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3. Click on the Core entry under Info Area in the tree structure.

A table is displayed listing all info areas.

Click  (Find) to search for info areas (by name or ID). The search works as
described for the CRM Process search, see Searching for CRM Processes on
page 102.

4. Click in the Fields column of the info area you wish to edit.

5. Edit the fields in the info area by:

• adding new fields, see Adding New Fields on page 317

• editing field names, see Renaming Fields on page 340

• editing field properties, see Field Options on page 340

Note:  Aurea recommends using the existing data model as much as possible,
for example by renaming free fields. Only define new info areas and fields if the
standard info areas cannot meet your requirements.

6. Close the Fields table. The info area is highlighted in pink.

7. Continue editing the info area, see Info Area Options on page 298.

8. Close the Info Area table.

Info Area Options
Find the list of info area options here.

Below are some of the options for info areas:

Name and No.
Name of the info area and its internal ID.

• No.: The internal ID of the info area:

• A 2 character abbreviation for predefined info areas ("Core")

• C + 3 digit serial number of the info area (for info areas added by Customers)

• P + 3 digit serial number (for info areas added by Partners of Aurea)
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• U + 3 digit serial number (for info areas added by Aurea)

• A + 3 digit serial number (for info areas added on a Base development station)

• Name: Name of the info area:

• Fixed name for predefined info areas

• C + 3-digit serial number of the info area

• P + 3-digit serial number

• U + 3-digit serial number

• A + 3-digit serial number

Both fields cannot be edited. To edit the name of an info area in Aurea CRM, use
the Text field, see Text on page 311.

Properties
The general properties of an info area.

Click in the Properties column to define the general properties of an info area.

Note: You cannot change the properties of predefined ("Core") info area.

• Included in selections: Enable this option to display the info area in the Selection
info area and to include data from it in selections. This option is only available,
if:

• The info area is a child of the Company or Person in Company info areas.

• The info area is indirectly dependent on the Company or Person in Company
info areas and includes a link to the Company or Person info area.

Note: Note (BTB only): This option is not available for child info areas of the
Property info area.

• No rights definition: Enable this option to exclude the info area from any access
rights settings. The info area is then not displayed in the Rights info area.

• Do not communicate: Enable this option to exclude the info area from
communication. The info area is then not displayed in the C.Format info area in
the Communication module and thus not communicated.
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Gen. ID
The Gen.ID field is automatically enabled if the primary key used by the info area
is composed of the station number and a serial number.

This is the case for the following:

• Info areas of the type root, primary index: sno, lno

• Info areas of the type child, N-1 or child, 1-1 that are dependent on info areas
for which Gen.ID is enabled.

If this field is enabled, a sequential number is assigned when a new record is added.
Records can be linked using generic links.

Fields
The Fields column displays the number of fields in each info area.

Click in this column to edit the fields in the corresponding info area, see Field Options
on page 340.

Telephone
The Telephone column displays the number of telephone fields.

Click in this column to display these fields.

To define a new telephone field:

1. Click in the first empty row and select the Type ("Telephone", "Fax", "Modem" or
"Mobile tel.").

2. Click in the following columns and select the desired info areas or fields:

• Info Area Prefix (only for KP and CP): Click in this column to determine whether
the area and country codes are taken from fields in the Person in Company
or Company info area. Select the desired field in the Country Code and Area
Code columns.

• Country Code: Field for the country code.

• Area Code: Field for the area code.

• Telephone: Field used to store the telephone, fax or modem number.
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• Extension: Field for the extension.

• Search: Can only be enabled for telephone and mobile telephone fields. This
field is used during the search for telephone numbers (if the record containing
the phone number is linked to a company/person and contains a station number
and serial number).

The Info Area Tel. column displays the info area of the field in the Telephone
column.

The Info Area Prefix column displays the info area of the fields in the Area Code
and Country Code columns.

Note:  If you delete telephone fields in the data model, the telephone numbers in
the Tel.No./E-mail info area are retained. To update the entries, use Drop table
and Create table in the SQL tool to update the Tel.No./E-mail (TN) table and select
Fill from the context menu in the Tel.No./E-mail info area.

If the current user has a valid phone profile, telephone fields of type "Telephone"
and "Mobile tel." display a telephone icon beside the number. (In Aurea CRM web
the phone number is displayed as a link when in View mode.) If CRM.phone is in-
stalled, clicking on the icon (or the link) dials the number entered in the filed,
see CRM.phone documentation.

Telephone fields of type "Fax" and "Modem" have no special functions.

Array Fields
Learn how to display fields that are linked to one another.

Click in the Array fields column to display all the fields that are linked with one
another in the search or in selections (i.e. a condition linked with OR is applied to
all the linked fields). If you define conditions applied to a field in the Select. Field
column, the condition is also applied to the corresponding fields in the Array Fields
column.

Note:  If you specify one of the array fields in addition to the selection field in the
search (with or without a comparison value), the other array fields are not taken
into consideration.
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To add a new group of linked fields, click in the Select. Field column and select a
field. Click in the Array Fields column to select the linked fields. You can only select
fields of the same type as the field selected under Select. Field.

Note: You can only add one group per info area that uses the same selection field.
In prior versions of Aurea CRM, this was possible for multiple groups. If you have
defined multiple groups, only the last group defined is taken into account.

The catalog fields in a group access the same catalog.

Index
When adding a new info area or link, indices are generated automatically.

You can define additional indices for the most commonly used search processes.

Note:  Only add index fields that you require. A large number of index fields impact
negatively on performance, e.g. when searching.

The Index column displays the number of indices defined for the info area.

1. Click on the Index column to display/edit/add indices:
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The primary index is highlighted in gray and cannot be changed.

• No.: The number of the index is assigned automatically.

• ID: The ID is automatically assigned. IDs 0-99 are used by the default data
model, IDs star ting from 100 are assigned depending on the user group and/or
station number, see Number Ranges in Aurea CRM on page 398.

• Properties: The index properties:

• [ID] indicates the primary index. This is the index highlighted in gray.

• [DUPLICATE] indicates the index is not unique; i.e. several records could
contain identical values in the index fields. Click in this column for generated
indices to enable the [DUPLICATE] property. If disabled, the index is unique.

• [NOT NULL] indicates that empty values is not saved. Example: If the Synonym
index for FI is used, companies, where no Synonym is entered, are not par t
of the search result.

• Fields: The fields forming the index.

2. To add a new index, double-click in the first empty row. A list of the fields of the
info area is displayed. Select the first index field. Click on the Properties cell to
specify the index' properties (s. above). Add more index fields by clicking on the
Fields cell (s. below).

To edit an existing index:

• Edit custom indices by clicking in the Fields column.

• Extend predefined indices (except primary indices) by adding Additional index
fields.

Note:  Additional index fields are ignored by the business logic and when executing
triggers.

3. To add an index field:

a. Click on the Fields cell (of a custom index).

b. Click on the first empty row.

c. Select a field.
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d. For text fields you can define the following properties:

• Properties:

UPPER: Adds the index in upper case (and therefore does not distinguish be-
tween upper or lower case).

CASE: Adds the index with the field value and distinguishes between upper
and lower case for that field.

ALPHA: Removes all characters apart from letters and digits (e.g. spaces,
special characters) and saves the result in a new field (<field name>_GEN_A).
A database index is added, accessing this field.

Note:  Core Alpha Index only works with CRM.Win client. It does not work
with CRM.Web. Furthermore, there is no configurable alphanumeric search
in CRM, only a phonetic search. The phonetic search also allows searches
for other fields and other info areas.

PHONETIC: Adds a phonetic index in a new field (<field name>_GEN_P). Use
this option to define a phonetic search index for Aurea CRM web. (The pho-
netic search fields are fixed in Aurea CRM win.) For a description of the al-
gorithm used by the phonetic search, see Phonetic Search in the Business
Logic Manual.

Note:  If a text field is already used in an index where the ALPHA or PHONETIC
options have been enabled, the same field length must be used by this field
in all other indices using the ALPHA or PHONETIC options.

To search phonetically in KP you need to define the phonetic index in PE or
CP. This phonetic index is then automatically used for KP as well if a field
is searched that is mapped to a field with a phonetic index in PE or CP.

• Length: Enter the number of characters to be used by the index. If undefined,
the entire field value is used.

• Binary-Sort: If checked, the sor ting definitions defined in the mmdb.ini
file (COLLATION (MS SQL) or MM_NLS_SORT (Oracle)) are ignored.

e. For field of any type you can check the Not Null cell, i.e. if the field contains
no value the record is not a par t of the search result.

4. To add an additional index field:

a. Click on the Additional index fields cell.

b. Click on the Fields cell.

c. Select a field.
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d. The field is added with property [ADD].

e. The Not in Key flag is automatically set. This means that the field is added to
the index as "included column", i.e. the field does not affect the sor ting and
uniqueness of the index. Remove the flag to change this behavior.

Note: The Not in Key option is not supported by Oracle databases.

Link
The Link column displays the number of links to other info areas.

To display the number of links to other info areas:

1. Click in the Link column to display the existing links or to add new ones.

• Each info area is linked to itself. This entry is highlighted in gray.

• The number of the link is displayed in the first column.

• ID: An ID is displayed if several links exist to the same info area (e.g. a link
from the Relationship info area to the source and target companies), see Link
IDs on page 394.

• The third column displays the type of link: 1-1, N-1.

• Info Area: The info area that is linked.

• Index (<Info Area>): The index used by the current info area to form the link.

• Index: The index of the target info area.

• The attributes of the link are determined by the type of link. They are displayed
in the last column:

DUPLICATE: The info area is already linked to the target info area using the
same index. For example, the Relationship info area is linked to the Company
info area twice; once to the source company and once to the target company.
One of these links is indicated as a duplicate.

SECONDARY: If a dependent info area is linked by a link with the attribute
Secondary, the dependent info area cannot be displayed from the parent info
area.

HIDE: The link is not displayed.
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UPD/DEL: If the data in the index fields in one info area are deleted or changed,
the corresponding fields in the linked info area are also updated. For example,
if the company number is edited in the Company info area, this change is ap-
plied to all activity records associated with the company.

MUST: This attribute applies to the target info area. In this case the link is
mandatory; i.e. if the fields used by the link have not been entered, the record
cannot be added.

2. Click in the first free row in the table to define a new link.

3. Select the type of link:

• A "1-1 Link" allows you to associate a record in the parent info area with exactly
one record in the child info area.

• The "N-1 Link" allows you to associate any number of child records with the
record in the parent info area.

• The "N-1 Generic Link" allows you to associate any number of child records
with the record in the parent info area. The parent info area is not fixed,
however; it can be any info area with a primary key composed of the station
number and a serial number. Only one generic link can be defined for each info
area.

• The "N-N Link" allows you to associate any number of child records with the
record in the parent info area where the child records and the parent record
have a common field or index in another record (e.g. all service contracts for
an opportunity where the company is the same for the service contracts and
the opportunity). 1-N is displayed as the link type (not N-N) in the third column.

4. Click on OK.
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5. If you selected either "1-1", "N-N" or "N-1", the Select Info Areas window is
displayed:

a. Select the info area you wish to define a link to.

b. Click OK.

6. If you selected the Person info area, a fur ther dialog is displayed. Select the
index used to link the person from this dialog.

Use index 1 to add a link to the Company and Person info areas; use index 6 to
add a standard link to the Person info area.

7. Click on OK.

For each newly defined link:

• The corresponding key fields are added (and an additional field for the target
info area for "1-N Generic Links").

• a link field is added (a field of the type "reference (uid)" for reps or "reference
(table)" for info areas). You need to define a level in the desktop format used
to display the record when a user clicks on the link, see Defining New Levels
and Defining Links in the Aurea CRM win Administrator Guide.

• An index is created using the key fields. The index is unique for 1-1 links; the
index is not unique for N-1 links, which uses key fields from the parent info
area).

Note:  Generic links are not displayed in the link table. You need to delete the
corresponding field to remove a generic link.

8. You can use the Mapping column to determine that additional fields are transferred
from the linked info area, see Field Mappings.

Mapping
The number of info areas to which information is transferred from the info area is
displayed in the Mapping cell.

A link needs to exist between the source and target info areas for data to be trans-
ferred between info areas in this manner, see Link on page 305.

You can display existing settings and define additional fields that are mapped:

1. Click in the Mapping cell for the desired info area.
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The target info areas are listed in the Info Area column. The Index Relationship
column displays the index relationship with the target info area.

2. The following options are available:

• Disable: Use this option to turn off the mapping. For example, if the City info
area mapping is disabled, adding a new company in a new city no longer
automatically adds the city to the city table, see Adding New Cities (Aurea CRM
win Main Module).

• New: Enable this option to determine that a new record should be added to the
target info area whenever a new record is added to the source info area. The
appropriate field values are transferred from the source record.

• Del: Enable this option to determine that the contents of mapped fields should
be deleted in the target info area if the corresponding source record is deleted.

• Delete record: Enable this option to determine that the record in the target
info area is deleted if the record in the source info area is deleted. This feature
is already included in the data model for dependent info areas (e.g. deleting a
company also deletes all persons in the company).

Note: The options New, Del and Delete record are only available for info areas
that are linked via a 1:n or 1:1 relationship. The source record must contain the
station number and serial number of the target record.

• Upd: Enable this option to determine that edits are transferred between the
info areas:

1 :n and 1:1 relationships: Changes to the record in the source info area are
transferred to the mapped fields in the target info area.

n:1 relationship: Changes to fields linked to a function (see Field Mappings)
in the source record result in updates to the fields defined in the function in
the target info area

• Create Default: Enable this option to determine that the contents of mapped
fields are transferred to the source record when a new record is added. The
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source info area must be a child of the target info area (child n-1 or child 1-1),
see Adding New Info Areas on page 293.

• Load: Enable this option to determine that the contents of mapped fields are
transferred as soon as a record in the source info area is linked to a record in
the target info area.

Note: This option is only available for info areas linked via an n:1relationship.

• Allow triggers: By default, tr iggers initiated by events in the database (new,
update, delete) are not executed for the target info area of a mapping. Enable
this option to execute triggers in the target info area.

3. Click in the Fields cell to display and edit the mapping for the corresponding info
area, see Field Mappings.

4. Click in an empty line to define a new mapping, see Defining Mappings.

5. Click on  (OK).

Defining Mappings

To define a new mapping:

1. Click in the Mapping cell of the source info area.

2. Click in an empty line.

A dialog box is displayed.

3. Select the desired target info area.

Note:  If you wish to map an info area to itself or add a second mapping to an
existing target info area, you need to add an additional link first, see Link on page
305.

4. Select an Index Relationship and click OK.

5. Click in the Fields column to define the field mappings, see Field Mappings.

6. Click on  (OK).

Field Mappings

To display and edit the list of mapped fields:

1. Click in the Fields column of the desired mapping.
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(In this example for the FS ver tical, a mapping has been defined between a new
info area named Product and the Product Overview info area (1:n link, index:
Sno, lno -> Link Type, Prod.St.No., Prod.Ser.No.".)

The table displays the IDs and the mapped fields in the source and target info
areas.

2. Click in an empty line to define a new field mapping.

A dialog box is displayed listing the fields in the target info area.

3. Select a field and click OK.

A dialog box is displayed listing the fields in the source info area.

4. Select a field and click OK.

Note:  Ensure that you map fields of the same type, see Aurea CRM Field Types.
If the value is invalid for the field in the target info area, the field is left empty or
the contents truncated. For example, if you transfer a field of the type "decimal
(8 Byte)" to a field of the type "int (4 Byte)", the decimal places are lost.

Mapping catalog fields is only possible for fields using the same catalog.

5. Click in the Function cell to select the function to be applied to the target info
area.

Note:  Functions are only available if the info areas are linked via an n:1
relationship and the Upd option is enabled for the mapping.

The following functions are available:

• Number of records: Writes the number of child records to the parent record.

• Sum: Writes the sum total of the corresponding values in the child records to
the parent records.
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• Minimum: Writes the lowest value in the corresponding fields in all child records
to the parent record.

• Maximum: Writes the highest value in the corresponding fields in all child
records to the parent record.

If the link between the records is changed (i.e. the source record is linked to a
different record in the target info area), values in the old and new records are
recalculated.

6. Click on  (OK).

You can use field mappings to transfer data from linked records, e.g. to transfer an
item name from the Item Master. In this case, the info area to which data is to be
transferred must be defined as the source info area. An n:1 link must exist between
the source and target info areas, and the Upd option must not be enabled under
Mapping.

Alternatively, you can add a reference field to the info area you wish to transfer the
data to, see Adding New Fields on page 317.

Text
Click in the Text column to edit the names of the info area (singular and plural) and
its fields.

Enter the new texts in the Language-independent column and the columns for the
defined languages, see Languages on page 109. For information on applying text
changes, see Applying Text Changes.

The value in the Language-independent column is used if no alternative value is
entered for a specific language (or its parent language). If no value is entered in
the Language-independent column, the name in the Name column is used instead.

If the text is linked to a record in the Text info area, the Reference (Text) column
contains a reference to the Text record.
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XML Name

The XML Name column contains the XML field name. XML names of info areas and
fields are ver tical-independent. XML field names are used to identify fields for exter-
nal interfaces and in configuration units in CRM.designer.

1. Enter XML names for new fields in the XML Name column. If you do not enter
XML names, the following defaults are used:

• Fields: F<fieldID>, e.g. F7000

• Info areas: <infoAreaID>, e.g. C001

2. To view the built-in XML names of the default data model, select Display resource
texts from the context menu:

Note:  XML names for built-in fields and info areas can not be changed.

Use the context menu option Import XML names from dictionary.xml to import
custom XML names from earlier versions (as defined in .. \system\xml\dictio-
nary.xml). Only XML names of custom fields and info areas are imported. Already
existing XML names are overwritten without confirmation.

Automatic Numbering

The Core data model contains fields that are automatically numbered to reduce
translation costs.

Example: Actual Value M1 to M12 in P5

The texts for these fields are saved as "Actual Value M" for all 12 fields.

To customize the position of these numbers (e.g. to meet grammatical requirements
of another language), you can use a '#' character. Enter e.g. "M# Actual Value" for
the above example. '#' is replaced with the respective number, otherwise the number
is appended to the end of the string.
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Reusing Texts

To reuse an existing text you can reference other fields or catalog values using
placeholders:

• {[FI,2]} ... text of field 2 in the Company info area

• To reference an info area name use field number 4240: {[FI, 4240]} is the reference
to the name of the info area "Company"

• {[FIX4,0]} ... text of the fixed catalog Activity Type, value 0 "Telephone"

• {[VAR,2]} ... text of the variable catalog Country

You can also use a reference within a text, e.g. "My {[FI,2]} (Private)".

Select the context menu option Resolve references (blue) to display the actual
text instead of the reference.

If you want to use a reference for all languages, enter it in the Language-indepen-
dent column.

Consolidating Texts

To keep your texts consistent and to reuse as many texts from the Text info area
as possible you can search for identical texts used in other info areas:

1. Select a row.

2. Select Search for identical texts from the context menu.

All occurrences of the text in the data model are listed (info area names, field
names, variable catalog names, fixed catalog values).

If the context menu option Display resource texts is active, the resource texts
(i.e. the texts in the language DLLs) are searched as well and displayed in green.
Custom texts that are identical to resource texts are displayed in red.

Use the following context menu options to consolidate your texts:

• Remove row: Removes the current row from the list. The consolidation functions
are applied only to the displayed rows. If you remove a row, the changes are
not applied to it.

• Set all texts in the selected language to the same: Copies the text of the
selected entry to all entries for this language. Use this option to consolidate
inconsistent translations.
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• Set all texts in all languages to the same: Copies the text of the selected
row and all languages to all rows in the list (including the reference to the Text
info area if applicable).

• Transfer the text in the selected field to the source field: Copies the text
of the selected field to the original field (the one from which you opened the
list).

You can also inser t references instead of texts:

• Transfer source field's reference to the selected field: Enters the reference
to the source field instead of a field name into the selected row.

Transfer selected field's reference to the source field: Enters the reference
to the selected field instead of a field name into the originally selected row
(gray).

• Transfer reference to all selected fields: Transfers the reference to the
selected field to all rows of the list.

Select Resolve references (blue) to display the actual text instead of the ref-
erence.

3. Upon closing the Search for identical texts level a confirmation message is
displayed: If you click Yes the text changes are saved.

4. To apply your changes you need to select Apply text from the context menu in
the info area level, >> .

If you have custom texts that are the same as the original resource texts (displayed
in red with Display resource texts active), you can delete these duplicate texts.
Use the following context menu options (in the Text level of a specific info area and
in the Search for identical texts level):

• Delete all identical (red) texts in the selected row: Reverts the red texts from
the selected row to the original resource texts.

• Delete all identical (red) texts in the selected language: Reverts the red texts
for the selected language to the original resource texts.

• Delete all identical (red) texts: Reverts all red texts (of the info area or the
Search for identical texts list) to the original resource texts.
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To globally remove custom texts from an info area or for all info areas in a specific
language use the following context menu options:

• Delete current info area's texts: Reverts the custom texts for the current info
area to the original resource texts (including the reference to the Text info area
if applicable).

• Delete current info area's texts (only core fields): Select this option to only
remove custom texts for built-in fields and not for user-defined fields.

• Delete texts in selected languages and independent of info area: Reverts all
custom data model texts to the original resource texts (including the reference to
the Text info area if applicable).

For all three options you can select the languages for which you want to revert
texts.

For stations with number >= 10.000 the following additional context menu option is
available (not in the Text level but generally):

• Delete all translations if the (<language>) translation equals the resource
text: Deletes all custom texts in all info areas that are identical to the resource
texts.

Applying Text Changes

Use the following context menu options to apply text changes in the data model:

• For info area and field names:

• Select Apply texts (in the Info Area level) to apply the text changes for the
selected row.

• Select Apply  all texts to apply text changes for all info areas.

• For catalogs and values of fixed catalogs:

• Select Apply changes to apply the text changes for the selected row.

• Select Apply  all changes to apply text changes for all catalogs (and values).

These options are also available for info areas (Text column).

When selecting one of these options the text changes are applied to the active
data model. To create/update text table records for these texts, select Transfer
texts in the Text info area, see Displaying and Editing Texts on page 373. The
text record's ID is written to the Reference (Text) column in the data model.

In addition you can transfer texts to and from the Text info area. The following
context menu options are available for info areas (Text column) and catalogs:

• Transfer current info area's texts to the Text table (translate): Select this
option to transfer custom texts defined for an info area (or catalog) to the Text
info area. You are prompted to choose the languages for which texts should be
transferred.

The text record's IDs are written to the Reference (Text) column. If a text already
exists in the text table but is used in other formats or records, a new text record
is created for the data model text. Select Apply changes to save the text table
references in the data model.
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If you delete custom texts from the data model, the corresponding text table
records are deleted when selecting Transfer current info area's texts to the
Text table (translate).

To transfer the original resource texts of an info area as well (e.g. for translation
purposes), activate the Include resource texts option before selecting Transfer
current info area's texts to the Text table (translate).

• Transfer current info area's texts form the Text table (apply translation):
Select this option to transfer translated custom texts from the text table to the
date model for the current info area (or catalog).

Note:  Only texts that are already linked to a text ID (Reference (Text) column)
can be transferred to the data model.

Triggers
You can use triggers to carry out database actions whenever a record is added,
edited or deleted.

For example, you could calculate the key used by an external application and enter
this value in a field.

1. Click in the Trigger column to enter the SQL code for the database trigger.

2. Select the type of database you are defining the trigger for (MSSQL or Oracle).

3. Select New, Update or Delete to determine whether the trigger is initiated by
adding, editing or deleting a record.

4. Enter the SQL statement in the Text field.

5. Click OK.

Note: This is only possible for custom ("generated") info areas.
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Adding New Fields
Learn how to add new fields.

Follow the below steps:

1. Click in the Fields column of the info area you wish to add a field to.

2. Click in one of the first four columns in an empty row.

3. Select the type of field from the Select Field Type dialog, see Aurea CRM Field
Types.

4. Depending on the selected field type you may need to define additional properties
(e.g. the length for text fields), see Field Options on page 340.

5. Enter a name for each new field, see Renaming Fields on page 340. Otherwise the
fields are not displayed in Aurea CRM.

Note:

1. Aurea CRM logs a warning if a field name in an infoarea is duplicated. The warning
is in the following format:

Duplicated field name is found on info area 'XX'. Field name is 'XX' and field id
is 'XX'. Please use unique xml names in your info area model.

2. An info area can contain up to 1088 fields (1024 user-defined fields, the rest are
reserved for default fields).

Aurea CRM Field Types

The Aurea CRM data model supports the following field types:
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

---By/nBoolean field

mandatory:
Length
(see Length
on page 342)

optional:
Properties
(see Proper-
ties on page
342), Mask
(see Mask
on page 348)

---CtextText field

---If
CRM.phone
is installed,
clicking a
number
star ts di-
alling. Phone
fields are de-
fined in the
data model
(Telephone
column),
see Tele-
phone on
page 300.

CtextTelephone
field

---If the "E-
Mail" proper-
ty is set in
the data
model, e-
mail address-
es are dis-
played as a
hyperlink:
Clicking the
address
opens the
mail client.

CtextE-Mail field
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

---If the "Hyper-
link" proper-
ty is set in
the data
model, web
addresses
are dis-
played as a
hyperlink:
Clicking the
address
opens the
web page.

CtextHyperlink
field

optional (for
uid): Proper-
ties
(see Proper-
ties on page
342)

---Consists of
four fields,
e.g. Rep (Z)
| Rep ID (L)
| Rep Group
(Z) | Rep
Group ID (L)

If a user en-
ters a rep's
ID in the
Rep ID field,
the Rep,
Rep Group
ID and Rep
Group fields
are filled in
automatical-
ly.

Z,Luid, refer-
ence (uid)

Rep fields

mandatory:
Catalog
(see Catalog
on page 341)

---Field refer-
encing a
fixed catalog

Xfix catalogCatalog field

mandatory
Catalog

---Field refer-
encing a
variable cata-
log

Kvar catalogCatalog field

optional:
Mask
(see Mask
on page 348)

---Date field
(without
time)

Ddate (4Byte)Date field
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

---Time field
with hours
and minutes

Ttime (hh:mm)Time field

---Time field
with hours,
minutes and
seconds

Ttime
(hh:mm:ss)

Time field

---Time field
with hours,
minutes,sec-
onds and
milliseconds

Ttime
(hh:mm:ss,ttt)

Time field

---Consists of
two fields
(Date and
Time)

Use these
fields to rep-
resent time
zones.

Use mm-
ba.exe –-
writeDate-
Time to out-
put a list of
all combined
date and
time fields,
seemm-
ba.exe Pa-
rameters on
page 13 .

D,Tdate, time
(hh:mm)

Combined
date/time
field

---D,Tdate, time
(hh:mm:ss)

Combined
date/time
field

---D,Tdate, time
(hh:mm:ss,ttt)

Combined
date/time
field
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

optional: For-
mat
(see Format
on page 344),
Mask
(see Mask
on page 348)

---Integer be-
tween 0 and
255

Ssmall int (1
Byte)

Number field

optional: For-
mat, Mask

---Integer be-
tween 0 and
65535

Sshort int (2
Byte)

Number field

optional: For-
mat, Mask

---Integer be-
tween -
2147483647
and
+2147483647

Lsigned int (4
Byte)

Number field

optional: For-
mat, Mask

---Integer be-
tween 0 and
2147483647

Lint (4 ByteNumber field

optional: For-
mat, Mask

---Integer be-
tween 0 and
99999999999999999
(17 places)

Llong int (8
Byte)

Number field

optional: For-
mat, Mask

---Floating
point number

Fdecimal (4
Byte)

Number field

optional: For-
mat, Mask

---Double-
length float-
ing point
number

Fdecimal (8
Byte)

Number field

mandatory:
Length
(see Length
on page 342)

---Field contain-
ing binary
data

Binary data
can only be
entered and
read via add-
on program-
ming.

binaryBinary field
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

optional: For-
mat
(see Format
on page 344)

---Field contain-
ing a station
number

Ssno (2 Byte)Station num-
ber field

optional: For-
mat

---Field contain-
ing a serial
number

Llno (4 Byte)Serial num-
ber field

Note:  Do not use field type "lno (4 Byte)" for fields where you copy e.g. the serial
number of Offer (PR) records (via trigger etc.), as this may result in an integer
overflow. Either use a field of type "long int (8 Byte)" or activate the Generate
sequence numbers without year configuration (MC) entry, see General Settings
on page 41. If this option is enabled, serial numbers for PR, AU etc. are generated
without the year.

Naming convention for station/serial number fields:

• <InfoAreaId>-StaNo / <InfoAreaId>-SerNo: Station and serial number fields
representing the unique key of a record. <InfoAreaId> is the info area ID of the
current record, e.g. FI-StaNo and FI-SerNo for company records.

• <InfoAreaId>_StaNo / <InfoAreaId>_SerNo: Station and serial number fields
representing a link to another record. <InfoAreaId> is the info area ID of the
linked record. If more than one link to the same info area exists, the fields are
numbered, e.g. FI_1_StaNo, FI_2_StaNo etc.

4003Tenant num-
ber field: An
integer field
used to store
the tenant
number,
see Tenants
on page 221.

Naming con-
vention: <In-
foAreaId>-
TenNo, e.g.
FI-TenNo.

Only one
field of this
type is per-
mitted per in-
fo area.

Lmno (4 Byte)Tenant num-
ber field
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

4005Stores the
currency
used for the
record.

This field ac-
cesses the
Currency
catalog.

Only one
field of this
type is per-
mitted per in-
fo area.

KcurrencyCurrency
field
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

4017, 4018Consists of
two fields:
Ext. System
(K, 4017) |
Ext. Key (C,
4018)

This field
type is avail-
able in all in-
fo areas
whose key
consists of
station num-
ber plus seri-
al number
and for all in-
fo areas
whose key
consists of a
numeric field
(e.g. the Rep
info area).

The Compa-
ny, Person
and Proper-
ty info areas
have exter-
nal key fields
by default.

The external
key can be
used when
importing,
see Import-
ing with Ex-
ternal Keys
in the Aurea
CRM win Ad-
ministrator
Guide.

K,Cext.keyExternal key
fields
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

Read-only by
default - can
be changed,
see Proper-
ties on page
342.

Only avail-
able in info
areas with at
least one rep
field.

The field
stores a
rep's hierar-
chy code.

If a rep is
entered in
the rep field,
the rep's hier-
archy code
is automati-
cally entered
in the corre-
sponding hi-
erarchy code
field.

Chierarchy
code

Hierarchy
code field
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

4019-21Consists of
three decod-
ed fields
(Score,
Text, De-
scription)
used to
match up da-
ta using an
external ap-
plication,
see External
Match-up on
page 40.

Aurea CRM
copies the
values from
the node in
the external
XML file as
follows:

Score
(match-up)
(4019): The
score that in-
dicates how
similar the
records are
("Score"
node).

Text
(match-up)
(4020): Con-
tents of the
"Text" node.

Description
(match-up)
(4021): Con-
tents of the
"Description"
node.

Zext.matchupExternal
match-up
fields
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

F,X,Lgeographic
coordinates

Geographic
coordinates
field
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

Select this
type to save
geographic
coordinates
for a record.
The follow-
ing fields are
created:

x (geograph-
ic coordi-
nate): Lati-
tude (deci-
mal(8Byte))

y (geograph-
ic coordi-
nate): Longi-
tude (deci-
mal(8Byte))

Precision
(Geo-coordi-
nates): fixed
catalog
defining the
quality of the
geocoding:
empty (de-
fault), Manu-
al input,
High, Medi-
um, Low,
failed.

Updated
(Geo-coordi-
nates): Date
and time of
creation or
last update
of the coordi-
nates (long
int(8Byte))

The out-of-
the-box data
model con-
tains these
fields for ID,
FI, KP, ZA,
OJ (BTB on-
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

ly) and PE.

To use geo-
graphic coor-
dinates in
variable
queries (us-
ing the loca-
tion of the
current rep
or station as
a compari-
son value),
use the geo-
graphic coor-
dinate fields
in the Rep
info area
(ID) and/or
define geo-
graphic coor-
dinate fields
in the Sta-
tion info
area (AS).

If you are us-
ing MS SQL,
an additional
field (type:
"geography",
name:
"XY_F<Field
number>") is
created in
the
database.
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

If an index is
defined for
the longitude
and latitude
fields and
the "geogra-
phy" data
type is sup-
ported, a
spatial index
is only
added for
this field.For
information
on the inter-
face with ex-
ternal appli-
cations,
see Geo-Co-
ordinates on
page 49.
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

mandatory:
Length
(see Length
on page 342)

If you linked
the html field
to a text
field, the text
field's length
is used.

Chtml-textHTML field
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

Select this
type to add a
field for stor-
ing formatted
text in the
database,
e.g. when
importing e-
mails into
Aurea CRM
or when cre-
ating html-
formatted
text in Aurea
CRM web
(e.g. for e-
mail activi-
ties).

Note:  Enter-
ing html-for-
matted text
is not sup-
ported in Au-
rea CRM
win.

To create an
HTML field:

Create a
new field of
type "html-
text".

Select an ex-
isting text
field to which
the HTML
field is
linked.

Note:  Aurea
recommends
to always
link HTML
fields to text
fields since
not all
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

clients sup-
port html-for-
matted text
in all circum-
stances.

When adding
text to the
HTML field,
the plain text
(without html
tags) is auto-
matically en-
tered into
the linked
text field.
Line breaks
are pre-
served in the
plain text
field.

Make sure
that only one
of the fields
- either
HTML or text
- is editable
for the user.
Otherwise
the field con-
tents may no
longer be
synchronized
correctly:

If the plain
text field is
edited,
changes are
transferred
to the HTML
field.
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

If the HTML
field is edit-
ed in a way
that the field
content no
longer star ts
with a <PRE>
tag, changes
in the plain
text field are
no longer
transferred
to the HTML
field.
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

Stores val-
ues of a
record in the
2nd curren-
cy, see Cur-
rencies in
the Business
Logic Manu-
al.

This field
type is only
available, if
a field of
type "curren-
cy" and a nu-
meric field
(small int,
short int,
signed int,
int, long int,
decimal) with
the "Curren-
cy" property
checked in
the Proper-
ties column
exists.

The 2nd cur-
rency field's
name is auto-
matically
generated as
"<field
name>
(2C)".
Changing
the label of
the linked
numeric field
changes the
label of the
2nd currency
field as well.

Zvir tual(2nd
currency)

2nd currency
field

335AUREA CONFIDENTIAL

Maintenance Module



Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

Properties
(see Proper-
ties on page
342)

4024-26F,K,Dcorporate
currency

Corporate
currency
field
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

Stores val-
ues of a
record in the
corporate
currency.

To create a
corporate
currency
field:

Define a Z5
variable up-
date_Corpo-
rateCurren-
cy (for info
area Ex-
change Rate
(BTB/FS:
WK, OTC:
WT), field
Currency).

Define the
corporate
currency as
variable val-
ue, i.e. value
of the "Cur-
rency" cata-
log.

In the data
model, cre-
ate a new
field of type
"corporate
currency".

Select the
field whose
value should
be convert-
ed.

The follow-
ing fields are
created:

4024 (Curren-
cy): A cata-
log field con-
taining the
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

currency de-
fined in the
Z5 variable.

4025 (Rate):
The ex-
change rate
as defined in
WT or en-
tered manual-
ly.

4026 (Date):
The date of
the most re-
cently en-
tered ex-
change rate.

the actual
corporate
currency
field display-
ing the value
of the refer-
ence field
converted to
the corpo-
rate curren-
cy.

For detailed
information
on the busi-
ness logic,
see Curren-
cies in the
Business
Logic Manu-
al.

---Contains a
field value
transferred
from another
info area.

Zreference
(field)

Reference
field
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

---Contains the
link to anoth-
er record.

The actual
link consists
of key fields
(e.g. sno,
lno) plus one
field of type
"reference
(table)", e.g
the link to a
Ticket (KM)
record in the
Activity
(MA) info
area.

The list con-
tains one en-
try per info
area and
link.

Select the
desired entry
and confirm
with OK.

The fields in
the selected
info area are
then listed in
a new win-
dow. Select
the field
whose con-
tents should
be trans-
ferred and
confirm with
OK.

Zreference
(table)

Link field
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Additional
Properties

(data model)

Fixed Field
No.

DescriptionData TypeField Type
(data mod-

el)

Field Type

>=4000Fields that
track when a
record was
added, edit-
ed or commu-
nicated,
when, on
which station
and by
whom,
see System
Fields in the
Aurea CRM
win Adminis-
trator Guide.

<various><various>System
fields

Fields de-
fined in Cus-
tom-
Fields.xml.

------Custom
fields

Renaming Fields
Learn how to rename a field.

1. Click in the Text column of the info area to change its field names.

2. Enter the field names in all the available languages, see Text on page 311.

Note:  Aurea CRM logs a warning if a field name in an infoarea is duplicated. The
warning is in the following format:

Duplicated field name is found on info area 'XX'. Field name is 'XX' and field id is
'XX'. Please use unique xml names in your info area model.

Field Options
Find the list of field options here.

Below are some of the options for info areas:

ID, Name, Type, Reference
The field name, type, reference and ID.

Serial Number

The first column displays the sequential serial numbers for each field.
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ID

An ID (fixed field number) is automatically assigned and displayed in the ID column.

Core fields: 1-3,999

System fields: 4,000-5,000

Custom fields: from 5,000 (update internal); from 7,000 for customers, see Number
Ranges in Aurea CRM on page 398.

Name

The field is automatically named and numbered according to its type.

Edit the name of the field using the Text field in the Info Area table, see Text on
page 311.

Type

The field type is determined when the field is added and cannot subsequently be
edited, see Aurea CRM Field Types.

Reference

Several associated fields are added for some field types. The Reference column
displays the fields that a field is linked with. You cannot edit the values in this col-
umn.

date, time: Date and time fields are linked to one another.

sno, lno: The station number and serial number are used to form a record's unique
key. It there is a link to another record using the station and serial number, a corre-
sponding reference is displayed here.

uid: A corresponding group field is added for each rep field. If a user enters a rep's
ID in the Rep ID field, the Rep, Resp. Rep Group ID and Rep Group fields are
filled in automatically.

Catalog
This column is used to link a field with a catalog.

Users can then access the catalog when editing the field.

You can only edit the catalog for fix catalog and var catalog fields.

You cannot change the associated catalog once the info area has been applied to
the active data model.

DB Column
The name of the column in the database is displayed here.

This name is assigned automatically and cannot be edited. The name is composed
of F + ID or F + ID + _DT for date fields.
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Time Stamp
This fields option is to display the current date and time.

Enable the Time Stamp cell for a field, if you wish to update the Upd field with the
current date whenever the field contents are edited.

Length
The length of the field in the input mask is determined here.

This corresponds to the number of characters for text fields.

In Aurea CRM web fields with length >= 256 characters are automatically displayed
as multi-line fields unless a contrasting field attribute is set.

Note: You can define text fields longer the 8 KB in Oracle. However, if you wish to
communicate data to other stations using an MS SQL database, you should
nonetheless restrict the field length to 8KB. Otherwise problems could occur in the
receiving MS SQL database.

Properties
Properties for various field types.

You can select the following properties for the various field types:

Text Fields

• Document: Document fields function as standard document fields. A document
field must have a Length of at least 20 characters.

• E-mail: Clicking on an e-mail field opens the mail client with an empty e-mail
addressed to the recipient entered in the field. The field length should be at least
50 characters.

• Hyperlink: If a user clicks on a hyperlink field, the URL is opened in the user's
web browser.
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Rep, Date and Time Fields

• Default: When a new record is added, the current rep, date or time is automatically
entered in this field.

Rep Fields

• Rep, Group, Resource : Use the first of the four linked rep fields ("uid") to
determine whether reps, groups or resources can be selected in the field.

Numeric Fields

• Currency: If the info area already contains a field of the type currency determining
the currency used by the record, you can select a numeric field used to store
amounts in the selected currency.

All Fields

• readonly : The field is set to read-only and cannot be edited.

Further Properties

The following properties are only displayed and cannot be edited.

DescriptionProperty

Associated with an input function"in()"

Associated with an output function"out()"

Search filter function"filter()"

Hidden field"hide"

Locked field"lock"

No totals displayed in lists"no sum"

Display the associated company as a reference"refFi"

Display the associated person as a reference"refKp"

Standard list field"def.listfield"

Not a list field"no listfield"

Not a mask field"no mask-
field"
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DescriptionProperty

read-only field (including for the SU)"readonly"

Boolean field"y/n"

Not communicated"no
comm.field"

No time stamp is entered when the field is edited"no times-
tamp"

Mandatory field"must"

Locked for selections"select.lock"

Locked for activities"activity.lock"

Obsolete"not used"

Tenant number (names are output by language)"mno"

Free field"free"

Serial number"lno"

Station number"sno"

Format
The format determines the output of the field contents.

Click in the Format column to select a format, depending on the field type.
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Select the desired options. Depending on your settings, a code is displayed in the
Format field.

CodeDescriptionOption

e.g. "#.1" (1 decimal
place); "#.1234567" (7
decimal places)

Number of decimal places for
decimal fields.

Decimal Places

"signed"Determines whether negative val-
ues are allowed.

Negative

"leading zero"Determines whether leading zeros
are displayed so that the value
takes up the full field length.

Leading zeros

"0"

"00:00" for time fields

Determines whether values of ze-
ro are displayed.

Display zero values

"1.000"
Determines whether a separator
is used for numbers from 1,000
onwards.

If a number entered exceeds the
length of a field, digit grouping
symbols are not displayed (irre-
spective of the setting above).
This allows the entire number to
be displayed.

Thousand separator

".-"Adds a ".-" after the value.Value tag

"%"Determines that the value is dis-
played with a percentage sign.

Percent symbol

"left"The field contents are aligned to
the left.

Align left

"center"The field contents are centered.Centered

"right"The field contents are aligned to
the right.

Align right

"button"Edit field with arrow(no option)

"ddmmyy", "ddmm",
"mmyyyy", "mmyy

Date format (d = day, m = month,
y = year)

(no option)

"only digits"Text field containing digits only(no option)

"hhmmss", "hhmmss,ttt"Time format (h = hours, m = min-
utes, s = seconds)

(no option)
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Depict Rep Reference

Rights definitions that check for a specific rep being entered in company-/person-
dependent info areas may impact performance because the evaluation of such
conditional access rights involves multiple tables. If configured, the Rep Reference
info area (10) can be used instead: The Rep Reference info area contains a record
for each instance of a rep in a dependent record which can be used in queries and
rights definitions, see Rep-Based Access Rights on page 146.

To configure the creation of rep reference records:

1. Activate the Depict Rep Reference flag for all rep fields for which rep reference
records should be created.

2. Apply the data model changes.

3. The creation of rep reference records is activated per station: Switch to the Station
Configuration info area.

4. Activate the Calculate rep reference checkbox for those station where you want
to use rep references.

5. Save.

Rep reference records are maintained via database triggers. Once the Calculate
rep reference flag is set for a station (and communicated, if applicable), these
triggers are created in the station's database for the info areas where a Depict Rep
Reference flag was set.

For the above example (MA):
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Entering/changing a rep in the MA Participant field creates/updates the respective
rep reference record.

Note:  Rep reference records can not be displayed in Aurea CRM win or Aurea CRM
web. Fields from the Rep reference info area can not be used as mail merge fields.
Manual changes to rep reference records are not supported.Rep reference records
can not be transported via communication or CRM.cockpit.

If you add the Depict Rep Reference flag for a rep field, new database triggers and
rep reference records are created accordingly. Removing the flag deletes the corre-
sponding records from the Rep Reference info area (and the database triggers, if
applicable).

Removing the Calculate rep reference flag removes the database triggers.

In addition, you can re-create rep reference records and the data base triggers using
the SQL tool (mmba.exe -q):

1. Select an info area for which rep references are configured.

2. Click on Calculate rep reference.

Use the ReCreate Procedure and ReCreate All Procedures buttons to re-create
the database triggers.

For information on the SQL tool, see SQL Tool on page 469.

Mask
Use the Mask column to determine the characters that can be entered in a field.

For example, you can determine that the station number consists of two groups of
digits separated by a hyphen.

You can either enter these restrictions in the Mask field or select a list of predefined
masks from the list. If you select a mask the code assigned to the mask is displayed
(e.g. #108).
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Note: These settings are only applied to Aurea CRM win. You need to enable the
Masked input fields option in the user interface settings (Masks tab) in order to
use this function, see Masks Tab in the Aurea CRM win Administrator Guide.

Selecting Field Masks

1. Double-click in the Mask column or click on the small arrow to open the Selection
dialog box.

2. Select one of the following options:

• Numeric: Only digits can be entered.

• Alphanumeric: No digits may be entered.

• IP Address: The field is made up of 4 blocks or 3 digits separated by a full
stop; e.g. 123.123.123.123

• E-mail: The field must contain the @ sign.

• Currency: The field is displayed as a currency fields and uses the same settings
(decimal places, digit grouping symbol).

• Time (standard): Time field using the format configured for the system.

• Time (am/pm): Time field with "am" or "pm" appended.

• Time: Time field without "am"/"pm".

• Percent (without decimal places): The number is displayed as a percentage
without decimal places; e.g. "13 %".

• Date (standard): The date is displayed according to the Windows settings.
However the date is not subject to consistency checks and the pop-up calendar
cannot be accessed.

Defining Field Masks

You can determine your own input restrictions for fields by entering them directly
in the Mask column.

• Fixed characters are entered directly

• Groups of characters are defined using the following format:
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[LIMIT:FILTER:FLAGS:LENGTH:MIN:MAX]

Number of characters allowed. Enter -1
for no limit.• LIMIT

Permitted characters. You can enter the
characters themselves or a range; e.g.
"ABCD" or "0-9", "a-z".

FILTER

Attributes that determine the behavior
of the group, >> Flags Options on page
163.

FLAGS

Number of characters available for this
group. If you have determined that
leading zeros are displayed (FLAGS
option), zeros are added until the num-
ber of characters is equal to the
LENGTH.

LENGTH

The smallest possible valueMIN

The largest possible value.MAX

You do not need to enter values for all options. For example, you could enter "[4:0-
9]" and ignore all options apart from LIMIT and FILTER. However, if you only want
to enter values for FLAGS, you need to precede the value for FLAGS with two colons
(for LIMIT and FILTER).

Examples
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ExampleExplanationInput

AUp to 1 character[1]

7:4Up to 3 characters[3]

Ad943Any number of characters[-1]

RUp to 1 capital letter[1:A-Z]

AUTUp to 3 capital letters[3:A-Z]

123Up to 3 digits[3:0-9]

AUp to 1 character; either A, B, C or D[1:ABCD]

FUp to 1 character between C and M[1:C-M]

BN1 4NETwo groups of up to 3 characters sep-
arated with a space.

[3] [3]

MfjUp to 1 capital letter followed by up to
2 lower case letters.

[1:A-Z][2:a-z]

1234-123Two groups of digits separated by a
hyphen. The first group can be up to
4 digits long; the second up to 9 digits
long (station number - serial number)

[4:0-9]-[9:0-9]

1- 1Two groups of 3 digits separated by a
hyphen. If less than 3 digits are en-
tered, the digits still occupy space for
3 digits

[3:0-9::3]-[3:0-
9:3]

43 digit number no higher than 255[3:0-9:::0:255]

Flags Options

The options used to determine the attributes of a field can be combined with one
another. Each attribute has an associated value:
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On ScreenExampleExplanationValue

***1 ***

*** 1***

***[3:0-9:1:3]***

***[3:0-9::3]***

If the LENGTH is set,
the field is aligned to
the left. Otherwise
the field is aligned to
the right.

1

***abv******[3:0-9:2]***Determines that the
characters entered
under FILTER are
those that may not
be entered.

2

[2:0-9:4]Removes any leading
zeros.

4

***001***[3:0-9:32:3]If the LENGTH is set,
determined that any
empty places are
filled with leading ze-
ros.

32

1,- or empty[-1:0-9:64],-If fixed characters
are entered to the
right of the group,
these characters are
only displayed if the
group is not empty.

64

123,-

1.234,-

[3:0-9:192].[3:0-
9:320],-

The group only be-
comes "active" if val-
ues from the group to
its right overflow.

128

123,-

1.234,-

[3:0-9:192].[3:0-
9:320],-

The group on the
right is filled out first.
The values in the
group on the left are
deleted first.

256

Press "-" to jump to the second
group.

[3:0-9:512]-[2:0-9]If the separator char-
acter is entered and
the character is not
allowed within the
group, input switches
to the next group.

512
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On ScreenExampleExplanationValue

As soon as a capital letter is
entered, the letter is entered
in the second group.

[3:0-9:4096]-[3:A-Z]If a character is en-
tered that is not per-
mitted in the current
group, the system
tries entering it in the
next group.

4096

When deleting digits, the hy-
phen is not deleted.

[1:-:8192][3:0-
9:192].[3:0-9:320],-

Prevents deleting a
previous group when
deleting a latest
group.

8192

• To enable multiple options, add the values for the options you wish to enable and
enter this value in the Mask column.

• Note that value entered under FLAGS corresponds to a binary representation of
an integer, whereby the first option corresponds to the least significant bit, the
second option to the next bit etc.

• The values 64, 128, 256 and 8192 are used to define print options for currency
fields. The thousand separator is only displayed when the four th digit is entered
(and removed if the four th digit is deleted). Values in these fields are deleted
from right to left.

Note: Saving: The options in the Length, Properties and Format columns only
affect the display and not how data is saved in the database. The options entered
under Mask determine that the data is also saved differently. For example, if
[1:ABC]-[1:123] is entered, "A-1" would be saved in the database.

Importing: The value entered under Length is tested when importing data. Numeric
values that exceed the threshold are refused; alphanumeric values are truncated
to fit. The attributes entered under Mask are not taken into account when importing
for performance reasons.

Reference Search
Use the reference search to check which objects (formats, queries, distribution logic,
opportunity plan) use an info area, a field or a variable catalog.

The Reference Search context menu option is available in the following levels of
the data model:

• Info Area

• Fields

• Variable Catalog node on the data mode main page: This results in a list of all
catalog values referenced in formats etc.

• Variable Catalog list: Lists the references to values of the selected catalog.

Example: Reference search for "Country" catalog
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The last column displays the referenced catalog value with the tenant number in
curly brackets (if applicable).

Deleting Entries
Learn how to delete info areas or fields.

Before deleting an info area or field or a variable catalog, select Reference search
to check which objects (formats, queries, distribution logic, opportunity plan) refer
to the info area, field or catalog you plan to delete, see Reference Search on page
353. Edit these objects to remove the references.

Double-click in the first column and confirm the message to delete a field, info area
or catalog value.

Fixed catalogs can only be deleted by double clicking when using the integrated
view. Otherwise the first click opens the Fixed Catalog table. Resize the Fixed
Catalog by dragging the left hand border. You can now delete the catalog by double-
clicking. If you save your windows settings, the next time you double-click, you do
not need to resize the window.

The info area, field and or catalog with the highest number (or ID) should never be
deleted from the data model. If you no longer wish to use such a value, delete it
from the mask or list or set it to inactive. If you remove such an entry from the data
model and subsequently add a new one, the new entry is assigned the same number
as the deleted entry. This can lead to problems when communicating the data
model or in CRM.designer.

Example: Customer Complaints
This example uses a new table that is used to store complaints from customers.

The table should be dependent on the Company info area; i.e. complaints are stored
for companies.
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Adding the Customer Complaints table

First you need to define the properties of the new table:

1. Open the Maintenance module.

2. Switch to the Data Model info area.

3. Click Generated below Info Area in the tree structure.

The Info Area: Generated table is displayed.

4. Click in the No. or Name cell in the first empty row to add a new table.

5. Choose "child, N-1" from the dialog box and click OK. This defines an N-1
relationship between the parent info area (Company) and this info area; i.e. a
company can be linked to any number of customer complaint records, and each
customer complaint is linked to a single company.

6. Select "Company" as the parent info area in the next dialog box and click OK.

Your new line should look like the following:

7. Click in the Info Area cell to display a table containing the fields in the new info
area. A number of fields are added by the system. These include system fields,
such as time stamps, delete and communication codes, as well as the fields
required to establish the link between the new info area and its parent, key and
index fields.

8. To add the Description field, used to store a description of the complaint:

a. Click in one of the first four columns in an empty row.

b. Select "Text" as the field type, and click OK.

c. Specify the length for the text field in the Length column.

9. Add the other fields in the same manner, but select the corresponding field type
from the dialog box:

• Product Group: Select "var catalog" as the field type. Select "Product Group"
as the catalog to link the field to the Product Group catalog.

• Product: Select "var catalog" as the field type. Select "Product" as the catalog
to link the field to the Product catalog. You are then asked to specify the parent
catalog. Select "Cat.Var" (the only option) to link the Product catalog with the
Product Group catalog.

• Rep: Select "uid" as the field type. 4 new fields are added, that display the
rep's name, ID, group and group ID.

• Reply by: Select "date(4Byte)" as the field type.

10.Click on  (OK).

11.In the row of the new info area click in the Text column.

The info area and a list of the fields in the info area are displayed.
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12.Enter the name of the info area (e.g. "Customer Complaints) and fields (e.g.
"Description", "Product Group", "Product", "Rep", "Reply by") in the Language
Independent and language-specific columns.

13.Click on  (OK).

14.Select Apply info area from the context menu to apply the changes to the data
model used by Aurea CRM.

Integrating the new Table

In order to use the Customer Complaints table in Aurea CRM win, a level containing
the info area needs to be defined.

1. Start the Aurea CRM win main module.

2. Select Extras > Define Desktop from the menu.

3. Click on Define Levels.

4. Click OK.

5. Click on  (New) in the Levels pane.

6. You are prompted for an ID for the level. Accept the default value by clicking OK.

7. Enter the name of the level ("Customer Complaints") in all available languages.

8. Click on  (Edit) next to Info area selection.

9. Select the Customer Complaints info area from the list.
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10.Click OK.

11.Select a mask and list to be used by the level.

12.Click on  (Edit) next to the Settings field.

13.Enable the Select All check box in the Level commands pane:

All the commands are then available in the Customer Complaints level.

14.Click OK.

15.Click on  (Edit) next to the Predecessor field.

16.Select Company + Person as the predecessor level.

17.Click OK.

18.Click on  (Edit) next to the Relationship with Parent field.

19.Select "Ratio n:1" and enable the Mandatory check box for the Company info
area.

20.Click on  (Flags) next to the Company info area and enable PRO_PREL_KEY.
This setting causes the system to automatically enter the company group and
number when adding a new customer complaint record.

21.Click OK three times.
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Accessing the Level

In order to access the new level, you need to add commands used to open the level
to the desktop format. You can open levels from the Info menu, the level header,
context menu or icon bar, see Desktop in the Aurea CRM win Administrator Guide.

Database Analysis
You can analyze the structure and contents of your Aurea CRM database - the info
areas used, the number of records per info area, the time of the last modification,
customer-specific customizations (fields and formats).

The analysis results can be used e.g. to plan and execute the migration from Aurea
CRM win to Aurea CRM web, see Migrating Data on page 407.

Executing the Analysis
Learn how to execute the analysis.

To analyze the Aurea CRM database:

1. Switch to the Data Model level in the Maintenance module.

2. Select Analysis from the context menu.

Note: The Analysis option in the context menu is available for the SU and users
who have access to CRM process 1.5.1.6 "Data Model" and 1.5.1.6.40. "Analysis",
see CRM Process Configuration on page 98.

The Analysis info area is displayed.

When first accessing the Analysis level info areas that contain records are dis-
played in red. Info areas that contain no records are displayed in black.

When subsequently accessing the Analysis level all info areas are displayed in
red until they have been analyzed (again).

358AUREA CONFIDENTIAL

Chapter 3: Using CRM Core

https://help.aurea.com/crm/crm-win-admin-guide/crm-win-admin-guide/dita/topics/c_win_adm-4_3-Desktop_crm.html


Available context menu options:

• Info areas: The Info areas view displays the results of the analysis per info
area (fields used, active triggers, workflows etc.), see Info Areas on page 360.

• Format: The Format view displays the results of the analysis per format type
(number of formats and formats in use), see Formats on page 365.

• Rep: The Rep view displays the usage of the Aurea CRM modules per rep,
login and station, see Reps on page 366.

Note: These options are only active once the data base has been analyzed
completely.

• Transfer to Spreadsheet: Select this option to transfer the analysis results to
Microsoft Excel.

• Display info area abbreviations: If this option is enabled, the info area IDs
are displayed after the info area names in the Info Area column.

• Display all: If this option is enabled, all info areas are displayed. Disable this
option to restrict the display to only those info areas that contain at least one
record.

• Analyze selected info area: Select this option to analyze the currently selected
info area. In this case, the result of the analysis only update the Number of
records to Fields columns. Information on formats is not updated for the info
area.

You need to (re-)analyze the Format info area to update the information on
formats used by the info area.

• Migration: Opens the Migration level, see Migrating Data on page 407.

Note: The Migration option is only available to internal update users and partners
(Select user group option in the Data Model level).

3. Click on  (Execute) to analyze the entire database.

Aurea CRM searches for records and formats in all info areas. The results of the
analysis are displayed in three views (Info areas, Format, and Rep) and saved
as a BLOB in a new record in the Process Tracking (T3) info area. Select
Transfer to Spreadsheet to transfer the analysis results to Microsoft Excel.

The next time the Analysis level is opened the results are automatically loaded.
The info field above the table displays the time and date at which the analysis was
saved. All info areas are again displayed in red, as the contents of the database
may have changed since the last analysis.
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Info Areas
Learn about the info areas view displays.

The Info areas view displays the following information for each info area:

• Number of records: The number of records in the info area. Records marked as
deleted are also included in the total.

Double-click on the column-header to count the number of records in the info areas
again. If the number of records counted differs from the number stored in the
loaded analysis, the number is displayed in blue. Double-click in the Number of
records cell to only count the records in that info area again.

• Records analyzed: The number of records analyzed in the info area.

Different figures in the Number of records and Records analyzed columns result
from records that have been marked as deleted; these records are counted but
not analyzed.

• Analyzed: Date and time of the last analysis

• Last record added: Date on which the most recent record was added in this info
area.

• Last change: Date of the most recent change to a record in this info area.

• Q1-4 New/update: These columns display the number of added and edited records
over the course of the past year (i.e. the current date - 1 year) in "quarters" (i.e.
9-12 months ago, 6-9 months ago, 3-6 months ago, and the last 3 months).

• Fields: The number of fields in the info area that contain data in at least one
record. Click on the Fields cell to display details on the corresponding info area,
see Fields on page 300.

• Search Condition/List/Selection etc.: These columns display information on
the number of formats of that type which reference the corresponding info area.
Switch to the Format view to display an overview of the formats across the entire
database, see Formats on page 365.
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A column is displayed for each type of format where at least one format is stored
in the database. To display/update these values, (re-)analyze the Format info area.

Click in a cell to display details concerning the formats of that type for the corre-
sponding info area.

The following information is displayed for each format:

• Format name and name of the user who created the format. (No user name is
displayed for global formats.)

• Created on/Updated on: The date on which the format was added / last updated.

Select Print Format from the context menu to display the selected format in the
print preview; select View XML to display the format in the XML view.

Formats that are relevant when migrating to Aurea CRM web (e.g. word processor,
rights, triggers etc.) are split up into active and inactive formats, see Active/Inactive
Formats.

Click in a cell to display details concerning the formats of that type for the corre-
sponding info area

Active formats are displayed in black; inactive formats in gray. Select Active or In-
active from the context menu to determine which formats are displayed.
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Fields

Click in the Fields cell in the analysis results to display details of the fields in the
corresponding info area:

The Quantity column displays the number of records where the corresponding field
contains data. Fields that do not contain data in any record are not listed.

For information on the other columns in this view, see Field Options on page 340.

Active/Inactive Formats

Formats that are relevant when migrating to Aurea CRM web (e.g. word processor,
rights, triggers etc.) are split up into active and inactive formats.

Note:  Formats (e.g. XML reports) that are not integrated in other formats but can
instead be accessed directly (from the File menu) are not counted as active formats.

Criteria for active formats:
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CriteriaFormat Type

Used in:

an active workflow

an active mask or list

an active desktop

an active dashboard

Analysis

Used in an active XML reportChart

Used in a communication connection (C1)Communication

Used in:

an active desktop

an active workflow

an active mask or list

Dashboard

Assigned to:

an active rep record (rep or group)

a station

an active role

Note: A Rep or Login Role is active if the
Inactive field is disabled.

Desktop

Executed at least once in the past year

The time of the last execution is stored
in the Communication Logs info area for
imports, and directly in the format for
exports.

Note: The communication log records
must be present on the station on which
the analysis is carried out.

Import/Export

Used in:

an active desktop

an active configuration (MC) entry, >> .

Info Area
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CriteriaFormat Type

Used in:

an active trigger

an active workflow

an active mask or list

an active desktop

an active dashboard

an active interface format

an active info area format

a level definition ("Defined levels" format)

Masks (masks and lists)

Used in:

an active XML report

an active analysis

an active word processor format

an active chart

Read engine

(transfer fields format)

Assigned to:

an active rep record (rep or group)

a station

a role

Or used in:

an active workflow

an active rights format in the case of
global or local extensions

Rights

Used in:

an active dashboard

an active mask or list

an active desktop

Timeline
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CriteriaFormat Type

Used in:

an active rights format

an active workflow

an active desktop

an active mask or list

an automatic selection ("Autom.Selection"
and "Autom. Property Selection" (BTB
only) formats)

an active dashboard

an active chart

Trigger

Used in an active desktopUser interface

Used in:

an active workflow

an active mask or list

an active trigger

Word processor (transfer format)

Used in:

an active rights format

an active desktop

an active mask or list

an active dashboard

an active chart

Workflow

Used in:

an active workflow

an active mask or list

an active desktop

an active dashboard

XML reports

Formats
The Format view displays the results of the analysis per format type.

To update these values, re-analyze the Format info area.

A row is displayed for each type of format where at least one format is stored in the
database. Formats that are relevant when migrating to Aurea CRM web are split up
into active and inactive formats, see Active/Inactive Formats.
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Note:  Formats (e.g. XML reports) that are not integrated in other formats but can
instead be accessed directly (from the File menu) are not displayed as active
formats.

Click in the Quantity cell of the desired format type to display a list of the available
formats. Click in the Active or Inactive cells to restrict the display to only active or
inactive formats.

The following information is displayed for each format:

• Format name and name of the user who created the format. (No user name is
displayed for global formats.)

• New/Upd: The date on which the format was added / last updated.

• Active formats are displayed in black; inactive formats in gray.

Select Print Format from the context menu to display the selected format in the
print preview; select View XML to display the format in the XML view.

Reps
The Rep view displays the usage of the Aurea CRM modules per rep, login and
station.

The analysis is based on the data stored in the User Tracking (T1) info area.
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A column is displayed for each used module containing the number of reps, the av-
erage usage and the number of times the reps and logins have logged in to the
module

Quantity

Number of users per module:

The first value indicates the number of reps that have at some point logged on to
this module

The second value indicates the number of reps that have logged on to this module
in the past year (i.e. the current date - 1 year)

Nutzung

Average use of the modules:

The first value indicates the number of times users have logged on to this module
divided by the number of users (login records) where the Active column is enabled.

The second value indicates the number of times users have logged on to this module
divided by the number of users (login records) where the Active column is enabled
and where the user has accessed the module at least once.

Below this node, a node is displayed per rep record (Name + Rep/Group ID) with
all associated login names of the rep as child nodes (User Name + Stat.No. of the
stations that the user has logged on to). The columns for the individual modules
display the number of times the module has been logged on to.

Inactive reps are displayed in gray (the Inactive field is enabled in the rep record).

The "Does not exist" node contains all login names (User Name + Stat.No. the login
is assigned to) that are not assigned to a rep record. This node is ignored when
calculating the "Quantity".
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Active Column

The Active column allows you to exclude individual reps (login records) from the
usage calculations (e.g. administrative users such as COM, WWW, IMP etc.). The
"Nutzung" row and the number of times that users logged on entered in the parent
rep node (or "Does not exist") are updated accordingly.

Text Info Area
Use the Text info area to manage user-defined texts.

For fur ther details, see Displaying and Editing Texts on page 373.

The Text info area displays:

• All user-defined multi-language texts saved in formats (messages, field names,
info area names, buttons etc.), see Entering Texts in Multiple Languages on page
369.

• All texts entered in multi-language fields in the database (e.g. field help,
questionnaire etc.), see Multi-language Fields on page 371.

Words or sentences that occur multiple times (e.g. in several formats) are linked to
a single entry in the Text info area, see Displaying References on page 378.

Use CRM.translation tool to translate user-defined texts, see CRM.translation tool
on page 474.

The text IDs of new or edited field names and info areas are output in curly brackets
in the mm_dbstr.txt file, see mmba.exe Parameters on page 13.

The following information is displayed for each text entry:

• Record: A check mark in this column indicates that the text is used in a record,
e.g. a questionnaire or field help record.

• Field Help: The text is referenced by a field help record, see Field Help on page
380.

• Data Model: The text is used by the data model, i.e. a field or info area name or
a value of a fixed catalog. For texts used as field or info area names the Info
Area column contains the name of the info area.

Note: Values of variable catalogs are maintained in the Catalog info area,
see Catalogs on page 270.
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• Format: The text is used by a format (except the data model format), e.g. a trigger
or mask.

• Info Area: Displays the info area where the text is used. If a text is referenced
by more than one info area, the first occurrence is displayed.

If a text is referenced by a record or the data model, the Info Area column displays
the respective field name as well.

• Format Type: Displays the format type for texts referenced by formats. If a text
is reference by more than one format, the first occurrence is displayed.

• ID: The ID of the text.

• Language columns: One column for each defined language plus the Language
Independent column is displayed. (The text in the Language Independent column
is used if no translation is available for a language (or its parent language).)

The text for each language is saved in a separate text record. All translations of
a text are linked via the 04_1_StaNo and 04_1_SerNo fields (unique key for
translated texts).

Note:  By default, the text in the Language Independent column is always
displayed even when the native language text is present in the defined language
column. To display the native language text enable the Disable Language Inde-

pendent Text Overrides Native option in the general settings. For more
information, see Disable Language Independent Text Overrides Native.

The usage information (Record, Info Area etc.) is automatically added to text
records, if a text is added in the data model or when saving a record. To update all
text records with this information, select Calculate Text Usage from the context
menu.

Note: You cannot load any texts, propagate any changes or remove any references
in the Text info area if the Data Model is open.

If you are using tenants: Do not define tenant rights settings for the Text info area.
Tenant-dependent texts are not supported.

Entering Texts in Multiple Languages
You can enter user-defined texts (messages, field names etc.) in multiple languages
in Aurea CRM.

To do so, you need to define the languages in the Language info area in the Rights
module and assign the languages to the corresponding stations in the Station info
area, see Defining Languages on page 109 and Assigning Languages on page 113.
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You can define multi-language text fields in info areas in order to provide the means
for users to enter data in their current language, see Multi-language Fields on page
371.

You can manage user-defined texts in the Text info area, see Displaying and Editing
Texts on page 373.

To enter text in multiple languages:

1. Click on  (Multi-language Input) next to a text field.

The Edit text dialog box is displayed:

2. Enter the text in the desired languages or click on  (Load) to load a text from
the Text info area. Use Ctrl+Enter to add line breaks in multi-line fields.

The Text Selection dialog box is displayed.
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The list of texts is stored in the cache and updated every 30 minutes.

• Double-click on an entry to transfer it to the Edit Text dialog box.

• Click  (Edit) to edit an entry.

• Click  (New) to add a new entry.

• You can group entries in the list and move entries from one group to another,
as in the Text info area, see Grouping Texts on page 374.

3. Click OK.

Click  (Remove link) in the Edit Text dialog box to remove the link between the
text and the Text info area.

Multi-language Fields
You can add multi-language fields to info areas in order to display and enter data
in multiple languages.

To do so, you need to link the desired info area with the Text info area. "Reference
fields" allow users to enter information in multiple languages while accessing the
Text table.

Multi-language fields are implemented by default for the following info areas: Answer
(F3), Field Help (FH), Question (F2) and Questionnaire/Portfolio (F1).

To define a multi-language field, for example in the Activity info area:

1. Open the Maintenance module and switch to the Data Model info area.

2. Define an N:1 link from the Activity info area to the Text info area, see Link on
page 305.

3. Make sure you select index "(2) 04_1_StaNo,04_1_SerNo,Language No.".

The fields 04_<linkID>_04_1_StaNo, 04_<linkID>_04_1_SerNo. and
04_<linkID>_Link are added.

4. Specify the length of the reference field (04_<linkID>_Link) and its name,
see Length on page 342 and Text on page 311.

5. Apply the changes to the data model, see .

Aurea CRM web: Apply the changes to the CRM.designer database using
CRM.bulkloader, see Data Model, CRM Processes, Roles and Catalogs in the
Aurea CRM web Administrator Guide.

6. Add the field e.g. to the MA Details control, see Customizing Controls in the Aurea
CRM web Administrator Guide.
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The contents of such multi-language fields are displayed in the current user's current
language. If no text is defined for the current language, the text is determined as
follows:

• if a text exists in one of the parent languages, then this text is used

• otherwise the language-independent text is used

• if no language-independent text is found, the next available text in any other
language is used (the search order is determined by the language numbers in
ascending order).

If a user enters text into a multi-language field, the text is saved as follows:

• If no link to the text table exists, a new record is created either

• for the current language (if the current language has no parent language)

• or for the last parent language in the hierarchy

• If a link to the text table exists already, this text record is updated.

Note: This may alter a text in another language (s. above). Define conditional
access rights for 04 to make sure users cannot change translations they are not
supposed to change.

The record containing the field is not updated, i.e. the system fields containing
the update information (Updated by, Updated on etc.) are not updated.

Note: When communicating info areas that contain multi-language fields, make
sure you also communicate the related text table entries, see Communicating
System Tables in the Aurea CRM win Administrator Guide.

By clicking  (Edit) next to the field users can add the text in other languages:
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All languages assigned to the current station and which the user has access rights
for are displayed. Exception: All languages defined in Aurea CRM are displayed for
the administrator (SU).

The Languages.Editable and Languages.Visible Web Configuration parameters
determine, which languages are displayed/can be edited (defaults: display = all,
edit = current language), see Languages.Editable/Languages.Visible in the Aurea
CRM web Administrator Guide.

Languages.Editable and Languages.Visible do not apply to the SU, i.e. the SU can
view/edit all languages.

Note: The  (Edit) icon is only visible in Expand views (not in lists).

Displaying and Editing Texts
Learn how to display and edit all texts defined in Aurea CRM.

To display and edit all texts defined in Aurea CRM:

1. Switch to the Text info area in the Maintenance module.

2. Select Apply  all texts from the context menu. (Or click in a language column
and select Transfer language: <language> from the context menu.)

You can restrict which texts are transferred using conditions, e.g. applied to the
format type (Data > Define Conditions).

3. Answer the prompt with Yes, see Propagating Changes on page 376.

All user-defined texts are displayed in the table.

• Click on a gray language column header to sor t the texts in the column
alphabetically.

• Click  (Find) to search for a specific text, see Searching for Texts on page
375.
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4. Double-click in the line you wish to edit.

The Edit Text dialog box is displayed.

5. Enter the desired changes and click on OK.

6. Write your changes to the formats, see Propagating Changes on page 376. (Records
that reference a text from the Text info area load the (changed) texts at runtime.)

To add a new entry in the Text info area:

1. Click on  (New).

The Edit Text dialog box is displayed.

2. Enter the text in the appropriate fields.

3. Click OK.

The text is displayed in a new line.

Grouping Texts
Learn how to group entries.

To group entries:

1. Add a new entry as the title of a new group.

2. Click on the entry you wish to assign to the group for a couple of seconds.

3. Drag the entry to the title. The entry is displayed as a gray shadow.

Drag an entry to the table's header to remove it from a group and move it to the
top-most level.

Select Expand all or Collapse all from the context menu to display or hide all
grouped entries.

Texts are grouped using the 04_1_StNo. and 04_1_SerNo. fields. The 04_1_StNo.
and 04_1_SerNo. of the group name are written to the 04_2_StaNo. and
04_2_SerNo. fields.
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User-defined texts in multi-language fields (see Multi-language Fields on page 371)
can be assigned to groups when entered by entering values in the Predecessor
fields using default values or triggers:

• Define the desired default values for the 04_2_StaNo. and 04_2_SerNo. fields
in the Text info area, see Default Values when Adding Records on page 152.

• Define suitable triggers for the info areas containing multi-language fields,
see Triggers on page 169.

Note: The default values and triggers do not work when adding texts from the tree

view (  (New) button in the Text Selection dialog), see Entering Texts in Multiple
Languages on page 369.

Sorting Texts
Texts in groups are sor ted within the group.

To sor t texts in the Text info area:

1. Click on one of the gray column headers to sor t the entries in the column
alphabetically.

Empty texts are sor ted according to the entry in the Language Independent
column.

Searching for Texts
Learn how to search for texts info area.

To search for texts in the Text info area:

1. Open the Text info area in the Maintenance module.

2. Click  (Find).

3. Enter the text (or par t of it) in the Text field.

4. Select the Language. If you do not select a language, the string is searched for
in all languages.

5. The following search options are available:

• Case sensitive: Enable this option to carry out a case sensitive search.

• Wildcards ( * ? ): Enable this option to use wildcards in your search (* = several
characters; ? = a single character).
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Note:  Note: You can use literal character values of ‘*‘ and ‘?’ using the escape
sequences ‘\*’ and ‘\?’.

• Hidden Texts: Enable this option to search in text groups that are hidden (i.e.
not expanded), see Grouping Texts on page 374.

• Search Up: Enable this option to change the search direction.

Note: The search is carried out from the current cursor position.

6. Click Find to begin the search.

7. Click Close to exit the search.

Propagating Changes
Learn how to propagate changes.

You can restrict texts transferred to the Text info area and formats using conditions
(e.g. a condition applied to the format type using Data > Define Conditions > For-
mat).

Note: When transferring new data model texts using a condition, make sure the
condition includes the format types "Data Model" and "Design". Otherwise the IDs
of newly generated text records is not written to the data model.

Texts that you have deleted in the Text info area are not deleted in formats.

For information on all available options for applying text changes in the data model,
see Applying Text Changes.

Changes to texts are transferred to branch offices within the scope of communication
between stations. Ensure (using access rights) that no edited texts are input on the
main office during communication.

Formats -> Text Info Area

To transfer changes to texts in all languages from formats to the Text info area:

1. Click in the left-most column and select Transfer all texts form the context menu.

2. Confirm the prompt with Yes.

3. Select any languages to be excluded from the match-up in the Language(s) to
exclude from match up when first transferring texts dialog. All other languages
are matched up when transferring the texts.

4. Click on OK.
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5. If you selected all languages (i.e. no match-up), a message is displayed asking
whether texts that are identical in all languages should be merged.

• Yes: Texts that cannot be matched up using the unique key are matched up
with entries in all languages and possibly merged.

• No: Texts that cannot be matched up using the unique key are added as new
entries.

6. A message is displayed if texts present in the Text info area have been changed
in either the Text info area or a format:

• Select Update Record to transfer the text from the format to the Text info area.
In the above example, the record in the Text table would be changed to "New
Phone Call".

• Select Update Format to transfer the text entered in the Text info area to the
all formats using the text. In the example above, "New Call" would be written
to all appropriate formats.

• Select No changes to retain both versions of the text, e.g. "New Call" in the
Text info area and "New Phone Call" in formats. If you select Transfer all texts
from the context menu again, the message is displayed again.

• Select Cancel to cancel the process.

To display this message for empty text strings, enable the following options in
the context menu before transferring the texts:

• Prompt when transferring new texts and updating Text table (match up by
ID): The message is displayed if the text in the Text table is empty.

• Prompt when transferring empty texts and updating Text table: The message
is displayed if the text in the format is empty.

The Text info area and formats containing the text are updated according to your
settings.

To transfer changes to texts in a single language from formats to the Text info
area:

1. Click in the desired language's column and select Transfer language from the
context menu.

2. Confirm the prompt with Yes.

The transfer is carried out the same way as for the Transfer all texts option.
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Text Table -> Formats

Records that reference a text from the Text info area load the (changed) texts at
runtime.

To propagate text changes to the formats referencing these texts:

1. Select Write  all texts from the context menu to propagate all changes, or select
a field in a language column and select Write language from the context menu
to propagate the changes in the selected language.

2. Answer the prompt with Yes.

The updated texts are transferred to the formats.

Displaying References
Learn how to display references.

To list the formats that use a specific text:

1. Click in the corresponding line in the Text info area.

2. Select Reference search from the context menu. The formats that use the selected
text and records that are linked to this text are displayed.

The info area and field number is displayed for texts used in the data model.

If texts differ between the format and Text table, "Text is not identical" is displayed
as a comment.

3. Click on  (OK), to return to the Text info area.

Select Remove  all References from the context menu to remove the links between
the Text info area and the formats. Select Apply  all texts to read the references
including all texts anew.

Merging Texts
You can merge text records in the Text info area to a single record

To merge texts:

1. Click on the text you wish to retain.

2. Select Merge from the context menu.

The Merge dialog is displayed.
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3. Search for the texts you wish to merge with the initial text, see Searching for
Texts on page 375.

4. Click on Find.

The search results are listed under Merge with selected text.

You have the following options:

• Click on  (Edit) next to the Selected Text field to edit the text you wish to
retain.

• Click on  (Find) to search for fur ther texts. Texts found by the new search
are added to the list of results.

• To remove entries from the list, enable the corresponding check boxes and

click on  (Delete).

• Click on  (Delete All) to clear the list.

5. Enable the check boxes next to the desired entries in the list. Click on  (Select

All) to select all entries in the list. Click on  (Clear Selection) to clear the
current selection.

6. Click on Start.

7. Confirm the prompt with Yes.

The selected text records are deleted. The text in formats using the selected texts
is replaced by the text entered in the Selected Text field.

Note:  Click on Cancel to cancel the replacement process. Any replacements that
have already been made are not undone.
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Field Help
Information about all the fields in the database is stored in the field help.

Field help is displayed as context-sensitive help in the Aurea CRM application.

To make the field help available for your users:

1. Download the field help from the Aurea CRM support page at https://support.au-
rea.com.

2. Use CRM.translation tool to import it into your database, see Importing Field Help
on page 495.

The field help is stored in the Field Help info area (FH). The FH table is linked to
the Text table (04).

The field help is displayed in the current language. If no field help is available for
the current language, the texts are determined as follows:

• if no field help is available for the current language, the parent languages are
searched

• if no field help is available in the parent languages, the catalog base language
is used

• if no field help is available in the catalog base language, the language-independent
text is used

• if no language-independent text is found, the next available text in any other
language is used (the search order is determined by the language numbers in
ascending order).

Note:  Import the field help to be used as a fallback for languages for which no
translated field help exists to the catalog base language or as language "0" (i.e.
language-independent).

You can edit the field help to adapt it to your requirements and to reflect customiza-
tions made to your system, see Editing Field Help on page 381. If you add new fields
to your Aurea CRM database, make sure you define field help entries for them,
see Adding Field Help for New Fields on page 383. The field help can be exported
from and imported to Aurea CRM's database using CRM.translation tool, allowing
you to edit and translate the texts in Microsoft Excel, see Exporting Field Help on
page 496 and Importing Field Help on page 495.

Note:  Access rights defined for the Field Help info area do not affect the displaying
of the field help, i.e. Deny Access defined for FH does not prevent the field help
from being displayed in Aurea CRM win and Aurea CRM web
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Editing Field Help
You can edit the field help in the Aurea CRM win Maintenance module and in Aurea
CRM web.

To access field help, go to Administration > Field Help.

Alternatively you can export the field help and edit its contents in Microsoft Excel,
see Exporting Field Help on page 496.

To edit the field help in Aurea CRM:

1. Locate the field help record you want to change.

2. Double-click it to open the mask view.

3. Enter the desired text in the Short Text and Long Text fields. For more
information, see Contents of the Field Help File on page 500.

4. To reuse another field's field help, click  (Search) to change the Reference.
Select the field whose field help you want to use.

Note: When reusing the same text for multiple fields, make sure all fields
reference the same field to avoid circular references.

5. Click  (Save).
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Note: The field help is cached on the server. However, changes to a field help
record are applied within the same session. To display the updated field help in
Aurea CRM web you need to recycle the application pool.

Note:  Obsolete field help records (i.e. field help for deleted fields) are not
automatically deleted from the database; you need to manually delete these FH
records from the database (and from the XSLX file if you maintain your field help
there).

Text Formatting and Placeholders
Learn about how to format text.

Markdown Syntax

You can format text in the field help using Markdown syntax,
see http://en.wikipedia.org/wiki/Markdown. When displaying the field help, Aurea
CRM win and Aurea CRM web convert the Markdown syntax automatically.

Placeholders

References to info areas and other fields can be entered using placeholders. These
placeholders are replaced by the actual field name at runtime. Aurea CRM win dis-
plays these field names as a link to the referenced field.

Examples:

{FI/Country} references the Country field in the Company info area (Aurea recom-
mends always using the XML field names).

{FI/22} references field 22 in the Company info area.

{PE} references the Person info area. (using field numbers is possible but not rec-
ommended)

Note:  XML field names are case-sensitive.

You can output the XML field names using the --xmlFieldNames parameter,
see mmba.exe Parameters on page 13.

When editing the field help in MS Excel, use the Export XML field names option
to export the XML field names in an extra column of the XSLX for reference,
see Exporting Field Help on page 496.

Conditional Text

You can define product-specific par ts of the field help as conditional text.

Use the following syntax:

< product >||This is the product-specific text.||<product>
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Available values for <product>: win, web, mobile, pad

Example:

This is a generic help text. win||This is an Aurea CRM win-specific help
text.||win web||This is an Aurea CRM web-specific help text.||web The
generic text continues.

If the help text ends with product-specific text, the closing tag may be omitted.

Adding Field Help for New Fields
You can check the field help against the current data model.

Aurea CRM automatically generates a field help record for those fields without any
field help.

To update the field help for the current data model:

1. Select Update field help in the context menu.

2. Select Take rights settings into account to create field help records only for
fields that you can access according to your current rights settings.

3. Select Global System Fields to generate Field Help records for all global system
fields (field IDs 4000 to 4299). These Field Help records do not have an info area
and only the field number is entered. Since these fields are used in almost all
info areas with the same meaning, they are only stored once in the field help.

4. Click Update All Info areas or click Select Info areas and select the info areas
for which you want to update the field help.

5. Decide if you want to view the new entries you have created.

Note: This is done with a filter. Any other existing filters are removed from the
Field Help list.

New field help entries contain NO FIELD HELP in the Comment column. You can
now add information to the new field help records.

Delete Level
Use the Delete level to delete cer tain records under specific conditions from your
database.

Note:  Back up your database before using the Delete level.
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When deleting records, all deleted records' child records are also deleted.

Note: You can only delete data from one info area in each deletion process.

The Delete Records info area provides you with the following options:

Use the drop down list box in the top left-hand corner to select the info area from
which records should be deleted.

Delete: Indicates the info area from which data are to be deleted.

Condit. Active: If a previously defined condition is to take effect, you should enable
this check box. Click the Condit. Activ. check box or select Data > Activate Con-
ditions.

Condition: Use the Condition button to restrict the records to be deleted even
fur ther.

You can only define conditions for the currently selected info area from which records
are to be deleted. The box used for defining conditions appears, see Conditions in
the Aurea CRM win User Manual.

Note:  Only the Supervisor should delete records from the Process tracking info
area. A condition should also be defined to prevent records with the status "open"
from being deleted. Otherwise active processes is deleted.

Conditions are especially important when deleting or updating dependent records
which are part of a previously defined selection. A selection record of all companies
to which a telephone activity was entered, contains not only the activity records
where the activity (type) = telephone but also all activity records (company/person)
where at least one telephone activity exists.

Star ting a deletion or update process would affect all the activity records in this
selection. To therefore delete or update only those telephone activities that satisfy
the condition activity (type) = telephone (one telephone activity), the condition must
be activated again.

Selection: Activates the chosen selection.

Sel. Name: Should you only wish to delete the companies and persons included in
a selection, not all the records:

384AUREA CONFIDENTIAL

Chapter 3: Using CRM Core

https://help.aurea.com/crm/crm-win-user-manual/crm-win-user-manual/dita/topics/c_win_UsrMan-4_10-Conditions_upd.html


Property Selection (BTB only): If you only want to delete companies and persons
that have been limited by a property selection and not all records:

1. Double-click on the field to open the list of defined selections.

2. Select the desired property selection.

User Confirmation: If you want to be able to check the deletion process manually,
enable the User Confirmation check box. For every record to be deleted, the system
then prompts you to confirm the deletion manually.

Do Not Communicate Deleted Records:

By default, information on deleted records is communicated to other stations,
see Communicating Deleted Records in the Aurea CRM win Administrator Guide.

Enable the Do Not Communicate Deleted Records option if you want to be able
to delete records on one station, but retain them on another. Information on deleted
records is not communicated to other stations, and records are only deleted physi-
cally on the local station.

Note: This setting is not applied to info areas for which the Mark as Deleted option
is enabled in the access rights, see Mark as Deleted on page 155

Total: This field indicates how many records have been searched.

Deleted: Indicates how many records have actually been deleted.

1. Click on  (Execute) to star t deleting records.

Update Level
You can update field contents in the entire database from this info area.

Note:  Back up your database before extensive updating measures!

You can update:

• data fields (numerical, alphanumeric values, or catalog values)

• Country and city entries
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Note: You can only update a single info area at once.

The Update level provides you with the following options:

• Use the drop-down list in the top left-hand corner to select the info area from
which you want to update records.

• Condit. Active: If a previously defined condition is to take effect, you must make
sure it is activated. Click the Condit. Active check box or select Data > Condition
Active.

• Update Cond.: With the Update Cond. button you can restrict the records to be
updated even fur ther.

The dialog box used for defining conditions is displayed, see Conditions in the
Aurea CRM win User Manual.

The condition determines the records and field to be replaced. (The condition is
set for an existing entry.)

Conditions are especially important when deleting or updating dependent records
that are par t of a previously defined selection. A selection of companies to which
a telephone activity was entered contains not only the activity records where the
activity (type) = telephone, but all activity records (company/person) where at
least one telephone activity exists.

Star ting a deletion or update process would affect all activity records in this se-
lection. To delete or update only those telephone activities that satisfy the condi-
tion activity (type) = telephone (one telephone activity), the condition must be
activated again.

• Selection: Activates the chosen selection.

• Sel. Name: Enable the Selection check box.: choosing a selection does not
automatically activate it.
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If you do not wish to update all records but only a subset of company or person
records defined by a selection (or their supplementary info),

1. Double-click the field to open the Selection catalog.

2. Make the required selection from the Selection catalog.

• Property Selection (BTB only): If you only want to update companies and persons
that have been limited by a property selection and not all records:

1. Double-click on the field to open the selection list.

2. Select the desired selection from the property selection list.

• User Confirmation: If you want to be able to check the update process manually,
enable the User Confirmation check box. You are then required to confirm each
updated record manually.

• Updated: This field indicates how records have actually been updated.

• Field: Name of the field to be replaced.

• Replace with: Beneath the mask is the replacement table. The replacement table
contains all the fields in the currently selected info area. In this table you can
specify in which field the current entry should be replaced with the new value.
Double-click the field to open the catalog, if available. The contents of all the
fields in the database to which the condition(s) apply(ies) are replaced with the
entry in the Replace With field. To update a field without a replacement value
(i.e. to replace the field with a blank field), select the field but do not enter a
replacement value (no input).

• Upd: Click in the Upd column to specify which fields should be updated by the
update process.

Note:  Do not edit the CmCd field, as this could lead to inconsistent data during
communication.

• Start: Before you star t the update process, check that manual control has been
activated (for safety's sake). To commence the update process, click the Start
button.

• User Confirmation: If the User Confirmation check box is enabled, the first
record appears inside a dialog box.

• Update: To update the record on the screen, confirm the update process with the
Update button.

• OK: To retain the data in the record, accept the old entry with OK, and the next
record appears on the screen.

• Stop: Use Stop to terminate the entire update process prematurely.
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Example:

1. A city's area code has changed.

2. Click the Update icon in the icon bar.

3. Select Company from the drop down list.

4. Enable the Condit. Active check box.

5. Click the Update Cond. button.

6. Define the condition "Area Code=0222", and click OK.

7. In the Area Code row click the Replace With column.

8. Enter the new area code.

9. Check the Upd field on that row.

10.Click on  (Execute).

All the 0222 area code entries are replaced with the replacement value throughout
the Company info area.

Displaying all Fields in a Mask
Learn how to display all fields in a mask.

Select View > All Mask Fields from the menu to display all fields in a level's info
areas. The following options are available:

• Click on  (Load all fields) to display system fields as well, see System Fields
on page 392.

• Click on  (Show last change) to display the last modification date and time for
each field.

• Double-click with the right mouse button in the window's header to display the
following additional information:
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The header contains the following information: Info area name (info area code -
info area number) [record ID in decimal, Record ID in hexadecimal]

The following is displayed for each field: Field name (sequential field number |
fixed field number | base field number - field type) [catalog number] {field length
in the database, maximum input length} number of the field text in the resources

Note:  Info area numbers and field text numbers are only intended for use internally
by Aurea. For information on field numbers, see ID, Name, Type, Reference on
page 340 and Vertical-independent Configuration on page 528.For information on
field data types, see Data Types in Aurea CRM on page 391.

Language IDs
Learn about the language IDs in Aurea CRM.

Languages in Aurea CRM are identified using the following IDs and codes:

IDCodeLanguageIDCodeLanguage

16sweSwedish0gerGerman

17finFinnish1engEnglish

18norNorwegian2freFrench

19turTurkish3spaSpanish

20croCroatian4porPortuguese

21serSerbian5nldDutch

22ronRomanian6danDanish

23jpnJapanese7itaItalian

24chnChinese8czeCzech

25korKorean9hunHungarian

26bulBulgarian10slkSlovakian
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IDCodeLanguageIDCodeLanguage

27thaThai11polPolish

28albAlbanian12greGreek

13ukrUkrainian

14slnSlovenian

15rusRussian

Module Numbers
Learn about the Aurea CRM module numbers.

Aurea CRM modules are identified using the following numbers:

13CRM.cockpit0Configuration

1Main Module

15CRM.phone2Rebuild

16CRM.mobile3Import

17CRM.webservices4Rights

5Analysis

6Communication

20CRM.connector7Print

8Export

22CRM.server9Maintenance

23CRM.pad10Aurea CRM web
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11CRM.interface

12CRM.connectLive

Data Types in Aurea CRM
In some dialog boxes, the field type is also displayed along with the field name and
number.

The following data types are available:

• B = Boolean (logical)

• C = Character string

• D = Date

• F = Floating point number

• K = Variable catalog

• L = Long integer

• S = Short integer

• T = Time

• X = Fixed catalog

• Z = Decoded field. Values in these fields are automatically entered by the business
logic. Z-fields do not exist in the database. (Examples: reference fields, fields
that contain links to other records, rep fields, rep group fields, 2nd currency fields,
external match-up fields etc.).

Z-fields cannot be added as search fields or used for defining filters and queries.

The content of a Z-field is not updated in lists if the target record is updated by
another process. Workaround: Instead of the Z-field add a linked field of the target
record to the list. Example: Instead of using the Company field (MA:76), add the
Company field from FI as linked field to the MA List control.
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System Fields
System fields are fields that track when a record was added, edited or communicated,
when, on which station and by whom.

System fields have field numbers star ting from 4,000. Select View > All Mask Fields
from the menu and click on  (Load all fields) to display the system fields.

• Created on: Date the record was created.

• Updated on: Date the record was last updated.

• DelCd: Delete code, used to indicate that the record has been deleted. This field
is automatically enabled if a record is deleted that has been communicated to
other stations (determined from the CmCd field), see Communicating Deleted
Records in the Aurea CRM win Administrator Guide.

• Added on StNo.: Number of the station the record was added on.

• CmCd: Communication code that indicates whether the record has been
communicated to other stations.

• Created at: Time the record was created.

• Updated at: Time the record was last updated.

• Created by Rep ID: ID of the rep that added the new record.

• Created in Module: Module the new record was created in.

• Updated on Station: Number of the station on which the record was last updated.

• Updated by ID: ID of the rep that last updated the record.

• Updated in Module: Module the record was last updated in.

• Com Station: Number of the station from which the record was last communicated
to the current station.

• Com Date: Date on which the record was last communicated to the current station,

• Com Time: Time at which the record was last communicated to the current station.

• Created by: Rep that created the record.

• Updated by: Rep that last updated the record.

Fields with Fixed IDs
Learn about the fields with fixed Ids.

The following fields have fixed unique field IDs. They are visible in the data model.
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NameID

TenNo4003

Currency4005

Created on4010

Updated on4011

Added on StNo.4012

DelCd.4013

CmCd.4014

Created at4015

Updated at4016

Ext. System4017

External Key4018

Score (match-up)4019

Text (match-up)4020

Description (match-up)4021

The following fields have fixed unique field IDs. They are NOT visible in the data
model (flagged as Vir tualCore). They are automatically created for each info area..

NameID

Created by ID4200

Created in Module4201

(Created on) internal code4202

Updated on Station4203
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NameID

Updated by ID4204

Updated in Module4205

(Updated on) internal code4206

Com Station4207

Com Date4208

Com Time4209

Created by4210

Updated by4211

Time stamp4215

Last communicated on4223

Number of records4230

Link IDs
Learn how link Ids are assigned.

Links are assigned the following IDs based on their type and context:

DescriptionID

Default link0

More links to the same info area (e.g. three additional links to FI in
KM)

1,2,3...

Generic N:N link125

Generic N:1 link126
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DescriptionID

Generic 1:N link127

User-defined links. (Number ranges for links defined by partners or
for Industry Solutions, >> Number Ranges in Aurea CRM on page
398.)

250-299

Reverse links, i.e. links in the opposite direction300-499

Company-related links (i.e. the person key is reset to "0")

Example: FI -> MA - use link 500 to read only company-related
records.

These links are available for PE as well ("person-only" related links):

PE -> MA via link no. 1 reads child records linked to PE and KP.

PE -> MA via link no. 500 reads only records linked to PE.

500-599

Links to the Rep info area>=1000

Indirect links from Relationship records (PB) to all info areas con-
taining indexed links to FI and/or PE:

• 900-919: Returns all records linked to the source company/person
of the relationship record.

• 920-939: Returns all records linked to the target company/person
of the relationship record.

The relationship record determines whether child records are read
company-/person-dependently: If the relationship record is e.g.
company-independent, the child records are read in the same manner.

900-939
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DescriptionID

Links from FI/KP/CP/PE to PB allowing to read PB records within
corporate structures:

• 950: Returns all relationship records in the structure (including
siblings).

• 960: Returns all parent relationships of the current record.

• 970: Returns all child relationships of the current record.

• 980: Returns all parent and child relationships of the current record.

Use 951,961,971,981 to read company-related (or "person-only") re-
lationship records.

For details on defining corporate structures, see Corporate Structure
in the Business Logic Manual.

Analogous: Links from AR to IS allowing to read IS records within
item structures, see Item Structure in the Business Logic Manual.

950,960,970,980
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DescriptionID

Indirect links from FI/KP/PE/CP (via PB) allowing to read child info
areas based on relationship records:

• 24000: Returns all child records of all records where a relationship
exists from the current record.

• 26000: Similar to 24000-25999, but only relationship records with
Affiliate = true (or a custom condition defined by Z5 variable CORE:
:INDIRECT -PB-LINK) are taken into account. These links are used
by the Affiliation View, see Affiliations on page 23.

Note:  Displaying only company-related child records of affiliation
members (e.g. when using the respective Tree view flag) is not
supported.

• 28000: Returns all child records of all records where a relationship
exists to the current record (i.e. a reciprocal relationship).

These links are only available if the company or person key of the
source info area is par t of the link and if the target link is indexed.
The link ID is composed of the base link ID (1,2,500, etc.) and the
corresponding indirect link ID (24000, 26000 etc.).

Child records that are directly linked to the current record are always
returned. The result set does not contain duplicate records.

24000-29999

30000-
130000
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DescriptionID

Indirect links from FI/KP/PE/CP (via PB) allowing to read child info
areas within a corporate structure (see Corporate Structure in the
Business Logic Manual):

• 30000: Returns the entire corporate structure (including siblings).

• 32000: Returns all parents of the current company/person.

• 34000: Returns all children of the current company/person.

• 36000: Returns the parents and children of the current company/per-
son.

The link ID is composed of the base link ID (1,2,500, etc.) and the
corresponding indirect link ID (30000, 32000 etc.).

By default, all existing relationship records are taken into account
when using links 30000-36000. You can restrict the relationships by
Relationship Type via a condition defined in a Z5 variable CORE:
:INDIRECT -PB-LINK-TREE-0. In addition you can create up to 9 addi-
tional links 40000, 50000 etc.) to depict different corporate structures
(corporate group, supplier, etc.) via additional Z5 variables
CORE::INDIRECT-PB-LINK-TREE-1 to 9.

The same link IDs are used to access records in product hierarchies:
Indirect links AR -> AR via Item Structure (IS) records (see Item
Structure in the Business Logic Manual).

Analogous to the Z5 variables CORE: :INDIRECT -PB-LINK-TREE-0 etc.
you can filter item structure records (IS) by Structure type via vari-
ables called CORE::INDIRECT-IS-LINK-TREE-0 to CORE::INDIRECT-
IS-LINK-TREE-9.

Number Ranges in Aurea CRM
IDs for user-defined info areas, fields, catalogs, links and indices are assigned from
number ranges depending on the selected user group or station number

For fur ther details, see Station Number Ranges on page 526.
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IndicesLinksFixed
Cata-

log
En-

tries

Fixed
and
Vari-
able

Cata-
logs

FieldsInfo
Areas

TypeSta-
tion
No.

1-99200-249100-199150-17480-
104

6000 -
6999

6000
-
6999

A0-500Base10000

100-499400-499200-299175-199130-
154

5000 -
5999

5000
-
5999

U0-500Indus-
try So-
lution
Dev
(BTB)

10001

100-499400-499200-299175-199130-
154

5000 -
5999

5000
-
5999

U0-500Indus-
try So-
lution
Dev
(OTC)

10002

100-499400-499200-299175-199130-
154

5000 -
5999

5000
-
5999

U0-500Indus-
try So-
lution
Dev
(FS)

10003

1-99250-279500-59925-29105-
109

7000 -
7199

13000
-
13499

A500-
599

Base10010

1-99280-309600-69930-34110-
114

7200 -
7399

13500
-
13999

A600-
699

Base10011

1-99310-339700-79935-39115-
119

7400 -
7599

14000-
14499

A700-
799

Base10012

1-99340-269800-89940-44120-
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7799
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-
14999
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Lan-
guages

CRM
Pro-

cesses

IndicesLinksFixed
Cata-

log
En-

tries

Fixed
and
Vari-
able

Cata-
logs

FieldsInfo
Areas

TypeSta-
tion
No.

1-99370-399900-99945-49125-
129

7800 -
7999

1500
-
15499

A900-
999

Base10014

100-499500-5191000-
1099

200-204155-
159

8000 -
8199

15500
-
15999

U500-
599

Indus-
try So-
lution
Dev

10020

100-499520-5391100-
1199

205-209160-
164

8200 -
8399

16000
-
16499

U600-
699

Indus-
try So-
lution
Dev

10021

100-499540-5591200-
1299

210-214165-
169

8400 -
8599

16500
-
16999

U700-
799

Indus-
try So-
lution
Dev

10022

100-499560-5791300-
1399

215-219170-
174

8600 -
8799

17000
-
17499

U800-
899

Indus-
try So-
lution
Dev

10023

100-499580-5991400-
1499

220-224175-
179

8800 -
8999

17500
-
17999

U900-
999

Indus-
try So-
lution
Dev

10024

500-999600-699400-449225-229180-
189

10000-
10999

10000
-
10999

P0-
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Partner10100

500-999700-719450-459230-234190-
194

11000-
11499

11000
-
11499

P500-
P599

Partner10101
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Lan-
guages

CRM
Pro-

cesses

IndicesLinksFixed
Cata-

log
En-

tries

Fixed
and
Vari-
able

Cata-
logs

FieldsInfo
Areas

TypeSta-
tion
No.

500-999720-729460-469235-239195-
199

11500-
11999

11500
-
11999

P600-
P699

Partner10102

500-999730-739470-479240-244200-
204

12000-
12499

12000
-
12499

P700-
P799

Partner10103

500-999740-749480-489245-249205-
209

12500-
12999

12500
-
12999

P800-
899

Partner10104

>=1000800-999300-399250-299210-
255

1024 -
4999

7000
-
8999

C0-999Cus-
tomer

<10000

Note:  Language number ranges are ignored when automatically assigning language
numbers. They are used exclusively when merging data models in order to prioritize
field texts, >> Merging Data Models on page 523.

Regular Expressions Syntax
You can use regular expressions in triggers, workflows and to transform field
contents.

This makes it easier to edit or evaluate texts.

The following functions are available:

• Search: The system searches for a string in a text.

• Match: Similar to "Search", except that the search is only successful if the entire
text matches the search criteria.

• Find: Similar to "Search", but returns only the position where the string was found.

• Replace: Certain strings are replaced by others.

• Transform: Transforms the text based on a predefined pattern.
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General Notation

A command to evaluate a regular expression is a list of parameters separated by
commas. Each parameter can be included in single or double quotation marks. If a
parameter contains one or more commas, the parameter needs to be specified
within quotation marks.

Note:  Note: The regular expression parameter uses the comma as a delimiter. In
order to be interpreted correctly, ensure that you enclose the parameter using comma
as a delimiter within double quotes.

The order of the parameters is as follows:

TYPE,REGEX,MODIFIER,OPTIONS,POSITION,OCCURRENCE,…

TYPE and REGEX must always be specified, the remaining parameters are optional
or dependent on the function.

• TYPE: The function type

• REGEX: The regular expression

• MODIFIER: Dependent on the regular expression language

• OPTIONS: Options that control the behavior of the regular expression, >> Options
below.

• POSITION: The position in the source text from where the processing should
star t. The default is 0 (star t of the text). The position may not be more than the
length of the text.

• OCCURRENCE: Determines which occurrence of the text should be returned.
The default is 1 (the first occurrence) for one-off operations (e.g. search) and 0
(all) for other operations (e.g. replace and transform).

By default, the grammar ecma is used. A different one can be specified by a language
flag (bre,ere,awk,grep,egrep):

e.g. s,John,,grep;i

For more information on the regular expressions that are supported, see http://ms-
dn.microsoft.com/en-us/library/bb982727.aspx.

The following examples always use "john.doe@example.org" as the source text.

Options

General options (>> OPTIONS above) consist of a single character. Upper and
lower case are treated differently. Multiple options must be separated using semi-
colons.

Example: The option 'i' is used to compare strings ignoring upper and lower case:
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s,John,,iRegular Expres-
sion

johnResult

In this case, all characters are converted to lower case before
being compared. This option can only be applied to specific strings
and not to character ranges.

Description

For more information on the available options, see http://msdn.microsoft.com/en-
us/library/bb982727.aspx.

Options supported by the C++ backend

Language flags: bre,ere,ecma,awk,grep,egrep

Syntax modifiers: icase,nosubs,optimize,collate

Match options and format flags: bol,eol,bow,eow,any,null,cont,prev and
fdef,fsed,fnocpy,ffirst

Functions

Search (TYPE = s): Searches for a string and returns it. If the string cannot be
found, an empty string is returned.

s,[a-z]+Regular Expres-
sion

johnResult

Searches for a string consisting purely of letters.Description

s,[a-z]+,,,2Regular Expres-
sion

hnResult

Searches for a string consisting purely of letters star ting from the
3rd character (position 2).

Description

s,[a-z]+,,,,3Regular Expres-
sion

exampleResult

Searches for the third occurrence of a string that consists purely
of letters.

Description
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Match (TYPE = m): Tests whether the entire string matches the regular expression.
If so, the entire text is output, otherwise an empty string is returned. If a modifier
is specified, the result of the modifier is returned.

m,[a-z]+\.[a-z]+@example.atRegular Expres-
sion

emptyResult

Tests whether the e-mail address contains "@example.at". As
this is not the case in our example, an empty string is returned.

Description

m,[a-z]+\.[a-z]+@example.orgRegular Expres-
sion

john.doe@example.orgResult

Tests whether the e-mail address contains "@example.org". As
this is the case in our example, the entire text is returned.

Description

m,([a-z]+)\.([a-z]+)@example.org,$1Regular Expres-
sion

johnResult

Tests whether the e-mail address contains "@example.org". As
this is the case in our example, the result of the modifier '$1' is
returned.

Descriptions

Find (TYPE = f): Searches for a string and returns the index (star ting with 0 relative
to the star t position). If the string is not found, -1 is returned.

f,[a-z]+Regular Expres-
sion

0Result

Finds the first string (consisting of letters only) at position 0.Description
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f,[a-z]+,,,2Regular Expres-
sion

0Result

Searches for the first string (consisting of letters only) star ting at
position 2. Finds the string at position 2 and returns the relative
position as 0.

Description

f,[a-z]+,,,,3Regular Expres-
sion

9Result

Finds the third occurrence of a string consisting of letters only.Description

f,[a-z]+,,,8Regular Expres-
sion

1Result

Searches for the first string (consisting of letters only) from posi-
tion 8 . Finds it at position 9 and returns the relative position as
1.

Description

Replace (TYPE = r): Searches for a text and replaces the text with the text specified
in the MODIFIER parameter. This function does not support the OCCURRENCE
parameter.

r,@,-AT-Regular Expres-
sion

john.doe-AT-example.comResult

Replaces all occurrences of '@' with "-AT".Description

r,[a-z]+,xxxRegular Expres-
sion

xxx.xxx@xxx.xxxResult

Replaces all strings consisting purely of letters with "xxx".Description

405AUREA CONFIDENTIAL

Regular Expressions Syntax



r,@[^.]+,@xxxRegular Expres-
sion

john.doe@xxx.comResult

Replaces the string star ting with the '@' character up to the first
period ('.') with '@xxx".

Description

Transform (TYPE = t): Transforms the input text and returns the result. The following
optional parameters can be specified at the end of the regular expression:

• DELIMITER: The text to be inser ted between individual occurrences of the search
string.

• BEGIN: The text to be inser ted at the star t of the generated text.

• END: The text to be appended at the end of the generated text.

t,([a-z]+)\.([a-z]+),'($2,$1)',,,,;,<,>Regular Expres-
sion

<(doe,john);(com,example)>Result

Swaps strings consisting purely of letters and separated by a
single period, separates the two strings with a comma and enclos-
es them in brackets. Strings transformed in this manner are sep-
arated by a semicolon and enclosed in angled brackets.

Description

t,([a-z]+)\.([a-z]+),'($2,$1)',,,1,;,<,>Regular Expres-
sion

<(doe,john)>Result

Swaps strings consisting purely of letters and separated by a
single period, separates the two strings with a comma and enclos-
es them in brackets. Only one occurrence is transformed; the
DELIMITER parameter is therefore not included in the result.

Description

t,([a-z]+)\.([a-z]+),'($2,$1)',,,2,;,<,>Regular Expres-
sion

<(com,example)>Result

As above, but with the second pairs of strings.Description
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Migrating Data
You can migrate data and formats in an existing customer solution for into another
Aurea CRM environment in order to reuse the data and formats.

Examples of use cases:

• Aurea CRM win > Aurea CRM web

• Aurea CRM win > Industry Solution

• within Aurea CRM win: user-defined info areas > core info areas

You can (par tially) automate the following tasks when migrating data:

• Moving data to different fields of info areas based on mappings

• Adjust or convert existing masks and other formats

Data is migrated to the current database.

Note:  Some changes made to data within the scope of migrating data are
irreversible. Before migrating, back up your database or first carry out the migration
on a test system, see Recommended Procedure on page 430.

User-specific settings (e.g. list settings, active conditions, sor t orders etc.) saved
in the *.cfg files cannot be migrated; these settings are lost.

Below topics are solely directed at internal Aurea CRM users and partners.

Accessing the Migration Area
Learn how to access the migration area.

To access the Migration area:

1. Switch to the Data Model level in the Maintenance module.

2. Select Migration from the context menu.

You can also open the Migration area from the Analysis level, see Executing
the Analysis on page 358.

Note: The Migration option is only available to internal Aurea users and partners
(Select user group option in the Data Model level).You do not need to carry out
an analysis of the database to use the migration functions. Information on
active/inactive formats and the fields in use can however only be obtained from
a database analysis.

The Migration level is displayed.
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All changes (and test runs) are logged in the Migration History. The Result
column displays the number of records or catalog values that were changed by
the migration process.

Conflicts and errors are displayed in red. These need to be resolved manually.
In the case of errors, the error code is output to the Result column, see General
Error Codes on page 508.

If data models have been merged on the current station, this is also logged in the
migration history ("Merged with template" entry, irrespective of the source station’s
station number), see Merging Data Models on page 523.

3. Carry out the migration. The following options are available from the context
menu:

• Migrate languages: Converts the existing language numbers to new ones,
see Migrating Languages on page 409.

• Migrate tenants: Converts the existing tenant numbers to new ones, see Mi-
grating Tenants on page 410.

• Migrate station number: Converts a station number to a new one. All records
that contain the station number are edited accordingly, see Migrating the Station
Number on page 411.

• Map variable catalogs: Defines the mapping of existing catalog values to
new/existing catalog values in another variable catalog, see Mapping Variable
Catalogs on page 413.

• Migrate fixed catalogs: Converts catalog values within a fixed catalog,
see Migrating Fixed Catalogs on page 416.

• Migrate info areas: Migrates data from one info area to another, see Migrating
Info Areas on page 417.
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• Export masks: Exports mask formats as XML files, which can be imported into
CRM.designer, see Exporting Masks on page 426 and Importing Mask Formats
into CRM.designer.

• Delete line: You can delete individual lines or nodes in the migration history,
e.g. to document the steps that are actually required (in order to migrate the
data to a live system).

Note: Triggers and workflows defined in the currently valid access rights and
any business logic functions are triggered by changes carried out within the scope
of migrating data. Any such changes are not logged in the History (H0).

4. Click on  (Save). The migration history is saved as a format with the type
"Migration".

The next time the Migration level is opened, the last used format is loaded. Click
on  (Load) to load another format. If no migration format is found, the corre-
sponding record in the Process Tracking (T3) info area is read.

5. Click  (OK) to close the Migration level.

Note: You may need to close the Maintenance module and restar t for all changes
to be visible after migrating.

Migrating Languages
To migrate from a "classic" Aurea CRM win solution to an Industry Solution, you
can convert the existing language numbers to the language numbers used in the
Industry Solution.

The languages in the Aurea CRM database are uniquely identified by their number
(Language No. field in the Language info area), see Languages on page 109.

To migrate languages:

1. Select Migrate languages from the context menu in the Migration info area.

The Source column lists the languages currently stored in the database.
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The Base Solution uses language numbers < 100. For this reason, suggestions
are displayed in the Target column for languages with numbers < 100: 1000 +
the number of the corresponding Aurea CRM language (e.g. 1000 + 7 for Italian).
If the resulting number is already assigned to a language in the database, no
number is suggested.

2. Enter the desired new language number in the Target column. If you do not enter
a new number for a language, the existing number is retained.

You can merge languages by assigning the same target number to several lan-
guages. Before merging languages, ensure that there are no conflicts between
texts stored in these languages.

Note:  Catalog entries in the catalog base language are ignored when migrating
languages, i.e. existing catalog entries in the catalog base language are kept in
the catalog base language (language number 0) after migrating the languages,
and cannot be moved to another language within the scope of migrating. You
need to subsequently merge these catalog entries, e.g. using an import/export.

3. Enable the Migrate Language (00) cell if you want to migrate language numbers
in the Language (00) and Station Language (01) info areas as well.

Disable the corresponding cell for those languages where a target record already
exists (with the new number) in the current database.

4. Select one of the following entries form the context menu to being the migration:

• Migrate all rows: All language numbers are migrated.

• Migrate selected row: Only the language number in the currently selected row
is migrated.

Changes are applied to records, catalogs and formats according to your settings
and are logged in the Migration History.

5. Click  (OK) to return to the Migration level.

Migrating Tenants
Learn how to migrate tenants.

The Aurea CRM database supports tenants, see Tenants on page 221. In order to
migrate from a "classic" Aurea CRM win solution to an Industry Solution, you must
migrate tenant numbers, if the existing customer solution uses tenant numbers that
are also used in the Industry Solution.

Note:  Free fields defined as tenant fields in tenant rights are ignored by the
migration process. Define proper tenant fields ("mno" type) in the affected info areas,
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edit the tenant rights accordingly and copy the tenant number to the new fields
before migrating tenant numbers.

To migrate tenants:

1. Select Migrate tenants from the context menu in the Migration info area.

The Source column lists the tenants currently stored in the database.

2. Enter the desired new language number in the Target column. If you do not enter
a new number for a tenant, the existing number is retained.

You can merge tenants by assigning the same target number to several tenants.
Ensure that there are no overlaps before merging tenants.

3. Enable the Migrate Tenant (M1) cell if you want to migrate tenant numbers in
the Tenant (M1) and Additional Tenant (M2) info areas as well.

Disable the corresponding cell for those tenants where a target record already
exists (with the new number) in the current database.

4. Select one of the following entries form the context menu to being the migration:

• Migrate all rows: All tenant numbers are migrated.

• Migrate selected row: Only the tenant number in the currently selected row
is migrated.

Changes are applied to records, catalogs and formats according to your settings.

5. Click  (OK) to return to the Migration level.

Migrating the Station Number
Learn how to migrate station number.

Aurea CRM stations are uniquely identified by their station number, see Station on
page 111. You can convert an existing station number to a new one (e.g. if a customer
solution uses a station number reserved for the Industry Solution (1, 9001)). The
change is applied to all records.

To migrate the station number:

1. Select Migrate station number from the context menu in the Migration info area.
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2. Enter the station number you wish to change in the Source column.

3. Enter the new station number in the Target column.

4. Select Migrate station number from the context menu.

5. Confirm the prompt with Yes.

The migration is carried out as described in Station Number Ranges on page 526:
All records that contain the station number are edited accordingly. The changes
are logged in the Migration History.

6. Click  (OK) to return to the Migration level.

Migrating Document Fields
You can migrate the Customer Document info area (D2) to the Document info area
(D1).

For fur ther details, see Customer Document (D2) -> Document (D1).

To migrate all info areas containing document fields:

1. In the data model (Data Model > Info Area > Link column), create a 1:1 link from
D2 to D1.

2. In the Migration Tool, select Migrate Info Areas from the context menu.

3. Select "Customer Document (D2)" as a Source and "Document (D1)" as a Target.

4. Select the 1:1 link under Link.

5. Click OK ( ).

6. Select Migrate Document Fields from the context menu in the Migration info
area to update all document fields in records with the new document key. The
appropriate D1 and D3 records are created as well.
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Mapping Variable Catalogs
Within the scope of migration, you can convert catalog values in a variable catalog
to values in another variable catalog.

In the process, values is child catalogs can be migrated to non-hierarchical catalogs,
see Migrating Hierarchical Catalogs.

To define the mapping of variable catalogs:

1. Select Map variable catalogs from the context menu in the Migration info area.

2. Double-click in the Source column to select the catalog whose values you wish
to migrate.

3. Double-click in the Target column to select the catalog to which you wish to
migrate the values.

Select Delete line from the context menu to delete a mapping.

4. Select Mapping definition from the context menu.

A list of all catalog values in the source catalog is displayed, along with recom-
mendations for the migration. Values are matched up using the catalog value’s
Text.
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The color-coding indicates the following:

• White: Catalog value prior to migration.

• Yellow: The catalog values is not yet present in the target catalog and is added
when saving.

• Pink: The catalog value is already present in the target catalog (e.g.
"Europa/Europe" in the example). You can change these values by selecting
Select target value from the context menu and selecting a different value from
the target catalog.

Catalog values whose mapping you have edited (using Select target value)
are also displayed in pink.

• Green: The catalog value has already been saved (Save selected row option)
and is used when migrating data and formats. Subsequent changes to green
rows are ignored.

• Red Text: Applying this change would result in a conflict in the target catalog
("UK" in the example: the catalog value exists in the target catalog, however
with a different catalog text in the catalog base language). Such catalog values
must be edited manually (in the Catalog info area) before they can be saved.

Note: You can add new catalog values (to the target catalog) when migrating;
editing or deleting catalog values is only possible within the scope of catalog
maintenance, see Catalog Info Area on page 271.

The following options are available from the context menu:

• Text: match all rows (language):  All rows are matched up again (based on
the catalog text in the selected language).

• Text: match selected row (language): The current row is matched up again
(based on the catalog text in the selected language).

• Ext. Key: Match all rows (language): All rows are matched up again (based
on the external key in the selected language).

• Ext. Key: Match selected row (language): The current row is matched up
again (based on the external key in the selected language).

• Select target value: Select this option to select an existing catalog value in
the target catalog that the current value should be converted to. (Alternatively,
double-click on the value.) A dialog is opened displaying the entries in the
target catalog. Select the desired target value and click on OK.

• Copy source to target: Select this option to copy the source text to the target
catalog. If the value does not exist in the target catalog, the row is displayed
in yellow. If the value already exists in the target catalog, the row is displayed
in pink.
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• Save all rows: All changes are saved (in the Catalog info area): The catalog
values are added to the target catalog if applicable.

• Save selected row: The changes to the current row are saved (in the Catalog
info area): The catalog value is added to the target catalog if applicable.

5. Make the desired changes:

• Determine which catalog values are migrated and should be added to the target
catalog: yellow rows / Copy source to target option.

• Determine which catalog values should be migrated and merged with existing
values in the target catalog: Select target value option.

• If you do not want to migrate a value, do not save the corresponding row.

• Furthermore, you can determine or change the following settings for new catalog
values: Tenant,Ext . Key, Sort Order, Description, Valid from/to and Lock,
see Editing Variable Catalogs on page 273.

6. Select Save all rows or Save  selected row to save the defined mappings.

Note:  Resolve any conflicts that may occur manually before saving. You cannot
subsequently edit saved (green) rows.

The changes are saved (in the Catalog info area): No data is written to the Cat-
alog Maintenance info area in the process.

The catalog values in the source catalog are retained after migrating. They can
be deleted after successfully migrating.

The actual migration takes place within the scope of data migration, i.e. when mi-
grating info areas and formats, the affected catalog values in records and formats
are migrated based on the mappings defined here. Only green rows are taken into
account by the migration process.

If info areas are migrated with mapped catalog fields (accessing different catalogs)
(see Migrating Fields on page 419), mappings are automatically defined for the affect-
ed catalogs (in the test run). If conflicts arise, Aurea CRM attempts to merge catalog
values in each language.

Migrating Hierarchical Catalogs

You have the following options when migrating hierarchical catalogs:

• Child catalog > non-hierarchical catalog: You can map entries in the source catalog
to entries in the target catalog while ignoring the parent catalog.

• Child catalog > another child catalog: You first need to define and save a mapping
for the parent catalog. When defining mappings for the child catalog, you can
then select the desired parent values (double-click in the corresponding field in
the Parent Catalog column).
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Catalog values that have not yet been mapped to a parent catalog value are dis-
played with "???". These catalog values cannot be saved.

• Non-hierarchical catalog   child catalog: same as when migrating between child
catalogs.

Migrating Fixed Catalogs
Learn about migrating catalog values.

You can migrate catalog values within a fixed catalog.

1. Select Migrate fixed catalogs from the context menu in the Migration info area.

A dialog is displayed allowing you to select a catalog.

If you click on Cancel, you can access the dialog using the following context
menu options:

• Select fixed catalog: This option allows you to select from all available
catalogs.

• Select saved fixed catalog: This option allows you to select a catalog for
which you have already defined a mapping.

2. Select the desired catalog.

3. Click on OK.

A list of existing catalog values is displayed.
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4. Enter the desired values in the Target column:

• Double-click in a cell and select the desired target value.

• Enter the code of the desired value directly in the cell: This allows you to map
values that are not present in the current database.

Rows for which a target value has been entered are displayed in pink: These
are used by the next migration process (Migrate all rows/Migrate selected
row), irrespective of whether data has already been migrated (Date, Time
column).

• Select Delete line from the context menu to delete a mapping, or  (Delete)
to delete all mappings.

5. Define any necessary conditions for the migration:

• Condition (format): Select this context menu option to define conditions under
which the changes should be applied to formats (e.g. only to specific format
types etc.).

• Migrate in data: If this option is enabled, changes to catalogs are applied to
records.

• Migrate in formats: If this option is enabled, changes to catalogs are applied
to formats.

Note: These settings are applied and saved globally, not per catalog.

6. Test the mappings:

• Test data migration (selected row/all rows): Select this option to test how
many records would be affected by the migration and in which info areas.

• Test format migration (selected row/all rows): Select this option to test how
many formats would be affected by the migration.

7. Migrate the catalog values:

• Migrate all rows: All changes are applied according to your settings.

• Migrate selected row: Changes defined in the selected row are applied.

The results (of test runs and the migration) are logged in the Migration History.

Migrating Info Areas
Learn how to migrate data between info areas.

To migrate data from one info area to another:

1. Select Migrate info areas from the context menu in the Migration info area.
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2. Define the desired settings:

• Source: Select the info area whose data you wish to migrate.

• Target: Select the info area the data should be migrated to.

• With Conditions: You can define the conditions under which data should be
migrated.

• Link: If a 1:1 link exists between the source and target info areas, you can
select the link here. This allows data to be matched up with existing records
in the target info area (Match & update column), links to be migrated and the
field mappings to be subsequently updated.

If you are migrating data in the History (H0) info area, you also need to migrate
the corresponding links to the history.

• New: Enable this option if new records should be added to the target info area
based on the data from the source info area. If you are migrating data within
the same info area (source = target), do not enable this option.

• Generate new ID: Enable this option in addition to the New option to determine
that new IDs (keys) should also be generated when adding new records.

• Match & update: If this option is enabled, data is matched up with existing
records in the target info area when migrating. The records are updated
accordingly.

Note: The Match & update option only works if you have selected a Link or if
you are migrating fields that are par t of the unique index, see Migrating Fields
on page 419.

• Migrate fields: Define the desired field mappings between the source and
target info areas, seeMigrating Fields on page 419.

• Migrate links: Determine which links should be migrated, see Migrating Links
on page 421. This controls the migration of child records.

• Migrate formats: Enable this option if the changes defined here (target info
area, field mappings, links, variable catalogs) should also be applied to formats,
see Migrating Formats on page 422.

• Condition (format): Use this option to define conditions under which the
changes should be applied to formats (e.g. only to specific format types etc.).

For examples of this setting, see Examples on page 423.
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3. Select Test format migration (selected row) from the context menu to test the
defined mappings (for the selected row). The system checks whether fields can
be migrated based on the field types (i.e. the source and target field are
compatible), and whether migrating leads to any other errors (e.g. a field is not
migrated and the Remove in formats option is not enabled). The system does
not verify whether the formats function correctly after migration.

4. Carry out the migration:

• Migrate selected row: Changes defined in the selected row are applied
according to your settings.

• Select Delete line from the context menu to delete a mapping.

The results (of test runs and the migration) are logged in the Migration History.

Note: The info area and fields in conditions defined in plain text ("filter strings")
are converted during migration (Variable value and Distribution Logic). The
following are not migrated:- Conditions defined in the Update priority configuration
entry (Communication category)- The Info Area and Field fields in records in the
Question info area.

The records in the source info areas are retained after migrating. They can be
deleted after successfully migrating.

Migrating Fields
Learn about migrating fields from source info area to target info areas.

When migrating info areas, you need to determine which field contents from the
source info area are written to which fields in the target info area (field mapping).

1. Click in the Migrate fields cell in the Migrate info areas level.

A list of fields (Source) and suggested mappings (Target) is displayed.
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The Suggested mappings cell is enabled for those field mappings that were
suggested by Aurea CRM. If you change the mapping manually, the tick is removed
from this cell.

2. To edit the field mappings:

• Use the Search  to search for a field in the list. You can choose to search
in the source or target info area.

• Click in a cell in the Target column to select a field in the target info area.

Note: The system does not check that the source and target fields are of
compatible data types when selecting a field.

• Click in a row and select Remove mapping from the context menu to remove
a mapping.

• Select Mappings only from the context menu to remove all fields from the list
for which no Target has been defined.

• Select Delete line from the menu to delete the current row.

• Click in the last (free) row in the list to define a new field mapping.

• You can migrate multiple fields to a target field (of the type "Text"): The field
contents are appended to one another in the target field in the order they are
defined in the list.

• Hide mapped fields: Enable this option to only display those fields that have
not yet been mapped.

• Append to end of list: Enable this option to determine that new fields are not
sor ted according to their field number, but are appended to the end of the list.

• Mark used fields: Enable this option to determine that rows corresponding to
fields that contain data in at least one record (according to the database
analysis) are displayed in pink, see Database Analysis on page 358.

3. Use the Transf. column to define field transformations. The transformations are
defined as for imports, see Transforming Field Contents in the Aurea CRM win
Administrator Guide.

4. Enable the option Remove in formats to remove a field in the source info area
from all formats (e.g. mask formats). The conditions defined under Condition
(format) in the Migrate info areas level are taken into account.

Note:  If you use this option, you need to verify that the formats work correctly
after migrating.

5. You can define default values for the target fields:

6. Select View  > All Mask Fields from the menu.
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7. Enter the desired default values.

8. Select Test field mapping from the context menu to test the defined mappings.

You can navigate through the records in the test results. Field values that were
not migrated because no target field was selected or because the field types are
incompatible are displayed in red. The results of matching up and updating records
(Match & update option) are not displayed for the test run.

If you have mapped catalog fields (using different catalogs), mappings are defined
automatically for the corresponding catalogs (if not already defined), see Mapping
Variable Catalogs on page 413.

9. Click  (OK) to save the field mapping.

Migrating Links
When migrating info areas, you can determine which links should be migrated.

This allows you to ensure that child records are also migrated accordingly.

This requires a 1:1 link from the source info area to the target info area, and the
link must be entered in the Link cell in the Migrate info areas level. Alternatively,
you can migrate the fields in the unique index (Migrate fields level).

To migrate links:

1. Click in the Migrate links cell in the Migrate info areas level.
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A list of all links that exist in the source info area is displayed, along with sugges-
tions for corresponding links in the target info area. The In use column displays
which links are actually used.

The Suggested mappings cell is enabled for those mappings that were suggested
by Aurea CRM. If you change the mapping manually, the tick is removed from
this cell.

2. Select Determine link usage from the context menu to update the In  use column.

Links that are in use, but are not assigned to a Target, are displayed in red.

3. Click in a cell in the Target column to select the link or to change/delete a defined
mapping.

Select Clear selected links from the context menu to delete all rows. The Migrate
links cell in the Migrate info areas level is disabled in the process.

4. Click  (OK) to save the field mapping.

Migrating Formats
If you have enabled the Migrate formats option, the changes defined for the
migration of the info area (target info area, field mappings, links, variable catalogs)
are also applied to formats.

 Use the Condition (format) column to define conditions that need to be met for
formats to be migrated (e.g. to only migrate cer tain types of formats).

The following format types are migrated by default:

• Query

• Condition

• Chart

• Dispatching dashboard

• Label

• Custom mask

• Import/export

• Communication

• List

• Mask

• Read engine

• Rights

• Transformation

• Trigger
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• Info area default values

• Workflow

• Timeline

All other formats are not taken into account by the migration. (The migration history
contains "Not migrated" in the Result column.) These formats may need to be
manually edited of recreated in the new environment.

Note: When migrating formats, Aurea CRM attempts to directly map fields in the
source and target info areas that are used in indices. If no exact mapping is possible,
the indices no longer functions after migrating. Manually verifying the migrated
formats (read engine, triggers, workflows, rights) is therefore highly recommended.
Mask formats must be migrated (Migrate formats option) before they are exported
for CRM.designer, see Exporting Masks on page 426.

Examples
Examples for Migrating Data.

Refer to below examples:

Offer (PR) -> Ticket (KM)

To migrate records in the Offer info area to the Ticket info area, define the following
info area migration:

1. Define a condition, e.g. "Request Type = ‘Customer Problem’ ", to determine that
only customer problems are migrated.

2. Define a 1:1 link from the Offer info area to the Ticket info area, and select this
link in the Link cell.

3. Enable the New and Generate new ID options. New records should be added to
the Ticket info area.

4. Define the desired field mapping by clicking in the Migrate fields cell:
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A field transformation has been defined for the Service Level here: Entries in
the SAP Company Code field in the offer are converted to corresponding catalog
values.

The Subject of the ticket is generated using the Company, Contact Person and
PR_SerNo. fields in the offer.

5. Define which links should be migrated by clicking in the Migrate links cell:

When migrating, the corresponding child records (Activity and Notes) are linked
to the new tickets: Child records are "moved" from the old to new parent record;
generic (NO) and additional links (MA) are updated accordingly.

6. Enable the Migrate formats cell in the Migrate info areas level and define a
condition in the Condition (format) cell used to migrate formats (e.g. "Type =
‘Masks’ OR ‘Search Condition’ ").
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Offer (PR) -> Ticket (KM): Add and Match Up

If records have already been migrated, you can define the migration as follows:

1. Enable the New and Match & Update options: New records should be added;
existing records should be updated.

2. In order to match up records in this case, you need to migrated fields in the unique
index (PR_StaNo+PR_SerNo):

Customer Document (D2) -> Document (D1)

To migrate records in the Customer Document info area to the Document info
area, define the following info area migration:

When migrating, corresponding new records are added to the Document info area.
Furthermore, the corresponding links to the Company or Person in Company info
areas are generated in the Document Link (D3) info area. The configuration entry
Company document link in person (Document category) is taken into account in
the process, see Documents on page 36.

To migrate also all info areas containing document fields, see Migrating Document
Fields on page 412.

Linking Reps (ID) with Persons in Company (KP)

In order to log on to Aurea CRM web, each Rep must be linked to a Person in
Company. To implement this via migration:

1. Define a 1:1 link from the Person in Company to the Rep info area.

2. Define the following info area migration:

The first row creates new person records.

The second row enters the corresponding company and person key in the rep
record.
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3. Define a condition, e.g. "KP_SerNo = ‘’ AND Inactive = ‘No’ " for the migration of
reps > persons so as to only add new person records for reps not assigned to a
person record and that are active.

4. Define the field mappings for the migration of reps > persons:

You can use default values (View  > All Mask Fields) to determine which company
the person should be added to.

5. Define the field mappings for the migration of persons > reps:

Exporting Masks
To migrate from a "classic" Aurea CRM win solution to an Industry Solution, you
must convert user-defined masks/lists to CRM.designer field groups.

The lists and masks defined in Aurea CRM win using the Mask Generator can be
exported as XML files and imported into CRM.designer. To do so, you need to migrate
the mask formats in the scope of migrating info areas (Migrate formats option),
see Migrating Info Areas on page 417.

To export mask formats:

1. Select Export masks from the context menu in the Migration info area.
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All mask formats stored in the database are listed. Active formats are displayed
in black; inactive formats in gray. Select Active or Inactive from the context menu
to determine which formats are displayed.

Note:  In order for the active formats to be displayed correctly, you need to analyze
the database, >> Database Analysis on page 358. Otherwise all formats are
displayed as inactive.

2. Enable the Export cell for those mask formats you wish to export.

Click on  (Delete) to remove all the ticks.

3. Start the export using one of the following context menu options:

• Export all rows: All formats where the Export cell is enabled are exported.

• Export selected row: Only the format in the currently selected row is exported.

The selected formats are exported to an XML file: .. \sys-
tem\db\transf_masks_YYYYMMDD_HHMMSS.xml (e.g.
transf_masks_20110727_095816.xml).

4. Click  (OK) to return to the Migration level.

The XML file can be imported into the CRM.designer database using DesignerIm-
port.exe, see Importing Mask Formats into CRM.designer.

Importing Mask Formats into CRM.designer

Masks/lists exported from Aurea CRM win can be imported into CRM.designer using
the Designer Import tool.
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In order to import the masks, you require a CRM.designer database containing
the current data model, i.e. the target CRM.designer database must contain all
info areas and fields referenced by the mask formats.

To import Aurea CRM win mask formats into CRM.designer:

1. Start the Designer Import tool: .. addons\DesignerImport.exe in the Aurea
CRM web installation directory.

2. Enter the connection to the CRM.designer database in the Connection String
field. (The syntax is identical to the syntax in the settings.xml file, see Aurea
CRM web Technical & Installation Guide.

3. Click on Connect.

The connection to the CRM.designer database is established.

4. Enter the path and name of the XML file containing the exported mask formats in
the XML File Name field, or click on  (Browse).

5. Click on Load to load the XML file.

The Aurea CRM win mask formats contained in the file are listed. Vertical is read
from the XML file.

6. Select the CRM.designer configuration you wish to import the masks into in the
Import Configuration field.

7. By default, the format name is used as FieldGroupName. Change the values in
the FieldGroupName and InfoArea columns as necessary.
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Field groups are defined for a specific info area in Aurea CRM web. Masks/lists
are defined for levels in Aurea CRM win, which can contain one or more info areas,
see Defining a New Mask in the Aurea CRM win Administrator Guide. When im-
porting, the info area that the field group should be added for is determined as
follows (InfoArea column):

• If the format name star ts with a valid info area code, this info area is used.

• Otherwise the first info area in the <GmParam> section (in the XML file) of the
format is used.

8. Enable the Import checkbox for those formats you wish to import. Use the
Select/Deselect All buttons to enable or disable the option for all formats.

9. Determine which text groups the mask texts should be imported into, see Lan-
guages and Texts in the Aurea CRM web Administrator Guide.

• Enter the name of the text group that tab headers should be imported into in
the TextGroup-Name for Imported Tab Texts field, see Tab Group Properties
in the Aurea CRM win Administrator Guide.

• Enter the name of the text group that field texts should be imported into in the
TextGroup-Name for Imported Alternate Field Labels field, see Field Prop-
er ties in the Aurea CRM win Administrator Guide.

• If you enter a valid language number in the Default Lang. No. field (Language
No. field in the Language info area), texts in this language are added as default
texts in CRM.designer. This requires this language number to be entered as
the CRM Sub-Language for the corresponding language in CRM.designer,
see Languages in the Aurea CRM web Administrator Guide.

10.Click on Import.

The masks/lists are imported into the CRM.designer database as field groups
according to your settings:

• Masks are converted to Details controls: The tabs are imported with their field
texts and texts sor ted by position on the mask (first the Y axis then the X axis).

• Lists are converted to List controls: Only fields and their widths are imported.
All other settings are ignored.

• No fur ther field properties are imported from Aurea CRM win and no field
attributes are generated.

If the import of a format fails, the entire import is reverted, i.e. nothing is imported.

The Status column is updated accordingly:

• For rows that would be successfully imported, the following text is displayed:

"Successful."

• For rows that would be successfully imported but to a renamed field group:

"Successful. Field group with name <fieldGroupName> already exists in config-
uration <configurationID>. New field group renamed to <fieldGroupName>_1."

• For rows where an error occurred a problem description is displayed, e.g.

"Field for id 103, info area MA in ver tical FS not found!"
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The entire import process and all errors are logged in the DesignerImport.log
file located in \addons\logs.

11.Fix all errors (or deselect the respective formats) and import again.

After successfully importing all selected formats, you can integrate the imported
controls in the desired configuration units.

Recommended Procedure
Recommended procedure for migrating from Aurea CRM win to an Industry Solution.

The following procedure is recommended for migrating from Aurea CRM win to an
Industry Solution:

Requirements

• The Industry Solution input for the migration may only contain the data model and
vertical-specific texts, but no formats, as these are not migrated.

• No changes may be made to the data model and catalogs may no longer be
maintained in the customer database (live system) once the migration project has
star ted.

• Test and live systems must both be defined as the main office and have different
station numbers, see Migrating the Station Number on page 411.

Migrating the Test System

1. Create a back up of the database.

Note:  Document the following steps in details, to ensure that you can repeat the
migration process and any necessary manual changes on the live system.

2. Check whether there are overlapping fixed catalogs in the customer database
and Industry Solution (i.e. the catalogs have identical codes for different catalog
values), and migrate the affected catalog values, see Migrating Fixed Catalogs
on page 416.

Conversely, you need to merge any customer-specific catalog values with Industry
Solution catalog values if the maximum number of catalog values would be ex-
ceeded after migrating (e.g. the Activity catalog). Ensure that you select catalog
values that are not linked to the business logic when mapping catalogs.

Note:  If you use conditions when migrating fixed catalogs, you need to make a
note of these settings for each catalog: These settings are saved globally in the
migration history, i.e. only the last used condition or setting (Migrate in
data/Migrate in formats) is logged.

3. Check whether there are overlapping tenants in the customer database and
Industry Solution, and migrate the tenant numbers if required, see Migrating
Tenants on page 410.

4. Migrate the languages in the customer database to language numbers in the
Industry Solution, see Migrating Languages on page 409.
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5. Input the Industry Solution (data model, texts) on the test system (using
CRM.cockpit).

6. Migrate the variable catalogs and info areas, see Mapping Variable Catalogs on
page 413 and Migrating Info Areas on page 417.

7. Input the formats in the Industry Solution once the migration is complete (using
CRM.cockpit).

8. Adjust the formats to the new environment as needed: For example, define the
current station access rights as an extension of the Industry Solution station
access rights, grant access to Aurea CRM web-specific info areas in the station
access rights etc.

9. Test the results of the migration.

10.Export the masks, see Exporting Masks on page 426.

Making Adjustments in CRM.designer

1. Load the current data model into the CRM.designer database using
CRM.bulkloader.

2. Import the Industry Solution configuration into the CRM.designer database using
CRM.bulkloader.

Migrating the Live System

1. Create a back up of the database.

2. Migrate the fixed catalogs, tenant numbers and languages according to the notes
you made when testing the migration (see steps 3-5).

3. Input the data model, texts and migration format from the test system (using
CRM.cockpit or via communication).

4. Repeat the migration of variable catalogs and info areas according to the migration
history.

5. Input the formats in the test system once the migration is complete (using
CRM.cockpit or via communication).

6. Test the results of the migration.

7. Ensure that every rep (ID) is assigned to a person record (KP), see Linking
Reps/Users to Persons in the Aurea CRM web Technical & Installation Guide.

8. Delete any unnecessary info areas (and catalogs) from the data model on the live
system.

9. Generate a new data stock download for all branch offices.
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4
Additional Modules and Applications
Explore additional possibilities with Aurea CRM.

Managing Companies and Persons
Learn how to manage companies and persons.

Personal and company-related data about a person is split over two info areas -
Person (PE) and Contact Person (CP):

• The Person info area (PE) represents the "physical" person. It contains data that
only needs to be entered once for a person, such as their first and last name,
date of bir th and private address.

• The Contact Person info area (CP) contains data related to a specific company
(e.g. department, position, phone extension).

• The Person in Company info area (KP) depicts all data concerning a person in
the context of a company (using a JOIN applied to the PE and CP tables),
see Data Model(KP). No data is stored in KP.

The following chart shows the relationships in the data model:

Depending on your customer structure you can work only with FI and KP records,
or also use the PE info area to manage your data.
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Use cases for working with PE records:

• Private bank customers

• Doctors who both work at a hospital and have a private practice

• A contact person working for a new company: It may be useful to retain e.g. the
contact history form the former company

If you plan to use the Person info area (PE), integrate PE into your customizations
as an independent info area like FI. In addition you can still use the Person in
Company view (KP) if needed. (The name of the database view is "CPPE".) All info
areas that can be linked to FI and CP can be linked to PE as well.

Note:  In Aurea CRM web you can control the access to PE-related functions via
the CRM Process Configuration; to hide PE-related functions lock CRM Process
1.4.1.3.11 "Person" (CRM Process ID 2470000).

For fur ther details, see Configuring CRM Processes.

Descriptions of procedures for "Persons" in the Aurea CRM documentation generally
apply to both KP and PE/CP.

Special cases and differences are described in the following chapters, in the Aurea
CRM win User Manual and in the Business Logic Manual.

Data Model (KP)
Each field of KP is mapped to a field in either PE or CP. The mapping is defined in
the data model (info area KP, Fields level, Mapping column).

To add a new field to the KP info area:

1. Create a corresponding field in the CP or PE info areas, see Adding New Fields
on page 317.

2. Apply the data model change.

3. Create the new field in KP.
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4. Select the field in CP/PE to which you want to map the new KP field.

5. Apply the data model change.

When displaying KP, Aurea CRM reads the data from the mapped CP and PE fields.

Analogously, links have to be first created in CP/PE. The link fields can then be
mapped in KP.

To delete such fields and links you have to proceed in reversed order:

1. Delete the field or link first from KP.

2. Apply the data model change.

3. Delete the field or link from CP/PE.

4. Apply the data model change.

Adding, Editing and Deleting Persons
Learn about info areas to add, delete and edit persons in Aurea CRM.

When creating, deleting and editing person records, KP and CP/PE are maintained
in parallel automatically, which means:

... causes the followingThis action ...

Adds a CP and PEAdding a KP

Just adds the PEAdding a PE

KP view availableLinking a PE with a FI using a CP

434AUREA CONFIDENTIAL

Chapter 4: Additional Modules and Applications



... causes the followingThis action ...

Changes are reflected in KP (KP pro-
vides a view of the fields in CP and
PE).

Changing field values in CP or PE

Changes are reflected in CP and PE.Changing field values in KP

PE is retained.PE with one CP: Deleting the CP

PE is deleted as well.PE with one CP: Deleting the KP

PE is retained.PE with more than one CP: Deleting one of
the KPs

PE is retained.PE with more than one CP: Deleting an FI
to which one of the CPs is linked

PE is deleted as well.

Note:  Enable the No deletion of
Person records when a Company is
deleted configuration entry (Data
Model category) to prevent this behav-
ior, see Data Model on page 34.

PE with one CP: Deleting the FI to which the
CP is linked

Rights Settings
Rights settings defined for the PE and CP info areas are applied to the KP info area.

Locking Person Info Areas

Aurea recommends setting the same locks for the KP, CP and PE info areas in the
Deny New, Deny Update and Deny Deletion columns in the Rights info area.
Otherwise the following can occur:

Deny New, Deny Update and Deny Deletion only for KP

ResultAction

Not possible.Adding a KP

A KP is added automatically.Adding a PE and CP
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ResultAction

Changes are visible in the KP.Changing field values in a PE
and CP

The corresponding CP is deleted automatically. The
corresponding PE is deleted if it is only linked to this
company.

Note: To prevent the PE from being deleted, set
Deny Deletion for the PE info area in the access
rights.

Deleting a KP

The corresponding KP is deleted automatically.Deleting a CP

All corresponding CPs and KPs are deleted automat-
ically.

Deleting a PE

Deny New, Deny Update and Deny Deletion only for PE

ResultAction

You can enter data in CP-specific fields but you
cannot save the record.

Adding a KP

Not possible.Adding a PE

Possible.Adding a CP and using it to link
FI and PE

Editing the CP-specific fields and saving is pos-
sible.

Editing a KP

The corresponding CP is deleted automatically,
the PE is retained.

Deleting a KP
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Merging Persons
Persons from all Person info areas (KP, CP and PE) can be merged.

... causes the followingThis action ...

If only one corresponding PE record exists, the CP records are
merged.

Merging KP
records

If more than one corresponding PE record exists, the PE records
are merged.

Merges the PE records and links child records to the resulting
record.

Merging PE
records

If you have defined triggers initiated by deleting KP records during the merge process
in previous versions of Aurea CRM, they no longer work. You need to define these
triggers for the PE or CP record.

Note: When merging companies identical persons (KP, CP, PE) are only merged
if the PE-record is linked to only one company record.

Generic Links to KP and CP
Learn about linking info areas KP and CP.

When linking a record to a person via a Link field (i.e. generic link), the behavior
differs depending on the info area you are linking from:

• Favorite and History records can be linked to both Contact Person (CP) and
Person in Company (KP) records. If, for example, both the CP and KP are added
to the favorites, the person is displayed in the Favorite list twice.

• Document Links (D3) that are linked to a Person in Company (KP) are
automatically converted to a link to the Contact Person (CP) when you save the
link.

• All other info areas: You can link both Person in Company (KP) and Contact
Person (CP) records in a link field. In both cases you switch to the Person in
Company (KP) info area when you click the link.
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Telephone Number/E-Mail Search
This topic is about defining custom telephone and email fields.

For differences between the person info areas when searching for a phone number,
see Searching Using the Complete Number and Telephone Number/E-Mail Search
on page 66.

Note: When defining custom telephone fields for persons, you need to define them
for both KP and CP or PE, see Telephone on page 300. Make sure all fields composing
a number (area code etc.) come from either CP or PE, i.e. you may not mix telephone
fields from CP and PE.

Match-Up (PE)
Learn about match-up (PE) parameter.

When matching up records, either when importing or adding PE records, the following
fields are compared:

• First Name and Last Name

• PE-SerNo (import only)

• External Key (import only)

• Private Address

The settings defined in Extras > Other Options under Match-up Control Person
apply to both PE and KP records.

For information on match-up during communication, see Match-up (topic Communi-
cation) in the Aurea CRM win Administrator Guide.

CRM.server
CRM.server is a background service used to carry out time- and resource-consuming
tasks (marketing activities, queries, calculations, etc.).

CRM.server is available for both Aurea CRM win and Aurea CRM web. CRM.server
is installed as part of the Aurea CRM web setup.

For additional information, see the ar ticles “How to Configure the CRM.server to
process To-Do jobs” and “Available Jobs for the CRM.server” at https://support.au-
rea.com.
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Configuring the Service
Learn how to configure the service.

update.server.exe is located in the ..\bin directory of the Aurea CRM web
installation.

All required settings are configured in the settings.server.xml file located in
the .. \system\settings directory of the Aurea CRM web installation. The
CRM.server user must be specified in the users.xml file (located at web\sys-
tem\settings as well).

CRM.server uses the connection to the Aurea CRM database as defined in the
mmdb.ini file (located at web\system\sys). CRM.server does not require a con-
nection to the CRM.designer database.

To configure the service:

1. Ensure that the following files and directories are present on the server:

• The web\bin directory (containing update.server.exe and all required
DLLs)

• The web\system\settings directory (containing the settings.server.xml
and users.xml files)

2. Create a Aurea CRM user (rep and login record) solely for use by CRM.server.
This user requires access rights for all info areas required to execute tasks.

3. Specify configuration settings in the settings.server.xml file, see settings.serv-
er.xml on page 440.

4. Enter the CRM.server user in the users.xml file:

• <User type="Server">

• <Name>CRMSRV1</Name>

• <Password></Password>

• </User>

Note: You can set up several instances of CRM.server for the same user or for
different users, see Running Multiple Instances of CRM.server on page 440.Aurea
recommends using multiple users if CRM.server accesses the same database
from different computers.
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5. To send mailings via CRM.server (required when carrying out marketing activities
via e-mail):

a. Configure SMTP (in the Configuration info area) as the e-mail client on the
station that CRM.server runs on, see General Settings on page 41 (E-mail
Client option).

b. Specify valid SMTP connection settings for the CRM.server user, see SMTP
Connection Settings on page 92.

6. Register the service via the command prompt:

update.server.exe --install [-n <servicename>]

7. Start the service:

update.server.exe --start [-n <servicename>]

For a complete list of available parameters, see update.server.exe Parameters
on page 19.

8. To use CRM.server with Aurea CRM web you need to specify the CRM.server
user's Rep ID in the UpdateServer.RepID Web Configuration parameter, see Up-
dateServer.RepID in the Aurea CRM web Administrator Guide.

settings.server.xml
CRM.server is configured via the settings.server.xml file located in the ..
\system\settings directory of the Aurea CRM web installation.

The settings.server.xml file contains the following settings:

• Logging settings as described in the ar ticle “How To Configure Logging on the
Server” at https://support.aurea.com.

• The <PlugIns> node contains the plug-ins to be loaded by CRM.server. The
delivered server.settings.xml file already contains the correct settings.

• Specify all jobs you want CRM.server to carry out in the <Jobs> node, see
CRM.server Jobs on page 442. The MonitorTodosJob and MonitorExecuteActivi-
tyTodosJob are activated by default in the delivered server.settings.xml file.

Running Multiple Instances of CRM.server
You can run multiple instances of CRM.server using the same installation.

You need to register each CRM.server instance using a different service name:

update.server.exe --install -n crm.server1

update.server.exe --install -n crm.server2
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The service name is set as environment variable SERVICENAME. Use the environment
variable to

• configure each CRM.server instance to use a different log file (mandatory)

• configure each instance for a different user (optional).

For additional information, see the ar ticle “How to run multiple CRM instances” at
https://support.aurea.com.

Configuring the Logging For Multiple CRM.server Instances

Since log files can not be shared between processes, you need to configure each
CRM.server instance to use a different log file.

Define the following in the settings.server.xml:

<update.lib>

<Logging>

...

<Writer

filePath="&dataPath;\log\server.%SERVICENAME%.log" name="DefaultLog"

maxSizeKB ="8192"

closeOnIdleTimeout ="5"

type ="update.Lib.Logging.Writers.FileLogWriter,update.Lib" />

...

</Logging>

</update.lib>

If both CRM.server instances as defined above are running, the following log files
are created (at the location defined as dataPath):

• server.crm.server1.log

• server.crm.server2.log

• web.log

Configuring Multiple CRM.server Users

By default, CRM.server uses the Aurea CRM user specified in the users.xml (User
type="Server").

Use the SERVICENAME environment variable to configure multiple CRM.server users:

1. In the server.settings.xml specify the user file as follows:

<update.crm.base>

<UsersFile>users.%SERVICENAME%.xml</UsersFile>

...
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</update.crm.base>

2. Create one file per user in the web\system\settings directory as follows:

• users.xml

• users.crm.server1.xml

• users.crm.server2.xml

3. Enter the names of the CRM.server users in the <User type="Server"> node of
the appropriate file, e.g.

<User type="Server">

<Name>CRMSRV1</Name>

</User>

4. To use CRM.server with Aurea CRM web you need to set the UpdateServer.RepID
Web Configuration parameter of the desired configuration.

CRM.server Jobs
Learn about configuring jobs to be executed.

The jobs that should be executed by CRM.server are configured via the set-
tings.server.xml file, see settings.server.xml on page 440.
<Job name="FIImport" schedule="0 2 * * * "
type="update.Crm.Server.Jobs.ImportJob,update.Crm.Server">
<FormatName>CompanyImport</FormatName>
<ImportPath>E:\MyDocuments\FI_import.txt</ImportPath>
<CreateProtocol>false</CreateProtocol>
</Job>

For each job you can specify the following attributes:

• name: the job's name (if you want to define different jobs of the same type).

• schedule: the job's schedule, see Scheduling CRM.server Jobs on page 459.

• type: the type of job, e.g. MonitorTodosJob, ImportJob etc.

• additional parameters as additional nodes inside the <Job> node, if applicable.

The following chapters list all available jobs and parameters.

If a job is not relevant for your installation, make sure to remove the job from the
settings.server.xml file.

Automatically Completing To-Dos
Learn about the To-Dos server jobs.

To-dos created for CRM.server are carried out by the MonitorTodosJob as defined
in the settings.server.xml file:
<!--
Execute open todos for the crm.server user (every three minutes)
-->
<Job schedule="*/3 * * * * "
type="update.Crm.Server.Jobs.MonitorTodosJob,update.Crm.Server" />
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If the schedule attribute is undefined, the MonitorTodosJob checks for due to-do
records of Type "Calculate" every minute.

To-do records are automatically created with all necessary parameters by various
Aurea CRM features (e.g. mass data operations, background queries etc.) and by
the business logic respectively.

To (manually) define a to-do for CRM.server:

1. Add a To-Do (TD) record.

2. Specify the following:

• Rep/Group: the CRM.server user

Note:  For to-dos created in Aurea CRM web the CRM.server user specified
by the UpdateServer.RepID Web Configuration parameter (for the current
configuration) is automatically entered.

• Type: "Calculate"

• Due on/at: The date and time the job should be completed.

3. Specify the task or workflow that should be carried out:

• Task: Enter the to-do type and its parameters in the Text field, e.g. 14 ;MA or
0;;2014;2014; etc.

For a list of available types and their parameters, see To-Do Types on page
444.

Use a semicolon as separator. To include a semicolon in a parameter, you need
to escape it by entering "\;".

• Workflow:

1. Select "Workflow" as Execution Type.

2. Select the desired workflow format in the Execution Format field.

3. Enter the parameters in the Text field.

Notes: The Hidden option must be enabled for the workflow in the workflow's
General Settings.

The workflow is executed in the to-do records context, i.e. data entered in the
to-do record can be read and used in the workflow.
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Note: The Hidden option must be enabled for the workflow in the workflow's
General Settings. The workflow is executed in the to-do records context, i.e.
data entered in the to-do record can be read and used in the workflow.

4. Save the To-Do record.

The to-do is carried out as follows:

1. CRM.server polls for due to-do records as specified in the settings.server.xml
file.

2. CRM.server enters the Starts on/at time.

3. CRM.server completes the task.

4. Once the task is completed, the to-do record's Status is set to "Completed" and
the Ends on/at time is entered.

5. A message is sent to the rep entered in the Assigned by Rep ID field in the to-do
record informing the rep that the task is complete. The message includes a link
to the to-do record.

To-Do Types
Learn about the types of To-Do types tasks.

CRM.server can process the following tasks:

Calculate Support Costs: Type = 0

Executes the same function as the Calculate option in the Support info area.

Parameters:

• <FI_StaNo>-<FI_SerNo> (e.g. 100-12) (leave empty for all companies)

• Star t year (integer, 4 digits)

• End year (integer, 4 digits)

• Currency (catalog code); optional; the base currency is used by default

Calculate Campaign Status: Type = 1

Executes the same function as the Calculate option in the Campaign info area.

Parameters:

• <CM_StaNo>-<CM_SerNo> (e.g. 10-47) (leave empty for all campaigns)

Calculate Activity Status: Type = 2

Executes the same function as the Calculate option in the Marketing Activity info
area.
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Parameters:

• <AK_StaNo>-<AK_SerNo> (e.g. 1-57)

Fill Telephone Number Table: Type = 3

Executes the same function as the Fill option in the Tel.No./E-mail info area (no
parameters).

Inventory: Type = 4

Executes the same function as the Stocktaking option in the Stock info area,
see Stocktaking in the Business Logic Manual.

4 ;20121005 ;20121020;text;10000003

Parameters:

• ID of the stocktaking format

• Star t date (integer, 8-digit, yyyymmdd)

• End date (integer, 8-digit, yyyymmdd)

• Stocktaking text (max. 100 characters)

• Rep ID (ID of the rep for whom the stocktaking should be executed)

Specifying a Rep ID in the to-do overrules the rep selection in the stocktaking
format (Employee list on the General tab).

Allocate Business Line: Type = 5 (OTC only)

Executes the same function as the Allocate option in the Business Line info area
(no parameters).

Execute Query: Type = 7

Executes a query in Aurea CRM web, see Background Queries in the Aurea CRM
web Administrator Guide. The query result is either saved in a query result record
(Q1) or written to a file.

Parameters (all optional):

• -n: name of the query result (if no name is specified, the following name is
assigned: <query_name>_<creation_date>_<creation_time>)

• -r : maximum number of result lines (if not specified, no restrictions apply)

• -f: private (>0 = private, otherwise global)

• -csv: the query results are written to a file

The query format is saved as a document in the database (D1 table) and linked to
the To-Do by means of a document link. The document contains the XML definition
of the query. After successfully executing the query, the document is deleted from
the database.

XML Report: Type = 9

Creates an XML report, see Reports in the Aurea CRM win User Manual.
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Parameters:

• -xml <report name>

• -xfile <Path> (path to a file containing a report name per line)

• save=1;context=1;doc.class=<text>;keyword=<text>

Use these parameters to specify how the report should be saved in Aurea CRM's
database.

• save=1 ... The report document is saved to the Document info area (D1) under
the name specified in the report format. (save=0 (default) ... The report is not
saved in the database but created as specified in the Report format).

• context=1 ... The D1 record is linked to the record entered in the Link field in
the To-Do record via a Document link record (D3).

If the Context of the report format is set to "current record", the linked record
is used as context for the report.

This parameter is ignored when used in the command line.

• <doc.class> is a text parameter: You can enter the external key of the catalog
value that is added to the new D1 record (Document class field).

• <keyword> is a text parameter: You can add a value (for example the customer's
ID) that is added to the new D1 record (Keyword field).

The four parameters must be separated by semicolons.

If the record entered in the Link field is already linked to a D1 record with the
document and the same Document class catalog value via D3 record, the docu-
ment is replaced by the new report and no new records are created. If the D1
record contains a document with a different name than specified in the Report
format, the document's name is left unchanged and updated with the contents of
the report. If there's a different Document class entered, a new link is created
in addition to the already existing one.

Prerequisites:

• The report format must be present in Aurea CRM.

• The path and file name of the report (defined under Select File/Directory in the
Define Report Format window; or under Save first transformation to file) must
be defined.

• The report may not use any variable conditions.

If these prerequisites are not met, the process is aborted.

Calculate Accommodation & Event Venue Ratings: Type = 10

Calculates the average of all event ratings (accommodation and venue).

Parameters:

• Star t date of the campaign (format: YYYYMMDD). All campaigns that star t after
the specified date are calculated. If no star t date is specified, the average is
calculated for all campaigns.

Calculate Lecture & Speaker Ratings: Type = 11

Calculates the average of all event ratings (lecture and speaker).
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Parameters:

• Star t date of the agenda item (format: YYYYMMDD). All agenda items that star t
after the specified date are calculated. If no star t date is specified, the average
is calculated for all campaigns and agenda items.

Update Sales Territory Management: Type = 12 (BTB and FS only)

Updates the allocation of reps (in sales groups and property management records)
for companies, persons and properties (BTB only), see Territory Management in the
Business Logic Manuals.

Enter the To-do type and affected info areas in the Text field :

12;FI,KP,OJ updates the allocation for all three info areas,

12;KP only updates the allocation to persons in the Person in Company info area.

Mass Updates: Type = 14

Applies mass data updates for Aurea CRM web, see Mass Data Operations in the
Aurea CRM web Administrator Guide.

Parameters:

• Abbreviation of the info area subject to the change (e.g. "FI")

• The frequency with which the To-Do is executed (between the due date and end
date). Format: 3d = 3 days, 2m = 2 months. This parameter is optional.

If errors occur, a log file is saved in the database and linked to the appropriate
message. If the web URL configuration entry is present, the file also contains a link
to the Aurea CRM web record that the error affects.

Mass Deletions: Type = 15

Mass Deletions without Communication: Type = 16

Carries out mass deletions for Aurea CRM web, see Mass Data Operations in the
Aurea CRM web Administrator Guide.

Parameters:

• Abbreviation of the info area subject to the change (e.g. "FI")

• The frequency with which the To-Do is executed (between the due date and end
date). Format: 3d = 3 days, 2m = 2 months. This parameter is optional.

If errors occur, a log file is saved in the database and linked to the appropriate
message. If the web URL configuration entry is present, the file also contains a link
to the Aurea CRM web record that the error affects.

Create Calendar Definition Entries: Type = 17

Creates records in the Calendar Definition (CD) info area for the specified time
span and calendar IDs, see Calendar Definition Info Area on page 94.

17 ;YYYY -MM-DD,YYYY-MM-DD,ID1,ID2,...
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Parameters:

• Star t / End Dates (format YYYY-MM-DD or YYYYMMDD): The records are created
the specified time span. The maximum number of days and therefore records is
3660. If the time span exceeds this number, no records are created.

• Calendar ID(s): Catalog value IDs of the fixed catalog "Calendar". If no value
exists for the specified ID, no records are created.

Calculate Root Ticket for Existing Ticket Hierarchy: Type = 18

Enters a link to the respective root ticket in all existing (hierarchical) tickets
(KM_2_StaNo/SerNo/Link). (This is required to highlight all Activity records be-
longing to a ticket hierarchy in the Dispatching Dashboard.)

18 ;KM

Alternatively, you can use the Generate Root ID context menu option in the Ticket
Overview (in Aurea CRM win).

Calculate Corporate Structures: Type = 19

Generates/updates relationship levels for corporate structures in Aurea CRM web,
see Corporate Structures in the Business Logic Manual.

19 ;force ;highLevelUpdate;timestamp

Parameters (optional):

• force : By default, corporate structures are only created, if at least one
relationship hierarchy entry is present in the Relationship level (BL) info area.
Use the force parameter to create corporate structures even if no relationship
hierarchy exists.

• highLevelUpdate : By default, no triggers are executed when this to-do changes
records. Use the highLevelUpdate parameter to enable the execution of triggers.

• timestamp : By default, no time stamps are set in the relationship records when
this to-do changes records. Use the timestamp to enable the setting of time stamps.

The calculation is tracked in the Process Tracking (T3) info area (process "Generate
Relationship Hierarchy" (1010)). Relationship records with no children are deleted
during this process. Relationships with a depth greater than 10 levels and relationship
loops are written to the log file.

Calculate Item Structures: Type = 20

Generates/updates item structure records (IS), see Item Structure in the Business
Logic Manual.

This to-do type supports the same parameters as described for type 19.

Import: Type = 21

Allows star ting an import, see Import/Export in the Aurea CRM win Administrator
Guide.

21;import_FI;C:\temp\FI_imp.txt;1
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Parameters:

• Name of the import format (required when importing from file and from database)

• Path and name of the import file (only required when importing from file)

If undefined, the file specified in the import format is used. In this case, you need
to add an "empty" parameter, e.g. 21;import_FI;;

• Switch for creating Import Results records (C5): 0 or 1.

If undefined, the setting specified in the import format is used (Log import results
check box in the File Format dialog).

After completion of the to-do the following information is written to the database:

• The message (MD) that is created for the Assigned by rep contains the number
of records that have been imported successfully and the number of records for
which the import failed in the Message field.

• The record ID of the import log record (created in the Communication Log info
area C3) is written to the Text field of the message record (e.g.
"#71/x0000000000000001").

For imports which should be executed at regular intervals you can define jobs of
type ImportJob in the settings.server.xml, see Scheduling Import Jobs on
page 453.

Export: Type = 22

Allows star ting an export, see Import/Export in the Aurea CRM win Administrator
Guide.

22;export_PR;C:\temp\PR_export.txt

Parameters:

• Name of the format

• Path and name of the target file

If undefined, the file specified in the format is used. In this case, you need to add
an "empty" parameter, e.g. 21;export_PR;;

For exports which should be executed at regular intervals you can define jobs of
type ExportJob in the settings.server.xml, see Scheduling Export Jobs on
page 454.

Note:  Since CRM.server can not handle Selections and Property Selections (BTB
only), you can not use export formats exporting records restricted based on
selections.

Note: To-Dos of types 1, 2, 6, 7, 9-12, 14-17, 21 and 22 are executed within the
user context, i.e. they are executed using the access rights of the user who added
the To-Do record (Assigned by field).
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Linking To-Dos to Other To-Dos
Learn how to link To-Dos to other To-Dos.

You can link a to-do to a predecessor to-do. The to-do is only processed after its
predecessor has been completed. The Due on and Due at values are taken into
account, i.e. the child to-do is processed at its scheduled time if the predecessor
to-do has been completed successfully.

Note: This feature is only available for CRM.server, i.e. update.seven sever does
not support concatenated to-dos.

To-do records are linked via the TD_1_StaNo and TD_1_SerNo fields containing
the key of the Predecessor to-do.

If a to-do can not be processed due to a technical problem (e.g. an import fails be-
cause the database is unavailable), the child to-dos are not processed as well.

If a to-do can not be processed due to a problem regarding its content (e.g. parent
record or catalog value not found, wrong date/time format, etc.), the child to-dos
are processed regardless.

For to-dos that failed due to a technical problem, the Status is set to "Aborted".

Sales Planning
Aurea CRM's sales planning & optimization functionality uses CRM.server to-dos
to perform calculations.

Each function creates a to-do of To-Do Type "Calculate" calling a workflow (Execu-
tion Type = "Workflow", Execution Format = "<workflow_name>"), see Automati-
cally Completing To-Dos on page 442.

Syntax:

To enter parameters directly in the to-do record (Text field), use the following syntax:

parameter name = <value/>

Example:

"BY=<2013/> FilterFi=<F0='2' AND F1='100'/> FilterP5=</> RepId=<010000003/>"

Global Parameters

ServerId: Rep ID of the CRM.server user for asynchronous to-dos.

ExecutionMode: synchron | asynchron (default)

Available Functions (Workflows) and Parameters

Name: U_BL_P5_1

Creates "empty" Sales Optimization records (P5) for the specified year (no values,
no quantities).

Parameters:
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Business year for which the P5 records are generated. If unde-
fined, the previous year is used.

BY

Filters for specific FI records.FilterFi

Filters by rep.FilterId

Filters by country.FilterLa

Filters for specific P5 records.FilterP5

If defined, the P5 records are generated for this rep.

If a company "belongs" to another rep and its product records
are rep-related (i.e. no company or country entered), no P5
records are created.

RepId

Name: U_BL_P5_2

Calculates default target values by reading the actual values from the specified year
and adds the percentages specified in P6 or P7.

Parameters:

Business yearBY

Filters for specific FI records.FilterFi

Filters by rep.FilterId

Filters by country.FilterLa

Filters for specific P5 records.FilterP5

If set to true, the calculated defaults are directly copied to the
target values. Only if CopyFunction = <false/>.

If set to false, the values are only calculated and the U_BL_P5_3
function has to be used to update the P5 records.

Copy

If set to true, U_BL_P5_3 is called with parameters BY, FilterP5
and HierachyLevel (see below).

CopyFunction

Specifies on which product level the target values are calculat-
ed, i.e. the planning level. Available values: 1-6

HierarchyLevel

Specifies the type of plan: 1...company, 2...rep, 3...country,
4...business year.

AggType
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Name: U_BL_P5_3

Copies default targets to target values (annual values).

Parameters:

Business yearBY

Filters for specific P5 records.FilterP5

Specifies on which product level the target values are written,
i.e. the planning level. Available values: 1-6

HierarchyLevel

Specifies the type of plan: 1...company, 2...rep, 3...country,
4...business year.

AggType

Name: U_BL_P5_4

Calculates the market growth per product and target values based on the growth.

Note:  P5 records for the newly calculated target values must exist.

Parameters:

Business yearBY

Filters companies for the calculation (read).FilterFI

Filters companies for the result (write).FilterFIWrite

Filters reps for the calculation (read).FilterId

Filters reps for the result (write).FilterIdWrite

Filters countries for the calculation (read).FilterLa

Filters countries for the result (write).FilterLaWrite

Filters for specific P5 records.FilterP5

If set to false, target values are calculated.

If set to true, forecast values are calculated.

Forecast

Error Codes

• BL_ERROR_TODO_PARAMETER = 280

• BL_ERROR_READ_FILTER_FORMAT = 281
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• BL_ERROR_WRITE_FILTER_FORMAT = 282

• BL_ERROR_STRING_TO_FILTER = 283

Carrying Out Marketing Activities
Learn how to carry out and abort marketing activities.

Marketing activities defined to be carried out by CRM.server are executed by the
MonitorExecuteActivityTodosJob as defined in the settings.server.xml file:
<!--
Execute open todos with marketing activities for the crm.server user (every three
minutes)

-->
<Job schedule="*/3 * * * * "
type="update.Crm.Server.Jobs.MonitorExecuteActivityTodosJob,update.Crm.Server" />

If the schedule attribute is undefined, the MonitorExecuteActivityTodosJob checks
for due to-do records of Type "Execute Marketing Activity" every minute.

For detailed information on defining and executing marketing activities, see Marketing
Activities in the Business Logic Manual.

Aborting the Execution of a Marketing Activity

You can define that users can enable a Boolean field in the Execution (Marketing
Activity) info area while the marketing activity is being executed in order to abort
the execution of the marketing activity. Which field is used for this purpose is defined
by the Field used to cancel the execution for marketing activities configuration
option (Campaigns category) in the Configuration info area (MC), see Campaigns
on page 29.

When executing the marketing activity, CRM.server regularly polls to check whether
this field has been enabled. The default polling interval is 5 seconds. To change
this interval, enter "Interval=n" (where n is the desired number of seconds) in the
Comment field if the configuration entry.

If the execution is aborted, the Execution Status field in the Execution (Marketing
Activity) info area and the status of the corresponding to-do are both set to "Can-
celed". The time at which the execution is aborted is written to the Time field in the
Log (Marketing Activity) info area.

Note: This function can impact negatively on the system's performance when
executing marketing activities.

Scheduling Import Jobs
Learn how to schedule import jobs execution.

Imports which should be executed at regular intervals can be executed by the Im-
portJob in the settings.server.xml:
<Job schedule="0 2 * * * "
type="update.Crm.Server.Jobs.ImportJob,update.Crm.Server">
The import format name
<FormatName>CompanyImport</FormatName>
The path to the import file (optional)
<ImportPath>E:\MyDocuments\FI_import.txt</ImportPath>
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Set to true if an import result should be generated (optional)
<CreateProtocol>false</CreateProtocol>
</Job>

The import is executed based on an import format, see Import/Export in the Aurea
CRM win Administrator Guide.

Available parameters:

FormatName

The name of the import format.

ImportPath

The path to the import file. This can be a relative or absolute path, environment
variables are resolved. If undefined, the import file specified in the import format is
used.

CreateProtocol

If set to true, Import Result (C5) records are generated for import errors. If unde-
fined, the setting specified in the import format is used (Log import results check
box in the File Format dialog).

Use the name attribute to schedule multiple import jobs with different parameters to
execute multiple imports at regular intervals.

Default: false

Scheduling Export Jobs
Learn how to schedule export jobs execution.

Exports which should be executed at regular intervals can be executed by the Ex-
portJob in the settings.server.xml:
<Job schedule="0 2 * * * "
type="update.Crm.Server.Jobs.ExportJob,update.Crm.Server">
The export format name
<FormatName>Export_format</FormatName>
The path to the export file (optional)
<ExportPath>export.txt</ExportPath>
</Job>

The export is executed based on an export format, see Import/Export in the Aurea
CRM win Administrator Guide.

Available parameters:

FormatName

The name of the format.

Note:  Since CRM.server can not handle Selections and Property Selections (BTB
only), you can not use export formats exporting records restricted based on selec-
tions.
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ExportPath

The path and name of the target file. This can be a relative or absolute path, envi-
ronment variables are resolved. If undefined, the file specified in the format is used.

Use the name attribute to schedule multiple export jobs with different parameters to
execute multiple exports at regular intervals.

Background Geo-Coding
Learn about jobs to retrieve and recalculate geocodes in the background.

Background geo-coding consists in the following tasks executed by CRM.server:

• retrieve geographic coordinates for large amounts of data, see Batch-Geocoding
on page 456

• recalculate geographic coordinates of low quality, see Re-Encoding Failed Geo-
Codings on page 457

Both tasks are executed in one step by the BatchGeocodingJob job as defined in the
settings.server.xml file:
<!--
Update missing or faulty geo-coordinates in records each night at 2 o'clock
You need a valid Bing license!
-->
<Job schedule="0 2 * * * "
type="update.Crm.Server.Jobs.BatchGeocodingJob,update.Crm.Server">
The catalog value of the precision catalog: all records with a value equal or lower
is recoded

<Precision>2</Precision>
The interval which should be checked: i.e. P1Y2M10DT2H30M
<Timespan>P2D</Timespan>
</Job>

Available parameters (for more details,see Re-Encoding Failed Geo-Codings on
page 457):

Precision

Defines the precision of records which should be re-encoded. All records with a
lower value is re-encoded.

Timespan

Defines the interval which is subtracted from the current date to re-encode all records
with a value lower than this date in the Updated (Geo-coordinates) field.

Background geo-coding can only be executed on a Aurea CRM database containing
a server license, see Aurea CRM License on page 130.

To enable server-side geo-coding, enable the Use Geo-coordinates configuration
options (Geo-Coordinates category) in the Configuration info area (MC), see Geo-
Coordinates on page 49.

In addition, at least the following configuration options must be defined:

• License key

• Geolocation handler
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To restrict geo-encoding to batch-geocoding only, set the Active in the following
modules option to "mmse".

Batch-Geocoding
Learn about batch geocoding.

The following records are updated:

• A configuration entry Geolocation Handler (MC) is defined for the record's info
area.

• Mandatory address fields (Country, City, Street and ZipCode (default) or custom
fields as defined by the Field Mapping configuration entry) are not empty.

• Records with Precision != "failed".

• The coordinates fields (Longitude and Latitude) are empty.

By default, when the configuration options are not defined, the following limits are
enforced:

• 200,000 records per batch

• five batches per day

• 10,000,000 records per year

The maximum size of a batch is 300 MB (uncompressed request).

The limits can be configured using the following configuration options (MC, Geo-
Coordinates category):

• Maximum number of addresses per batch request: Records per batch.

• Maximum number of batch requests per day: Batches per day.

• Maximum number of addresses in batch requests per year: Records per year.

Enter the desired values in the Numeric field. These settings are applied globally.

Note:  For Bing maps license keys supplied by Aurea Software Inc., refer to Aurea
Bing Maps Usage Limits on page 457.

The information on the remaining number of records to be geo-encoded in the current
year is saved in T3 (Process "(10,000) TrackingProcessTypes.BatchGeocodingRe-
mainingLimit") and displayed on Aurea CRM web's System Information page (Re-
maining number of geocodes for the current year).

Note: The year always star ts at January 1st. The counter (on the System Information
page) is reset when batch-geocoding is executed for the first time in a year.
Therefore, limit changes are only applied at this time.
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Re-Encoding Failed Geo-Codings
After batch-geocoding is completed and if the limit of the daily quota is not yet
exceeded, records with a low geo-coding precision are re-encoded.

The following records are updated:

• A configuration entry Geolocation Handler (MC) is defined for the record's info
area.

• Mandatory address fields (Country, City, Street and ZipCode (default) or custom
fields as defined by the Field Mapping configuration entry) are not empty.

• Records with Precision below acceptable (as defined by the <Precision> attribute,
see below).

Records with Precision = "Manual input" are not changed.

• The date of the last geo-encoding (Updated (Geo-coordinates) field) is older
than the re-encoding timespan (as defined by the <Timespan> attribute, see below).

• The records to be re-encoded are ordered by Date ascendant (= oldest first) and
Precision descendant (lowest first).

The amount of records to be re-encoded is limited by the maximum batch size and
the daily quota that is left. The sum of the number of records geo-coded by batch-
geocoding and re-encoded may not exceed the daily quota.

The precision and timespan defining which records are to re-encoded is defined in
the settings.server.xml file:
<Job schedule="0 2 * * * "
type="update.Crm.Server.Jobs.BatchGeocodingJob,update.Crm.Server">
<Precision>2</Precision>
<Timespan>P2D</Timespan>
</Job>

Enter the code of the desired value of catalog Precision (97), e.g. 2 for "High". In
this case records with Precision = "Medium", "Low" and "failed" is re-encoded.

Enter the timespan using ISO 8601, see http://en.wikipedia.org/wiki/ISO_8601#Du-
rations.

Examples:

P1Y2M10DT2H30M => 1 year, 2 months, 10 days, 2 hours and 30 minutes.

Values without a value can be omitted: P2D => 2 days.

Aurea Bing Maps Usage Limits
The mandatory limits apply to Bing Maps license keys supplied by Aurea Software
Inc.

For information about the limits applicable to license keys supplied by Microsoft or
other 3rd parties, please contact the corresponding supplier.

CRM.core Batch Geocoding Configuration
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Access the Win Rights module (mmri.exe) and assure the following configuration
options exist:

• Maximum number of batch requests per day: 3

• Maximum number of addresses per batch request: 2.500

• Maximum number of addresses in batch requests per year: 1.200.000

CRM.server Job Configuration

For the background service CRM.server, the limits are:

• Medium(3) as minimum precision

• 7-day re-encoding timespan

The above limits are defined in the configuration file settings.server.xml.

For example, a daily execution at 4am would be defined as follows:

<Job schedule="0 4 * * * "
type="update.Crm.Server.Jobs.BatchGeocodingJob,update.Crm.Server">

<Precision>3</Precision>
<Timespan>P7D</Timespan>

</Job>

Additional considerations

• If the same License Key is configured in multiple stations with Batch Geocoding
enabled, the 3 requests per day must be balanced between all stations, for exam-
ple, 1 in production, 1 in development and 1 in test.

• It is recommended not to keep Batch Geocoding permanently enabled in non-
productive systems, ideally jobs should be scheduled individually for specific
tests.

• It is a best practice to keep the CRM.server Batch Geocoding job schedule con-
sistent with the batches per day CRM.core configuration.

Generating License Reports (Saas)
Learn how license reports are automatically generated.

In an Saas environment license reports are automatically generated by the Gener-
ateLicenseReportJob as defined in the settings.server.xml file:
<!--
Generate the license report at the first day of every month at 23 o'clock
-->
<!--
<Job schedule="0 23 1 * *"
type="update.Crm.Server.Jobs.GenerateLicenseReportJob,update.Crm.Server">
The path to which the license report should be exported.
Can be a relative or absolute path, environment variable are resolved.
(Default is "LicenseReports")
<ExportPath>..\testLicenseReport</ExportPath>
Should user names be anonymized (default is false)
<EncodeUserNames>true</EncodeUserNames>
</Job>
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Available parameters (optional):

ExportPath

Defines the path to which the license report should be exported. This can be a rela-
tive or absolute path, environment variables are resolved. If undefined, the file is
saved to the web\LicenseReport directory. (The directory is created if it does
not exist).

EncodeUserNames

If set to true, user names are anonymized in the report.

For more information, see  License Report in an SaaS Environment on page 133.

Default: false

Escalating To-Dos
The escalation of to-dos is done in a background thread of CRM.server.

The job checks for to-dos to escalate every 30 seconds.

This job is always active and cannot be disabled.

Processing Rep Hierarchy Changes
The processing of Hierarchy Changes is also done in a background thread of
CRM.server.

The processing of Hierarchy Change (05) records (see Rep Hierarchy on page 127)
is done in a background thread of CRM.server checking for hierarchy changes every
30 seconds. This job is always active and cannot be disabled.

Scheduling CRM.server Jobs
CRM.server jobs are scheduled via the server.settings.xml file using the
crontab syntax.

For fur ther details, see http://www.adminschoice.com/tag/crontab-syntax.

Example:
<Job schedule="*/3 * * * * "
type="update.Crm.Server.Jobs.MonitorTodosJob,update.Crm.Server" />

In this case the MonitorTodosJob is star ted every three minutes.

Jobs with the schedule attribute undefined are star ted every minute.

Note:  If you suffer lag in processing background jobs, set the pooling interval to 1
minute in the configuration file as mentioned below.
<Job schedule="1 * * * * "
type="update.Crm.Server.Jobs.MonitorTodosJob,update.Crm.Server" />
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update.seven server
In Aurea CRM CRM.server replaces update.seven server.

The "old" update.seven server is discontinued with future service packs.

For a list of differences between update.seven server and CRM.server, see the ar-
ticle “Comparison between old and new CRM.server” at https://support.aurea.com.

Configuring update.seven server
Learn how to configure CRM.server.

To set up update.seven server:

1. Ensure that the following Aurea CRM directories are present on the server:

• The .. \exe directory (containing mmserver.exe and all DLL files)

• The .. \sys directory

• A user directory for the administrator (SU)

2. Add a user to Aurea CRM win solely for use by CRM.server. This user requires
access rights for those info areas required to execute tasks.

3. To send mailings via CRM.server (see Automatically Executing Marketing Activities
on page 466):

a. Configure SMTP (in the Configuration info area) as the e-mail client on the
station that CRM.server runs on, >> General Settings on page 41 (E-mail Client
option).

b. Specify valid SMTP connection settings for the CRM.server user, see SMTP
Connection Settings on page 92.

4. Register the service by entering the following at the command prompt, see mm-
Server.exe Parameters on page 19:

mmserver --install [-n <servicename>] [-u <username>] [-p <password>]

-n = Name of the instance of CRM.server

-u = The CRM.server user's user name

-p = The CRM.server user's password

Note: You can set up several instances of CRM.server for the same user. Logs
are written per user. Aurea recommends using multiple users if CRM.server
accesses the same database from different computers. If single sign-on has been
configured for the CRM.server user, you do not need to specify the -u and -p
parameters. The password must be entered in upper case, unless the PW must
contain upper and lower case option is enabled. In this case, you need to enter
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the password exactly as defined. Use mmserver --remove to remove the service,
see mmServer.exe Parameters on page 19.

The service is registered per instance under HKEY_LOCAL_MACHINE/Software/up-
date.com/mmServer.

5. Start the service.

Using update.seven server
Learn where to use CRM.server.

You can use update.seven server to:

• Add a to-do, see Automatically Completing To-Dos on page 442.

In addition, update.seven server is used to automatically perform various calcula-
tions used by the business logic, see To-Do Types (update.seven server) on page
461.

• Define an automatic marketing activity, see Automatically Executing Marketing
Activities on page 466.

• Define that hierarchy codes should be updated automatically, see Automatically
Updating Hierarchy Code Fields on page 467.

• Calculations for the sales planning&optimization functionality are performed as
described for CRM.server,see Sales Planning on page 450.

To-Do Types (update.seven server)
To-dos for update.seven server are created as described for CRM.server.

For fur ther details, see Automatically Completing To-Dos on page 442.

Aurea CRM server can process the following tasks:

Calculate Support Costs: Type = 0

Executes the same function as the Calculate option in the Support info area.

Parameters:

• <FI_StaNo>-<FI_SerNo> (e.g. 100-12) (leave empty for all companies)

• Star t year (integer, 4 digits)

• End year (integer, 4 digits)

• Currency (catalog code); optional; the base currency is used by default

Calculate Campaign Status: Type = 1

Executes the same function as the Calculate option in the Campaign info area.
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Parameters:

• <CM_StaNo>-<CM_SerNo> (e.g. 10-47) (leave empty for all campaigns)

Calculate Activity Status: Type = 2

Executes the same function as the Calculate option in the Marketing Activity info
area.

Parameters:

• <AK_StaNo>-<AK_SerNo> (e.g. 1-57)

Fill Telephone Number Table: Type = 3

Executes the same function as the Fill option in the Tel.No./E-mail info area (no
parameters).

Inventory: Type = 4

Executes the same function as the Stocktaking option in the Stock info area.

Parameters:

• Stocktaking format ID

• Star t date (integer, 8-digit, yyyymmdd)

• End date (integer, 8-digit, yyyymmdd)

• Stocktaking text (max. 100 characters)

Allocate Business Line: Type = 5 (OTC only)

Executes the same function as the Allocate option in the Business Line info area
(no parameters).

Execute Selection: Type = 6

Executes a selection.

Parameters:

• Selection format ID

• Selection format name

Only one of the parameters needs to be entered.

Execute Query: Type = 7

Executes a query in Aurea CRM web, see Background Queries in the Aurea CRM
web Administrator Guide. The query result is either saved in a query result record
(Q1) or written to a file.

Parameters (all optional):

• -n: name of the query result (if no name is specified, the following name is
assigned: <query_name>_<creation_date>_<creation_time>)

• -r : maximum number of result lines (if not specified, no restrictions apply)
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• -f: private (>0 = private, otherwise global)

• -csv: the query results are written to a file

The query format is saved as a document in the database (D1 table) and linked to
the To-Do by means of a document link. The document contains the XML definition
of the query. After successfully executing the query, the document is deleted from
the database.

Automatic Selection: Type = 8

Executes all the automatic selections entered in the Autom. column in the Autom.
Selection info area with a frequency >0, see Automatic Selections in the Aurea
CRM win User Manual. Also enter the End Date for this type: the automatic selection
is executed with the specified frequency between the Due on and End Date entered
in the To-Do.

Parameters:

• SL: Executes the automatic selection

• OS: Executes the automatic property selection (BTB only)

• SL,OS or OS, SL: Automatic selections and automatic property selections (BTB
only) are executed. Selections are always executed prior to property selections.

XML Report: Type = 9

Creates an XML report, see Reports in the Aurea CRM win User Manual.

Parameters:

• -xml <report name>

• -xfile <Path> (path to a file containing a report name per line)

• save=1;context=1;doc.class=<text>;keyword=<text>

Use these parameters to specify how the report should be saved in Aurea CRM's
database.

• save=1 ... The report document is saved to the Document info area (D1) under
the name specified in the report format. (save=0 (default) ... The report is not
saved in the database but created as specified in the Report format).

• context=1 ... The D1 record is linked to the record entered in the Link field in
the To-Do record via a Document link record (D3).

If the Context of the report format is set to "current record", the linked record
is used as context for the report.

This parameter is ignored when used in the command line.

• <doc.class> is a text parameter: You can enter the external key of the catalog
value that is added to the new D1 record (Document class field).

• <keyword> is a text parameter: You can add a value (for example the customer's
ID) that is added to the new D1 record (Keyword field).

The four parameters must be separated by semicolons.
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If the record entered in the Link field is already linked to a D1 record with the
document and the same Document class catalog value via D3 record, the docu-
ment is replaced by the new report and no new records are created. If the D1
record contains a document with a different name than specified in the Report
format, the document's name is left unchanged and updated with the contents of
the report. If there's a different Document class entered, a new link is created
in addition to the already existing one.

Prerequisites:

• The report format must be present in Aurea CRM.

• The path and file name of the report (defined under Select File/Directory in the
Define Report Format window; or under Save first transformation to file) must
be defined.

• The report may not use any variable conditions.

If these prerequisites are not met, the process is aborted.

Calculate Accommodation & Event Venue Ratings: Type = 10

Calculates the average of all event ratings (accommodation and venue).

Parameters:

• Star t date of the campaign (format: YYYYMMDD). All campaigns that star t after
the specified date are calculated. If no star t date is specified, the average is
calculated for all campaigns.

Calculate Lecture & Speaker Ratings: Type = 11

Calculates the average of all event ratings (lecture and speaker).

Parameters:

• Star t date of the agenda item (format: YYYYMMDD). All agenda items that star t
after the specified date are calculated. If no star t date is specified, the average
is calculated for all campaigns and agenda items.

Update Sales Territory Management: Type = 12 (BTB and FS only)

Updates the allocation of reps (in sales groups and property management records)
for companies, persons and properties (BTB only), see Territory Management in the
Business Logic Manuals.

Enter the To-do type and affected info areas in the Text field :

12;FI,KP,OJ updates the allocation for all three info areas,

12;KP only updates the allocation to persons in the Person in Company info area.

Mass Updates: Type = 14

Applies mass data updates for Aurea CRM web, see Mass Data Operations in the
Aurea CRM web Administrator Guide.
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Parameters:

• Abbreviation of the info area subject to the change (e.g. "FI")

• The frequency with which the To-Do is executed (between the due date and end
date). Format: 3d = 3 days, 2m = 2 months. This parameter is optional.

If errors occur, a log file (massdata_log.txt) is saved in the database and linked
to the appropriate message. If the web URL configuration entry is present, the file
also contains a link to the Aurea CRM web record that the error affects.

Mass Deletions: Type = 15

Mass Deletions without Communication: Type = 16

Carries out mass deletions for Aurea CRM web, see Mass Data Operations in the
Aurea CRM web Administrator Guide.

Parameters:

• Abbreviation of the info area subject to the change (e.g. "FI")

• The frequency with which the To-Do is executed (between the due date and end
date). Format: 3d = 3 days, 2m = 2 months. This parameter is optional.

If errors occur, a log file (massdata_log.txt) is saved in the database and linked
to the appropriate message. If the web URL configuration entry is present, the file
also contains a link to the Aurea CRM web record that the error affects.

Create Calendar Definition Entries: Type = 17

Creates records in the Calendar Definition (CD) info area for the specified time
span and calendar IDs, see Calendar Definition.

17 ;YYYY -MM-DD,YYYY-MM-DD,ID1,ID2,...

Parameters:

• Star t / End Dates (format YYYY-MM-DD or YYYYMMDD): The records are created
the specified time span. The maximum number of days and therefore records is
3660. If the time span exceeds this number, no records are created.

• Calendar ID(s): Catalog value IDs of the fixed catalog "Calendar". If no value
exists for the specified ID, no records are created.

Calculate Root Ticket for Existing Ticket Hierarchy: Type = 18

Enters a link to the respective root ticket in all existing (hierarchical) tickets
(KM_2_StaNo/SerNo/Link). (This is required to highlight all Activity records be-
longing to a ticket hierarchy in the Dispatching Dashboard.)

18 ;KM

Alternatively, you can use the Generate Root ID context menu option in the Ticket
Overview (in Aurea CRM win).

Calculate Corporate Structures: Type = 19

Generates/updates relationship levels for corporate structures in Aurea CRM web,
see Corporate Structures in the Business Logic Manual.
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19 ;force ;highLevelUpdate;timestamp

Parameters (optional):

• force : By default, corporate structures are only created, if at least one
relationship hierarchy entry is present in the Relationship level (BL) info area.
Use the force parameter to create corporate structures even if no relationship
hierarchy exists.

• highLevelUpdate : By default, no triggers are executed when this to-do changes
records. Use the highLevelUpdate parameter to enable the execution of triggers.

• timestamp : By default, no time stamps are set in the relationship records when
this to-do changes records. Use the timestamp to enable the setting of time stamps.

The calculation is tracked in the Process Tracking (T3) info area (process "Generate
Relationship Hierarchy" (1010)). Relationship records with no children are deleted
during this process. Relationships with a depth greater than 10 levels and relationship
loops are written to the log file.

Calculate Item Structures: Type = 20

Generates/updates item structure records (IS), see Item Structure in the Business
Logic Manual.

This to-do type supports the same parameters as described for type 19.

Note: To-Dos of types 1, 2, 6, 7, 9-12 and 14-17 are executed within the user
context, i.e. they are executed using the access rights of the user who added the
To-Do record (Assigned by field).

Automatically Executing Marketing Activities
Learn to set up auto marketing activities execution.

1. An Aurea CRM user enables the Start automatically check box in the Execution
(Marketing Activity) info area, and enters the CRM.server user in the Rep field.

Note: The access rights assigned to the user entered in the Sel. User field are
used when executing queries/selections and generating records.

2. The number of the station on which CRM.server is running must be entered in
the Station No. field.

3. If the execution definition (Execution (Marketing Activity) info area) contains
all required settings, the CRM.server user receives a To-Do record of type "Execute
Marketing Activity", see Marketing Activities in the Business Logic Manual.

4. Aurea CRM server searches for To-Do records that meet the following conditions
once every minute. It processes them sequentially by date and time.

• Records in the To-Dos info area, where the Type is set to "Execute Marketing
Activity" and the execution date is today or in the past. If the execution date is
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today, then the execution time needs be in the past or empty. The status is
"Open".

• Linked to a marketing activity, whose Status is either "In Progress" or
"Scheduled", and whose Execution Status is neither "Error" nor "Done".

5. A control file is created for serial letters and faxes.

6. Mass mailings can be generated by CRM.server. The e-mails should be merged
by Aurea CRM; i.e. the Body File Txt in the Generate dialog box should link to
the desired file.

7. A control file is created:

• The path and the file entered in the Execution (Marketing Activity) info as
the control file is used. If a file with this name already exists, the first three
characters of the file name are combined with a unique hexadecimal number
to form a new name. The name of the control file is entered in the Log File
field in the Log (Marketing Activity) info area.

• If no control file is defined in the Execution (Marketing Activity) info area,
the file is created temporarily in the user's Windows directory and subsequently
deleted.

CRM.server requires write access and the web server requires read access to
this directory.

Note:  Delete the control file at regular intervals to prevent performance issues.

8. CRM.server informs the user of completion of tasks by sending a message to the
user.

If the Create log field is enabled in the Execution (Marketing Activity) info area,
the execution is logged in the file

<user_name>_<service_name>.log in the .. \system\db directory.

Set the log level to "Info", see Logs and Error Messages on page 506.

You can define that users can manually abort the execution of a marketing activity.
Implement this functionality as described for CRM.server, see Aborting the Execution
of a Marketing Activity.

Automatically Updating Hierarchy Code Fields
Learn how to automatically update hierarchy code field.

To update the hierarchy codes after changing the rep hierarchy using CRM server:

1. Add a new record for the updated rep in the Hierarchy Changes info area.

2. Enter the new superior.
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3. Enter the date for the changes to be applied (Due on and Due at).

4. Enter the CRM.server user in the Executing Rep ID field.

Note: You can also enter a different station in the Station No. field, in order to
apply the change to another station. You need to ensure that CRM.server is
configured on the station, and that no reps affected by changes to the hierarchy are
missing in the station's database.

If the rep hierarchy is changed, the user does not receive a message. The result is
saved in the record.

Rebuild module
The Rebuild module is used to restore damaged indices which Aurea CRM is no
longer able to access.

A power failure, a defective hard disk or even incorrect settings in the ini files can
be the cause of such an incident.

Rebuilding the Indices

To rebuild the indices:

1. Check that you have the necessary access rights, see Rights on page 136.

2. Lock the system in order to make sure that no other users are accessing the
database, see System Locks on page 236.

3. Back up your data.

4. Start the Rebuild module (see Star ting Modules in the Aurea CRM win
Administrator Guide) or click the Rebuild button in the System Lock dialog box.
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The list contains all info areas for which an alphanumeric or phonetic index exists.

5. Select the info areas to be rebuilt. Select All to select all info areas.

6. Select the rebuild functions you wish to execute:

• Rebuild Internal  update.CRM Fields: The internal key fields are rebuilt.

• Rebuild Person Counter: The persons are counted per company.

7. Click on Start.

The rebuild is star ted.

8. Click on Cancel to close the dialog box.

9. Unlock the system, see System Locks on page 236.

You can also star t the Rebuild module from the command line, e.g. to star t the
module at specific times using external scheduling software, see mmba.exe Param-
eters on page 13.

SQL Tool
Learn to use Aurea CRM's SQL Tool to carry out changes to the SQL database.

Note: The SQL Tool can only be star ted by the administrator (SU) and reps assigned
a role where the "Aurea CRM SQL Tool" CRM process is not locked, see CRM Pro-
cess Configuration on page 98.You can irretrievably delete your Aurea CRM database
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and your license with this tool! Only use this program if you have detailed knowledge
of the system.

1. Start the SQL tool by executing mmba.exe (in the .. \system\exe directory)
using the following parameter:

mmba.exe -q

2. Log on as "SU", as otherwise you cannot access the tool.

The update.CRM SQL-Tool dialog box is displayed.

3. In order to enable the functions that carry out far-reaching changes to the
database, enter the password "130369" in the Pwd field and click on Enable.

4. Carry out the desired changes to the database.

• Create All Tables/Indexes: Creates all tables and indices anew.

• Drop All Tables/Indexes: Deletes all tables (and all data in the tables) and
indices.

Note: Warning: Your data is deleted irretrievably!

• Create All Indexes: Creates all indices anew.

• Drop All Indexes: Deletes all indices.

• Create Table/Index: Creates the selected table together with its index.
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• Drop Table/Index: Deletes the selected table including all records and indices.

• Create Index: Creates a new index for the selected table.

Aurea recommends only changing indices in the Maintenance module,
see Data Model on page 280.

• Drop Index: Deletes the selected table's index.

Note: You need to carry out the "drop" action before carrying out the
corresponding "create" action.

• Rebuild Table: Rebuilds the keys in the selected table.

Aurea recommends using the Rebuild module to rebuild tables, see Rebuild
module on page 468.

• Rebuild All Tables: Rebuilds the keys in all tables.

• Rebuild COLLATION Indexes, Rebuild NLS_SORT Indexes: Rebuilds the
indices used to sor t the selected table, see Multi-language Sort (Oracle) and
Multi-language Sort (SQL).

• Rebuild ALL COLLATION Indexes, Rebuild ALL NLS_SORT Indexes: Creates
all the indices used to sor t data in tables, see Multi-language Sort (Oracle) and
Multi-language Sort (SQL).

• Calculate rep reference: Re-creates rep reference records for the selected
info area, see Depict Rep Reference on page 347.

• Count Table: Counts the number of records in the selected table.

• Count All Tables: Counts the number of records in all tables.

• Count All Sel. Tables: Counts the number of records in all selection tables.

• Recreate All Sel. Indexes: Rebuilds the indices in all selection tables.

• Check Table: Checks whether a table is present in the database.

• Check All Tables: Checks whether all tables are present in the database.

• Recreate Sequence: Regenerates the automatically generated serial numbers.

• Recreate All Sequences: Regenerates all the automatically generated serial
numbers.

• Analyze Table: Synchronizes the memory usage counter (sysindex tables).

• Analyze All Tables: Carries out an analysis of all tables.

• Recreate Procedure: Creates the assigned stored procedures anew.

• Recreate All Procedures: Creates all stored procedures anew.

• Recreate All Functions: Creates all functions for conditions that affect system
fields anew.
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• Rebuild Pers.Counter: Aurea recommends using the Rebuild module,
see Rebuild module on page 468.

• Write Script to File: Writes all the executed SQL statements to file under ..
\system\db\<table prefix>_ct.sql.

• Check -> Check Cols.: If this option is enabled, after adding or checking a
table, the table is checked that all columns are present.

5. Click on Done to close the SQL Tool.

CRM.cryptographic tool
Use CRM.cryptographic tool (update.crypto.exe) to encrypt/decrypt files and
XML documents used/produced by Aurea CRM.

You can:

• encrypt XML files (par tially or entire files), e.g. to encrypt the connection string
in the settings.xml file used by Aurea CRM web.

To partially encrypt an XML file use the XML attribute encrypt:
<?XML version="1.0"?>
<sample xmlns:uxe="http://schema.update.com/xmlenc#">
<sensitiveInformationuxe:encrypt="True">mysecretpassword</sensitiveInformation>
</sample>

• decrypt XML files (par tially or entire files)

• encrypt and sign documents (using X509 Certificates, file extension .p7m)

For details on encrypting documents, see Security on page 62.

The cer tificate's private key (used for encryption) is required to decrypt the docu-
ments.

• verify the signature of signed files

• decrypt signed documents

update.crypto.exe is located in Aurea CRM webs' ..\bin directory.

Use CRM.cryptographic tool to encrypt the settings.xml and Offline.xml files.
To encrypt the users.xml, use CRM.users tool, see CRM.users tool on page 501.
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User Interface

Command Line Parameters

Usage: update.crypto operation [OPTIONS]

Operation

Decrypts a file (*.p7m).decrypt

Signs and encrypts a file (creates a *.p7m file).encrypt

Verifies the signature of a signed and encrypted
file (*.p7m).

verify

Encrypts an XML file.encryptxml

Decrypts an XML file.decryptxml

[OPTIONS]

Show help.-h, -?, --help

The file name-f, --file, --files=VALUE

The output file name or directory.-o, --output=VALUE
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[OPTIONS]

The name of the encryption key.-k, --key=VALUE

The id to be used for the key stored in
the XML file (operation encryptxml).

--keyid=VALUE

An XPath expression defining the ele-
ments to encrypt (operation encryptxml).

--xpath=VALUE

The output file name or directory.-c, --cert, --certificate, --cer=VALUE

If set use the Local Machine store to re-
trieve keys and cer tificates.

--ms

Deletes the input files after decryption
(operation decrypt)

--di, --deleteinput

Specifies the name of a log file.-l, --log=VALUE

For more information and examples, see the ar ticle “How to Use update.crypto.exe”
at https://support.aurea.com.

CRM.translation tool
Use CRM.translation tool to manage the translation of customized texts in Aurea
CRM.

You can export (untranslated) catalog values and texts from both the Aurea CRM
and CRM.designer databases, see Exporting Texts for Translation on page 475. Once
the texts have been translated, you can import them into the same or another
database, see Importing Translated Texts on page 491.

The tool supports both CSV and XML formats. The XML output is optimized for in-
teraction with SDL Passolo.

You can also import and export Aurea CRM's field help with CRM.translation tool
see Importing Field Help on page 495 and Exporting Field Help on page 496. The
source file can be edited with Microsoft Excel, see Contents of the Field Help File
on page 500.

CRM.translation tool (TranslationTool.exe) is located in Aurea CRM win's ..
\system\exe directory. CRM.translation tool logs to the TranslationTool.log
file located in .. \system\db.

Prerequisites for using CRM.translation tool:

• .NET Framework 4.5

• For importing/exporting the field help Microsoft Excel must be installed

• When translating texts from the CRM.designer database, you need to assign a
CRM Sub-Language to each target language: The language number in the Aurea
CRM database (Language No. field in the Language info area) must be entered
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as the CRM Sub-Language in CRM.designer, see Global Language Settings in
the Aurea CRM web Administrator Guide.

• If both Aurea CRM and CRM.designer texts are to be translated, only languages
defined in both databases are listed.

• When importing translations into another database ("database-independent"
import/export):

• The language numbers and catalog base language must be the same in the
source and target databases.

• Catalog entries must have unique external keys in the catalog base language
at least.

• The Text records (04) must have the same IDs in the source and target
databases.

Exporting Texts for Translation
Learn how to export texts for translation.

To export texts for translation:

1. Start TranslationTool.exe.

(The Manual button opens this book if present in the .. \manuals folder.)

2. Select Export texts for translation.

3. Select the desired database type: MS SQL or ORACLE.

4. Click Next.
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5. Select the texts you want to export by activating the corresponding check boxes:

• Designer Texts: Exports texts from the CRM.designer database, see Texts in
the Aurea CRM web Administrator Guide.

• Text Table: Exports texts from the Text info area (04), see Text Info Area on
page 368.

• Catalogs: Exports variable catalog values, see Catalogs on page 270.

6. Select the Output Format: CSV (Excel) or XML (Passolo), see Contents of the
Export File on page 481.

7. Enter the path and file name in the Target File field or browse to the desired
location.

8. Click Next.
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9. Enter the Connection String(s) for the Aurea CRM and/or CRM.designer
database(s) using the following syntax:

• for MS SQL databases:
Server=[name];Database=[name];UID=[login];PWD=[password]

• for Oracle databases: Data Source=[name];user id=[login];password=[password]

10.Enter the Table Prefix for the Aurea CRM database if applicable.

11.Click Check Connection(s).

12.Check Save settings to save the connection settings for later use.

13.Click Next.
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Depending on the specified database connection(s) the following languages are
listed in the language selection fields:

• languages defined in the Aurea CRM win database (Language info area (00))

• languages defined in the CRM.designer database with a CRM Sub-Language,
see Languages in the Aurea CRM web Administrator Guide.

If both Aurea CRM and CRM.designer texts are to be translated, only languages
defined in both databases are listed. (Text Table Base Language always lists
all languages as defined in Aurea CRM win.) The language number in the Aurea
CRM database (Language No. field in the Language info area) must be entered
as the CRM Sub-Language in CRM.designer.

14.Specify the desired Languages settings:

Note: The source and target languages may not be the same.

Catalog translations: The catalog base language cannot be selected as the target
language.

• Target Language: Select the target language.

When exporting to CSV, you can select multiple target languages. For each
language a separate row is output to the CSV. Thus you can create translations
to multiple languages in a single export and import.

• Text Table Base Language: This language is used to determine the number
of untranslated records in the Text info area (04). By default, the catalog base
language is selected.
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In addition to the languages defined in the Aurea CRM win database, the list
contains a "Language-independent" entry with Language No. '0' (for counting
the Language-independent entries in the Text info area), see Displaying and
Editing Texts on page 373.

• Additional Languages (CSV): When exporting to CSV, select the source
language here. You can select additional languages to be exported, e g. if you
are using an extra "language" to document texts and catalog values.

The following options only apply when exporting to XML:

• Text Table Add. Lang. (XML): When exporting the text table to XML, select
an additional language here. This language's text is written to the AdditionalInfo
attribute. It can give translators more information about the usage of the text.

• Source Language (XML): When exporting to XML, select the source language
here.

• Passolo Source/Target Language (XML): Select the matching SDL Passolo
languages.

• Generate glossary file for Passolo (XML): Enable this check box to create a
Passolo-compliant glossary file in addition to the export file. The glossary file
allows you to reuse translated strings. It contains all existing translations as
"language pairs" in the source and target languages.

15.If you chose to export CRM.designer texts, specify the desired Designer settings:

• Designer texts per verticals: Select the desired ver tical(s).

• Configurations to Export: Select the configurations from which texts are to
be exported.

All available CRM.designer configurations are displayed with their names and
IDs. The UPDATE* configurations are listed as well. Although texts from these
default configurations may be exported (e. g. to create a glossary), they cannot
be imported.

• Truncate Texts/Meaning at Character: Use these options to truncate the
strings to be exported (default=250 characters).

By default, all text fields and the Meaning field have a length of 1024 characters.
Exporting the Default Text plus one additional language plus Meaning would
result in a row width of 6K. The Truncate options enable you to set a row width
below the 8K database limit.

The Truncate Texts option affects the following fields: Default Text, Text and
texts in additional languages.

The Truncate Meaning option affects the Meaning field.
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16.Specify Further Options:

• Database-independent: Enable this check box if you plan to import the
translated texts into another database. This option affects the match-up method
used when importing, see Match-up on page 494.

In addition, the XML output is created with database-independent IDs, see ID
Creation (XML) on page 481.

Note:  If you use the Database-independent option when exporting you have to
enable this option when importing the file as well, see Importing Translated Texts
on page 491.

• Only export texts with translations: Enable this check box to export translated
texts only (e.g. to change texts in a sub-language that are already translated
in a parent language). If this check box is enabled

• Only export texts without translations is disabled automatically

• Text Table Base Language is disabled automatically

Only export texts with translations works as follows:

• If text table items are exported, only texts containing a text table entry for
the target language are exported. The "DefaultText" column contains the
language-independent text. If no language-independent text exists, it contains
the same text as the Text column, see Contents of the Export File on page
481.

• If catalog values or texts from CRM.designer are exported, only texts where
a translation exists for the target language are exported.

If Only export texts with translations is disabled all texts are exported.

• Only export texts without translations: Enable this check box to export
untranslated texts only. If this check box is disabled all texts are exported.

• Only export used text table entries: Enable this check box to export only text
table entries that are used in the current installation and are therefore referenced
in one of the following files: mm_dbstr.txt and mm_fixcatno_custom.txt,
see mmba.exe Parameters on page 13. If you use the --CheckRights parameter
you can create these files for only those items for which the current user has
access rights.

The texts exported to the glossary are not affected by this option.

• Exclude text table entries used for online field help: Enable this check box
to exclude text table entries that are linked to field help records (FH) from the
export.

• Export field help in Usage column: This option is only available when exporting
text table records. Enable this check box to export field help for texts used by
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a field in the data model. The field help is written to the "Usage" column. If
multiple field help records are found, the first one is output.

This option requires an mm_dbstr.txt file in the .. \system\db folder.

The field help is exported in the Text Table Base Language. If no field help
exists for this language, the Target Language is used. If no field help exists
for this language, the Additional Languages are searched and the first one
containing field help is used.

• Exclude locked catalog entries: This option is only available when exporting
catalog values. Enable this check box to exclude locked catalog values from
the export. If this option is enabled, values with Lock set for the catalog value
in the language to export and/or the catalog base language are not exported.

17.Click Next.

18.Click Start Export.

The texts are exported to a file according to the specified settings.

CRM.designer texts flagged as "Sealed" are not exported, see Editing Texts in
the Aurea CRM web Administrator Guide.

19.Click Close to exit the application, or click Back to export texts for another target
language. Make sure to specify a different name for the output file.

ID Creation (XML)
ID creation when exporting to XML.

When exporting to XML, the following unique IDs are generated for the purpose of
matching up the source and target texts in SDL Passolo:

• Text table: T_<04_1_StaNo>_<04_1_SerNo>

• Catalog:

• database-dependent: C_KatNr_Code_Unterkat1

• database-independent: C_KatNr_ExtKey

• Designer:

• database-dependent: D_textid

• database-independent: D_Textgroupname_Nr

Contents of the Export File
Learn about the format in which the texts are exported.

The texts are exported as follows:
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CSV Output
Learn about the csv output format.

The output file is a Unicode CSV file using Tab as the field separator. If more than
one target language was selected, a separate row is created for each target lan-
guage.

Enter the translations in the "Text" column. If a translation already exists (Export
only texts without translation disabled), it is output to this column.

Do not change the number and order of columns in the CSV file. Otherwise the import
fails.

Tabs and line breaks are encoded as follows (and should not be changed):

• Tab (\t): #tab#

• Carriage return (\r): #cr#

• Linefeed (\n): #ln#

Note: To enter a text beginning with a single quote in Excel, you need to escape
it with a (second) single quote.

The following tables (one per text type) show the contents and significance of each
column. The "Import" column contains the following information:

• x: required for import

• d: required for database-dependent import

• i: required for database-independent import
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Text Table

ImportCommentsDB Col-
umn

Name

Field
Name

CSV Col-
umn

-Type of text: "Core"--Type

-Text in the selected text table base
language

-[Text in
base lan-
guage]

DefaultText

xNumber of the target languageSpracheNrLanguage
No.

LanguageNo

xEnter translations hereText/Long-
Text

Text / Text
(long)

Text

-Text of parent entry in the selected text
table base language, if applicable (de-
termined using the
04_2_StaNo./04_2_SerNo. fields)

[ID_042][04_2_StaNo./04_2_Ser-
No.]

Context

-Information on user interface items that
use the text:

Field names: DM:<infoAreaName> (<in-
foAreaId>),<fieldId> If Export field
help in Usage column is checked, the
field help is output as well.

Fixed catalog entries: CAT:<catalog-
Name> (<infoAreaName>) (<cata-
logId>),<code>

Field help: FH:<infoAreaName> (<in-
foAreaId>),<fieldName> (<fieldId>)

Prerequisites:The mm_dbstr.txt and
mm_fixcatno_custom.txt containing
the referenced text table entries (curly
brackets, last entry) must be present in
the ..\system\db directory.The field
help must be present in the database.

If a text is referenced by more than one
element, all occurrences are output
separated by a semicolon.

--Usage

xID of the Text table recordID_04StaNo.04_1_StaNo
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ImportCommentsDB Col-
umn

Name

Field
Name

CSV Col-
umn

xSerNo04_1_SerNo

-Additional language(s): source text--<Language
Name (Lan-
guage Num-
ber)>

Catalogs

ImportCommentsDB Col-
umn Name

Field
Name

CSV Col-
umn

-Type of text: "Catalog"-Type

xThe catalog value in the catalog base
language

-Text in
base lan-
guage

DefaultText

xNumber of the target languageSpracheNrLanguage
No.

LanguageNo

xEnter translations hereTextTextText

-Description in the catalog base lan-
guage

Beschrei-
bung

Descrip-
tion

Context

-Number of the catalog base language--CatBase-
LangNo

xCatalog numberKatNrCatalog
No.

CatNo

dThe number of the catalog valueCodeCodeCode

dThe code of the parent value, if appli-
cable

Unterkat1Parent
Catalog

Ucode
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ImportCommentsDB Col-
umn Name

Field
Name

CSV Col-
umn

iIf available, the external keys are
exported in both the target language
and the catalog base language,
>> Match-up on page 494.

Catalog values without an external
key are written to the log file.

Database-independent export/import:
The external key must be unique for
each catalog value.

ExtKeyExternal
Key

ExtKeyBase-
Lang

ExtKey

xTenant numberMandNr<xx>-Ten-
No

TenantNo

-Additional language(s): source text--<Language
Name (Lan-
guage Num-
ber)>

Designer Texts

ImportCommentsDB Column
Name

CSV Column

-Type of text: "Designer"-Type

-Default TextDefaultText

xNumber of the target languageLanguage No.LanguageNo

xEnter translations hereLangtextText

-Exported if available in CRM.designerMeaningContext

-Format: name (source, additional in-
fo), e. g. PR (Tabs, Details).

If a text is referenced by more than
one element, all occurrences are
output separated by a semicolon:
name (source, additional info); name
(source, additional info); etc.

UsageUsage

dIDTextId
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ImportCommentsDB Column
Name

CSV Column

iTextgroupnameTextgroupname

iNrNr

iCustomconfig-
name

Customconfigname

dCustomconfigIdCustomconfigId

iConfignameConfigname

dConfigIdConfigId

-Additional language(s): source text-<Language Name
(Language Num-
ber)>

-The number of times a text was
loaded during all tracked Aurea CRM
web sessions, see Logging the Usage
of CRM.designer Texts in the Aurea
CRM web Administrator Guide.

-UsageWebInstalla-
tion

XML Output
Learn about the XML output format.
<?xml version="1.0" encoding="utf-8"?>
<!DOCTYPE pslXMLExportImport SYSTEM "pslXMLExportImport.dtd">
<pslXMLExportImport>
<pslTransList Id="" Source-Language="en" Target-Language="it">
<Entry Id="T_1_65426" Origin="text table" Comment="CAT: Lead Status (Company) (3),
000; "

AdditionalInfo="Keiner" LangNo="3">None</Entry>
AdditionalInfo="Produktwert i. Konzernwährung" LangNo="3">Total Product Value
(Corporate
Curr.)</Entry>
<Entry Id="T_1_40000" Origin="text table" Comment="FH: Login (US), No. (0000); "
AdditionalInfo="Nummer des Benutzers" LangNo="3">User number</Entry>
<Entry Id="C_2_2_0" Origin="catalog" Comment="2" LangNo="3" TenantNo="100"
BaseLang="Germany"
CatBaseLangNo="2" Code="2" ParentCode="0" ExtKeyBaseLang="1_2_2"
ExtKey="">Germany</Entry>
<Entry Id="D_9511" Origin="MA (Tabs, Details)" Comment="Title of the main tab in
the Activity
info area (MA)." Language="" LangNo="3" ConfigId="1001"
ConfigName="customized_parent"
CustomConfigId="" CustomConfigName="" TextId="9511" TextGrpName="" No="0"
VerticalId="1">Appointment Data</Entry>
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The XML output can be translated with SDL Passolo. The pslXMLExportIm-
port.dtd file supplied by Aurea (located in .. \system\exe) has been adapted
to contain all necessary attributes. Translators need to copy this file to their Passolo
installation.

Each <entry> node contains a text to translate. If a text does not exist in the selected
source language, the following text is used:

• Text table: the text in the selected text table base language

• Catalog: the text in the catalog base language

• Designer: the Default Text

The following tables (one per text type) show the contents and significance of each
attribute. The "Import" column contains the following information:

• x: required for import

• d: required for database-dependent import

• i: required for database-independent import

Text Table

ImportCommentsDB Col-
umn

Name

Field
Name

XML At-
tribute/Tag

xUnique ID for SDL Passolo, see ID
Creation (XML) on page 481

-Id

-Type of text: "text table"-Origin
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ImportCommentsDB Col-
umn

Name

Field
Name

XML At-
tribute/Tag

-Text of parent entry in the selected
text table base language, if applica-
ble (determined using the
04_2_StaNo./04_2_SerNo. fields)

Information on user interface items
that use the text:

Field names: DM:<infoAreaName>
(<infoAreaId>),<fieldId> If Export
field help in Usage column is
checked, the field help is output as
well.

Fixed catalog entries: CAT:<catalog-
Name> (<infoAreaName>) (<cata-
logId>),<code>

Field help: FH:<infoAreaName> (<in-
foAreaId>),<fieldName>(<fieldId>)

Prerequisites:The mm_dbstr.txt
and mm_fixcatno_custom.txt
containing the referenced text table
entries (curly brackets, last entry)
must be present in the ..\sys-
tem\db directory.The field help must
be present in the database.

If a text is referenced by more than
one element, all occurrences are
output separated by a semicolon.

[ID_42][04_2_StaNo./
04_2_Ser-
No.]

Comment

-Text of the entry in an additional lan-
guage

-AdditionalIn-
fo

xNumber of the target languageSpracheNrLanguage
No.

LangNo

xText to translateIf the text is missing
in the source language, the text in
the selected text table base language
is output.

Text/Long-
Text

Text / Text
(long)

<Entry></En-
try>
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Catalogs

ImportCommentsDB Col-
umn

Name

Field
Name

XML At-
tribute/Tag

xUnique ID for SDL Passolo--Id

-Type of text: "Catalog"--Origin

xCatalog number; Description field of
the catalog value in the catalog base
language

KatNrCatalog
No.

Comment

xNumber of the target languageSpracheNrLanguage
No.

LangNo

xTenant numberMandNr<xx>-Ten-
No

TenantNo

xThe catalog value in the catalog base
language

-Text in
base lan-
guage

BaseLang

Number of the catalog base language--CatBase-
LangNr

dThe number of the catalog valueCodeCodeCode

dThe number of the parent value, if
applicable

Unterkat1Parent Cat-
alog

ParentCode

iIf available, the external keys are
exported in both the target language
and the catalog base language,
see Match-up on page 494.

Catalog values without an external
key are written to the log file.

Database-independent export/import:
The external key must be unique for
each catalog value.

ExtKeyExternal
Key

ExtKeyBase-
Lang

ExtKey

xText to translateIf the text is missing
in the source language, the text in
the catalog base language is output.

TextText<Entry></En-
try>
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Designer Texts

ImportCommentsDB Column
Name

XML At-
tribute/Tag

xUnique ID for SDL Passolo-Id

-Type of text: value of the Usage field.

Format: name (source, additional info),
e. g. PR (Tabs, Details).

If a text is referenced by more than one
element, all occurrences are output sepa-
rated by a semicolon: name (source, addi-
tional info); name (source, additional info);
etc.

[Usage]Origin

-Exported if available in CRM.designerMeaningComment

xNumber of the target languageLanguage No.LangNo

dConfigIdConfigId

iConfignameConfigName

dCustomcon-
figId

CustomConfigId

iCustom config-
name

CustomConfig-
Name

dIDTextId

iTextgroup-
name

TextGrpName

iNrNr

xText to translateIf the text is missing in
the source language, the Default Text is
output.

Langtext/De-
fault Text

<Entry></Entry>
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Importing Translated Texts
Learn how to import translated texts.

To import translated texts:

1. Start TranslationTool.exe.

2. Select Import translated texts.

3. Select the desired database type: MS SQL or ORACLE.

4. Click Next.

5. Select the texts you want to import by activating the corresponding check boxes:

• Designer Texts: Imports texts into the CRM.designer database, see Texts and
Languages in the CRM.designer Administrator Guide.

• Text Table: Imports texts into the Text info area (04), see Text Info Area on
page 368.

• Catalogs: Imports variable catalog values, see Catalogs on page 270.

If you import catalog values, make sure an up-to-date mm_catno.txt file is
present in the .. \system\db directory of the target station, see mmba.exe
Parameters on page 13 (--writedbstr parameter). Otherwise no Catalog
Maintenance (KW) records are created when importing translated catalog val-
ues. In that case you need to distribute the new catalog values via a data stock
download. For more information, see Communicating Catalogs in the Aurea
CRM win Administrator Guide.
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6. Activate the Database-independent check box if you are importing texts from
another database.

Note: This option must be enabled for files that were exported using the
Database-independent option. Otherwise the file cannot be imported.

7. Select the Input Format: CSV (Excel) or XML (Passolo).

8. Enter the path and file name of the translation in the Input File field or browse
to the location.

9. Click Next.

10.Enter the Connection String(s) for the Aurea CRM and/or CRM.designer
database(s) using the following syntax:

• for MS SQL databases:
Server=[name];Database=[name];UID=[login];PWD=[password]

• for Oracle databases: Data Source=[name];user id=[login];password=[password]

11.Enter the Table Prefix for the Aurea CRM database if applicable.

12.Click Check Connection(s).

13.Check Save settings to save the connection settings for later use.

14.Click Next.

The Import Summary is displayed.
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15.Enter the number of the target station in the Current Station No. field.

16.Click Check Import File to verify your settings.

The Target Language and affected CRM.designer configurations are displayed.

If the target language or a CRM.designer configuration is not found in the target
database, the file cannot be imported. (UPDATE* configurations are ignored on
import.)

When importing catalog values, the catalog base language of the import file must
match the catalog base language in the database. Otherwise the file cannot be
imported.

17.Click Next.

18.Click Start Import.

The texts are imported to database according to the specified settings. For infor-
mation on match-up rules, see Match-up on page 494.

CRM.designer texts flagged as "Sealed" are not updated on import.

Existing texts are overwritten without checking for changes since the last export.
If a translation exists in the database but not in the import file, the translation is
not deleted by the import process.

The import process is logged in LogFile.txt. Texts that could not be imported
are listed here.

Note: The changes to the database are not logged in detail. No History (H0)
records are written.
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19.Click Close to exit the application, or click Back to import another file.

20.Text table only: To apply the changes (translations) to the formats, select Write
language from the context menu in the Text info area, see Propagating Changes
on page 376.

Match-up
Learn how the texts are matched up while importing translations.

When importing translations, the texts are matched up as follows:

Text Records

Records in the Text info area are matched up by 04_1_StaNo + 04_1_SerNo +
Language No.

If a corresponding entry is found in the database, the Text field (or Text (long) if
the text length exceeds 2000 characters) is updated. Otherwise a new text record
is created. Language independent texts (Language No. '0') are never updated or
created.

Catalog Values

Catalog values are matched up by:

• DB-dependent: Catalog No. + Language No. + <xx>-TenNo + Code + Parent
Catalog

• DB-independent: Catalog No. + Language No. + <xx>-TenNo + External Key

If available, the external keys are exported in both the target language and the
catalog base language. When importing, the catalog values are first matched up
by the external key of the target language. If no matching key is found, the value
is then matched up by the external key of the base language.

If a corresponding entry is found in the database, the catalog value is updated.
Otherwise a new catalog value is created.

Designer Texts

Texts in CRM.designer are matched up by:

• DB-dependent: ConfigID + ID

• DB-independent: ConfigName + Textgroupname + Nr

If a corresponding entry is found in the database the text is updated. Otherwise a
new text is created.
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Importing Field Help
You can import field help that was provided by update, or you can import your own
field help that has been adapted to your customization.

To import field help to the Aurea CRM database:

1. Start TranslationTool.exe.

2. Select Import Online Field Help.

3. Select the desired database type: MS SQL or ORACLE.

4. Click Next.

(The Manual button opens this book if present in the .. \manuals folder.)

5. Enter the Connection String for the Aurea CRM database using the following
syntax:

• for MS SQL databases:
Server=[name];Database=[name];UID=[login];PWD=[password]

• for Oracle databases: Data Source=[name];user id=[login];password=[password]

6. Enter the Table Prefix for the Aurea CRM database.

7. Enter the path and file name of the field help (*.xlsx) in the Input File field or
browse to the location.

8. Click Check Connection(s).

9. Check Save settings to save the connection settings for later use.

10.Click Next.
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11.Select the Target Language and Station Number for the import.

Note:  Depending on the specified database connection the languages defined
in the Aurea CRM win database (Language info area (00)) are listed.

12.Click Start Import.

Field help is imported from the specified file to the Aurea CRM database. Records
with Do not update checked in the database are not updated by the import (if
the Do not update field help records marked with 'Do not Update ' check box
is enabled).

13.Click Exit to exit the application, or click Back to import field help for another
target language.

Note:  Importing field help does not delete obsolete field help records (i.e. field
help for deleted fields) from the database; you need to manually delete these FH
records from both the XSLX file and the database.

Exporting Field Help
To translate or edit the field help in MS Excel, you can export the contents of the
Field Help info area (FH) to an *.xlsx file.

Note: You can also generate a report to display the field help outside of Aurea
CRM, see Reports in the Aurea CRM win User Guide.
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You can also export the Text info area in order to translate texts, see Exporting
Texts for Translation on page 475.

To export the field help:

1. Make sure the information on the currently active data model is available in the
.. \system\db\mm_dbstr.txt file, see mmba.exe Parameters on page 13
(--writedbstr parameter). Make sure you create the mm_dbstr.txt file in the
language you want to export.

2. To update the field help to reflect the current data model, select Update field
help from the context menu (in the Field Help level), see Adding Field Help for
New Fields on page 383. This creates field help entries for the new fields (with NO
FIELD HELP in the "Comment" column).

3. Start TranslationTool.exe.

4. Select Export Online Field Help.

5. Select the desired database type: MS SQL or ORACLE.

6. Click Next.

7. Enter the Connection String for the Aurea CRM database using the following
syntax:

• for MS SQL databases:
Server=[name];Database=[name];UID=[login];PWD=[password]

• for Oracle databases: Data Source=[name];user id=[login];password=[password]

8. Enter the Table Prefix for the Aurea CRM database.
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9. Enter the path and file name in the Target File field or browse to the desired
location.

10.Click Check Connection(s).

11.Enable Save settings to save the connection settings for later use.

12.Click Next.

13.Select the Language To Export.

Note: The languages defined in the Aurea CRM win database (Language info
area (00)) of the specified database connection are listed.

14.Specify additional options if applicable:

• Only export items changed after: Specify a date and time to export only a
delta (for translation). The following field help records are exported:

• field help records created or updated after the specified date,

• field help records for which one of the linked Text records (Short Text, Long
Text, Admin Text) was created or updated in the specified language after
the specified date.

• Use this language to check update: Select a language against which Aurea
CRM should check for updated text table records linked to the field help. If
undefined, the Language to Export is used.
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When using these options, the following field help entries are exported:

• Field help records that where created or updated after the specified date

• Field help records whose linked text table records (Short Text, Long Text
or Administrator Info) were changed or added in the specified language
after the specified date.

If you have enabled Use this language to check update without selecting
a language, the text table record of the language specified under Language
to export is used.

• Export changed texts in language to check: Use this option together with
Only  export items after and Use this language to check update to create
a delta file for translation.

Enable this option to export all changed texts in the Language to check (i.e.
the source language) and any matching unchanged texts in the Language to
Export (i.e. the target language). This creates an XSLX file where only the
changed texts of a field help record (e.g. just the Functionality cell) is exported
in the source language and all unchanged texts are exported in the target lan-
guage.

• Resolve placeholders for fields and info areas: If enabled, all placeholders
used in field help texts are resolved to the actual field and info area names,
see Text Formatting and Placeholders on page 382. Use this option if you want
e.g. to create a PDF file containing the field help.

• Export XML field names: If enabled, the export creates an extra column
containing the XML field names (for reference). This column is ignored on
import.

Note: When using the Resolve placeholders for fields and info areas (and
XML field names as placeholders) and/or Export XML field names options,
the mm_dbstr.txt file required for the export needs to be created with the
additional parameter --xmlFieldNames.

15.Click Start Export.

The field help is exported to the specified file.

16.Click Exit to exit the application, or click Back to export texts in another language.
Make sure that an mm_dbstr.txt file for that language is available and specify
a different file name as Target File.
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Contents of the Field Help File
Learn about editing contents of field help file.

Instead of editing field help in the Field Help info area (see Field Help on page 380),
you can edit the *.xlsx file that you received from Aurea or that you exported from
the database.

You can edit the following columns in the field help XSLX:

• Description: Short description of the field.

• Functionality: Longer description of functionality and business logic.

• Comment: For internal use (max. 2500 characters); visible only in the XSLX file
and the Field Help info area (Maintenance module)

• Reference Info Area, Reference Field: Info area and field number of the field
whose field help you want to reuse. The Reference column contains the link to
the respective row.

On import, a link to the field help record is created automatically. If a row contains
both short/long texts and a reference, the texts are ignored.

Note: Texts (short and long) that are referencing the field help of another field
are output in green in the XSLX file (if exported with Resolve placeholders for
fields and info areas disabled): If you change the field help for such a field,
make sure you remove the reference from the XSLX.

• Do not update: If you enable this check box for a field help record, the field help
in the XSLX file is ignored during import and the existing field help record is
retained.

• Administrator Info: Information about the field which is only relevant to
administrators. This information is not displayed when a user opens the field help
(as a tooltip or using a function key). This information can be displayed in Aurea
CRM web by enabling the System.ShowAdminHelp Web Configuration parameter.

• Referenced by: Lists all fields which use this field help entry, thus providing
information on which field help entries are affected by changing the text of the
current entry.

Note: The Referenced by column is ignored on import.

The other columns (IDs, numbers) are handled by Aurea CRM. Do not remove these
columns.

For more information on editing the field help, see Text Formatting and Placeholders
on page 382.
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CRM.users tool
Use CRM.users tool (update.Users.exe) to set/change the special users required.

Example - for Aurea CRM web and to encrypt/decrypt the users.xml file,
see Creating the Special Users for Aurea CRM web in the Aurea CRM web Installation
& Technical Guide.

update.Users.exe is located in Aurea CRM webs' ..\bin directory.

User Interface

Command Line Parameters

Usage: update.Users operation [OPTIONS]

operation

Sets user name and password for a spe-
cial user.

set

Encrypts a users.xml file.encrypt

Decrypts a users.xml file.decrypt
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[OPTIONS]

Show help.-h, -?, --help

The path and name of the file.-f, --file, --files=VALUE

The output file name or directory.-o, --output=VALUE

The name of the encryption key (default "up-
date.eight.users").

-k, --key=VALUE

The type of user (operation set):

-t=Special

-t, --type=VALUE

The user name, e.g. WWW (operation set)-u, --username=VALUE

The password for the user (operation set)-p, --password=VALUE

For more information and examples, see the ar ticle “How to use users.xml” at
https://support.aurea.com.

Record Cache
Learn how record caching works for Aurea CRM.

Aurea CRM caches records both globally and locally, i.e. per session. If multiple
instances of Aurea CRM access the same record, the record may be cached by one
instance while it is updated by another instance. If instance 1 reloads the record
from the cache it may "lose" the changes made by instance 2.

CRM.core provides a configurable record cache:

• Global cache:

• single: Record cache per info area for frequently used info areas, e.g. FI.

• mixed: Up to 10 info area-independent caches, i.e. multiple info areas are
cached collectively.

• Session cache: one info area-independent (mixed) record cache.

The record cache is configured hard-coded, see Record Cache Defaults on page
503. These defaults can be overruled via an XML file, see performanceSettings.xml
on page 504.
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Read/Write

• Aurea CRM web:

• FetchId():

• if the MMC_RECORD_SEARCHINCACHE flag is enabled

• if MMC_READ_FOR_UPDATE or MMC_RECORD_BLOB are disabled and the cache
attribute <> "low" or FetchId() is explicitly disabled

• LoadRecordById():

• if the MMC_RECORD_SEARCHINCACHE flag is enabled (e.g. when building
references, or via FetchId())

• CRM.core:

• LoadReadRec(): if the cache attribute is set to "high"

Update/Delete

Update and delete operations are reflected in the cache.

Record Cache Defaults
Learn about the default record cache settings.

Info areas that are not cached:

• Catalog (KA)

• Language (00)

• Station Language (01)

• Key (02)

• System Event (03)

Info areas that are cached by the local cache (mixed):

• WWW Interest (II)

• WWW Interest Configuration (I9)

Info areas that are cached by the global cache (single):

• Company (FI)

• Person in Company (KP)

• Contact Person (CP)

• Person (PE)

• Activity (MA)

• Task (A1)
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• Absence (A3)

• To-Do (TD)

Custom info areas are cached in the global cache 2.

All other info areas are cached globally (mixed).

Once a minute the system checks for changes of the perfomanceSettings.xml
file if defined.

In debug mode once a minute the current state of the cache is written to the ..
\system\u8.log file.

To change these defaults and/or define fur ther settings, create a perfomanceSet-
tings.xml file, see performanceSettings.xml on page 504.

performanceSettings.xml
To configure the record cache create the file performanceSettings.xml in the
.. \sys directory.

Example:
<PerformanceSettings>
<RefreshCycle min='1' />
<DumpCycle min='1' />
<RecordCache>
<CacheTypes>
<CacheType id='1' cache='low' maxSize='2000' maxRecs='100' reloadInMin='30'
checkInMin='2'/>
</CacheTypes>
<GlobalCache>
<Table code='FI' cacheType='1' cacheNo='1' />
</GlobalCache>
<SessionCache>
</SessionCache>
<Not>
<Table code='KA'/>
</Not>
</RecordCache>
</PerformanceSettings>

Syntax:

The following settings are available:

<RefreshCycle min='1' />

By default, the system checks for changes of the perfomanceSettings.xml file
once a minute. Use this tag to define the refresh cycle in minutes.

<DumpCycle min='1' />

By default, in debug mode once a minute the current state of the cache is written
to the ..\system\u8.log file. Use this tag to set a different dump frequency in
minutes.
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<CacheTypes>

Use the <CacheTypes> node to define a set of parameters as a cache type to be
referenced by your global or session cache definitions (s. below).
<CacheType id='1' flags='9' cache='low' maxSize='2000' maxRecs='100'
reloadInMin='30'
checkInMin='2'/>

Available attributes:

id: Used to reference the cache type.

cache: Indicates what is cached:

• low: Only references are cached.

• medium: References and FetchId() operations performed by Aurea CRM web are
cached.

• high: In addition to the above LoadReadRec() operations performed by CRM.core
are cached.

maxSize: Determines the size of the cache in Bytes.

maxRecs: Determines the size of the cache in no. of records.

If the defined maxSize or maxRecs are exceeded, the least recently used records are
deleted from the cache.

reloadInMin: Determines the time span after which a record is reloaded.

checkInMin: Determines if a cached record is still valid, i.e. time span after which
the system checks if the record was updated. This setting applies only for
cache='medium' | 'high'.

<GlobalCache>

Use the <GlobalCache> node, to define one or more global caches (mixed and single).

<Table code='FI' cacheType='1' cacheNo='1' />

Available attributes:

• Table code: The info area to be cached.

• cacheType: The cache type to be used.

• cacheNo (optional): Defines an info area-independent (mixed) cache.

<SessionCache>

Use the <SessionCache> node, to configure the local record cache (mixed).

Available attributes: Table code and cacheType.

<Not>

Use the <Not> node to exclude info areas from being cached.
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Available attribute: Table code

Note: You can use wildcards in the Table code attribute to specify multiple info
areas at once.

Logs and Error Messages
Learn about the logs and error messages.

Logs are written to the following files in the .. \system\db directory:

User- and module-independent information: cam-
paign designer, XML output of conditions (debug
version), messages relating to loading the data
model, message relating to sending e-mails via
SMTP)

##GLOBAL_-1.log

user-independent information per module##GLOBAL_<module>.log

module-independent information per useru8_<USER>.log

The following files log user- and module-specific information:

mman.exeu8_analyze_<USER>.log

mmba.exeu8_base_<USER>.log

mmco.exeu8_communication_<US-
ER>.log

mmcfg.exeu8_config_##GLOBAL.log

mmim.exe -eu8_export_<USER>.log

mmim.exeu8_import_<USER>.log

mmpr.exeu8_print_<USER>.log

mmri.exeu8_rights_<USER>.log
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update.server.exeu8_server_<USER>.log

mmri.exe -wu8_service_<USER>.log

Logging is configured via the mm.ini file located in the ..\system\sys directory.
For information on all available options, see the ar ticle “How to Configure Logging
for the core” at https://support.aurea.com.

By default, the following information is logged:

• General information ("General" in the log file)

• Information on the business logic, e.g. log files for CRM.server ("Businesslogic")

• Export/import of formats via XML (Aurea CRM, cockpit, Aurea CRM web) ("XML")

• Information on the data model ("Datamodel")

• Aurea CRM initialization ("Init")

• User interface (desktops, masks) ("Userinterface")

• Imports and exports and parameters ("Import", only at log level "Info")

• Communication parameters ("Communication", only at log level "Info")

• E-mails sent via SMTP ("SMTP")

You can additionally choose to log the following information (only at log level "Info"):

• SQL access logs ("SQL"): Star t the application with the parameter -q:stmtlog
(see General Aurea CRM Parameters on page 11) or enable the options Windows
Trace and Web Trace in the Station Configuration info area, see Station Con-
figuration on page 233

• Trigger logs ("Trigger"): Enabled using a configuration entry, see Triggers on
page 67

• Workflow logs ("Workflow"): Enable using a configuration entry, seeWorkflow on
page 69.

Information is also logged in the following info areas:

• User Tracking, Session Tracking, Process Tracking, see Tracking on page 242

• Log - Read and Log - Write, see Logging Read and Write Access on page 245

• History, see History on page 258

• Communication logs, see Communication Logs in the Aurea CRM win Administrator
Guide.

For information on logging in Aurea CRM web, see Server Log in the Aurea CRM
web Technical & Installation Guide and the ar ticle “How to Configure Logging on
the Server" at https://support.aurea.com.
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System Event Info Area
System events are logged in the System Event info area in the Aurea CRM win
main module.

System events include:

You can communicate these records from branch offices to the main station in order
to be able to track errors on branch offices from a central location.

The value in the Error Type field indicates the following:

• 1: Non-interactive trigger error, see General Error Codes on page 508

• 4: Error loading format. If an error occurs when loading a format, a system event
record is added. The Error No. is 0 in this case.

• 7: Mail system error, e.g. an SMTP server timeout. The Text field contains a more
detailed error description if provided by the mail system.

• 40004: MAPI communication error, see Error Codes when Communicating via
MAPI on page 518

General Error Codes
Learn about the common error codes that can occur when working with Aurea CRM.

The following error messages can occur when working with Aurea CRM:

DescriptionCode

Record already exists2

Record was changed on the network;
operation not possible

8

File cannot be opened/created12

Inconsistent data (verification prior to
saving)

13

Record is incomplete (e.g. key fields are
missing)

16

No free IDs available17

Persons are still linked to the company;
company not deleted

18
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DescriptionCode

Saving the record by the check function
is not allowed (WEBDLL)

19

Table is locked for editing20

Table is locked for editing (condition)21

Table is locked for editing (top-down)22

Table is locked for editing (bottom-up)23

Table is locked for editing (mandatory
fields in rights format)

24

Constraint violated: Invalid timespan25

Assigning hierarchy code: The superior
entered is already entered as an employ-
ee of this rep

40

Assigning hierarchy code: The rep or su-
perior is currently being edited

41

Hierarchy code change: Unable to load
rep

45

Hierarchy code change: The superior
entered is already entered as an employ-
ee of this rep

47

Hierarchy code change: Rep or superior
is currently being edited

48

Language record could not be saved (in-
finite loop in the language hierarchy)

55

The numeric value is too high.80

Invalid value81
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DescriptionCode

The value is out of range.82

General initialization error97

Internal initialization error98

The data model DLL could not be loaded
(vvdmxxi.dll, whereby vv = bb, bc or fs;
xx = mss or or8)

99

No language DLL found (vv_eng.dll,
whereby vv = bb, bc or fs)

100

Incorrect star t directory101

Station number could not be read102

Error reading station configuration103

Invalid license104

User does not exist105

Incorrect password106

User does not have the necessary access
rights for the module

107

User has no login108

No multiple logins allowed109

User is already logged in110

Module may only be used in exclusive
mode

111

Maximum number of users for the module
reached

112
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DescriptionCode

Password has expired113

Login is locked (number of failed login
attempts exceeded)

114

SU user cannot be loaded115

The system has been locked manually120

The system was locked on the current
date

121

Daily system lock122

mmdb.ini not found131

A section in mmdb.ini was not found132

No table prefix entered in the mmdb.ini
file

133

Internal error134

Secure login error135

No connection with the database136

Not all entries in mmdb.ini are present or
correct

137

The character set entry in the mmdb.ini
file (NLS_LANG) does not correspond to
the character set in the database

138

No login table (US) present139

Initializing Aurea CRM server: No login
for the specified rep

141
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DescriptionCode

Initialization of Aurea CRM server: Un-
able to load rep

142

Initialization of Aurea CRM server: Un-
able to load rep group

143

Initialization: Tenant cannot be loaded146

Initialization: Assigned access rights
cannot be loaded

147

Initialization of Aurea CRM server: Rep
is inactive

148

Initialization: Rep role cannot be loaded.149

Recurring appointments: No possible date
found

160

Recurring appointments: Neither a num-
ber nor end date have been entered

161

Recurring appointments: End date prior
to star t date

162

Recurring appointments: No interval en-
tered

163

Recurring appointments: No weekday
entered "Weekly" interval)

164

Recurring appointments: No month en-
tered ("Monthly" or "Yearly" interval)

165

Recurring appointments: The weekday
specified is invalid

166

Recurring appointments: No day of the
month entered

167
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DescriptionCode

Recurring appointments: The current
station number is not the station on which
the record was added

168

Recurring appointments: No date entered
in the activity record

169

Different campaigns/activities in linked
participant and agenda item.

175

Invalid par ticipation status176

Database transaction: Error executing
transaction

180

Database transaction: A transaction is
already active

181

Database transaction: The transaction to
be terminated is not active

182

Database transaction: Error committing
transaction

183

Database transaction: Error rolling back
transaction

184

Database transaction: Error executing a
program call tr igger in a transaction

185

Database transaction: Error executing a
single letter trigger in a transaction

186

Database transaction: Error executing an
e-mail tr igger in a transaction

187
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Error Codes for Marketing Activities
Learn about the error codes for marketing activities.

Marketing activity error messages are written to the following fields or log files:

• Log (Marketing Activity) info area, Error field.

• system\db\<user name>_<module number>.log in the case of activities
executed manually

• system\db\<user name>_<service name>.log in the case of activities
executed using CRM.server

• In a text field in the Target Group (Marketing Activity), if configured, see Cam-
paigns on page 29.

TextCode

OK0

Cancel1

General error2

Problem with access rights3

Problem opening the selection4

Problem opening the document5

Unable to log on to the e-mail system6

E-mail cannot be sent7

Connection with the word processor cannot be established10

Connection with the word processor cannot be established11

Word processor cannot be initialized12

Data cannot be sent to word processor13

Log file cannot be opened: <file name>14

Unable to log on to the SMS system15
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TextCode

SMS cannot be sent16

Activity format could not be loaded20

Record could not be loaded: Activity21

Record could not be loaded: Execution (Marketing Activity)22

Record could not be loaded: Campaign23

The current date is outside the defined timeframe of the Campaign:30

The status of the Campaign is incorrect:31

The status of the Activity is incorrect:32

The status of the Activity Execution is incorrect:34

The number of the executing station is not the number of the current station:35

The rep executing the activity is not the current user:36

It is not yet the star t date of the Activity Execution:37

It is not yet the end date for editing the target group:38

Activity has already been generated:39

It is not yet the scheduled generation date:40

Record could not be added:41

Record could not be changed:42

Record could not be saved: Activity50

Record could not be saved: Execution (Marketing Activity)51

Selection cannot be copied52
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TextCode

Selection cannot be loaded53

Selection cannot be executed54

Execution (Marketing Activity) cannot be changed55

Generation not necessary56

Company/Person level must be open57

At least one record must be generated to be able to generate packages58

Packages can only be generated based on a selection59

Data cannot be read60

Data cannot be read61

Temporary process cannot be created62

Cannot load query63

Cannot execute query64

Cannot execute query65

Access to record denied: Company70

Access to record denied: Person in Company71

No e-mail address entered:72

No telephone number for SMS entered:73

No fax number entered:74

No valid address for channel entered:75

Invalid Webserver Address76
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TextCode

The connection with the web server cannot be initialized.77

The HTTP session with the server address entered cannot be initialized.78

The HTTP request cannot be created.79

This query cannot be sent to the web server.80

The header information in the HTTP request could not be found.81

The data could not be read by the web server.82

The e-mail cannot be sent.

(Note that the process is continued nonetheless.)

83

Communication Error Codes
This topic has a list communication error code.

DescriptionCode

The output file cannot be created; this may be due to a lack of hard disk
space or system resources.

1

Output file cannot be opened; this may be due to a lack of hard disk space
or system resources.

2

Output file cannot be written; this may be due to a lack of hard disk space
or system resources.

3

Positioning is not possible in the output file; this may be due to a lack of
hard disk space or system resources.

4

Memory allocation error; this may be due to a lack of hard disk space or
system resources.

8

Incorrect file length30

Error applying catalog31
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DescriptionCode

Data error32

Internal error34

Incomplete file; the output process may have been interrupted. The file is
moved to the \<Source station number>\ERR directory on the
target station.

35

Catalog maintenance error when replacing an entry37

Error adding a new catalog maintenance record41

Transferred data model format cannot be deserialized44

New data model cannot be implemented45

Data model in the communication file is not up to date, see Outdated Data
Model at Branch Offices in the Aurea CRM win Administrator Guide

46

Error Codes when Communicating via MAPI
Learn about the error codes when communicating via MAPI.

DescriptionCode

MAILCALL.DLL could not be found.50

MAPI could not be initialized.51

File could not be sent.52

File could not be received (written).53

Confirmation could not be sent.54

General error (bug in mailcall.dll)55

Message could not be input56

Message acknowledgment could not be sent.57
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DescriptionCode

Message could not be sent.58

Try and load the MAPI lib a second time.59

Current station has no e-mail address.60

File could not be appended to message.61

Message was faulty on arrival.62

A new synchronization process could not be star ted.63

Recent output failed.64

This synchronization was aborted as a new one is already active.65

MAPI could not be star ted. Send file later.66

Import/Export Error Codes
Learn about the Import/Export error codes.

DescriptionCode

The name of the import/export file is not specified.501

No access to source file, i.e. unable to open import/export file.502

Unable to locate the position of the offset in the import/export file.503

No connection to source table or field(s) in the source table wrong (only
when importing/exporting databases).

504

No columns defined in the database table (only when importing/exporting
databases).

505

Database table cannot be opened (only when importing/exporting databases).506

Unique index required (only when importing/exporting databases).507
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DescriptionCode

Log file cannot be opened.508

No import fields defined.509

SQL error, i.e. database table cannot be read.510

Unable to write to export file.511

Record rejected due to condition.512

Record rejected due to tenant rights.513

Value exceeds the permitted maximum.514

Value is lower than the permitted minimum.515

The value may not be negative.516

Invalid month.517

Invalid day.518

Invalid catalog value.519

Invalid rep ID.520

Parent record has been deleted.521

Parent record could not be found.522

Rejected due to invalid field rights.523

Deleting field not permitted due to invalid field rights.524

Format not found.525

Invalid format.526

Invalid hour.527
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DescriptionCode

Invalid minute.528

Invalid second.529

Invalid conversion of data types.530

Invalid numeric conversion.531

Match-up record not found.

Note: This error may occur e.g. if a record is matched-up and not found in
the database and New is disabled for the record's info area in the import
format.

532

Catalog: Parent value not found.

This error occurs when importing catalog values into the KA table: If a parent
catalog value is not found, the catalog value is not imported.

534

Chart Error Codes
Learn about the error codes for chart structures.

The following error messages can occur when working with chart structures in Aurea
CRM win (see Chart Structures in the Aurea CRM win Administrator Guide):

DescriptionCode

No root node found251

Invalid input record252

Condition not met253

Query or transfer fields format cannot be loaded254

Infinite loop255

For internal use256

521AUREA CONFIDENTIAL

Logs and Error Messages



DescriptionCode

For internal use257

For internal use258

No link present in the data model between the parent and root node259

The generated record is of the wrong type (info area)260

Recursive reading is not supported261

The read engine cannot be initialized262

For internal use263

For internal use264

Collecting data for child records returns the wrong info area265

Collecting data for child records returns no data266

Unable to initialize the read engine for child records267

Internal sor t error268

Error Codes for Target Group Records
If an error occurs when sending e-mails, you can determine (in the Configuration
info area) that a message is linked to the target group record.

Further information can be found under see Campaigns on page 29 (Generate
message on error option).
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5
Industry Solution Configuration
Learn about the functions that support the development of industry solutions.

The following topics describes those functions that support the development of In-
dustry Solutions and deriving multiple solutions from a single Base Solution. This
topic is solely directed at internal Aurea CRM users and partners.

Merging Data Models
Learn how to merge data models.

By default, data model changes transferred between stations using the Aurea CRM
win Communication module or CRM.cockpit overwrite the data model on the target
station, see Communicating Data Model Changes on page 285. By using different
(station) number ranges, you can prevent changes to Industry Solution data models
from being overwritten by updated data models, for example. Any changes made to
the data model are instead merged with the existing data model on the station.

Requirements:

• Stations used to maintain data models must always be set as the main office,
see Defining a Station on page 112.

• Stations used to maintain data models must use different number ranges and/or
station number ranges, see Number Ranges in Aurea CRM on page 398 and Station
Number Ranges on page 526.

• A design data model must be present on the target station.

• For correct handling of texts, make sure to use different language ranges for Base
and Industry Solutions. Texts in languages with IDs>= 100 are not overwritten by
the base data model during import.

If these requirements are not met, the data model is overwritten on the target station
(default behavior).

Note:  Aurea recommends only changing those elements (info areas, fields, catalogs
etc.) on the station they were added on or have been assigned to the station’s
number range.
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Merging data models via e-mail

The data model can be exported, sent via e-mail, and imported on the target station.

1. Select Export Data Model (-> E-Mail) from the context menu for the Active data
model.

An e-mail is created with the subject "MM_BLOB_2". A file with the same name
is added as an attachment.

2. Send the e-mail.

3. Select Import Data Model (<- E-mail) from the Design node’s context menu.

The data model is imported. (The system searches for the corresponding e-mail
in the current user’s inbox.)

Two new archived data models are created on the target station:

• The newly imported data model (with the corresponding station number)

• The current design data model on the target station prior to importing the new
data model

Any messages concerning problems that occurred while importing the data model
are written to the Maintenance module’s log file, see Logs and Error Messages
on page 506.

4. The imported data model changes are color-coded, as with "normal" data model
changes, and need to be applied manually, see .

• yellow: New elements that can be applied to the data model or deleted

• red: Elements deleted in the external data model. If you apply the changes,
the element is also deleted on the target station. If you select Undo Changes
from the context menu, the element is retained on the target station.

• pink: Elements changed by the external data model that were already present
in the internal data model. In this case, the element properties are displayed
for the data model that the element was originally added to. You can apply the
change, undo the change, or change the affected element manually before
applying changes.
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Merging data models via communication

You can also merge data models using <suite's> communication mechanism. In order
to be able to merge data models, the data model you are importing may not have
been created on the target station.

When inputting the data model, a message is displayed:

• Confirm with Yes to merge the data models automatically. Only in the case of
conflicts are these changes color-coded and need to be applied manually (see
above).

• Select No to cancel the process with error 45.

Message concerning problems encountered when inputting the data model are
written to the Communication module's log file.

Once you have input the data model, you are prompted to restar t communication.

In order to merge data models using automatic communication, use the --DmMerge
parameter, >> mmco.exe Parameters.

Merging data models via CRM.cockpit

Merging data models in CRM.cockpit is identical to merging via communication. Any
conflicts need to be resolved after inputting the data model (see above).

Maintaining Catalogs on Multiple Stations
You can communicate catalog maintenance records between stations which are
both defined as the catalog maintenance station.

Example - a development station at a customer <-> Industry Solution station. The
(In. )Cat.Maint . ID field in the station record of the target station stores the highest
(Ext. )Cat.Maint . ID in the station record of the source station, and not the highest
catalog maintenance ID on the target station.

In such cases, IDs are generated when inputting catalog maintenance records (Ext.
Key field in the Catalog Maintenance (KW) info area; composed of the source
station number and serial number). This ID uniquely identifies catalog maintenance
records from other catalog maintenance stations. This prevents changes to catalogs
from being applied multiple times on the same station.
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Preventing the Updating of Catalog Values
Learn about the values that cannot be changed to prevent updating of catalog values.

To prevent the unwanted updating of variable catalog values delivered with an In-
dustry Solution, the following values (in the catalog base language) can not be
changed (i.e. the respective cells are read-only in the Catalog info area):

• Tenant

• External Key

• Text

This applies to catalog values delivered with an Industry Solution with the following
tenant numbers:

• ISI, FSI: 9000

• LSI: 9000, 9004, 9005

Note: This restriction is not applied in the Communication module and when
importing Industry Solutions with CRM.cockpit.

If you want to change these values anyway, add the following option to the mm.ini
file:
[Option]
ChangeTemplateCatalog=on

Note:  Only use this setting in an environment where no fur ther upgrades of the
Industry Solution are planned.

Station Number Ranges
Learn about the valid number ranges for stations.

Valid number ranges for station numbers:

• 1-9999: Station numbers for customers

• 10000-10003: update-internal station numbers

• 10000: Base development station

• 10001: BTB development station

• 10002: OTC development station

• 10003: FS development station
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• 10010-10014: update-internal station numbers for additional Base development
stations

• 10020-10024: update-internal station numbers for additional ver tical-specific
development stations

• 10100-10104: Station numbers for par tners

All other 5-digit station numbers are invalid.

Note: You need a password for station numbers higher than 9999.

Migration

If a station number is subsequently changed to a number over 10000, existing data
can be migrated accordingly (keys, formats, distributed logic records, rep, document
& text IDs) when next star ting the Maintenance module. After migrating the data,
all *.cfg files containing user-specific settings need to be deleted to prevent unex-
pected results, see .. \<user name> in the Aurea CRM win Administrator Guide.

When changing station numbers within the 1-9999 range (or from a station number
star ting from 10000 to a number below 10000), no data is migrated.

Functionality

Depending on the station number, IDs for user-defined info areas, fields, variables
and fixed catalogs, links and indices are assigned from different number ranges,
see Number Ranges in Aurea CRM on page 398.

Note:  On a station with a number > 10000, do not select a user group when e.g.
modifying the data model. The station number already determines the number ranges
to be used.

Only info areas, fields and catalogs present in all ver ticals are available in the data
model on stations 10000 and 10010-10014. This allows you to create "Base" config-
urations that can be used by Industry Solutions for all ver ticals, see Vertical-inde-
pendent Configuration on page 528.

Records created on a station with a station number >= 10000 cannot be deleted on
stations with a station number < 10000 (not even by the SU). Exception: Catalog
values in variable catalogs can be deleted on all stations (using Aurea CRM win’s
catalog maintenance features).

Use the Allow deletion of the following data configuration entry (Business Solu-
tions category) in the Configuration info area to override this behavior: You can
specify info areas from which records may be deleted on stations with a station
number < 10000, see Business Solutions on page 24.
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Vertical-independent Configuration
Learn about the ver tical independent info areas, fields and catalogs.

The data model on station 10000 contains those info areas, fields and catalogs that
are present in all ver ticals. All ver tical-specific elements are hidden or displayed as
inactive (e.g. when defining access rights). This allows you to make general changes
to the data model on this "Base" station and distribute the changes to Industry So-
lutions for individual ver ticals.

"Base" elements are identified by special IDs:

Info Areas

• Base info areas: Info areas that are identical in all ver ticals (e.g. Rep (ID),
Station (AS) etc.). Use the --writedbstr parameter to generate the file
mm_rel_base.txt, which contains a list of all base info areas, see mmba.exe
Parameters on page 13.

• Base info areas with different codes: Info areas whose contents are identical,
but whose info area codes differ. These info areas have an additional Base info
area code which is used in XML reports and to define variables (in the Variable
info area).

Info AreaBaseFSBCBB

Exchange Rate0WKWKWTWK

Relationship level0BLB5B5BL

Allocation0BZ-ZUBZ

Participant0RO-PARO

Sales Area (Partner)0VP-VEVP

Stock0B6B6BSB6

Stock Control0B7B7BVB7

Stock Cont.Item0B8B8BPB8

Receipt Type Calc.0BABABLBA

Installed Base Item/Inst. Base Position0KO-IPKO

• Info areas containing Base fields: Info areas present in all ver ticals, but whose
fields are only par tially identical (e.g. Company). Fields common to all ver ticals
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have Base field numbers. Use the --writedbstr parameter to generate the file
mm_dbfnr_base.txt: This file contains the common fields in these info areas
together with the Base field numbers, see mmba.exe Parameters on page 13.

Fields

The following number ranges apply to Base fields (see above):

CommentVerticalField Num-
ber

For all ver ticalsBase1000-1999

BTB + OTC2000-2499

BTB + FS2500-2999

OTC + FS3000-3499

The file mm_dbfnr_base.txt contains all Base fields and the Base field numbers
(see above). Base fields numbers are displayed as the third field number in the
window containing all fields in an info area, see Displaying all Fields in a Mask on
page 388.

Catalog

Base catalog numbers exist for variable catalogs using the following number ranges:

CommentVerticalCatalog Num-
ber

For all ver ticalsBase20000-22999

BTB + OTC23000-23999

BTB + FS24000-24999

OTC + FS25000-25999

The file mm_catno.txt contains the Base catalog number for Base catalogs (in
the last column), see mmba.exe Parameters on page 13.

There is no differentiation between Base and ver tical-specific fixed catalogs.
Vertical-specific fixed catalogs are located in the number range 10-29. Please note
that the order of catalog entries (and consequently their codes) may differ between
verticals (e.g. in the Activity info area).
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Distributing the Base configuration

Base configurations can be transferred to the same vertical using Aurea CRM’s
communication mechanisms. CRM.cockpit must be used to transfer the configuration
to other ver ticals to ensure that IDs are converted correctly. For more information,
refer to the CRM.cockpit documentation.

Base configurations defined in CRM.designer can be transferred using Aurea CRM
bulkloader or CRM.cockpit. For more details, refer to the Aurea CRM web Technical
& Installation Guide.

Mixed purpose:

To develop a base configuration for just 2 ver ticals, use the following mmdb.ini
entries:

[CORE]

Vertical = xxxx

The following values are possible:

DescriptionValue

BTB+OTCBBBC

BTB+FSBBFS

OTC+FSBCFS

This results in the common elements of two ver ticals being displayed on the Base
station: All fields, catalogs and info areas common to both specified ver ticals can
then be used by the Base configuration.

Empty texts in the Text info area
Learn how to add empty texts in text info area.

In the Text info area there is a context menu option Include empty texts (available
only on Industry Solution stations (station number >= 10000)).
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